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Preface
Welcome to the Outbound Contact 7.6 Deployment Guide. This document 
provides step-by-step instructions for the configuration and installation of the 
applications and components that are required in order to run Outbound 
Contact 7.6.
This document is valid only for the 7.6 releases of this product. 

Note: For releases of this document created for other releases of this product, 
please visit the Genesys Technical Support website, or request the 
Documentation Library DVD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com.

This preface contains the following sections:
Intended Audience, page 12
Chapter Summaries, page 12
Document Conventions, page 13
Related Resources, page 15
Making Comments on This Document, page 16
Document Change History, page 16

Outbound Contact 7.6 is an automated system for creating, modifying, 
running, and reporting on outbound campaigns for proactive customer contact. 
Outbound Contact Server (OCS) provides automated dialing and call progress 
detection, so that an agent is required only when a customer is connected. OCS 
also intelligently uses customer data to ensure that campaigns are contacting 
the right customers, not just a large number of customers.

mailto:orderman@genesyslab.com
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Preface Intended Audience

Intended Audience
This document is primarily intended for system engineers and other members 
of an implementation team who set and maintain Outbound Contact 7.6. This 
guide assumes that you have a basic understanding of:
• Computer-telephony integration (CTI) concepts, processes, terminology, 

and applications.
• Network design and operation.
• Your own network configurations.
You should also be familiar with the Genesys Framework architecture and 
functions, that support Outbound Contact 7.6.

Chapter Summaries
In addition to this preface, this document contains the following chapters: 
• Chapter 1, “Overview,” on page 23, provides an overview of the new 

features and functions for this release, and defines the basic terms and 
concepts that are relevant to this solution. 

• Chapter 2, “Architecture,” on page 29, provides information about each 
component of this solution. It also contains information about other 
Genesys applications that enable and support Outbound Contact 7.6.

• Chapter 3, “Deployment Planning,” on page 73, describes some of the 
system sizing requirements for the installation of the Outbound Contact 
product, and it also explains how to plan the configuration and installation 
of Outbound Contact.

• Chapter 4, “Outbound Solution Wizard,” on page 97, explains how to 
install and start the Outbound Contact Wizard. It also describes the 
configuration process using the Call Progress Detection (CPD) Server 
Wizard, and how CPD Server works with Dialogic boards.

• Chapter 5, “Manually Configuring and Installing Outbound Applications,” 
on page 103, explains how to manually configure and install Outbound 
Contact.

• Chapter 6, “Silent Setup,” on page 125, explains how to perform an 
automated electronic software distribution.

• Chapter 7, “Manually Defining Outbound Configuration Objects,” on 
page 129, explains how to configure the Outbound-related objects in 
Configuration Manager. It contains a section for each Outbound-related 
object and the properties to be defined.

• Chapter 8, “Outbound Contact Configuration Options,” on page 171, 
describes the various options that can be used to ensure that Outbound 
Contact performs as needed in your environment.
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• Chapter 9, “Log Files,” on page 263, explains how to enable record history 
logging and extended audit trail logs.

• Chapter 10, “Call Handling,” on page 275, describes how treatments can 
be used against various call results.

• Chapter 11, “Deploying Do Not Call Functionality,” on page 295, explains 
how to implement Do Not Call features.

• Chapter 12, “Configuring Dialogic Boards,” on page 301, describes 
various types of Dialogic boards, and explains how to install them.

• Chapter 13, “Starting and Stopping Procedures,” on page 327, explains 
how to start and stop Outbound Contact with the Solution Control Interface 
(SCI). It also explains how to start and stop Outbound Contact Server and 
CPD Server manually.

Document Conventions
This document uses certain stylistic and typographical conventions—
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:
76ou_dep_05-2008_v7.6.101.00 

You will need this number when you are talking with Genesys Technical 
Support about this product.

Type Styles

Italic

In this document, italic is used for emphasis, for documents’ titles, for 
definitions of (or first references to) unfamiliar terms, and for mathematical 
variables.

Examples: • Please consult the Genesys 7 Migration Guide for more information.
• A customary and usual practice is one that is widely accepted and used 

within a particular industry or profession.
• Do not use this value for this option.
• The formula, x +1 = 7 where x stands for . . .
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Monospace Font

A monospace font, which looks like teletype or typewriter text, is used for 
all programming identifiers and GUI elements. 
This convention includes the names of directories, files, folders, configuration 
objects, paths, scripts, dialog boxes, options, fields, text and list boxes, 
operational modes, all buttons (including radio buttons), check boxes, 
commands, tabs, CTI events, and error messages; the values of options; logical 
arguments and command syntax; and code samples.

Examples: • Select the Show variables on screen check box.
• Click the Summation button.
• In the Properties dialog box, enter the value for the host server in your 

environment.
• In the Operand text box, enter your formula.
• Click OK to exit the Properties dialog box.
• The following table presents the complete set of error messages T-Server 

distributes in EventError events.
• If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.
Monospace is also used for any text that users must manually enter during a 
configuration or installation procedure, or on a command line:

Example: • Enter exit on the command line.

Screen Captures Used in This Document

Screen captures from the product GUI (graphical user interface), as used in this 
document, may sometimes contain a minor spelling, capitalization, or 
grammatical error. The text accompanying and explaining the screen captures 
corrects such errors except when such a correction would prevent you from 
installing, configuring, or successfully using the product. For example, if the 
name of an option contains a usage error, the name would be presented exactly 
as it appears in the product GUI; the error would not be corrected in any 
accompanying text.

Square Brackets

Square brackets indicate that a particular parameter or value is optional within 
a logical argument, a command, or some programming syntax. That is, the 
parameter’s or value’s presence is not required to resolve the argument, 
command, or block of code. The user decides whether to include this optional 
information. Here is a sample:
smcp_server -host [/flags]
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Angle Brackets

Angle brackets indicate a placeholder for a value that the user must specify. 
This might be a DN or port number specific to your enterprise. Here is a 
sample:
smcp_server -host <confighost>

Related Resources
Consult these additional resources as necessary:
• The Outbound Contact 7.6 Reference Manual, which describes application 

features for Outbound Contact 7.6 and provides information about 
configuration options, constants, and communication protocols.

• Outbound Contact Manager 7.6 Help, which describes how to use 
Outbound Contact Manager.

• The Genesys 7.6 Proactive Contact Solution Guide, which consolidates 
information about the Genesys Proactive Contact solution. The Genesys 
Proactive Contact solution integrates Outbound Contact with Genesys 
Voice Platform (GVP), and provides the ability to proactively initiate and 
handle outbound campaign calls using GVP.

• The Genesys Proactive Routing Solution Guide, which provides 
instructions on how to integrate Outbound Contact with the Customer 
Interaction Management (CIM) Platform.

• The Framework 7.6 Deployment Guide, which will help you configure, 
install, start, and stop Framework components.

• The Framework 7.6 Configuration Options Reference Manual, which will 
provide you with descriptions of configuration options for other 
Framework components.

• The Framework 7.6 Configuration Manager Help, which will help you use 
Configuration Manager.

• The Genesys 7 Migration Guide, also on the Genesys Documentation 
Library DVD, which contains a documented migration strategy from 
Genesys product releases 5.x and later to all Genesys 7.x releases. Contact 
Genesys Technical Support for additional information.

• The Genesys 7 Events and Models Reference Manual, which contains the 
T-Library API, information on TEvents, and an extensive collection of call 
models.

• The Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library DVD and which provides a comprehensive list of 
the Genesys and CTI terminology and acronyms used in this document.

• The Release Notes and Product Advisories for this product, which are 
available on the Genesys Technical Support website at http://
genesyslab.com/support. 

http://genesyslab.com/support
http://genesyslab.com/support
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Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 
• Genesys 7 Supported Operating Systems and Databases 
• Genesys 7 Supported Media Interfaces 
Genesys product documentation is available on the:
• Genesys Technical Support website at http://genesyslab.com/support.
• Genesys Documentation Library DVD, which you can order by e-mail 

from Genesys Order Management at orderman@genesyslab.com. 

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 
You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.
When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

Document Change History
This section lists topics that are new in the current release of this document, or 
that have changed significantly from the preceding release.

New in Document Version 7.6.102.00
Table 1 provides details about what is new or has changed significantly from 
release 7.6.101.00 to 7.6.102.00 of this document.

Table 1: Document Changes

Chapter Heading/Topic Page Details

Chapter 1, “Overview,” on page 23

New Features in Release 7.6.101 24 New section added that 
identifies the features added in 
the 7.6.101 release.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
http://genesyslab.com/support
mailto:orderman@genesyslab.com
mailto:techpubs.webadmin@genesyslab.com
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Chapter 2, “Architecture,” on page 29

Outbound Architecture Overview > Call 
Progress Detection Server > Dialing 
Methods > Engaging Call section

34 A note added to reference the 
new section about how the 
predictive algorithm accounts 
for engaging call dialing 
duration.

Dialing Overview > Dialing Modes > 
Predictive Algorithm Self-diagnostic

54 A new section to explain this 
new capability of the 
predictive algorithm.

Dialing Overview > Dialing Modes > 
Predictive Algorithm and Engaging Call 
Dialing Duration

55 A new section to explain how 
the predictive algorithm 
accounts for engaging call 
dialing duration.

Dialing Overview > Dialing Modes > 
Preview Dialing Mode

57 A note added to reference a 
new option that instructs OCS 
how to handle the scenario 
when an outbound call is 
placed manually in the 
Preview dialing mode but then 
released when it is not 
established

Multiple Sites, Users, and Tenants> Multi-
Tenant Environment > Centralized 
Configuration and Shared HMP Resources

63 A new section to explain how 
HMP resources can be shared 
in a multi-tenant environment.

Chapter 5, “Manually Configuring and Installing Outbound Applications,” on page 103

Overview > Table 8, Task Summary 104 A new table to summarize 
configuration procedures and 
actions.

Configuration > CPD Proxy Server 112 A note added to reference a 
new section about configuring 
a multi-tenant environment to 
share HMP resources.

Installing on Windows > Installing OCM 
on Microsoft Windows 2000, 2003, Vista, 
or XP

120 Additions indicating that 
Outbound Contact Manager 
can be installed on Vista.

Table 1: Document Changes (Continued) 

Chapter Heading/Topic Page Details
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Chapter 7, “Manually Defining Outbound Configuration Objects,” on page 129

Campaign Group Object > General > 
Group section

166 A note was added to explain 
how OCS handles Personal 
Call backs and Personal 
Rescheduled records when 
running an outbound 
Campaign against multiple 
agent groups.

Campaign Group Object > Advanced tab 
> Buffer Size Coefficient section

169 Corrected the first sentence to 
explain that the default is [4] 
for Minimum. It had 
previously stated Maximum.

Chapter 8, “Outbound Contact Configuration Options,” on page 171

callback-observe-group 186 A new OCS option that 
specifies whether OCS should 
select Personal Callbacks and 
Personal Rescheduled records 
from the Calling Lists based 
on both the Campaign DBID 
and the Group DBID or just 
the Campaign DBID.

force-unload-wait-db 187 A new option that controls 
how OCS handles requests for 
a records update sent to the 
database when a Campaign is 
unloaded forcefully.

pa-selfcheck-awt-threshold 198 A new OCS option that 
specifies the percentage of the 
target Average Waiting Time 
that the predictive algorithm 
uses as the threshold to report 
about a dialing performance 
degradation.

Table 1: Document Changes (Continued) 

Chapter Heading/Topic Page Details
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pa-selfcheck-bf-threshold 199 A new OCS option that 
specifies the percentage of the 
target Busy Factor that the 
predictive algorithm (PA) 
uses as the threshold to report 
about a dialing performance 
degradation.

pa-selfcheck-interval 199 A new OCS option that 
specifies the time interval, in 
minutes, that the predictive 
algorithm uses to calculate the 
current values of the 
optimization parameters and 
to track any suspicious cases 
for reporting dialing 
performance degradation. 

pa-selfcheck-odr-threshold 199 A new OCS option that 
specifies the percentage of the 
target Overdial Rate that the 
predictive algorithm uses as 
the threshold to report about a 
dialing performance 
degradation.

preview_release_nocontact_action 219 A new OCS option that 
determines the teleset state 
after an agent releases an 
unsuccessful outbound call 
that the agent had placed 
manually.

vtd-override 209 A new OCS option that 
defines the name of the Voice 
Transfer Destination DN that 
OCS sends to CPD Server in 
the extensions of 
RequestSeizeAgent and 
RequestMakePredictiveCall.

Table 1: Document Changes (Continued) 

Chapter Heading/Topic Page Details
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New in Document Version 7.6.101.00
Table 2 provides details about what is new or has changed significantly from 
release 7.6.001.00 to 7.6.101.00 of this document.

max-dialing-channels 230 A new CPD Proxy Server 
option that specifies the 
maximum number of dialing 
channels that can be used by 
the OCS client of CPD Proxy 
Server.

max-engaging-channels 230 A new CPD Proxy Server 
option that specifies the 
maximum number of 
engaging channels that can be 
used by the OCS client of 
CPD Proxy Server.

engaged_answer_action 217 A new OCS option that 
determines the teleset state 
after an engaging call has 
been established.

engaged_release_action 217 A new OCS option that 
determines the teleset state 
after an engaging call has 
been released.

CPD Server Options > Correlation 
Between CPD Server Options and 
Dialogic Boards > ASM Dialer Mode > 
HMP (Table 20) > isdn section > use-
channel-state

249 The value for siphmp-
asmlinetype column was 
changed to No.

Table 1: Document Changes (Continued) 

Chapter Heading/Topic Page Details

Table 2: Document Changes

Chapter Heading/Topic Page Details

Chapter 1, “Overview,” on page 23

New Features in Release 7.6.1 26 New section added that 
identifies the features added in 
the 7.6.1 release.
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Chapter 2, “Architecture,” on page 29

Predictive Dialing Modes with Agent 
Feedback

53 A new section to explain this 
new capability.

Predictive Dialing Modes for Small 
Groups

54 A new section to explain how 
OCS handles small groups.

Chapter 4, “Outbound Solution Wizard,” on page 97

A new note 97 Note added that the Outbound 
Contact Configuration Wizard 
should only be used for 
standard configurations.

Chapter 5, “Manually Configuring and Installing Outbound Applications,” on page 103

Outbound-Specific Statistics for Stat 
Server > New Statistics as of Release 7.6.1

113 Two outbound-specific, real-
time statistics were added in 
the 7.6.1 release: 
CurrentTrustFactor and 
CurrentFeedbackAccuracy.

Chapter 7, “Manually Defining Outbound Configuration Objects,” on page 129

Table 16 > Assign to Group 159 Corrected the name of the call 
result (Agent CallBack 
Error) in the description

Table 16 > Mark as Agent Error 159 Corrected the name of the call 
results (Agent CallBack 
Error and Group CallBack 
Error) in the description.
Also added a note.

Chapter 8, “Outbound Contact Configuration Options,” on page 171

outbound_agent_outlier_limit 197 Note added explaining that 
this option has a lower 
priority when the new 7.6.1 
predictive-longcalls-
truncation option is 
configured.

Table 2: Document Changes (Continued) 

Chapter Heading/Topic Page Details
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predictive_algorithm 200 A new value, 
advanced_small_group, was 
added to release 7.6.1, which 
use an advanced small group 
algorithm that accounts for all 
inbound calls and also allows 
calls to be initiated, even if 
one or more calls remain in 
the dialing stage, rather than 
waiting until all dialed calls 
are completed.

predictive-longcalls-truncation 203 A new option added to release 
7.6.1 that instructs the 
predictive algorithm how to 
handle so-called “long” 
outbound calls, (that is, if a 
few outbound calls last 
significantly longer than the 
majority of the outbound calls 
for the given campaign 
group).

time-to-ready-tolerance 208 A new option was added in 
release 7.6.1 to specify the 
allowed variance on the time 
estimate provided by the 
desktop for when an agent 
will become Ready.

small_group_size 208 In release 7.6.1, the maximum 
valid value limit of agents to 
50 was removed.

Table 2: Document Changes (Continued) 

Chapter Heading/Topic Page Details
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Chapter

1 Overview
This chapter provides an overview of Outbound Contact 7.6. It introduces the 
new features and functions for this release, and defines the basic terms and 
concepts that are relevant to the Outbound Contact solution. 
This chapter contains the following sections:

Introduction to Outbound Contact 7.6, page 23
New in This Release, page 24

Introduction to Outbound Contact 7.6
Outbound Contact 7.6 is an automated system that is used to create, modify, 
and run outbound dialing campaigns in which agents interact with customers. 
Running a campaign involves launching the campaign, monitoring it, and 
making any necessary adjustments. To perform these tasks, Outbound Contact 
users can:
• Create calling lists from customer contact information.
• Group calling lists into campaigns for outbound dialing.
• Share campaigns among multiple agent groups.
• Create campaign sequences with the Campaign Sequence object, which 

provides predefined thresholds and automatic agent assignments.
• Chain records for a customer (multiple call records).
• Choose different dialing modes.
• Define treatments and scheduled calls for unsuccessful calls on each 

calling list.
• Monitor campaigns using Reporting tools.
• Apply Do Not Call restrictions by phone number or customer ID.
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Outbound Contact has a client/server architecture consisting of the following 
components: Outbound Contact Server (OCS), Outbound Contact Manager 
(OCM), Call Progress Detection Server (CPD Server), and CPD Proxy Server. 
See “Architecture” on page 29 for more information about these components.

New in This Release
This section describes the new configuration and/or installation procedures in 
Outbound Contact 7.6.

New Features in Release 7.6.101
The 7.6.101 release of Outbound Contact includes the following features:
• Predictive algorithm enhancements

Self-diagnostics—In order to limit performance degradation, which 
could result in a deviation from the optimization parameters (Busy 
Factor, Overdial Rate, and Average Waiting Time) associated with the 
loss of a dialing pace, the predictive algorithm can perform self-
diagnostics and report the expected cause of the degradation using log 
events.

Four new options include: pa-selfcheck-awt-threshold (see 
page 198), pa-selfcheck-bf-threshold (see page 199), pa-
selfcheck-odr-threshold (see page 199), and pa-selfcheck-
interval (see page 199)
Four new log events include: 12-50131, 12-50132, 12-50133, and 
12-50134. See the Outbound Contact section of Framework 7.6 
Combined Log Events Help for more information about the log 
events.

For more information, see “Predictive Algorithm Self-diagnostic” on 
page 54.
Engaging call dialing duration

Average engaging call dialing duration—OCS calculates the 
average engaging call dialing duration (defined as the time between 
an agent going ready and becoming ASM engaged when the 
engaging call is delivered to the agent) for a given Campaign Group 
and uses this value when calculating dialing pacing.
Advanced small group predictive algorithm and agent feedback—In 
ASM dialing modes, OCS adds the value of the average engaging 
call dialing duration to the agent’s ReadyTime notification to predict 
when the agent will become ready. 

For more information, see “Predictive Algorithm and Engaging Call 
Dialing Duration” on page 55.
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• AddRecord request enhancement—To handle the scenario in which several 
Campaign Groups are active or running for the same Campaign and ensure 
that a new record is added to an existing chain for the appropriate group, 
OCS places a higher priority on processing the GSW_RECORD_HANDLE attribute 
if present in the request over the GSW_CAMPAIGN_NAME attribute. The 
GSW_RECORD_HANDLE attribute provides information to identify the Campaign 
Group, and with GSW_CHAIN_ID, enables a new record to be added correctly. 
In addition, if the GSW_CHAIN_ID does not match the ID of the chain, OCS 
returns Error Code 103.

• Enhancement to Preview dialing mode when a call is not established—A 
new option, preview_release_nocontact_action (see page 219), instructs 
OCS on what action it should apply to an agent’s DN when the agent 
releases an outbound call that was placed manually in the Preview dialing 
mode but could not be established. In order to leverage this enhancement, 
the attached data of the manually placed call must contain the 
GSW_RECORD_HANDLE attribute with the record handle, which OCS had passed 
previously to the agent desktop.

• Campaign Group-related enhancements
Identifying the Campaign Group name—An existing attribute, 
GSW_CAMPAIGN_GROUP_NAME, can now be added to desktop protocol 
requests to identify the Campaign Group for environments where 
several groups are configured, active, and running for the same 
Campaign. This attribute has a higher priority than the 
GSW_CAMPAIGN_NAME attribute in desktop protocol requests, that does not 
uniquely identify the Campaign Group. This attribute can be used 
anywhere that the GSW_CAMPAIGN_NAME attribute is used.
Identifying the Campaign Group name associated with personal 
records—In a scenario in which one or more Campaign Groups share 
the same Campaign, and thus the same Calling lists, OCS updates the 
group_id field in the list with the current Group DBID, in addition to 
the campaign_id, when records are marked as Retrieved. 
The new callback-observe-group option (see page 186) instructs OCS 
whether to consider the Group DBID when Personal Callbacks and 
Personal Rescheduled records are retrieved by the Campaign Group.
This new feature is only available for Calling lists that have the 
group_id field included in the format. In order to maintain backward 
compatibility with Calling lists using format 6, OCS checks the format 
for this field and the callback-observe-group option. If format 6 is 
being used, the group-id field is not updated and the option value is 
ignored.

• Do Not Call list enhancement—When OCS switches from the backup to 
the primary, OCS rereads the Do Not Call records that were added after the 
Do Not Call list was initially read by OCS for all Tenants that have active/
running Campaigns and whose Do Not Call list(s) were imported. This 
synchronizes the Do Not Call list between the backup and primary OCS if 
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the primary OCS updates the list after the backup reads it, due to the 
addition of new records to the Do Not Call list. No calls requests will be 
created by OCS until the Do Not Call list table is completely read.

• Centralized configuration and sharing of HMP resources in multi-tenant 
environment—Outbound Contact supports this type of configuration for an 
HMP deployment in ASM mode and Transfer mode due to fast ISCC call 
routing between SIP Servers. For more information, see “Centralized 
Configuration and Shared HMP Resources” on page 63.

Note: Outbound Contact Manager can now be installed on the Windows 
Vista operating system.

New Features in Release 7.6.1
The 7.6.1 release of Outbound Contact includes the following features:
• Advanced small group algorithm—A new value, advanced_small_group, 

was added to the predictive_algorithm option (see page 200). This option 
value activates the new and improved predictive algorithm for small 
groups of agents. The advantages of this new algorithm include:

It better tracks inbound calls, because it counts inbound calls that are at 
all stages of processing and not just those that are queued.
It allows outbound calls to be initiated, even if one or more calls 
remain in the dialing stage, rather than waiting until all dialed calls are 
completed.

• OCS allows for better optimization of predictive dialing by accepting 
estimated call completion time notifications from agents.

New agent desktop notification—ReadyTime has been added to the 
Outbound Desktop protocol, which the agent desktop sends to OCS. 
For more information on this event, see the Outbound Contact 7.6 
Reference Manual.
A new time-to-ready-tolerance option (see page 208)—OCS uses this 
option to specify the allowed accuracy in the agent's estimation of 
when that agent will complete call processing and become Ready. This 
option is associated with the new advanced_small_group value for the 
predictive_algorithm option.
New real-time statistics: CurrentTrustFactor and 
CurrentFeedbackAccuracy— These statistics are calculated along with 
the trust factor calculations for each agent and for the Campaign Group 
when determining agent availability around call completion. These 
statistics are only available if you are using Stat Server version 7.6.1 or 
higher with OCC Extension 7.6.1 or higher.
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Three new OCS log events, 12-50128, 12-50129, and 12-50130—These 
log events are associated with the Predictive/Predictive with seizing 
dialing modes and the agent providing feedback on his or her 
availability. For information on these log events, see the Outbound 
Contact Server section of the Genesys 7.6 Log Events Help.

• Call duration distribution—a new option, predictive-longcalls-
truncation, instructs the predictive algorithm how to handle so called 
“long” outbound calls (that is, if a few outbound calls last significantly 
longer than the majority of the outbound calls for the given campaign 
group). For more information, see page 203.

• CPD Server implemented a new HMP licensing schema—This schema 
supports licensing changes for Dialogic drivers. This release of CPD 
Server requires Dialogic HMP 3.0 for Windows SU174 or higher.

• For more information, see the Outbound Contact 7.6 Reference Manual.
• A new supported version of IBM DB2 DBMS (Database Management 

System)—Outbound Contact now supports IBM DB2 version 9.1.

New Features in Release 7.6
The 7.6 release of Outbound Contact includes the following features:
• Security Enhancements:

Note: For configuration information on all of these security 
enhancements, see Genesys 7.6 Security Deployment Guide.

You can configure OCS, CPD Server, and CPD Proxy Server to use a 
fixed port when connected to a server behind a firewall to reduce 
susceptibility to security attacks. For additional information, see 
“Client-Side Port Security Configuration” on page 105.

Outbound Contact supports Transport Layer Security (TLS) for 
connections between various Outbound Contact and other Genesys 
components. In this guide, “Transport Layer Security Connections” on 
page 346 for information about which components support this.
OCM security timeout—A new OCM option, inactivity-timeout, 
allows you to automatically force a logged-in user to log in again if he 
or she has not interacted with any element of the interface for a set 
period of time. By default, this option is set to 0 minutes. For more 
information on this option, see “inactivity-timeout” on page 173. 
OCM Security Banner—You can create and display your own Security 
Banner when a user logs in to Outbound Contact Manager or any 
Genesys user interface. You define the content of the banner, typically 
the terms of use of the application. Users must accept the terms to 
proceed, or they can reject the terms to close the application without 
access.
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The user-defined Security Banner is specified during the installation of 
the application. During the OCM installation, you specify the URL 
where the banner is located (see “Installing OCM on Microsoft 
Windows 2000, 2003, Vista, or XP” on page 120).

• Hiding sensitive data contained in OCS Log SQL statements—Logged 
data can be truncated in order to hide sensitive data that would appear in 
the logs by configuring either the default-filter-type option or any of the 
log-filter-data section options to a value other than copy (for example, 
hide or skip).
The truncation will be represented in the log by four asterisks following the 
first three words. Two examples of a log entry include:

15:22:09.130 CM_DBCallRecord(101-101-106): DBServer 
'DBServer_Svarog' SQL:  update alpha_list set **** [ReqID=125]
15:22:09.150 CM_DBCallRecord(101-101-106): DBServer 
'DBServer_Svarog' SQL:  insert into alpha_list **** [ReqID=129]

If sensitive information appears in the log before the fourth word, such as 
in SELECT statements involving data for the DoNotCall list, OCS truncates 
the statement to the first word.
For more information about these options, see the Genesys 7.6 Security 
Deployment Guide, “Common Configuration Options” chapter.

Migration 
Refer to the Genesys 7 Migration Guide for detailed information about 
migrating Outbound Contact 7.5 to Outbound Contact 7.6.

License Control
The 7.6 release of Outbound Contact supports the same licensing requirements 
as the 7.x releases for the traditional dialing modes. New dialing modes such as 
Push Preview and Power GVP do not require licenses. If you are upgrading to 
7.6, you can continue to use the same license file that you were using for the 
Outbound Contact 6.5.x to 7.x releases. There are no changed Outbound-
specific licensing requirements for the Outbound Contact 7.6 release. 

Note: If you are using Dialogic HMP Dialogic software, additional licenses 
are necessary. See “HMP Software” on page 320 and contact your 
Dialogic representative for more information.

Refer to the Genesys 7 Licensing Guide for detailed information about 
licensing Outbound Contact 7.6.

http://resource.intel.com/telecom/support/releases/winnt/sr60pci/onldoc/pdffiles/release_guide.pdf
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2 Architecture
This chapter explains required architecture for outbound campaigns. It 
contains the following sections:

Outbound Architecture Overview, page 29
Outbound Contact 7.6 Terms and Concepts, page 38
Dialing Overview, page 49
Multiple Sites, Users, and Tenants, page 62
Other Supporting Solutions, page 67

Outbound Architecture Overview
Outbound Contact 7.6 provides an integrated environment for creating, 
running, and reporting on outbound campaigns. Figure 1 illustrates how the 
Outbound Contact components integrate with other Genesys components.
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Figure 1: Outbound Contact Architecture

Each of the following subsections describes one of these Outbound Contact 
components, and how it fits into the architecture illustrated in Figure 1.

Outbound Contact Server
Outbound Contact Server (OCS) is the core of Outbound Contact because it is 
the dialing engine. It instructs the PBX switch (through a CTI [computer-
telephony integration] link), or a Dialogic board (through CPD Server), or 
another dialer (when using Outbound Notification (OBN) or Interaction 
Server) to dial outbound calls or initiate outbound interactions. OCS retrieves 
information from the calling list(s) with the help of the DB Server, and delivers 
it to T-Server (or another type of dialer), which in turn relays it to the desktop. 
In this way, OCS issues dialing requests to agents. OCS also reacts to call 
results and responses from agent desktops.
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Desktop protocol for Outbound Contact enables OCS to communicate through 
T-Server with agent desktops. Third-party protocol for Outbound Contact 
enables OCS to communicate through a Communication DN with third-party 
applications. Outbound Contact is also capable of communicating with another 
OCS, Stat Server, and ICON.

Notes: Starting with release 7.5, Outbound Contact Server can also use 
Genesys Voice Platform to dial outbound calls. See “Genesys Voice 
Platform” on page 71 for more information.
Starting with release 7.5, Outbound Contact Server can also use 
Interaction Server to deliver interactions to agent’s desktops. See 
“Genesys Multimedia” on page 69 for more information.

OCS also performs the following functions:
• Reads configuration data—including the options for configuration objects 

such as Agent Groups, Place Groups, and Campaign Groups— from the 
Configuration Database.

• Receives commands from Outbound Contact Manager (or third-party 
applications) for starting and stopping campaigns.

• Provides pacing algorithms for the dialing of outbound calls.
• Updates call results. 
• Applies treatments to records based on call results.
• Processes Do Not Call (DNC) requests 
• Checks the Do Not Call list for telephone numbers and customer IDs that 

should not be contacted.

Outbound Contact Manager
Outbound Contact Manager (OCM) is the user interface for Outbound Contact. 
OCM enables contact center managers to perform tasks such as the following:
• Manage calling lists:

Add, modify, and delete records in a list.
Create chained records in a list.
Move records among calling lists that have the same table format and 
that exist in the same type of DBMS.
Import/export calling lists.

• Browse Calling Lists, Campaign Groups, and their components:
Use dialing and viewing filters to select records by a particular criteria.
OCM can automatically save a viewing filter when the user leaves the 
current calling list. When the user reopens the list, OCM retrieves and 
displays the filter.
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• View the relationships among campaigns, agent groups, and calling lists.
• Start and stop campaigns.

If you start a campaign with OCM, and then OCM stops, the campaign 
continues to run. When OCM restarts, OCS updates OCM with the current 
status of the campaign.

• Manage campaign sequences.
• Monitor the current status of outbound campaigns.
• Specify or modify the optimization parameters for any running campaigns 

and campaign sequences.
• Update Do Not Call lists with data from external sources.
• Prioritize records for dialing by record types.

Call Progress Detection Server 
Call Progress Detection Server is an optional component for switches that do 
not have Call Progress Detection (CPD) capability. This server uses a Dialogic 
board to perform CPD for outbound calls and, if configured, to record voice 
files. As the dialer, CPD Server interfaces with OCS and the Dialogic board.

Notes: 
• GVP can also be used to dial outbound calls, but only in Power GVP 

dialing mode. See “Genesys Voice Platform” on page 71 for more 
information.

• Starting with release 7.2, CPD Server supports only the Dialogic 
drivers for Service Release 6 that are provided on the CPD Server 
CD.

Dialing Methods

The way in which outbound dialing is performed depends on the dialing 
method and equipment that you use. There are several ways to perform 
outbound dialing:
• No Call Progress Detection (CPD) Server required (if a switch already has 

call progress detection capability).
• Transfer mode—The Dialogic board connects to the switch through an 

analog connection or a digital lineside connection. CPD Server instructs 
the Dialogic board to dial outbound calls, perform call progress detection, 
and transfer calls to an automatic call distribution (ACD) queue or routing 
point, which eventually distributes the calls to an available agent.

• Power GVP mode—GVP is used to dial outbound calls and enables you to 
provide voice self-service when the caller is contacted.
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• ASM mode—The Dialogic board connects to the switch through an ISDN 
carrier. In this mode, outbound calls are a combination of two calls: 

An internal call from the Dialogic board to the agent desktop (an 
engaging call). 
An outbound call from the Dialogic board to the Public Switched 
Telephone Network (PSTN).

CPD Server connects these two calls on the Dialogic board when it is time 
to establish a call between an agent and a dialed number. Therefore, this 
method requires twice as many Dialogic ports as Transfer mode requires.

Note: ASM mode is the only supported dialing mode when using T-Server for 
Cisco Call Manager.

Engaging Calls

An engaging call is one that seizes (engages) an agent when CPD Server dials 
in ASM mode. Based on the type of T-Server event, CPD Server can determine 
where CPD Server can obtain the connection ID for the agent to be engaged—
before the called party answers. 
CPD Server supports the ASM mode as a way to expedite call transfers and 
improve the connection time between a customer and an agent. 
When their switches do not perform satisfactorily, contact centers use ASM 
mode to solve performance problems. It provides the following functionality to 
enhance performance:
• Eliminates unacceptable delays between the time when a customer picks 

up the phone and when the call is connected to an agent. 
• Avoids lack of support for call transfers. 
• Eliminates force-tone problems in which a customer can hear a signal 

intended only for an agent — for example, when a signal alerts the agent 
that a call is transferred.

In the Predictive with seizing dialing mode, a call is dialed automatically, 
based on a prediction of agent availability; the agent is then seized (engaged) 
before the called party answers. There is no delay after the customer is 
connected. OCS includes a campaign-pacing engine with a Predictive dialing 
algorithm that initiates the record dialing. 
In the Progressive with seizing dialing mode, a call is dialed automatically 
when an agent is already on the line and ready to take the call. Progressive 
with seizing means Progressive dialing in ASM mode.
In both modes, the agent should be on the line (engaged) before the customer 
answers. The differences between these two dialing modes are as follows:
• In Progressive with seizing mode, the agent is already reserved for the 

call when it is dialed. 
• In Predictive with seizing mode, the agent is predicted to be available 

when the dialer places the call.
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Note: In release 7.6.101, the predictive algorithm accounts for the average 
engaging call dialing duration (defined as the time between an agent 
going ready and becoming ASM Engaged when the engaging call is 
delivered to the agent) for a given campaign and uses this value when 
calculating dialing pacing.

Centralized CPD Server

Outbound Contact 7.6 supports a centralized CPD Server. A contact center 
with a multi-site environment can use a single CPD Server at its central 
location. With a centralized CPD Server, a routing strategy at the central site 
can send calls and events to Routing Points that are distributed across the 
network.
For example, in a multi-site environment where a group of agents are logged 
into a switch, you can use a single CPD Server that is connected to any
T-Server at that same site. The agents do not have to be logged in to the same 
switch to which the CPD Server is connected. With a centralized CPD Server, 
a routing strategy at the central site can send calls and events to Routing Points 
that are distributed across the network. For more information, see also “Multi-
Sites” on page 62.

Sample Call Flow with Centralized CPD Server

The following is a sample call flow using a centralized CPD Server. In this 
example, Steps 1 through 7 occur at the central location in a wide-area network 
(WAN).
1. The OCS sends a dial request to the CPD Server. (Both the OCS and CPD 

Server are at the central location.) 
2. CPD Server sends a dial request to its Dialogic board.
3. The Dialogic board dials the customer’s number. A switch conveys the call 

to the customer, while the Dialogic board performs call progress detection.
4. After receiving an Answer call result, the CPD Server transfers the call to a 

Routing Point. 
5. A T-Server, that is monitoring the switch to which it is linked (by a CTI 

link), informs the Router about the call at the Routing Point.
6. The routing strategy at the central location determines how to route the 

call. In this example, the routing strategy determines that the call should be 
routed to an agent at an outlying site. 

7. The Router sends the call to Inter Server Call Control (ISCC), an external 
routing feature of T-Server. 

8. ISCC sends the call to a second switch that is being monitored by a second 
T-Server. The second switch relays the call to an ACD Queue for a group 
of agents. 
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In this step, the second switch, the T-Server that monitors it, and the group 
of agents associated with the ACD Queue, are all at an outlying location in 
the network.

Voice File Recordings

CPD Server is able to record files in a plain VOX format (PCM/8000Hz/8bps). 
It creates two voice files for each outbound call: 
• File 1 contains the line recording for the call progress detection stage.
• File 2 records the conversation between an agent and the called party if the 

call result is answer (ASM mode only). 

Recording on Dialogic Ports 

CPD Server records these voice files on the Dialogic ports used for outbound 
dialing. Specific ports are not dedicated for recording, but the number of ports 
to use for recording is configurable.
The option max-number-ports-to-record specifies the maximum number of 
agent ports on which CPD Server records at the same time. You configure this 
option in the CPD Server Application object in Configuration Manager.
The option cpd-recording enables or disables the recording of File 1 only (call 
progress detection stage).
CPD Server counts the ports being recorded, and stops recording when the 
specified number of ports is engaged for this purpose. CPD Server will not 
record on another port until one is disengaged.
The number of times that the same call transfers from Agent DN to Agent DN 
does not increase the number of ports being used for the recording of that call. 
The call remains on the same port when it passes from agent to agent. This 
extended port usage for recording might necessitate the allocation of more 
Dialogic resources — that is, an increased number of ports to be used for 
outbound dialing in general.
For information about the max-number-ports-to-record and cpd-recording 
options, See “CPD Server Options” on page 221.

Voice File Names and Content 

Voice file names have the format 
<Prefix>_<RecRef>_<PhoneNumber>_<Date>_<Time>_<AgentCustPortNames> 
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where each of the variables in angle brackets is replaced by an alpha/numeric 
string. Table 3 lists and describes each of these variables.

<Prefix> The prefix in the file name is set by the following CPD Server configuration 
options:
• cpd-file-name-prefix for call result (the default is cpd_).
• conversation-file-name-prefix for conversation (the default is conv_).
For more information about these options, See “CPD Server Options” on page 
221.

<RecRef> CPD Server assigns a recording reference number to each voice file as part of 
its name. 

<Date> The date is presented in the following format: 
<Month (two digits)> <day (two digits)> <year (two digits)> 
For example, 060703 represents June 7, 2003. 

<Time> Time is presented in this format: 
<Hour (two digits)> <Minutes (two digits)> <seconds (two digits)>

For example, 111545 represents 11 hours, 15 minutes, 45 seconds.
The hour is presented in 24-hour format as shown in these examples:
• 6:00 AM is 060000.
• 6:00 PM is 180000.

Examples of File
Names

The following are sample file names:
• Sample file name for a call result voice file:

Call_Result_5551212_060703_060000_dtiB1T1.vox

• Sample file name for a conversation voice file:
Conv_5551212_060703_060005_dtiB1T1_dtiB1T2.vox

Table 3: Information in File Names 

Variable in File Name 
Structure 

Description 

<Prefix> Prefix for file type

<RecRef> Recording reference number 

<PhoneNumber> Phone number 

<Date> Date of the recording 

<Time> Starting time of the recording 

<Agent/CustPortNames> Agent Dialogic port name
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Note: The call result file is created for call progress detection only, and the 
file name contains only one CPD port. A conversation file, which 
records an actual conversation between an agent and a customer, is 
recorded in ASM mode only and the file name contains two CPD ports.

CPD Proxy Server
CPD Proxy Server distributes calls among various CPD Servers for optimal 
load-balancing and utilization of system resources. CPD Proxy Server 
distributes calls for load-balancing when the volume of calls is particularly 
heavy. It also notifies clients about changes in hardware resources due to 
configuration and license modifications, or “out of service” events caused by 
hardware problems. In general, CPD Proxy Server can be used in any situation 
to improve overall system stability and load distribution. Figure 2 illustrates 
how CPD Proxy Server relates to other components.

Figure 2: Configuration with CPD Proxy Server
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Outbound Contact 7.6 Terms and 
Concepts

This section introduces the terminology and concepts that pertain to Outbound 
Contact 7.6.

Formats
The layout of each calling list is determined by a format. The term format has 
two meanings in Outbound Contact:
1. The field layout in a table in a relational database.
2. A configuration object in Configuration Manager.
A format consists of a number of Field objects.
You can create multiple calling lists of the same format, but each calling list 
can have only one corresponding format. The configuration database provides 
default formats; these consist of all of the mandatory fields that are required by 
Outbound Contact 7.x and 6.5. You can create new formats that consist of 
user-defined fields and the mandatory fields.
Each format within a tenant has a unique name, which you specify if you 
create a new format.

Fields 
The term field has two definitions for Outbound Contact: 
• The name of a column in a table in a relational database.
• A configuration object in Configuration Manager.
Each calling list field object contains both database-related information (such 
as data type) and business-related information (such as field type).

Records
A record is a row in a calling list table. Among its mandatory fields, each 
record contains:
• A phone number.
• The fields that determine how the records should be processed (Record 

Type and Record Status).
• The fields that store time boundaries and time zone information; these 

enable runtime determination of whether the record can be dialed.
A record can contain as many custom fields as needed as defined in a Calling 
List Format.
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Chained Records

Chained records are multiple records for the same customer in a calling list. 
These records typically contain alternative phone numbers such as home, 
business, and cellular phone. In addition, each record in the same chain can 
have different time boundaries and time zone information, and it can also have 
different values stored in its business data fields.

Flexible Prioritization of Record Types

Flexible prioritization means that a user can assign his or her own order of 
priority to specific record types for dialing purposes. 
A user can assign his or her own order of priority to specific record types for 
dialing purposes. A record type with a higher priority is dialed before a record 
with a lower priority. OCM automatically passes the priority for the record 
type and its parameters to Outbound Contact Server with events. 
The user can prioritize the following record types in the Predictive/
Progressive dialing mode and in the Preview dialing mode. 
• General records—All records are initially marked General in an Outbound 

Contact calling list. The status may change after the record has been dialed. 
Either an agent or a treatment in response to a call result can change the 
status of a record.

• Campaign Callback records—An agent reschedules a campaign callback 
record at the customer's chosen time. The callback may be dialed 
automatically or delivered to an agent's desktop softphone as a preview 
record depending on the value of the predictive_callback option. See 
page 200 for more information about this option.

Note: See the “Communication Protocols” chapter of the Outbound 
Contact 7.6 Reference Manual for information on the events 
distributed when rescheduling records.

• Campaign Rescheduled records—Treatments reschedule these records based 
on the detected call results. A campaign rescheduled call is dialed 
automatically and handled by any agent who is working on that particular 
campaign. 

Record types can be prioritized in Outbound Contact Manager or in a third-
party application that manages the campaigns. OCM provides an optional 
dialog box that you can use to set record prioritization. This dialog box 
pertains to both a standalone campaign and a campaign in a sequence. 
The behavior of OCM regarding flexible prioritization is controlled by four 
options, which you define in Configuration Manager -> Applications -> OCM 
Application -> Options -> OCManager section. For more information about 
these options, see “OCManager Section–Options for Record Prioritization” on 
page 176.
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If you are using a third-party application (instead of OCM) to communicate 
with OCS, you must use the KeyValue List from the Genesys Common Library 
with the events to transfer the priority information to OCS. 
You must define the priorities in the following user requests, that are sent 
through the Communication DN: 
• CM_ReqLoadCampaign 

• CM_ReqStartDialing 

• CM_ReqSetDialingMode

For more information about these user requests, see “Communication DN 
API” in the Outbound Contact 7.6 Reference Manual. 
Note that flexible prioritization does not apply to Personal Callback records or 
Personal Rescheduled records. An agent schedules or reschedules a personal 
call back record at the customers’ chosen time. OCS automatically delivers a 
Personal record to the agent’s desktop at the specified time, and the same agent 
who initially handled the record processes the Personal Call Back or Personal 
Rescheduled record.

Calling Lists
The term calling list has two meanings in Outbound Contact:
• A subset of records from a table in a relational database that satisfies the 

conditions of a filter that may be associated with it.
• A configuration object in Configuration Manager.
The two meanings converge in the following way: the Table Access Point 
configuration object in Configuration Manager contains the name of the table 
in the database. Each table in the database requires a separate Table Access 
Point object. The Table Access Point object is a property of the Calling List 
object in Configuration Manager. One or more calling list objects can share the 
same Table Access Point object. 
Each calling list table contains a number of mandatory fields that, for example, 
identify customers and the status of each record. 
The user can add a number of user-defined fields; these typically store 
business-related data.

Do Not Call 

The Do Not Call (DNC) function prevents a particular telephone number or 
customer ID from being dialed. Record-blocking can occur in Outbound 
Contact either by customer request or by a decision on the part of a contact 
center manager. 
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A Do Not Call request can be handled during either an outbound call or an 
inbound call-for example:
• During a conversation initiated by an outbound call, a customer tells an 

agent that he or she does not want to be called anymore. In outbound 
mode, the agent uses a unique record identifier generated by OCS 
(GSW_RECORD_HANDLE) to refer to the record. 

• A customer calls the contact center (inbound call) and explicitly asks not to 
be called concerning, a credit card payment that was already submitted. In 
inbound mode, the phone number or customer ID serves as a reference to 
the record.

In both cases, having received a Do Not Call request, OCS makes an entry in a 
special table (referenced in the gsw_donotcall_list Table Access) in the 
database. OCS reads all of the records from this table and populates two 
separate tables (buffers) in memory with unique values from the phone field 
and from the customer_id field. These tables can also be populated by Do Not 
Call requests to OCS from the following sources:
• An agent desktop — If an agent belongs to a Campaign Group, and that 

campaign is loaded, Outbound Contact Server uses the OCS-Agent 
Desktop protocol to handle DNC requests.

• A third-party application, through the Communication DN API — If an 
agent is not associated with a Campaign Group, OCS uses the 
Communication DN API.

• A routing strategy can insert records into the DoNotCall list.
• GVP can insert records into the DoNotCall list when OCS is running in 

Power GVP dialing mode.
A Do Not Call request (by phone number or customer ID) from the agent’s 
desktop updates not only the records that are in the database, but also retrieved 
records that are currently in the memory buffers of the Outbound Contact 
Server.
If a manual update to gsw_donotcall_list is required, OCS must be restarted in 
order to acknowledge the changes. Most administrators choose to update the 
Do Not Call table (gsw_donotcall_list) during off-hour periods, so that 
restarting the server does not disrupt calling activities.
Outbound Contact makes a provision for several customers with the same 
phone number in a calling list. The value of the customer_id option can specify 
a user-defined field in the Calling List table in order to identify DNC 
customers by a customer ID instead of by a phone number. You define the field 
name in the Field object with the send attribute assigned to it. (See“Field 
Object” on page 137 for more information). You then specify the field name as 
the value of the customer_ID option in the OCS Application object. The new 
field is part of the Format object. Through these configurations, you can apply 
the DNC restriction to a particular customer as an alternative to placing the 
restriction on a particular telephone number.
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To enable this enhanced Do Not Call functionality in Outbound Contact, see 
“User-Defined Field for Do Not Call” on page 295.
OCS stores records marked as NoCall in the gsw_donotcall_list (one per 
tenant) and monitors them in the following way: 
1. When an outbound campaign is running, OCS retrieves records that are 

ready to dial and checks them against the gsw_donotcall_list.
2. If a record retrieved from the calling list matches any record from the 

gsw_donotcall_list, OCS does not dial this record. Instead, it returns the 
record to the calling list and changes its record_type to NoCall. 

Dealing with a Large Do Not Call List 

Outbound Contact uses a database table to store Do Not Call contact numbers 
and other information related to DNC customers’ requests. This table serves as 
a persistent storage of Do Not Call –related information. While loading a 
campaign, Outbound Contact Server retrieves the data stored in this table, puts 
it into memory, and checks each phone number from the calling list against 
this table to determine whether a phone number should be dialed.
Generally this Do Not Call database table is intended to hold information 
regarding only internal Do Not Call requests rather than external Do Not Call 
requests.
An internal DNC request is one that is specific to a particular contact center. For 
example, a Do Not Call request is internal if either of the following is true: 
• A called party requests to be marked as Do Not Call when an agent 

contacts him or her through an outbound call.
• A called party contacts (through an inbound phone call, e-mail, or personal 

visit) the organization that makes outbound calls and requests to be marked 
as Do Not Call.

An external DNC request is one that is submitted to an authority that collects 
such requests and distributes them to contact centers.
The number of internal Do Not Call requests is relatively small compared to 
the number of external ones. A contact center may receive several thousand 
DNC requests from customers. The number of DNC requests nation-wide could 
number in the tens of millions. Since Outbound Contact Server stores all phone 
numbers from the Do Not Call table in memory (RAM), the following OCS 
performance factors are affected as the size of the table increases:
• The amount of time that OCS takes to load a campaign — or, more 

specifically, the amount of time that it spends reading the table data and 
storing it in memory.

• The amount of memory that is allocated by OCS after it reads the whole 
table.

To improve the performance of Outbound Contact Server, Genesys 
recommends that you minimize the amount of data stored in the Do Not Call 
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database table (accessible to OCS through gsw_donotcall_list Table Access). 
Ideally, this table would contain only internal DNC records. Information about 
external Do Not Call requests would be kept in a separate, custom DNC 
database table.

Note: See the “Recommended DBMS Optimizations” chapter in the 
Outbound Contact 7.6 Reference Manual for more information about 
tuning your database(s).

To address potential performance issues, Genesys recommends two methods 
for handling large Do Not Call tables (over one million records):
• Use a dialing filter— This improves OCS handling of large database 

tables.
• Run an SQL query — This completely avoids the performance problems.

Method 1: Use a Dialing Filter

Dialing filters are used to bypass records from the Calling List table that 
should not be dialed. Each calling list can have its own dialing filter. Suppose 
that a custom DNC database table contains the field dnc_phone for storing all 
phone numbers that should not be dialed. In this case, the dialing filter will be 
as follows:
• phone NOT IN (SELECT dnc_phone FROM <custom_do_not_call_table>)

• NOT EXISTS (SELECT dnc_phone FROM <custom_do_not_call_table> WHERE 
dnc_phone = phone)

Note that you must complete the following steps:
• Replace the <custom_do_not_call_table> placeholder with the actual name 

of the custom Do Not Call table.
• Replace the column name phone (in the Outbound 6.X format) with 

contact_info if you are using the Outbound 7.X format for the calling list.
The second dialing filter might be faster, but your Database Management 
System (DBMS) might not support an EXISTS SQL clause. Check your DBMS 
documentation or consult your Database Administrator if necessary.

Method 2: Run an SQL Query

You can run an SQL query directly on calling lists in your database, before 
loading a campaign. This query marks as NoCall any records in a calling list 
with phone numbers matching those in a custom Do Not Call table. Run the 
following SQL query on all calling lists that you plan to use for dialing: 
UPDATE <calling_list_table> SET record_type = 7 WHERE phone IN (SELECT 
dnc_phone FROM <custom_do_not_call_table>)
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Note that you must complete the following steps:
• Replace the placeholder <custom_do_not_call_table> with the actual name 

of the custom Do Not Call table. 
• Replace the placeholder <calling_list_table> with the actual name of the 

calling list table. 
• Change permissions, as needed, for modifying tables through the execution 

of the UPDATE SET statement. 
Note also that if you choose to maintain Do Not Call support manually, you 
must run this SQL query every time after you modify the calling list (by 
changing record_type to General and record_status to Ready) while preparing 
a calling list for the next campaign. 

Note: See Chapter 11, “Deploying Do Not Call Functionality,” on page 295 
for more information about working with Do Not Call lists.

Filters
Outbound Contact uses two kinds of filters: dialing filters and viewing filters.

Dialing Filter

A dialing filter customizes a calling list so that only certain phone numbers are 
dialed during a campaign. One use of dialing filters is to divide records that 
share the same calling list (database table) between two or more campaigns. 
As a configuration object in Configuration Manager, each calling list object 
requires its own filter in order to select records according to specific criteria. 
For example, if you intend to divide records in the same table between two 
campaigns, you need to create two calling list objects, each with its own filter. 
You create dialing filters and apply them to calling lists in either Configuration 
Manager or Outbound Contact Wizard. 
OCS supports WHERE and ORDER BY clauses in dialing filters that are longer than 
255 characters. For more information, see “Filter Object—Annex Tab Fields” 
on page 148.

Viewing Filter

A viewing filter selects records in a calling list for display in Outbound Contact 
Manager. One use of viewing filters is to display records in a certain order —
for example, alphabetically by the name of the city. Another use of viewing 
filters is to select customers by specific criteria that you define—for example, 
all records with a call_result value of NoAnswer.
It is possible to combine a dialing filter and viewing filter for browsing records 
in OCM when both filters are enabled. 
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When OCS receives notification from Configuration Server that a dialing filter 
has changed, OCS removes the retrieved records from the buffer (memory), 
returns them to the calling list database, and then retrieves the records that 
meet the criteria of the newly applied filter. Records that the agent is already 
working on remain in OCS memory until they have been processed.

Treatments
Treatments define options for handling calls by describing sets of actions to be 
performed on each call result. For example, if the call result for an outbound 
call is NoAnswer, a treatment might be to redial the number at a later time or to 
dial a different phone number for the customer. 
In addition to the standard treatments for busy signals, no answers, and so on, 
Outbound Contact gives the user the option to route, to an alternate DN, calls 
answered by fax machines or answering machines. For example, it can run a 
fax-on-demand campaign along with a campaign that plays messages to 
answering machines. This scenario requires a separate application that is 
responsible for playing prerecorded messages (for example, IVR or voice 
mail). You can create treatments and assign them to a calling list by using the 
Outbound Wizard or Configuration Manager. 
For more information, see Chapter 10, “Call Handling,” on page 275.

Campaign Group
A Campaign Group is the main configuration object in Outbound Contact. It 
can be found within the Campaign object in Configuration Manager. A 
Campaign Group is defined as a Campaign (a set of calling lists) that is 
assigned to work resources such as an Agent Group or a Place Group. 
A Campaign Group can be associated with Agent Groups or Place Groups. 
Agents are individuals who are set up as Person objects in Configuration 
Manager in order to handle customer contacts. Places can be telephone sets. 
There are two ways to group these individual objects:
• An Agent Group is a logical grouping of agents. Agents can be grouped by 

skill (for example, language or marketing knowledge) or time (for 
example, shifts). If the Agent Group is configured as “virtual”, Outbound 
Contact 7.6 uses the information provided by the Stat Server to monitor the 
Agent or Place Group and the Agent Status. Outbound Contact monitors 
the virtual agent group through the Stat Server that is configured in the 
Campaign Group object in Configuration Manager. If it is not specified, 
the group will not be processed, and Outbound Contact Server prints an 
error message in the log and stops processing the group. If Outbound 
Contact Server disconnects from the specified Stat Server, it will stop 
dialing for that group because of the unavailability of agent state 
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information. Dialing will resume when reconnection to the Stat Server is 
re-established.For more information on creating virtual agent groups, see 
the Framework 7.6 Stat Server User’s Guide.

• A Place Group is a logical grouping of telephone sets. An example of a 
place group is a group of telephone sets (sets shared by agents) in a contact 
center. When a place group is configured for a Campaign Group, 
Outbound Contact Server does not validate who logs in to the group. For 
its purpose, all that matters is that someone has logged in to the place 
group to handle outbound calls. A place group is commonly configured 
when a contact center requires a generic group (in other words, a physical 
group of phone sets) for a performance report on a campaign and does not 
need to know who participated in the campaign. In Contact Center Pulse 
Plus (CC Pulse+), the Genesys real-time reporting software where 
outbound statistics are reported, the place group report shows activities and 
statistics of the DNs belonging to places related to the Campaign Group.

The Agent Group or Place Group must be assigned to a campaign as a 
CampaignGroup object.
Stat Server provides status information about these configuration objects (real 
or virtual) to Outbound Contact Server. When loading a campaign for a 
particular Campaign Group, OCS registers and monitors the following DNs:
• All assigned Place DNs that are configured under the Switch object for the 

connected T-Server application
• The DN that is specified as the Voice Transfer Destination in the 

Advanced tab of the Campaign Group configuration object. 
If any other DNs (such as ACD Queues, Routing Points, and so on) are 
involved in an outbound call flow, they have to be monitored by OCS. These 
DNs should be specified as an Origination DN in the Advanced tab of the Agent 
Group or Place Group object that is linked to the Campaign Group.

Campaigns
A campaign is a flexible master plan that organizes calling lists for dialing 
calls and handling call results. An outbound campaign specifies what kind of 
work the agents perform (for example, collections, telemarketing, or fund-
raising). A campaign is structured as follows:
• An Agent or Place Group may be assigned to multiple active campaigns. 

An agent can participate in multiple active campaigns. You can reassign 
agents between any active campaigns. Only one campaign can run in 
Predictive or Progressive mode. Other campaigns must run in Preview 
mode. See “Campaign Group” on page 45 for more information.

• One campaign can use several calling lists, and one calling list can be 
shared among several campaigns. A special record-level locking 
mechanism prevents simultaneous dialing of the same dialing record for 
different campaigns.

These configuration elements can be modified at runtime without stopping the 
campaign. 
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Interaction with Agents

Outbound Contact maintains a documented protocol of interactions between 
itself and an agent’s desktop application. To simplify desktop application 
architecture and development, this protocol is based on the user events that
T-Server distributes at the client application’s requests. The supported types of 
interactions between Outbound Contact and the desktop application are 
described below. For more information about these interactions, see 
“Communication Protocols,” in the Outbound Contact 7.6 Reference Manual.

Agent Assignment in Multiple Campaigns

Universal Routing Server (URS) must be used in order to support agent groups 
in multiple campaigns. OCS will attach CampGroupID data to every outbound 
call to represent the CampaignGroup DBID. For every agent assigned to more 
then one active CampaignGroup, Outbound Contact designates only one 
CampaignGroup for this agent. OCS will change the CampaignGroups designation 
when the configuration of campaign priorities and the staffing limits have been 
changed, when agents have been logged in/out, or when some CampaignGroups 
have been started/stopped.
Stat Server uses the same information in the CurrentCampaignGroupDBID 
statistic.
URS can then target agents using the CampaignGroup target.

Notes: 
• Agent assignment is supported only in the Progressive and 

Predictive dialing modes. In addition, the Campaign Group routing 
target should not be used in other dialing modes.

• When URS receives agent-assignment statistics from Stat Server, it 
may not apply them immediately to the strategy. This may cause 
the outbound call to be abandoned during processing by the 
strategy. Set URS option pulse_time to a very low value (for 
example, 1 second) to prevent such calls from being abandoned. 
For more information on this URS option, see the Universal 
Routing 7.6 Reference Manual.

Routing Strategy Design and CampaignGroupID

The routing strategy must be designed to distribute outbound calls that contain 
the correct CampGroupID attached data only to agents that meet the following 
criteria:
• The agent belongs to the specified group that is configured for that 

CampaignGroup.
• The agent’s current statistic in Stat Server contains the 

CurrentCampaignGroupDBID statistic that is equivalent to the CampGroupID.
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Campaign Prioritization

Campaigns are prioritized according to the following definitions:
• An understaffed campaign is one in which the number of assigned agents is 

less than what is required to maintain a minimum Service Level 
Agreement (SLA).

• A staffed campaign means is one in which the number of assigned agents 
is sufficient to maintain a minimum SLA, but is less than the maximum 
SLA.

• An overstaffed campaign is one in which that the number of assigned 
agents is sufficient to maintain the maximum SLA.

Agents are assigned based on the following priorities:
• All active campaigns configured with an equal priority will have an equal 

number of agents assigned to each campaign if all of the campaigns are 
equally understaffed or equally staffed.

• When some campaigns with equal priority are understaffed, all non-
assigned agents are assigned to the understaffed campaigns only. If there 
are several understaffed campaigns, an equal number of agents are 
assigned to each campaign that has equal priority.

• When there are no understaffed campaigns, all non-assigned agents are 
assigned to staffed campaigns only. If there are several staffed campaigns, 
an equal number of agents are assigned to each campaign that has equal 
priority.

• Agents are not assigned to overstaffed campaigns.
Refer to “Outbound Contact Server Options” on page 178 for more 
information about how the following options help to configure agent 
assignment:
• agent-assignment

• agent-assignment-priority

• agent-assignment-min-num

• agent-assignment-max-num

• inbound-agent-assignment-priority

• inbound-agent-assignment-min-num

Personal and Campaign Callbacks

The OCS-Desktop protocol enables the agent to schedule personal or 
campaign callbacks for specific records. A personal callback is delivered to 
the agent who scheduled it. A campaign callback is sent to any agent working 
in the specified campaign. The records scheduled as either personal or 
campaign callbacks are marked accordingly in the calling list, so that reports 
can be generated.
If a campaign is stopped but not unloaded, OCS follows up on personal and 
campaign callbacks.
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Note: See the “Communication Protocols” chapter of the Outbound Contact 
7.6 Reference Manual for information on the events distributed when 
rescheduling records.

Campaign Sequencing

Outbound Contact supports dynamic manual sequencing of running campaigns 
(campaign sequencing). Only one campaign per Campaign Group can be 
running at a time, but multiple campaigns can be loaded into memory. This 
enables the user to stop a previous campaign and automatically start the next 
one without disrupting the agents’ work. After the new campaign has started, 
the agents working in the group are notified. If new agents log in to the group 
after an outbound campaign has started, they are informed of the name and 
status of the currently running outbound campaign. OCS sends the name and 
status of a campaign as user events by means of a communication protocol.
Campaign sequencing can be configured according to the following 
parameters:
• Stop at Contacts—This counter is increased when a dialed record is 

updated in the database with the Answer call result. Once the counter 
exceeds the campaign threshold, the campaign is stopped and unloaded.

• Stop at Dials—This counter is increased when a dialing request or a 
PreviewRecord user event is issued. When the counter exceeds the 
campaign threshold, the campaign is stopped and unloaded.

• Stop at time—This occurs when a campaign is stopped and unloaded after 
it had been running up to the specified time.

Dialing Overview
A typical Genesys system consists of agent desktops, a T-Server, one or more 
OCS applications, and a calling list database. The central component of the 
system is T-Server, a computer-telephony integration (CTI) server that 
provides a transport layer for all the system’s telephony information. All 
information to and from the desktop and other servers passes through T-Server. 
The agent desktop and OCS are clients of T-Server. 

General Agent Desktop Interaction with OCS
Figure 3 illustrates the data flow for a typical customer record. 

Note: This figure is not specific to any particular sequence of events. 
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Figure 3: Data Flow for Typical Customer Record
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List in the database. OCS checks these tables in memory during a Do Not Call 
pre-dial check. 
If OCS finds a phone number in the Do Not Call table in memory during a pre-
dial check, it applies the DNC restriction to the phone number and does not 
check the customer ID. The phone number has a higher priority than the 
customer ID if they are both in a dialing record. Figure 4 illustrates the pre-dial 
check process).

Figure 4: Pre-Dial Check by Phone and Customer ID

Dialing Modes
After a campaign has started, the user can change the dialing mode in the 
following ways:
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To change from any Predictive or Progressive dialing mode to Preview dialing 
mode, you must stop and restart the campaign.
Outbound Contact supports call blending in any dialing mode. Among other 
considerations, OCS takes into account queued inbound calls. By using the 
progressive_blending_reserved_agents option, you can specify the number of 
reserved agents in Progressive dialing mode that should be available for 
inbound traffic. For more information about the 
progressive_blending_reserved_agents option, see Chapter 8, “Outbound 
Contact Configuration Options,” on page 171.

Predictive Dialing Mode

Predictive dialing mode predicts agent availability when it dials calls from a 
calling list. Predictive mode is recommended for high-volume, low-value 
campaigns.
In Predictive dialing mode, Outbound Contact can dial more calls than the 
number of available agents in a group. The predictive dialing algorithm 
performs real-time pacing calculations based on continuously sampled values 
for the following parameters:
• Statistics:

Average talk time (for both outbound and inbound calls)
Average not ready time
Average wrap-up time

Average contact rate per campaign (percentage of answered calls over 
total dialed calls)

Number of currently queued calls (both inbound and outbound)
Average inbound traffic volume based on the value of the history-
length option

• Resources:
Number of available agents logged in the group
Number of available dialing ports

• Controllable Parameters:
Optimized parameter (Agent Busy Factor, Overdial Rate, Average 
Waiting Time)

Goal value of the chosen optimized parameter
Outbound Contact can support an unlimited number of agent groups, each of 
which has its own independent dialing engine. In other words, each group can 
run its own outbound campaign with its own pacing based on real-time, 
campaign-specific statistics. By default, Outbound Contact treats all agent 
groups with which it works as blended groups, immediately adjusting pacing if 
both inbound and outbound calls are routed to the same group.
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Optimization Parameters

In Predictive dialing mode, Outbound Contact offers optimization 
parameters. These parameters directly affect the performance of dialing 
algorithms in Predictive dialing mode. These parameters include:
• Agent Busy Factor.
• Overdial Rate.
• Average Waiting Time.
You specify these parameters as part of the campaign configuration process 
within Configuration Manager, and then change them in runtime, using OCM.

Predictive with Seizing

In the Predictive with seizing dialing mode, a call is dialed automatically, 
based on a prediction of agent availability, and the agent is “seized” (engaged) 
before the called party answers. There is no delay time after the customer is 
connected. Predictive with seizing is an Active Switching Matrix (ASM) 
mode.

Predictive Dialing Modes with Agent Feedback

To improve dialing efficiency in Predictive modes (for example, to increase 
the Busy Factor for a given value of the Abandon Rate), OCS supports better 
optimization by accepting estimated call-completion time notifications from 
agents through the ReadyTime event. In this event, the agent desktop provides 
OCS with preliminary information on the time remaining for an agent to 
complete call processing.
As a result of these notifications, OCS evaluates whether an agent is trusted or 
distrusted.
A trusted agent is one with a calculated trust factor that is less than the 
Overdial Rate optimization parameter for that campaign. In other words, the 
agent is available to handle another call when OCS expected the agent to be 
available. 
A distrusted agent is one with a trust factor that is greater than the Overdial 
Rate for that same campaign.
The trust factor is the percentage of false notifications in comparison to all 
ReadyTime events received. A notification is considered false when an agent is 
not ready within the tolerance set in the time-to-ready-tolerance option (see 
page 208) after OCS receives the ReadyTime event. This tolerance is the 
allowed accuracy in the agent's estimation of when that agent will complete 
call processing and become Ready.
OCS and the predictive algorithm rely on the accuracy of this information to 
determine when the agent will become Ready.
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Notes: 
• All agents are distrusted when a campaign first starts.
• The predictive_algorithm option (see page 200) must be set to 

advanced_small_group in order for the time estimate (when the 
agent will become Ready) delivered to OCS from the agent desktop 
to be considered by the predictive algorithm.

• Time to going Ready estimates are only taken into account if the 
Overdial Rate is used as the optimization parameter.

Predictive Dialing Modes for Small Groups

Outbound Contact provides you with two predictive algorithms for dialing 
outbound calls during a campaign that are specifically designed to handle 
small groups of agents.
• Small group algorithm—This algorithm waits until all dialed calls are 

completed before dialing new calls.
• Advanced small group algorithm—This algorithm accounts for all inbound 

calls and also allows calls to be initiated, even if one or more calls remain 
in the dialing stage, rather than waiting until all dialed calls are completed.

You specify the small group algorithm by configuring the 
predictive_algorithm option with either the small_group or 
advanced_small_group value. For more information on the 
predictive_algorithm option, see page 200.

Predictive Algorithm Self-diagnostic

In release 7.6.101, the predictive algorithm has been enhanced with self-
diagnostic capabilities to limit performance degradation, which could result in 
a deviation from the optimization parameters (Busy Factor, Overdial Rate, and 
Average Waiting Time) associated with the loss of a dialing pace.
Four options are associated with this self-diagnostic capability: pa-selfcheck-
awt-threshold (see page 198), pa-selfcheck-bf-threshold (see page 199), pa-
selfcheck-odr-threshold (see page 199), and pa-selfcheck-interval (see 
page 199).
Diagnostic results are reported using log events that identify the expected 
cause of the degradation and addresses four areas:
• 12-50131: call-related factors, which include the following scenarios:

Unexpected call-related agents’ activity, which can be caused by:
Agent state PA_StatAgentBusyRingOrDial that is not caused by 
Outbound, OutboundOther, or Inbound call types.
Agent goes to the Not Ready state from the Ready state but is not 
checked out.
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Agents log out from the Ready state, but does not use Smart LogOut.
Low Hit Ratio.
Transferring outbound calls to another campaign.
Receiving outbound calls transferred from another campaign.
Engaging call duration influence.

A sample log event of this type might be:
12:35:49.844 Std 50131 Campaign Group 'Alpha 
Campaign@AlphaAgentGroup', Busy Factor defined 80, actual 50, call-
related reason: Hit Ratio is low

• 12-50132: configuration factors, which include the following scenarios:
Long calls, which last more than outbound_agent_outlier_limit (see 
page 197) on agents and thus agents become Not Available.
A dials per second limitation on the switch or Campaign Group level
Violation of Overdial Rate limitation (predictive_max_overdial_rate, 
page 204) with a transition to the Progressive-in-Predictive mode.

• 12-50133: malfunctions, which include the following scenarios:
Abandoned calls in the presence of Ready agents.
Cleaning or removing outbound calls (calls frozen in either a Dialed or 
Queued state and removed by the Garbage Collector).
Not Ready agents become Busy with new outbound calls (usually 
caused by an inadequate telephony event sequence).
The Outbound dialing rate is greater or less than predicted.

• 12-50134: external conditions, which include the following scenarios:
Lack of dialing ports.
Campaign Group–related waits:

Lack of dialing records.
Lost connections to important supporting servers (for example, 
T-Server or Stat Server).
Missing connection to the Do Not Call list.

Predictive Algorithm and Engaging Call Dialing 
Duration

In release 7.6.101, OCS calculates the average engaging dialing call duration 
(defined as the time between an agent going ready and becoming ASM 
Engaged when the engaging call is delivered to the agent) for a given 
campaign group. The predictive algorithm takes this value into account when 
calculating dialing pacing. With this enhancement, OCS changes the dialing 
rate based on the optimization parameters:
• When using the Overdial Rate optimization parameter, OCS can restrict 

the dialing rate so that its growth will be less than 10%.
• When using Average Waiting Time or Busy Factor, OCS can increase the 

dialing rate.
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In addition, be aware of the following:
• As part of the self-diagnostic capability (“Predictive Algorithm Self-

diagnostic”), if OCS detects that the target value of the optimization 
parameter cannot be reached or that the dialing rate is restricted, OCS 
sends the STANDARD 12-50131 event, identifying the impact of the engaging 
call dialing duration.

• In a primary/backup configuration, OCS passes the value of the average 
engaging call dialing duration to the backup Predictive Algorithm.

• For the advanced small group predictive algorithm, when using the ASM 
dialing modes, after OCS receives the agent’s ReadyTime notification 
specifying when the agent will become ready for engaging calls, OCS 
increases the value by the average engaging call dialing duration to predict 
when the agent will actually become ready for new outbound calls. OCS 
uses this corrected ReadyTime value when it compares the value to the value 
when the agent actually becomes ready to determine the agent’s trust 
factor.

Progressive Dialing Mode

Progressive dialing mode dials calls from a calling list when an agent is 
actually available. Progressive mode is recommended for low-volume, high-
value campaigns. The number of calls dialed depends on the number of Ready 
agents. The next dialing attempt is triggered by either of the following factors:
• An Agent Ready event received from T-Server
• A non-positive call progress result received from the dialer

Progressive with Seizing

In the Progressive with seizing dialing mode, a call is dialed automatically 
when an agent is already on the line and ready to take the call. Progressive 
with seizing means Progressive dialing in ASM mode.
In both Progressive with seizing and Predictive with seizing modes, the 
agent should be on the line before the customer answers; however, there is a 
distinct difference between these two dialing modes:
• In Progressive with seizing, the agent is already reserved for the call 

when it is dialed. 
• In Predictive with seizing, the agent is predicted to be available when 

the dialer places the call.

Preview Dialing Mode

In Preview dialing mode, an agent requests one or several records from OCS, 
previews each record, and decides whether to dial a call. The agent interacts 
with the records by using the desktop application that communicates (via T-
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Server) with OCS. The OCS-desktop communication protocol enables the 
desktop application to perform the following tasks:
• Request and receive a record for preview.
• Update certain record fields.
• Schedule campaign or personal callbacks.
• Receive a scheduled record as an unsolicited event from Outbound 

Contact.
• Reject, cancel, or mark a record as Do Not Call.
Preview mode is recommended for low-volume, high-value applications for 
which individual ownership of accounts is the highest priority.
Preview dialing mode supports treatments based on call results.
Outbound Contact supports simultaneous participation by agents in multiple 
preview campaigns, including one Predictive/Progressive-mode campaign 
based on the following behavior:
• Outbound Contact Server distributes Campaign Status Notification 

messages for every campaign with which an agent is associated.
• If the agent participates in multiple preview campaigns, the record request 

for a specific campaign may be specified explicitly in the 
GSW_CAMPAIGN_NAME attribute of the PreviewRecordRequest. If not specified, 
Outbound Contact Server will select a record from any of the campaigns in 
a round-robin fashion. In this scenario, the GSW_CAMPAIGN_NAME attribute 
should have empty string value, or a NULL string value.

Note: In order to take effect for the round-robin algorithm, an agent must 
be configured for the single group that is assigned to multiple 
campaigns.

• If an agent wants to retrieve preview records from multiple campaigns, and 
the agent_preview_mode_start option is set with a value of yes, the 
PreviewDialingModeStart and PreviewDialingModeOver campaign requests 
should be submitted from the desktop for every campaign.

Note: In release 7.6.101, a new option, preview_release_nocontact_action 
(see page 219), instructs OCS on what action to apply to an agent’s DN 
when the agent releases an outbound call that was placed manually in 
the Preview dialing mode but could not be established. For this option 
to take effect, the attached data of this manually placed call must 
contain the GSW_RECORD_HANDLE attribute with the record handle, which 
OCS had passed previously to the agent desktop.
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Push Preview

Push Preview dialing mode uses Interaction Server to “push” records to agents. 
The amount of records “pushed” depends on the value of the Max Queue Size 
parameter. See “Genesys Multimedia” on page 69 for more information about 
this dialing mode.

Power GVP

Power GVP dialing mode uses Genesys Voice Platform (GVP) to dial outbound 
calls, to detect call results, and to further process successfully connected calls. 
The amount of records issued by OCS for dialing depends on the value of the 
Max Queue Size parameter. This dialing mode can be very effective when 
running “agent-less” campaigns, because it enables you to use custom-created 
VXML scripts to automate call processing and allow for self-service of the 
contacted outbound customers. See “Genesys Voice Platform” on page 71 for 
more information.

Typical Data Flow Scenarios
The following describes typical dialing scenarios for Predictive mode (or 
Progressive mode) and Preview mode.

Predictive Mode (or Progressive Mode)

The following is a typical data flow scenario for Predictive mode or 
Progressive mode:
1. When an outbound campaign is started, OCS places the call.
2. If the call is answered by a “live” voice, it is connected to an agent. User 

data attached to the call is delivered to the agent’s desktop. 
3. The agent updates the user data and the call result. The agent then either 

processes the call or, if requested by the customer, reschedules the call for 
a later time as a personal or campaign callback.

Figure 5 illustrates the data flow for a typical Predictive mode or Progressive 
mode call. In this instance, the switch has Call Progress Detection (CPD) 
capability, and T-Server requests the switch to dial the customer number. 
Alternatively, you could configure the system with the CPD Server, which 
uses a Dialogic board to dial the call. In either case, the agent is already logged 
in to the system.
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Figure 5: Predictive Mode Data Flow

1. OCS sends a request to the database to retrieve a record. 
2. A record is sent back to OCS, which forwards it to T-Server along with a 

request to initiate a call.
3. T-Server initiates the call. 
4. T-Server, or another device, interprets the call and determines that the call 

should be forwarded to an agent. The call result information goes back to 
OCS.

5. At the same time, T-Server transfers the call and customer-specific 
information to an agent. The agent and the customer are now connected. 

6. The customer provides data to the agent, who updates the record. This 
information might include a rescheduled call date and time, a do not call 
back request, or other data. The agent sends the updated record to OCS. 

7. After receiving the request, OCS sends an acknowledgment or error 
message back to the agent.

Note: The agent can update the record as many times as necessary. With 
each update, OCS stores the data to its internal buffer and responds 
with an acknowledgment or error message. 

8. When the agent and customer have finished, and the call ends, the agent 
sends the final event to OCS that the record is completed. 
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9. OCS responds to the agent desktop with either an acknowledgement that 
the transaction is complete or with an error message.

10. At the same time, the final update goes to the database.

Preview Mode

The following is a typical data flow scenario for Preview mode:
1. The agent requests that Preview mode begin.
2. The agent requests a preview record.
3. The agent either rejects the record or makes the call.

If the agent rejects the record, it is returned to OCS. The agent then has 
two choices:

Request the end of Preview dialing mode and log out.
Return to Step 2.

If the agent makes the call and if the customer requests no further calls 
for this campaign or no more calls ever, the agent requests OCS to 
mark the record as RecordCancel or DoNotCall. The agent then has two 
choices:

Return to Step 2.
Request the end of Preview dialing mode and log out. 

If the call reaches the customer, the agent updates the call results and 
custom fields. Next, the agent can terminate the call, sending the final 
call transaction back to OCS, or the customer can ask to reschedule the 
call. The agent then receives the rescheduled record. The agent then 
has two choices: 

Return to Step 2.
Request the end of Preview dialing mode and log out. 

If the call does not reach the customer, the agent can call an alternate 
(chained) record.
If there are additional records in the chain, the agent requests a chained 
preview record and returns the beginning of this Step 3.
If there are no additional records in the chain, the agent updates the call 
results and custom fields, sending the final call transaction back to 
OCS. The agent then has two choices: 

Return to Step 2.
Request the end of Preview dialing mode and log out. 

The data flow for Preview mode starts differently from that of the data flow for 
Predictive mode or Progressive mode, but is identical once the agent is 
connected to the customer. Figure 6 illustrates the data flow for a typical 
Preview mode call. The agent is already logged in to the system.
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Figure 6: Preview Mode Data Flow

1. The agent reports to OCS that he or she is ready to begin work in Preview 
mode.

2. OCS sends back an acknowledgment or error message.
3. The database sends a record or records to OCS, which forwards the records 

to the agent. These records might include previously scheduled calls. 
4. The agent signals T-Server to initiate a call. T-Server initiates the call. 
5. T-Server determines that the call is connected and signals the agent. The 

agent determines the status of the connection (fax, answering machine, 
modem, or customer). If the call is connected to a customer, the agent 
proceeds with the call. 

6. The customer provides data to the agent, who updates the record. This 
information might include a rescheduled call date and time, a Do Not Call 
request, or other data. The agent sends the updated record to OCS.

7. OCS either sends an acknowledgment or error message back to the agent. 

Note: The agent can update the record as many times as necessary. With 
each update, OCS stores the data to its internal buffer and responds 
with an acknowledgment or error message (Steps 6 through 8). 

8. When the agent and customer have finished, and the call is terminated, the 
agent sends the final event to OCS that the record is completed. 
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9. OCS sends the agent either an acknowledgment that the transaction is 
complete or an error message.

10. At the same time, OCS sends the final update to the database.

Multiple Sites, Users, and Tenants

Multi-Sites
Outbound Contact Server supports multi-site operation. Multi-site operation 
means that you can run several campaigns independently in different locations 
using only one Outbound Contact Server, or you can run one campaign from 
different sites at the same time. A site is a location with a contact center and an 
agent group.
OCS also supports environments in which agent groups or place groups are 
distributed across multiple sites. In this scenario, dialing is performed by one 
CPD Server or T-Server. OCS relies on ISCC call distribution to deliver 
successful calls to agents in multiple sites. If the value of the 
transfer_to_unknown_dn option is set to true or yes, OCS correctly processes 
the route of successful outbound calls or transfer calls between agents on 
different switches. See page 209 for more information about this option.

Note: The use-data-from option must be configured with the value consult-
user-data in the extrouter section of all T-Servers used with OCS. 
This value enables OCS to correctly process transferred calls between 
agents/DNs on different switches. When this value is set, 
AttributeUserData and AttributeConnID values are identified from the 
consultation call before the transfer or conference is completed. After 
the transfer or conference is completed, the EventPartyChanged 
message is generated, and then the AttributeUserData and 
AttributeConnID values can be taken from the original call.

In multi-site scenarios, OCS generates statistical user events only on the 
Communication DN that is configured under the same Switch object as the Voice 
Transfer Destination DN.

OCS makes multi-site operation possible because it connects to the T-Server at 
each site and tracks the campaign data that is assigned to each agent group at 
each site.
One example of a multi-site campaign is as follows: A customer has three sites 
with agents at each site. One campaign is assigned to three agent groups and 
runs concurrently at all three sites.
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Multi-site does not necessarily mean that a campaign is started at one site from 
which calls are distributed to agents in one of three sites; however, with a 
centralized CPD Server, it is possible to run a campaign from the central 
location and connect to agents at outlying sites. 

Multiple Users
Outbound Contact Server can support multiple instances of Outbound Contact 
Manager that run concurrently. 

Multi-tenant Environment
A tenant is typically a contact center (single-site or multi-site). In a multi-
tenant site, the administrator can grant permissions to other users to view their 
own tenant and run their own campaigns. Outbound Contact 7.6 supports 
multiple tenants. Note, however, that Outbound Contact Manager can work 
with only one tenant at a time. 
Outbound Contact Manager supports the Environment tenant, which can be 
used by administrators of multi-tenant sites or by a user with permission 
granted by an administrator. When multiple tenants are set up, an administrator 
can select any tenant, including the Environment tenant, from the Select 
Tenant dialog box. The Select Tenant dialog box displays the tenants that are 
available to each user, based on that user’s permissions.
The Environment tenant is created during the installation of the Configuration 
Layer. Although the Environment tenant is on the same level as all other 
tenants in the directory, it provides the administrator of a multi-tenant site with 
the following: 
• A single location for all the configuration objects that are shared by sub-

tenants (for example, Applications, Application Templates, and so on). 
• Preset templates in some folders (for example, the Formats folder includes 

a preset format).
• Privacy through restricted access to all users except the administrator. 
The elements of the Environment tenant simplify the process of adding new 
tenants.

Centralized Configuration and Shared HMP Resources

In release 7.6.101, Outbound Contact supports a centralized configuration and 
sharing of HMP resources in multi-tenant deployment. This functionality can 
be used for HMP deployment in the ASM mode and the Transfer mode due to 
the rapid ISCC call routing between SIP Servers.
This functionality includes the ability to:
• Have a centralized configuration of HMP in a multi-tenant environment.
• Share HMP resources among multiple Tenants.
• Isolate HMP configuration from Tenant access.
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• Configure a capacity-based resource allocation (This configuration 
involves dedicating one CPD Proxy Server for each Tenant or any subset 
of Outbound Campaigns in a Tenant, as described in “Managing Dialing 
Resources.”)

• Configure a demand-based resource allocation. (This configuration is 
based on one CPD Server shared among all Tenants.)

Configuration Requirements:

• All configuration of HMP must be accomplished under Environment/SIP 
switch and is not accessible by Tenants.

• The Tenant configuration contains only Outbound/agent-specific 
configuration.

Figure 7 provides a sample architecture of this configuration environment.

Figure 7: Sample Architecture

Note: Figure 7 does not show component connections. Be aware that 
CPD Proxy Server, which is used by the Tenant and connects OCS 
with CPD Server, is configured under Environment. The Tenant is not 
able to change its configuration.
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Tenant, or
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• For each CPD Proxy Server, configure the max-dialing-channels option 
(see page 230) and the max-engaging-channels option (see page 230), 
which set the maximum number of dialing and engaging channels for that 
CPD Proxy Server.
When OCS starts a Campaign, it requests and receives the maximum 
number available for these respective channels from CPD Proxy Server, as 
configured in these options.

Figure 8 illustrates how restricted dialing resources might be configured for 
two or more Tenants.

Figure 8: Dialing Resources for Tenant Campaigns
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This two step process is required because CPD Server cannot manage calls 
across multiple switches. By using this method, CPD Server works with the 
Environment/SIP switch only and OCS works with the premise SIP Servers 
only.
In order to accomplish this:
• For every Voice Transfer Destination on Tenant (premise) SIP switch, 

configure a corresponding Voice Transfer Destination on Environment SIP 
switch.

• Configure at least one VoIP Service DN for each Tenant to handle 
engaging calls.

• Create a routing strategy for each Environment/SIP Switch Route Point to 
route calls to the associated Route Point (VTD) on the Tenant switch.

• Configure the vtd-override option (see page 209) to specify the dialing 
number that OCS sends to CPD Server and that it will use as the 
destination number where a transfer call (HMP Transfer mode) or an 
engaging call (HMP ASM mode) is delivered.

Two Tenant Configuration Example

Figure 9 provides an example of a two Tenant configuration for handling 
engaging call distribution in HMP ASM mode.

Figure 9: Engaging Call Dialing and Distribution Diagram
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• Tenant2 includes the following:
Tenant2 has Switch2, SIP Server2, one Campaign Group 
(CampaignGroup3), and one agent group.
One route point as the VTD.
One external route point (not shown in Figure 9).

• The Environment SIP switch DNs includes the following:
Three route points. Two route points are the central VTDs for the two 
Campaign Groups for Tenant1. The third route point is the central 
VTD for the Campaign Group for Tenant2.
Two VoIP Service DNs for transferring engaging calls to premise SIP 
Servers. 

Other Supporting Solutions 
This section describes other Genesys applications that enable and support 
Outbound Contact 7.6. They include the following solutions:
• “Framework” on page 67
• “Genesys Multimedia” on page 69
• “Genesys Voice Platform” on page 71
• “Reporting” on page 72

Framework
Outbound Contact 7.6 is built on Framework 7.6, which includes DB Server, 
Configuration Server, the Management Layer, T-Server, and Stat Server.

DB Server

Outbound Contact relies on the DB Server for access to data in the calling list 
database tables, any Do Not Call list, and any other additional lists stored in the 
database.

Configuration Server

Outbound Contact 7.6 is configured through the Configuration Layer of 
Framework. More specifically, you use Configuration Manager to configure 
the components (applications and configuration objects) that enable Outbound 
Contact. OCS reads the configurations from the Configuration Server in order 
to perform its operations. Outbound Contact supports dynamic reconfiguration 
— that is, you can make changes to Outbound objects (such as Calling List, 
Table Access, and Campaign objects) in Configuration Manager or Outbound 
Wizard without stopping and restarting Outbound Contact. Messages notifying 
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the user of changes are displayed in Outbound Contact Manager. For 
information about configuring Outbound objects, see Chapter 7 on page 129.

Management Layer

The Management Layer of Framework includes Local Control Agent (LCA), 
Message Server, Log Database, Solution Control Server (SCS), and Solution 
Control Interface (SCI). LCA is used to start and stop applications. Message 
Server provides centralized processing and storage of every application’s 
maintenance events. Log Database stores events as log records, so that they are 
available for further centralized processing. SCS is the central processing 
center of the Management Layer. SCI displays the status of all installed 
Genesys solutions and provides information about each active alarm condition.

T-Server

T-Server is the key element of Genesys computer-telephony integration (CTI) 
because it handles call traffic. Each T-Server is linked to a switch, which it 
monitors. T-Server is also a “messenger” that enables communication among 
Outbound Contact components. For details, see the “Communications 
Protocol” chapter in the Outbound Contact 7.6 Reference Manual.

Network T-Server

Outbound Contact supports Network T-Servers in deployments that do not 
include CPD Server. To enable this functionality in Predictive dialing mode:
• The Service Number DN type, in addition to any applicable DNs of type 

ACD Queue and Route Point in Configuration Manager must be identified on 
the appropriate place group or agent group. 

• The Campaign object must specify the same Service Number DN as the 
Voice Transfer Destination within the place group or agent group that is 
specified on the Group tab.

Note: Outbound Contact Server does not support the load-balancing 
capabilities of the Network T-Server.Outbound Contact Server should 
not be configured to connect to multiple Network T-Servers that are 
associated with the same switch.

Stat Server

Stat Server provides the data source for the CCPulse+ application. It also 
provides agent state information to Outbound Contact Server so that it can dial 
effectively.
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Optional Solution Integration
In addition to the Framework components, Outbound can work with the 
following Genesys solutions:
• “Genesys Multimedia” on page 69
• “Genesys Voice Platform” on page 71
• “Reporting” on page 72

Genesys Multimedia

Outbound Contact calling list and campaign management are now integrated 
with the Customer Information Management (CIM) platform. This feature 
extends the Outbound Contact calling list and campaign management to 
multimedia channels, and it improves agent efficiency by pushing preview 
records to agents without waiting for an agent request. Therefore, it enables the 
prioritization of outbound interactions with other interaction types for blending 
purposes. This dialing method can also be referred to as “proactive routing” or 
“push preview”. Figure 10 illustrates how Outbound Contact integrates with 
the CIM platform.

Figure 10: CIM Integration with Outbound Contact
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The basic process for completing a proactive interaction is as follows:
1. OCS submits a preview interaction request to Interaction Server.
2. Interaction Server requests that Universal Routing Server execute a 

strategy to determine which agent to send the interaction to based on skill 
abilities. The agent must be logged in to Interaction Server and can still 
process other interactions during this process. The communication between 
the agent desktop and OCS is through Interaction Server in this scenario.

3. The agent processes the preview record appropriately, transfers the call to 
another agent, or places the call back into the queue. 

4. Special strategy blocks enable the routing strategy to process the preview 
call interaction automatically without agent involvement.

Notes: Refer to the Universal Routing Server documentation for more 
information about configuring strategies for proactive interaction 
routing.
Refer to “Advanced Tab” on page 167 for more information about 
configuring a proactive routing (or push preview) campaign.

ESP Port

In the Push Preview dialing mode, Interaction Server must be specified in the 
Connections tab of the CampaignGroup object to establish a client-server 
relationship between OCS (as the client) and Interaction Server (as the server). 
However in order for OCS to process requests and responses from Interaction 
Server, OCS must be a server for Interaction Server and receive these 
responses on a special ESP-type port rather than its default listening port. 
Create this additional port PortID, called ESP, on the Server Info tab of the 
OCS Application object. Use this ESP PortID instead of the default PortID, 
when configuring a connection to the OCS Application object on the Server 
Info tab of the Interaction Server Application object. In effect, this makes 
OCS a server for Interaction Server and Interaction Server a client for OCS.

Note: This ESP PortID will be available as a connection in the Interaction 
Server Application object only after you configure PortID in the OCS 
Application object.

Interaction Media Type

Interactions submitted to Interaction Server must contain a certain media type. 
By default, OCS creates interactions with the outboundpreview media type. 
However, OCS can assign other media types to interactions from particular 
calling list or to interactions created for the entire campaign. Refer to the 
interaction-media-type option on page 213 for more information.
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Notes: Refer to the direct-personal-callback option in “Campaign Group-
Level Options for OCS” on page 188 when configuring this solution.
Refer to the “Proactive Interaction Support” section in the Outbound 
Contact 7.6 Reference Manual for more information about Proactive 
Interactions with Outbound Contact.

Genesys Voice Platform

Outbound Contact can integrate with Genesys Voice Platform (GVP) in order 
to perform Power GVP dialing mode campaigns. OCS uses the Outbound 
Notification Manager (OBN) application as a connector to GVP to request that 
GVP dial records. The OBN Manager GVP application should be created in 
Configuration Manager to provide its host and port information to OCS. 
This application must be specified on the Connections tab of the Campaign 
Group configuration object in order to enable GVP integration. This 
configuration will enable basic connection capabilities.
If full connection abilities, including Advanced Disconnect Detection Protocol 
(ADDP) is required, then this application should also be present on the 
Connections tab of the OCS application, where the ADDP connection protocol 
can be specified.

Note: See “Campaign Group Object” on page 165 for more information 
about how to configure the Campaign Group configuration object for the 
Power GVP dialing mode.

When configured to enable connections, OBN opens a predefined port (for 
listening purposes) and then accepts requests from OCS in a client-server 
fashion.

Dialing Algorithm

In a GVP-assisted campaign, dialed outbound calls are dialed from GVP ports, 
and they can be completely processed and released by GVP. GVP issues 
information about call processing (such as call results and modified user data) 
to OBN Manager, which relays this information to OCS. OCS processes this 
information accordingly, applies any necessary treatments, and updates the 
records.

Do Not Call Records

OCS issues an EventOBNRecordStopProc message to OBN when it receives a 
DoNotCall request and determines that records are currently being processed 
by OBN. OBN immediately attempts to stop processing the specified record.
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Notes: Refer to the dialer-ttl and dialer-num-attempts options in 
“Campaign Group-Level Options for OCS” on page 188 when 
configuring this solution.
Refer to the 7.6 GVP documentation for more information about using 
Outbound Contact with the OBN application.

Calculating the Number of Records

The procedure that OCS uses to calculate the number of records (or chains) to 
retrieve from the database when a campaign is loaded is similar for both Push 
Preview and Power GVP modes, but differs from traditional Predictive, 
Progressive, or Preview modes. When a campaign is loaded, OCS selects 
records for retrieval from the database based on the value of the MaxQueueSize 
parameter for the Campaign Group. If more than one calling list is used in the 
campaign, the number of records retrieved from each calling list is determined 
by the specified list weight.
OCS then submits the records to Interaction Server or OBN Manager using the 
following criteria:
• The total number of interactions or dialing requests submitted is equal to 

the MaxQueueSize value for the Campaign Group.
• OCS retrieves records from the calling list table in the database to 

replenish its buffer when the number of calling list records in the OCS 
buffer is below half of the specified MaxQueueSize value for the Campaign 
Group.

Reporting

The Genesys Reporting solution contains tools for collecting historical and real 
time data, and for viewing and analyzing contact center performance. In 
Outbound Contact 7.6, the calculation of some real-time metrics is provided by 
the OCC Extension. All data required for the OCC Extension is directly 
submitted by OCS through the OCS DataStream protocol. For more 
information about the Genesys Reporting solution and the templates provided 
with Outbound Contact 7.6, see the Reporting Technical Reference Guide for 
the Genesys 7.2 release.
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3 Deployment Planning
This chapter provides an overview of the deployment process for Outbound 
Contact 7.6, and includes tools for deployment planning. It contains the 
following sections:

About the Deployment Process, page 73
How to Use This Chapter, page 74
System Requirements, page 75
Worksheet Definitions, page 81
Outbound Deployment Planning Worksheet, page 88
Other Resources, page 95

Note: The Outbound Contact 7.6 installation uses information that was set up 
during Framework 7.6 configuration and installation. You can install 
Outbound Contact 7.6 only after Framework 7.6 is installed. For more 
information, see “Outbound Object-Creation Sequence” on page 130.

About the Deployment Process
The deployment process involves the configuration and installation of the 
applications and components that are needed for a functional setup of 
Outbound Contact 7.6. 
Before deploying Outbound Contact, review the “System Requirements” on 
page 75, as well as the following documents, which contain information about 
licensing requirements, supported platforms, and sizing specifications:
• Genesys 7 Licensing Requirements
• Genesys 7 Supported Operating Systems and Databases
• Genesys 7 Supported Media Interfaces
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Also, use the “Worksheet Definitions” on page 81 to gather information for the 
configuration and installation of Outbound Contact 7.6. The Outbound Contact 
deployment process involves the following components: 
• Outbound Contact Server (OCS)
• Outbound Contact Manager (OCM)
• CPD (Call Progress Detection) Server (optional)
• CPD Proxy Server (optional)
When installing, test each component before you continue to the next. 
Make sure that you install all Framework components, including Configuration 
Server, Configuration Manager, T-Server, the Management Layer, DB Server, 
and Stat Server. 
For information about configuring and installing Framework products, see the 
Framework documentation. 
If necessary, install Dialogic boards and software for call progress detection. 
For more information about installing Dialogic boards, see “Introduction to 
Dialogic Boards” on page 301. 
For additional information about formats, calling lists, campaigns, and how to 
start or stop a campaign, see Outbound Contact Manager Help. 

How to Use This Chapter
Before beginning Outbound Contact 7.6 configuration and installation, review 
the “System Requirements” on page 75, and then complete the “Worksheet 
Definitions” beginning on page 81.
The worksheet provides space for your notes, and multiple boxes (cells) 
provide room to write additional values, if needed. If you need to provide 
additional information, you can make copies of the worksheet 
This chapter’s structure is based on the configuration sequence found in the 
Outbound Configuration Wizard. Outbound properties for Configuration 
Manager are also included.
After completing the installation, keep the worksheet as a reference. In the 
future, if you need help from Genesys Technical Support, you can fax the 
worksheet to a support engineer in order to provide the complete system 
configuration.
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System Requirements
This section describes some of the system sizing requirements for the 
installation of Outbound Contact 7.6. It contains the following sections:
• “Environmental Sizing” on page 75
• “Database Sizing” on page 77
• “Network Traffic” on page 77
In addition, the following documents on the Technical Support website provide 
detailed information about the operating systems and databases supported by 
Outbound Contact 7.6:
• Genesys 7 Supported Operating Systems and Databases 
• Genesys 7 Supported Media Interfaces 

Environmental Sizing
The information provided in this subsection helps you create the most effective 
environment for running Outbound Contact in your contact center.
Table 4 shows the recommended sizing requirements for various contact 
centers.

Table 4: Outbound Contact Environmental Sizing for Components

Outbound Contact 
Component

CPU Memory Network Transactions per Second 

Outbound Contact 
Manager

Pentium III, 
400 MHz 
(recommended)

128 MB 
(Windows 
2000 or 
Windows 
XP)

10 mbps 
(minimum)

Not applicable

Outbound Contact 
Server 

Pentium III, 
400 MHz 
(recommended)

512 MB 
(minimum)

10 mbps 
(minimum)

0.5–1 transactions per agent 
per second
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CPD Server
Supported interfaces:
• LSI 
• Line-side (E1/T1) 
• PRI
• HMP
The CPD Server and the 
Dialogic cards and 
drivers it controls must 
be installed on the same 
machine.

Single or dual 
processor, 
1GHz

512 MB 
Minimum

10 mbps 
(minimum)

0.5–1 transactions per agent 
per second

Environmental 
recommendation for 240 
Ports

Dual processor 
Pentium III, 
600 MHz

256 MB 100 mbps 0.5–1 transactions per agent 
per second

Number of Agents

25–100 Pentium III, 
400 MHz

128 MB 10 mbps 
(minimum)

0.5–1 transactions per agent 
per second

100–200 Pentium III, 
400 MHz

256 MB 10 mbps 
(minimum)

0.5–1 transactions per agent 
per second

200–600 Pentium III, 
400 MHz 
(minimum) + 
100 MHz for 
every 200 
agents

256 MB 10 mbps 
(minimum)

0.5–1 transactions per agent 
per second

600–1000 Single/dual 
processor,
1 GHz

512 MB 100 mbps 0.5–1 transactions per agent 
per second

1000–2000 Dual processor, 
1GHz

512 MB 
(minimum)

100 mbps 0.5–1 transactions per agent 
per second

2000–4000 Dual processor, 
1.5 GHz

512 MB 
(minimum)

100 mbps 0.5–1 transactions per agent 
per second

Table 4: Outbound Contact Environmental Sizing for Components (Continued) 

Outbound Contact 
Component

CPU Memory Network Transactions per Second 
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Note: The list of Dialogic boards might be extended based on their support 
by the CPD Server. Refer to the Genesys 7 Supported Media Interfaces 
for the current list of supported boards.

Database Sizing
Outbound Contact Server supports IBM’s DB2 database, in addition to the 
previously supported database management systems (Oracle, Microsoft SQL 
Server, Informix, and Sybase). 
The sizing of your database can affect the performance of the Outbound 
solution. The term sizing pertains to how the database is tuned, the available 
memory, and the number of processors. The term tuning pertains to the 
indexing of the calling list. The higher the number of transactions that the 
database processes, the more the database performance is affected, unless it is 
properly sized.
When sizing your database, consider the factors shown in Table 5.

If the size of one record is equal to the size of one transaction (1 KB), and 
if the size of the calling list is 100,000 records, the estimated size of the 
database is 100 MB. See the Outbound Contact 7.6 Reference Manual for 
more information about database tuning.

Network Traffic
Table 6 provides basic data about network traffic produced by Outbound 
specific activities among various Framework and Outbound components. This 
information can help you determine the optimal component location on the 
network.

Table 5: Database Sizing

Format Estimated Size for Each

Record 1 KB

Transaction 1 KB

Database 100 MB per 100,000 records per campaign

http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
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Table 6: Network Traffic Among Framework and Outbound Components

Primary Data 
Types

Average 
Message 
Length

Messages Per 
Transaction

Elements 
Determining Total 
Message

TrafficTotal 
Traffic Volume

OCS <-> DB Server

Record from 
Calling List

0.25 KB + total 
length of Field 
Names + 
average Record 
Data length

1 Number of Records 
requested per Select 
= <Number of 
Agents in Campaign 
Group> * <Optimal 
Buffer Size 
Coefficient> - 
Minimum Buffer 
Size Coefficient>

<Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

Update of 
Record 
Attributes

0.5 KB 1 if OCS is not 
configured to save 
intermediate results, 
otherwise,1 per 
treatment

Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

OCS <-> CPD Server

Dialing Request 0.25 KB + User 
Data

1 per Dial Attempt Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

Agent Seize 
Request (ASM 
mode only)

0.5 KB 1 per AgentReady 
TEvent

Conversation 
Duration

Total Number of 
successful 
Contacts
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Call Progress 
Result

0.25 KB 1 per Dial Attempt Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

OCS <-> Agent Desktop

Record 0.25 KB + User 
Data

1 per Answered Call 
or Preview Record 
Request

Number of Records 
processing Desktop 
sessions

Total Number of 
successful 
Contacts, in 
Predictive or 
Progressive 
mode, <Number 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>, in 
Preview mode

Desktop 
Protocol 
Requests

0.25 KB Typically 2 Number of Records 
processing Desktop 
sessions

Total Number of 
successful 
Contacts in 
Predictive or 
Progressive 
mode, <Number 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>, in 
Preview mode

Table 6: Network Traffic Among Framework and Outbound Components (Continued) 

Primary Data 
Types

Average 
Message 
Length

Messages Per 
Transaction

Elements 
Determining Total 
Message

TrafficTotal 
Traffic Volume
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OCS <-> T-Server

Requests (no 
CPD Server)

0.25 KB + User 
Data

1 per Dial Attempt Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

TEvents 0.25 KB + User 
Data

5 for simple call-
distribution scenario

Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

CPD <->T-Server

Dialing Request 0.25 KB + User 
Data

1 per Dial Attempt Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

Transfer 
Request

0.25 KB 1 per Dial Attempt Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

Table 6: Network Traffic Among Framework and Outbound Components (Continued) 

Primary Data 
Types

Average 
Message 
Length

Messages Per 
Transaction

Elements 
Determining Total 
Message

TrafficTotal 
Traffic Volume
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Worksheet Definitions
For more information about the following items, see “Other Resources” on 
page 95.

Logging in to Configuration Manager
• User name—Enter the user ID authorized to log in to Configuration 

Server.
• User password—Enter the password for the user ID authorized to log in to 

Configuration Server.
• Application—Enter the name of the Configuration Manager Application 

object.
• Host—Enter the host name of the computer on which the Configuration 

Server is installed.
• Port—Enter the port that the Configuration Server uses for client 

connections.

License Manager
• Path to License Manager—Enter the path to the License Manager. License 

Manager must be available for licensed application.

Agent Seize 
Request (ASM 
mode only)

0.5 KB + User 
Data

1 per AgentReady 
TEvent

Conversation 
Duration

TEvents 0.25 KB + User 
Data

10 for simple call-
distribution scenario, 
1 for unsuccessful 
dial attempt

Hit Ratio, Treatments <Number of 
Records from all 
Calling Lists in 
Campaign> * 
<Average 
Number of 
Attempts per 
Record>

Table 6: Network Traffic Among Framework and Outbound Components (Continued) 

Primary Data 
Types

Average 
Message 
Length

Messages Per 
Transaction

Elements 
Determining Total 
Message

TrafficTotal 
Traffic Volume
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Outbound Solution Object
• Name—Enter a name for the Outbound solution object.
• Solution Control Server—Enter an existing Solution Control Server.

Tenant
• Name(s)—If this a multi-tenant environment, enter the names of the tenant 

to be used for Outbound Contact 7.6.

Switches
As part of the Framework 7.6 configuration and installation, you will have 
already assigned agent names, agent logins, and DNs (see “DNs” on page 89) 
to switches.
In most systems, the telephone directly notifies the switch when the telephone 
set (teleset) status changes—for example, when agents begin or end a call. By 
default, Outbound Contact registers teleset states internally. Older PBX 
software does not enable the teleset to notify the switch directly when its status 
changes. If the contact center’s PBX software does not enable direct 
notification, you must customize the contact center’s teleset state disposition. 
Use configuration settings that instruct Outbound Contact to send 
Framework’s T-Server a notice for each teleset status change. For more 
information, see Chapter 8 on page 171.
The following refer to the capabilities of a switch:
• Name(s)—A switch set up during Framework configuration. Other 

switches can include numbers and types of all telephony devices (DNs) to 
be monitored and controlled through the CTI (computer-telephony 
integration) link. Enter the switch name(s) to be used for Outbound 
Contact 7.6. If new switches are needed, they must be added through 
Framework 7.6.

• CPD capability—Does the switch have call progress detection (CPD) 
capabilities? If the switch does not provide call progress detection, and you 
wish to use CPD Server as a part of Outbound Contact 7.6 for the contact 
center, collect the following information about the Dialogic boards:

• Call transferring—Does the switch have this capability?
Call conferencing—Does the switch have this capability?
Call forwarding—Does the switch have this capability?
Do Not Disturb—Does the switch have this capability?



Deployment Guide 83

Chapter 3: Deployment Planning Worksheet Definitions

Special DNs

Communication DN

Outbound Contact 7.6 reports on outbound activity by using a DN that is set up 
as a Communication DN.
• Number—Enter the name or number of the Communication DN.
• Type—Always enter “Communication DN.”

Overflow DN

Outbound Contact 7.6 monitors calls that cannot be handled by available 
agents, it does this through a DN set up as an Overflow DN.
• Existing DN name—Enter the name or number of the overflow DN.

Applications
Each application name must be unique, and it can contain alphanumeric 
characters and underscores. the properties for most applications are the same; 
therefore, definitions are given only once for the “Applications” section of the 
worksheet.
• T-server name(s)—Enter the name of the T-Server.
• Stat Server name(s)—Enter the name of the Stat Server.
• DB Server name(s)—Enter the name of the DB Server.
• OCS name—Enter the name of the Outbound Contact Server.
• CPD Server name(s)—Enter the name of the CPD Server.
• OCM name—Enter the name of the Outbound Contact Manager.
• Reporting—See the Reporting documentation.

Tenants

• Tenant name(s)—If this is a multi-tenant environment, select the name of 
the tenant.

Server Info

• Host—Select the host computer on which your application will be running.
• Communication port—Enter the port number that the application’s clients 

will use to establish connections to the named server.
• Back up Server—Select the back up server to be contacted if connection to 

the primary server fails.
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Options

• Option names—Options are changed according to the user’s needs. For 
detailed information about options, see Chapter 8, “Outbound Contact 
Configuration Options,” on page 171.

Database Access Point(s)
• Name—Enter the name of the Database Access Point (DAP) object.

Server Info

• DB Server name—Select the name of an existing DB Server.
• DB Server host—Select the host computer on which the DB Server will be 

running.

Tenants

• Tenant name(s)—If this is a multi-tenant environment, select the name of 
the tenant.

DB Info

• DBMS name—Select the name of the host computer on which the database 
resides.

• DBMS type—Select the type of database.
• Database name—Enter the name of the database.
• User name for login to DB—Enter the user name for accessing the 

database.
• Password for login to DB—Enter the password for access the database.

User-Defined Fields
A calling list must contain Genesys mandatory fields, and it can also contain 
user-defined fields. For more information about mandatory fields, see “Field 
Object” on page 137 and “Format Object” on page 141.
The user must create additional fields, containing business information that is 
used for sorting and chaining records—for example, Last_Name.
• Name—Enter the name of the user-defined field—for example, cust_id.
• Data type—Enter the type of data, for example, the data type for cust_id 

would be int, and must always be numeric.
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• Length—Enter the number of characters needed for field contents—for 
example, cust_id can be limited to five numeric characters.

• Default value (optional)—Enter the value that will be assigned to the field 
unless it is changed.

Formats
A format contains a collection of Genesys mandatory fields and user-defined 
fields. It defines the layout of a calling list. More than one format can be 
created and named for the specific needs of particular calling lists.
Identify the number of formats that you need, assign names to them, and 
identify the user-defined fields required for each.

Note: Plan and create your formats and all custom fields carefully. You 
cannot modify existing fields or add new fields after the calling list 
table is created in OCM.

• Name—Enter the name of format.
• User-defined field names—Enter the names of the user-defined fields to 

each format.

Table Access
• Name—Select the name of the Table Access object.
• Table type—Select “Calling List.”
• DB access point name—Select the name of the database access point 

through which the table can be accessed.
• Format name—Enter the name of the format applied to this table.
• Database table name—Enter the name as specified in the database.

Dialing Filters
Dialing filters select records from a calling list for dialing, based on specified 
criteria. They can be created in Outbound Contact Wizard as an object of a 
calling list, or in Configuration Manager within the Filters directory. Dialing 
filters are stored in the Filters directory in Configuration Manager.
For more information, see “Filter Object” on page 147.
• Name—Enter the name of the dialing filter.
• Criteria SQL statement—Enter the SQL statements that give the criteria 

for the filter.
• Order by SQL statement—Enter the field on which the list will be sorted.
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Treatments
Decide on treatments to use for unsuccessful call results. For more details and 
examples, see Chapter 10 on page 275.
• Name—Enter the name of the treatment.
• Call result—Enter the result of dialing a calling list record.
• Apply to record—Enter the action to be applied to a calling list record, 

based on the call result.
• Apply to call (very limited use)—Enter the final outcome of attempts to 

dial a record.
• Destination DN (if “Apply to call”)—Enter the DN to which a treatment 

will forward a call.
• Number in sequence—In a treatment sequence, each treatment contains a 

unique number that determines the order in which it will be applied to the 
same call result, on calls from the same calling list.

• Cycle attempt (only for redial)—Enter the maximum number of 
consecutive times that the treatment will be performed on the record.

• Interval—Enter the time interval, in minutes, that the application will wait 
between the first dialing attempt and the first treatment attempt, or between 
consecutive attempts.

• Increment—Enter the number of minutes that the application will add to 
the interval (see the previous item) after the first treatment attempt, and 
after each consecutive attempt.

• Date/Time—Enter the date/time when another treatment attempt will be 
performed.

Calling Lists
Calling lists contain dialing records. Decide where you will store the calling 
lists. They can be located either in the Genesys Configuration Database or in a 
separate database. The size of the calling lists and the ease of maintenance are 
the deciding factors when identifying the appropriate location. Very large 
calling lists should be maintained in a database other than the Genesys 
Configuration Database.
• Name—Enter the name of the new calling list.
• Table Access Point name—Enter the name of the Table Access object to 

which the calling list refers.
• Dialing filter name (optional)—Enter the name of default dialing filter to 

apply to the calling list.
• Script property—The Script property in the campaign, in the calling list, 

and in the Campaign Group defines the Script object, which contains all of 
the attributes that are required by Agent Scripting.
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Treatments

• Treatment names (optional)—Identify or create treatments that will be 
applied to the records on the calling list if calls are unsuccessful.

Campaigns
Campaigns are collections of callings lists and agent or place groups. Agent 
skills that may be considered during the processing of customer interactions 
include language or marketing knowledge.
• Name—Enter the name of the campaign.
• Calling list name(s)—Enter the names of the calling lists to be used by 

each campaign.
• List weight (if more than one list)—Enter the percentage of call records to 

be retrieved from a calling list for a campaign. For more information, see 
Outbound Contact Manager Help.

Campaign Group
• Group name(s)—Enter the names of the agent or place groups assigned to 

each campaign.
• Group type—Enter the type (agent or place) of each group assigned to each 

campaign.
• Dialing mode—Decide on a dialing mode to use as the default for the 

agent groups in a campaign. The dialing modes are Progressive, 
Predictive, Preview, Push Preview, and Power GVP.

• Voice Transfer Destination (“Origination DN” in previous releases)—
Enter the queue or Routing Point to which a call is transferred after a “live” 
answer.

• Optimization method—Sets the default dialing optimization method for the 
Campaign Group and applies only to Predictive dialing mode.

• Target value—Enter the percentage value of the optimization method.
• Buffer size coefficient minimum—Enter the minimum number of chains 

per active agent that OCS can keep on hand for dialing.
• Buffer size coefficient optimal—Enter the optimal number of chains per 

active agent that OCS can keep on hand for dialing.
• Number of CPD ports—Enter the number of dialing ports that can be used 

for dialing on behalf of a Campaign Group. If you are using ASM mode, at 
least one port is required for each agent for the engaging calls, in addition 
to ports for outbound dialing.
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• CPD Server name (if more than one)—Enter the name of the CPD Server 
to use for this Campaign Group.

• Script property—The Script property in the campaign, calling list, and 
Campaign Group defines the Script object, which contains all of the 
attributes that are required by Agent Scripting.

Reporting (Optional)
• Real-time reporting—If you install real-time reporting (CCPulse+), see 

also the Reporting 7.5 Deployment Guide and the Reporting 7.5 CCPulse+ 
Administrator’s Guide.

Note: You can also use CCPulse+ to view historical reports.

• CCPulse+ name—Enter the name of the CCPulse+ to be used.
• Stat Server name—Enter the name of the Stat Server to be used with 

CCPulse+.
• Historical reporting—If you install historical reporting (ICON and/or 

CCPulse+), see the Reporting 7.5 Deployment Guide and/or the Interaction 
Concentrator 7.5 Deployment Guide (or later versions).

Outbound Deployment Planning Worksheet
This planning worksheet provides a single place in which to record the 
information that is required to configure and install Outbound Contact 7.6. The 
cells on the worksheet provide room to write additional values. After it is 
completed, the planning worksheet expedites the installation and configuration 
process. It serves as a “look-up” sheet for critical information that you will 
need in order to complete the process. The information about the items in the 
“Sample Planning Worksheet” is important to have on hand.

Sample Planning Worksheet
Table 7 is a sample Planning Worksheet in which to record information that 
you need to have on hand during the configuration process.

Table 7: Planning Worksheet

Name Item Item Item Item

Logging In to Configuration Manager

1. User name

2. User password
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3. Application

4. Host

5. Port

License Manager

6. Path to License Manager

Outbound Solution Object

7. Name

Tenant

8. Names

Switches

8. Name(s)

9. Type of switch

10. Internal or External CPD capability

11. T-Server connected to each switch 
(one-to-one relationship)

12. Special DNs—for example, 
Communication DN and Overflow DN

DNs

13. ACD positions

14. Extensions

15. Call processing Ports (CPP)

16. ACD Queues

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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17. Routing Points

18. Virtual Queues

19. Communication DNs

Applications

T-Server(s)

20. T-Server name(s)

21. Host

22. Port

23. Back-up

24. Designated switch (one-to-one 
relationship)

Stat Server(s)

25. Stat Server name(s)

26. Host

27. Port 

28. Back-up server

DB Server

29. DB Server name(s)

30. Host 

31. Port

32. Back-up server 

33. Options (see page 84.)

34. DBMS type

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Outbound Contact Server (OCS)

35. OCS name

36. Host 

37. Communication port 

38. Back-up server 

39. Name(s) of T-Server(s) to which OCS 
connects

41. Name of Message Server to which 
OCS connects (optional)

CPD Server

42. CPD Server name(s)

43. Host 

44. Communication Port 

45. Back-up server for CPD Server

46. Name of T-Server to which CPD 
Server connects

47. Type of Dialogic board(s)

48. DTI Ports (DNs for Dialogic board). 
(See “DNs” on page 89.)

Outbound Contact Manager (OCM)

49. OCM name (application)

50. Name of OCS to which OCM connects

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Objects

Database Access Point(s)

51. Name

52. DB Server name (See page 90.)

53. DB Server host (See page 90.)

54. DB Server communication port (See 
page 90.)

55. DBMS name

56. DBMS type (See page 90.)

57. Database name

58. User name for login to DB

59. Password for login to DB

60. Case Conversion

User-Defined Fields

61. Name

62. Data type

63. Length

64. Default value (optional)

Formats

65. Name

66. User-defined field names (See above.)

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Table Access

67. Name

68. Table type

69. DB Access Point name (See page 92.)

70. Format name (See page 92.)

71. Database table name

Dialing Filters

72. Name(s)

73. Criteria SQL statement

74. Order by SQL statement

Treatments

75. Name

76. Call result

77. Apply to record

78. Apply to call

79. Destination DN (if “Apply to call”)

80. Number in sequence

81. Cycle attempt (only for redial)

82. Interval

83. Increment

84. Date/Time

85. Range

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Calling Lists

86. Name

87. Table Access Point name

88. Dialing filter name (optional)

89. Script property (optional)

90. Treatment names (optional) (See 
“Treatments” on page 86.)

Campaigns

91. Name

92. Calling list name(s)

93. List weight (if more than one list)

Campaign Group

94. Group name(s)

95. Group type

96. Dialing mode

97. Voice Transfer Destination 
(“Origination DN” in previous 
releases)

98. Optimization method

99. Target value

100. Buffer size coefficient minimum

101. Buffer size coefficient optimal

102. Number of CPD ports

103. CPD Server name (if more than one) 
(optional)

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Other Resources
You may want to use the following additional resources for reference.
• Framework 7.6 Configuration Manager Help—This Help system contains 

details about setting up application and component objects, and performing 
other important configuration tasks.

• Framework 7.6—You can obtain some Outbound Deployment Planning 
Worksheet information from Framework 7.6. For example, Tenants and 
Switch objects usually are created in the Framework 7.6 Wizard, but 
sometimes are created in the Configuration Manager. Outbound Contact 
uses some Framework 7.6 Application objects that are created in the 
Framework 7.6 Wizard or Configuration Manager--for example, the Stat 
Server and DB Server. For some objects, you only need to identify their 
names in Framework 7.6 and write those names on the worksheet. 

• Outbound Contact 7.6 Reference Manual—This document explains the 
constants and communication protocols for Outbound Contact.

• Wizard Advisories for Outbound Contact, Framework, and Reporting, also 
contain useful information, and are located on each specific solution CD. 
All other documents are provided on the documentation library software 
CD that is specific to Outbound Contact as well as to other Genesys 
software products.

104. Script property (optional)

105. Stat Server name

106. OBN Manager name (optional 
component)

107. Interaction Server (optional 
component)

Reporting (Optional)

108. Real-time reporting; if yes, see 
Reporting documentation.

109. Historical reporting; if yes, see 
Reporting documentation.

Table 7: Planning Worksheet (Continued) 

Name Item Item Item Item
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Note: Refer to the appropriate GVP and Interaction Server documentation if 
you are implementing Power GVP or Push Preview dialing modes.
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4 Outbound Solution Wizard
This chapter explains how to use the Outbound Solution Wizard, also known 
as the Outbound Contact Configuration Wizard. This wizard creates a standard 
configuration of the Outbound Contact components (Outbound Contact Server, 
Outbound Contact Manager, and Call Progress Detection Server). The wizard 
creates all mandatory options with their default values. You can easily redefine 
these default values based on the specific needs of your contact center. 
The Wizard also provides a method for setting up the Dialogic board channels 
(ports) for CPD Server.

Notes: 
• Use this Wizard for standard configurations only, rather than for 

complex configurations (for example, in an environment with two 
Dialogic boards for the same CPD Server or when configuring two 
or more DNs on a switch with the same dtiB number).

• The Outbound Contact Configuration Wizard was not updated for 
release 7.6. Use the Configuration Wizard for release 7.5, 
packaged with 7.6.

This chapter contains the following topics:
Before You Begin, page 98
Creating an Outbound Solution, page 98
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Before You Begin
First, complete the Framework installation and configuration. Be sure to refer 
to the “Worksheet Definitions” on page 81. New changes for the Outbound 
Configuration Wizard include:
• Introduces new component definitions in the Solution object for the GVP 

OBN Manager and Interaction Server applications.
• Supports the CampaignGroup object. The CampaignGroupInfo object is no 

longer supported.
• Dynamically adds new components in the Solution object.
• Supports the HMP configuration in the CPD Server Wizard.

Note: Only one instance of CPD Server using HMP software can be 
executed on a host machine.

Creating an Outbound Solution 
As mentioned, the Outbound Solution Wizard enables you to create an 
Outbound solution. The wizard is accessible through the Genesys Wizard 
Manager.

Procedure:
Using the Outbound Solution Wizard to create a 
solution

Start of procedure

1. Insert the Genesys 7.6 Outbound CD.
2. In the root directory, double-click setup.exe to install the Outbound 

Contact Configuration Wizard.
3. Open the Genesys Wizard Manager.
4. On the left pane of the Genesys Wizard window, select Outbound Contact.

The Genesys Wizard Manager displays existing solutions, if any, and a 
prompt to deploy a new Outbound Contact Solution.

5. Create an Outbound Contact Solution or reconfigure an existing one:
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• To create a new Outbound Contact Solution, click Outbound Contact 
on the right pane of the Genesys Wizard Manager page. 
The Outbound Solution Wizard launches and leads you through the 
process of creating a new Outbound Contact Solution. Skip the 
remaining steps below.

• To reconfigure an existing Outbound Contact Solution object, click the 
object name on the right pane of the Genesys Wizard Manager page.
The Properties dialog box opens for the Outbound Contact Solution 
object. Proceed to Step 6.

Note: Complete Steps 6 through 10 only if you are reconfiguring an 
existing Outbound Contact Solution object. 

6. Click the Components tab and select a specific component.
7. Click Properties.
8. Click More.

The Properties dialog box opens for the component that you selected in 
Step 7. 

9. Change the configurations, as needed.
For full explanations of the options in this dialog box, see Chapter 8, 
“Outbound Contact Configuration Options,” on page 171. Also refer to the 
information in your “Sample Planning Worksheet” on page 88.

10. Click Apply.

End of procedure

Recommended Configuration for CPD Server

The Wizard will not allow you to create an incomplete configuration. If you 
abort the configuration, the Wizard removes the incomplete configuration.

Resources Configuration Activity 

The Wizard implements a list of supported board types for selection. As more 
than one board may be installed, the Wizard allows selection of a few boards 
for configuration, instead of one-by-one configuration.
When configuring a virtual board, the Wizard assigns a DN to every channel of 
the board. The Wizard assigns the DNs in sequence, one by one.
Figure 11 illustrates the recommended configuration process for the CPD 
Server Application object. 
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Figure 11: Recommended Configuration for CPD Server Application Object

C r e a t e  a l l  S e c t i o n s

C o n f i g u r e  “ d e f a u l t ”  S e c t i o n

S e l e c t  L o c a t i o n

C o n f i g u r e  n e w  b o a r d s

C r e a t e  N e w

U s e  e x i s t i n g  L o c a t i o n

C h a n g e  c o n f i g u r e d  b o a r d s ?

N o

Y e s

E r a s e  c o n f i g u r a t i o n  i n
s e le c t e d  L o c a t i o n



Deployment Guide 101

Chapter 4: Outbound Solution Wizard Creating an Outbound Solution

Notes: Do not mix different board technologies. 
Do not use different protocols (such as ISDN and Melcas) in one box.
The CPD Server Installation Wizard will not recognize that the 
Dialogic drivers had been already installed if its version is different 
from the version of the drivers that are packaged on the Genesys CPD 
Server CD.
The CPD Server Installation Wizard will not create the Dialogic DN 
configuration if you do not create a CPD Server application.
CPD Server supports only the Dialogic drivers (for Service Release 6) 
that are provided on the CPD Server CD.

Procedure:
Deleting a previously configured Dialogic board
If you are creating a new configuration, you must first delete the previously 
configured Dialogic boards.

Start of procedure

To delete a previously configured board:
1. When the Wizard displays a list of configured boards, select the boards 

you want to delete.
2. If a board is associated with a CPD Server application, then the Wizard 

will warn you and ask for a confirmation. 
If the Wizard receives a confirmation, it clears the value of the location option 
in all applications that match the board name.

End of procedure

CPD Server Application Sections and Options

For information about the sections referenced in Figure 11, and their 
corresponding options, see “CPD Server Options” on page 221.
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5 Manually Configuring and 
Installing Outbound 
Applications
This chapter describes how to manually configure and install Outbound 
Contact 7.6. It contains the following sections:

Overview, page 103
Configuration, page 104
Installing on Windows, page 116
Installing on UNIX, page 122

Overview
Genesys strongly recommends using the Outbound Contact 7.5 Wizard to 
configure and install this solution (See “Creating an Outbound Solution” on 
page 98.) If you decide to manually install Outbound Contact 7.6, refer to this 
chapter during the installation process.
This chapter provides instructions for a manual, first-time configuration and 
installation of the Outbound Contact components, which include Outbound 
Contact Server (OCS), Outbound Contact Manager (OCM), CPD (Call 
Progress Detection) Server, and Outbound solution objects. This chapter also 
describes an Outbound-specific aspect of Stat Server. 
Use the completed “Worksheet Definitions” on page 81 in this guide, as well 
as the other relevant chapters in this guide, to configure and install Outbound 
Contact applications (components) and objects.

Note: Genesys does not recommend installing its components via a Microsoft 
Remote Desktop connection. You should perform the installation 
locally.
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The overall process of configuring and installing Outbound Contact 
components involves the following steps:

Configuration
Before you create an Application object, make sure that an application 
template exists. The template provides most of the application’s configuration 
options and default values.
To locate an existing template, open the Environment folder and then the 
Application Templates folder. If the template is absent, import one from the 
Templates folder on the Outbound Contact Center CD.

Table 8: Task Summary: Configuring and Installing Outbound 
Contact Components

Objective Related Procedures and Actions

1. Configure application 
objects in 
Configuration 
Manager

1. Configure and install all Framework 7.6 
components, which include Configuration 
Server, Configuration Manager, T-Server, the 
Management Layer, DB Server, and Stat 
Server. 

2. Start Configuration Server and Configuration 
Manager. 

3. Configure OCS as described on page 106.
4. Configure CPD Server as described on page 

109.
5. Configure OCM as described on page 108.

2. Install Outbound 
Contact components.

1. Install OCS as described on Windows (page 
116) or UNIX (see page 122).

2. Install CPD Server as described on page 117.
3. Install OCM as described on page 120.

3. Configure and install 
real-time and 
historical reporting.

Refer to page 121.
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Procedure:
Importing a template

Start of procedure

1. Select the Application Templates folder.
2. From the File menu, select File > Import Application Template.
3. Navigate to the appropriate template and select Open.
4. When the template is open, select OK to save it in Configuration Server.

End of procedure

Configuration Advisory
Application objects represent software components in Configuration Manager. 
This chapter describes four Outbound Contact application objects:
• Outbound Contact Server (OCS)
• Outbound Contact Manager (OCM)
• CPD Server (optional)
• CPD Proxy Server (optional)
Outbound Contact also requires the following Reporting applications:
• Stat Server—Determines what agents are assigned to which Agent or Place 

Groups, identifies the current Agent State, and for reporting purposes.
• CCPulse+—Calculates real-time and historical Outbound-specific 

statistics.
• ICON—Calculates historical Outbound statistics.
The person who will run or change an Outbound campaign requires access 
permissions that include Read access privileges to all campaign-related 
configuration objects. Click Permissions on the Security tab of each 
configuration object to view the Access Groups that have permission to read it.

Client-Side Port Security Configuration

To increase security, you can define a fixed port for the connection between an 
Outbound Contact component and another server that is behind a firewall. The 
client-side port definition feature allows a server application to control the 
number of client connections, preventing the server from an excessive number 
of malicious requests to the same server-side port.
For configuration instructions, see the “Client-Side Port Definition” chapter of 
the Genesys 7.6 Security Deployment Guide.
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Table 9 identifies which Outbound Contact-specific components support this 
configuration.

Connections to Configuration Server

During the application installation, new command-line arguments are added to 
connect to Configuration Server using the port designated during installation, 
which are then used during application startup. The arguments include:

-transport-address and -transport-port.
The command-line format for starting a connection to Configuration Server 
would be:

cm_server.exe -host <host_name> -port <port_number> -transport-
address <IP address> -transport-port <port number> -app 

<application_name> 

After installation, these arguments appear in three places:
• Configuration Server Application object > Start Info tab
• (Windows operating system) startServer.bat file; (UNIX operating 

systems) run.sh
• In the Registry when the application (OCS, CPD Server, or CPD Proxy 

Server) is started as a Service

Note: To support reconnecting to Configuration Server, you must still create 
or update the existing connection to Configuration Server in the OCS 
application object’s Connections tab, following the standard procedure 
for configuring connections to other servers. For specific instructions 
associated with client-side port connections, see the Genesys 7.6 
Security Deployment Guide.

Outbound Contact Server
Outbound Contact Server (OCS) is the main component of Outbound Contact.

Table 9: Component Support of Client-Side Port Security

Server Clients Configuration Server/
Configuration Server 
Proxy

T-Server

OCS Yes Yes

CPD Server Yes Yes

CPD Proxy Server Yes Not Applicable
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Procedure:
Configuring OCS 

Start of procedure

1. In the Configuration Manager main window, open the Environment folder 
and then select the Applications folder. 

2. From the File menu, select New Application. 
3. Select the template for the release of the application that you will be using.
4. On the General tab of the Application Properties dialog box, enter a 

name for the OCS application. 
5. Click on the Server Info tab, enter the host name of the computer on 

which this application will be installed, and enter the port that the 
application will use for client connections.
If you plan to use another server as a backup, in the event that the primary 
server fails, enter the name of the backup server and adjust the value of the 
Reconnect Timeout option.

6. On the Connections tab, select the Add button, and then add a T-Server 
application. Optionally, you can also add a Message Server application.
The only servers that OCS searches for in the Connections tab of its 
application at startup are T-Server and Message Server (optional). 
Connection to other servers that are required to run an outbound campaign 
(such as CPD Server, Stat Server, and Interaction Server) can be specified 
on the Connections tab of a Campaign Group object.

Notes: 
• If you are configuring OCS to support TLS: see the Genesys 7.6 

Security Deployment Guide for configuration instructions; see 
“Transport Layer Security Connections” on page 346 for 
information on which Outbound Contact components support 
TLS connections for this 7.6 release.

• If you are configuring a connection to Interaction Server, create 
a port called ESP. Use this ESP PortID instead of the default 
PortID, when configuring a connection to the OCS Application 
object on the Server Info tab of the Interaction Server 
Application object. This makes OCS a server for Interaction 
Server and Interaction Server a client for OCS.

• If you are configuring TLS between OCS and DB Server, add a 
Database Access Point (DAP) to DB Server on the Connections 
tab of the OCS Application object.

• If you are configuring TLS between OCS and CPD Server/
CPD Proxy Server, add a connection on the Connections tab of 
the OCS Application object to CPD Server/CPD Proxy Server 
respectively.
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7. Click on the Start Info tab, and then define the Working Directory and 
Command-Line properties - for example:
Working Directory: C:\GCTI\Outbound Contact Server

Command Line: cm_server.exe

Command Line Arguments: -host <host_name> -port <port_number> -app 

<application_name>

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

8. Click on the Options tab, and then change the values of the configuration 
options according to your configuration. 
For detailed information about OCS options, see the “Outbound Contact 
Server Options” on page 178.

End of procedure

Outbound Contact Manager
Outbound Contact Manager (OCM) is the graphical user interface (GUI) that 
contact center managers can use to control and manage outbound campaigns.

Procedure:
Configuring OCM

Start of procedure

1. In the Configuration Manager main window, open the Environment folder 
and then select the Applications folder. 

2. From the File menu, select New Application. 
3. Choose the template for the release of the application that you will be 

using.
4. On the General tab of the Properties dialog box, enter a name for the 

OCM application. 
5. Click on the Connections tab, and then add the OCS to which this 

application will connect.
6. Click on the Options tab, and then define the OCM options in a section 

folder called OCManager.
For detailed information about the options for OCM, including the new 
inactivity-timeout option, see “Outbound Contact Manager Options” on 
page 172.
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For more information on any of the security features, including some 
configuration information, see the Genesys 7.6 Security Deployment Guide.

Note: If you are using the Active Switching Matrix (ASM) mode, see 
page 174 for more information about how to enable it.

End of procedure

CPD Server
Outbound Contact 7.6 requires hardware that recognizes call results, a 
capability known as call progress detection (CPD). Outbound Contact works 
with a CPD device provided by the switch vendor, or with CPD hardware from 
Dialogic.
If the switch does not have call progress detection capability, you must install 
switch-extending equipment (a Dialogic board) in order to perform this 
function. Install the GlobalCall Dialogic package before installing the CPD 
Server.

Note: 
• Starting with release 7.5, you can also install the Dialogic Host 

Media processing (HMP) software.
• Only one instance of CPD Server using HMP software can be 

executed on a host machine.

Before configuring CPD Server, have on hand the “Worksheet Definitions” on 
page 81. Refer also to “CPD Proxy Server” on page 110 and “Dialogic Board 
Setup” on page 302.

Procedure:
Configuring CPD Server

Start of procedure

1. In the Configuration Manager main window, open the Environment folder 
and then select the Applications folder. 

2. From the File menu, select New Application. 
3. Select the template for the release of the application you will be using.
4. On the General tab of the Properties dialog box, enter a name for CPD 

Server.
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5. Click on the Server Info tab, and then enter the host name of the computer 
on which this application will be installed, and enter the port that the 
application will use for client connections.
If you plan to use another server as a backup in the event that the primary 
server fails, and if a Dialogic board is installed, enter the name of the 
backup server and adjust the value of the Reconnect Timeout option.

Note: If you are configuring CPD Server to support TLS, see the Genesys 
7.6 Security Deployment Guide for configuration instructions; see 
“Transport Layer Security Connections” on page 346 for 
information on which Outbound Contact components support TLS 
connections for this 7.6 release.

6. Click on the Connections tab, and then add the T-Server and the Message 
Server to which this application will connect.

7. Click on the Start Info tab, and then define the Working Directory and 
Command Line properties - for example:
Working Directory: C:\GCTI\cpd_server

Command Line: cpdserver.exe 

Command Line Arguments: 

-host <host_name> -port <port_number> -app <application_name> 

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

8. Click on the Options tab, and then change the values of the configuration 
options according to your configuration. 

For detailed information about the options for CPD Server, “CPD Server 
Options” on page 221.

End of procedure

CPD Proxy Server
CPD Proxy Server is the core load-distribution component of CPD Server. The 
main task of this optional component is to distribute client requests among 
various CPD Servers, in order to balance the call load and optimize the use of 
hardware resources within the system.
You must configure CPD Proxy Server before you install it.



Deployment Guide 111

Chapter 5: Manually Configuring and Installing Outbound Applications Configuration

Procedure:
Configuring CPD Proxy Server

Start of procedure

1. In the Configuration Manager main window, open the Environment folder 
and then select the Applications folder. 

2. From the File menu, select New Application. 
3. Select the CPD_Proxy template for the release of the application you will be 

using.
4. On the General tab of the Properties dialog box, enter a name for the CPD 

Proxy Server. 
5. Click on the Server Info tab, and then enter the host name of the computer 

on which this application will be installed, and enter the port that the 
application will use for client connections.
If you plan to use another server as backup, in the event that the primary 
server fails, enter the name of the backup server and adjust the value of the 
Reconnect Timeout option. See “Connection and Reconnection” on 
page 337 for more information.

Note: If you are configuring CPD Proxy Server for TLS, see the Genesys 
7.6 Security Deployment Guide for configuration instructions; see 
“Transport Layer Security Connections” on page 346 for 
information on which Outbound Contact components support TLS 
connections for this 7.6 release.

6. Click on the Connections tab, and then add the CPD Server(s) and the 
Message Server to which CPD Proxy Server will connect.

7. Click on the Start Info tab, and then define the Working Directory and 
Command-Line properties. For example:
Working Directory: C:\GCTI\cpd_proxy

Command Line: cpdproxy.exe 

Command Line Arguments: 

-port <port_number> -host <host_name> -app <application_name>

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

8. Click on the Options tab, and then define the values of the log 
configuration options.
For detailed information about these options, see Chapter 9 on page 263.
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Note: If you have a multi-tenant environment and want to share HMP 
resources, you can also configure options to restrict dialing and 
engaging channels. For more information, see “Centralized 
Configuration and Shared HMP Resources” on page 63.

End of procedure

DM3 Boards with CPA Functionality
If you are using ASM mode, and if you are using the DM3 families of boards 
with CPA functionality that CPD Server supports, you must install the 
GlobalCall Dialogic package before you install CPD Server. These families 
include the following: 
• DM/V1200-4E1 (number of ports = 120)
• DM/V600-2E1 (number of ports = 60)
• DM/V960-4T1 (number of ports = 96)
• DM/V480-2T1 (number of ports = 48)

Outbound-Specific Statistics for Stat Server
In addition to determining what agents are assigned to which Agent or Place 
Groups and identifying the current Agent State, Stat Server requires Outbound 
statistic definitions in order to monitor the Outbound activities of Campaigns, 
Calling Lists, Campaign Groups, ACD Queues, and agents. 

Procedure:
Importing Outbound-specific statistics into the Stat 
Server object

Start of procedure

1. In the Configuration Manager main window, open the Environment folder, 
and then open the Applications folder.

2. On the right pane, right-click the Stat Server object, and select Properties 
from the shortcut menu.

3. In the Properties dialog box, click the Options tab.
4. Locate and import StatProfile.cfg from the Stat Server template 

(Stat_Server_760.apd) located in the Templates folder of the Real-Time 
Metrics Engine 7.6 CD. For more outbound-specific metrics, see “New 
Statistics as of Release 7.5” and the Reporting Technical Reference Guide 
for the Genesys 7.2 Release.
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Note: Stat Server is usually configured using the Framework 7.6 
Configuration Wizard or in Configuration Manager. In release 7.6, you 
can also configure it using the Outbound Contact Wizard.

End of procedure

New Real-Time Statistics as of Release 7.6.1

In release 7.6.1, two outbound-specific real-time statistics were added: 
CurrentTrustFactor and CurrentFeedbackAccuracy. This section provides 
information on them.

Note: These statistics require Stat Server version 7.6.1 or higher with OCC 
Extension 7.6.1 or higher.

CurrentTrustFactor

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentTrustFactor
Objects: Agent, Place
This metric, with values ranging from 0% to 100%, defines the trust factor for a 
specific agent. For more information about how this factor is calculated and 
when it is used, see the time-to-ready-tolerance option (see page 208).
This statistic is calculated based on the following formula:

Aindiv = (1 - trust factor) * 100 = Ncorrect notifications/ Ntotal notifications * 
100%

CurrentFeedbackAccuracy

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentFeedbackAccuracy
Objects: CampaignGroup
This metric, with values ranging from 0% to 100%, defines the current accuracy 
of the agent’s ready time feedback for a session.
This statistic is calculated based on the following formula:

Asess = (1 - Total Number of False Notifications/ Total Number of 
Notifications) * 100%

New Statistics as of Release 7.5

In release 7.5, three outbound-specific statistics were added: 
CurrentAgentAssignment, CurrentNumberAgentsAssigned, and 
CurrentCampaignGroupDBID. This section provides information on them, as they 
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are not documented in the Reporting Technical Reference Guide for Genesys 
7.2 Release.

CurrentAgentAssignment

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentAgentAssignment
Objects: Agent, Place
The metric value identifies the current agent assignment to the outbound 
CampaignGroup. Possible values include:
• Inbound—Agent is only assigned to inbound calls and is not assigned to 

any outbound CampaignGroup.
• <CampaignGroup name>—The configuration object name for the 

CampaignGroup.

CurrentNumberAgentsAssigned

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentNumberAgentsAssigned
Objects: CampaignGroup
This metric value is the number of agents assigned to a particular 
CampaignGroup.

CurrentCampaignGroupDBID

Category: JavaCategory
JavaSubCategory: OCCStatExtension.jar:CurrentCampaignGroupDBID
Objects: Agent, Place
This metric value identifies the current agent assignment to an outbound 
CampaignGroup.

Possible values for this statistic include:
• 0—This value means that the agent is not assigned to any outbound                 

CampaignGroup.

• <CampaignGroup DBID>—This value is the DBID of CampaignGroup 
configuration object.

The Outbound Solution Object 
You can start Outbound Contact through Solution Control Interface (SCI), a 
Framework application. SCI uses the Outbound Solution object to start and 
stop the Outbound Contact components.
In the Configuration Manager main window, select the Solutions folder, and 
determine if the Outbound Solution object is in the list. If it is not, you must 
import it from the product CD and then configure it.
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Procedure:
Importing and configuring the Outbound Solution 
object

Start of procedure

1. Right-click the Solutions folder and select Import Solution from the 
shortcut menu. 

2. Select the OCSolution_761.sd file (Outbound Contact) from the Template 
folder on the product CD, and then click OK to open the Outbound Solution 
object’s Properties dialog box.

Note: This file was not updated for the 7.6 release.

3. On the General tab of the Properties dialog box: 
• In the Name field, enter a name.
• In the Assign to Tenant field, select a tenant.
• In the Solution Control Server, select a server.

4. Click the Components tab and then add the applications that Outbound 
Contact needs in order to run (see Table 10).

5. Click OK.

End of procedure

Table 10 shows the applications that you could add to the Components tab for 
the Outbound Solution Object. The table heading definitions are as follows:
• Application—The name of the application that Outbound Contact needs in 

order to run.
• Optional—The requirement status for the application: False means that the 

application is mandatory in order for Outbound Contact to be able to run; 
True means that the application is optional, and that it is not mandatory for 
Outbound Contact to be able to run.

• Priority—The order in which the application starts, relative to the other 
applications.

Table 10: Outbound Solution Object - Components Tab

Application Optional Priority

T-Server False 1

Interaction Server True 2

DB Server False 2

Stat Server False 2
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Installing on Windows
The Genesys 7.6 Outbound CD contains the installation packages for the OCS 
and OCM applications. The CPD Server installation package is located on the 
Genesys 7.6 Outbound CPD Server CD. 
The setup files for these components are located in the following folders: 
• OCM: \\solution_specific\outbound_contact_mgr\windows 
• OCS: \\solution_specific\outbound_contact_server\windows 
• CPD Server: \\solution_specific\cpd_server\windows 
If you downloaded Outbound Contact from an FTP site, the installation 
package is contained in a ZIP file and you must extract it using the WinZip 
utility. After you extract the files, the setup files for the applications will be in 
the Windows folder.

Procedure:
Installing OCS on Microsoft Windows 2000, or 2003

Note: The OCS Application object must already be configured before you 
begin the installation.

Start of procedure

1. From the product CD, open the following folder:
solution_specific\outbound_contact_server\windows and run setup.exe

Note: If you are installing a new version of the same release, you will 
need to select Install new instance of the application as the 
Setup Type.

Data Sourcer True 2

ETL Proxy True 2

Outbound Contact Server False 3

Message Server True 4

CPD Server True 4

Outbound Contact Manager True 5

Table 10: Outbound Solution Object - Components Tab (Continued)

Application Optional Priority
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2. If you are setting up client-side port configuration for the initial connection 
to Configuration Server, select the Use Client Side Port check box and 
then specify the following parameters:
• Port—Enter the port number for the client as pre-configured on your 

firewall. (This is not the Listening port of the OCS application.)
• IP Address—Enter the IP Address of the machine where you are 

installing and running the OCS application.

Note: After selecting this option, the installation process will add the 
necessary command line arguments (-transport-address and 
-transport-port) for connecting to Configuration Server at the 
application startup.

3. Enter the host name, port, username and password of the Configuration 
Server.

4. Select the application object that you created in Configuration Manager.
5. Select the license options:

• License Manager–Enter port and name for the license server.
• License File–Use the Browse button to locate the license file.

6. To select the destination directory, either click Next to accept the default 
(displayed) or click Browse to locate another directory.

7. Click Install to start the installation.
On Windows operating systems, all servers are installed as services. 
Therefore, during installation, you will not be asked whether you want to 
install OCS as a Windows service. See “Using Windows Services” on 
page 121, for more information.

8. Click Finish to complete the installation.

End of procedure

Procedure:
Installing CPD Server on Microsoft Windows 2000, or 
2003
CPD Server is an optional application.

Notes: It is not advisable to mix board technologies.
Do not use different protocols (such as ISDN and Melcas) in one 
box.
The CPD Server Installation Wizard may not recognize that the 
Dialogic drivers had been already installed if its version is different 
from the version of the drivers that are packaged on the Genesys 
CPD Server CD.
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CPD Server supports only the Dialogic drivers (for Service Release 
6) that are provided on the CPD Server CD.

Start of procedure

1. From the product CD, open the following folder:
solution_specific\cpd_server\windows and run setup.exe

2. As the Maintenance Setup Type, select either Install new instance of the 
application or Maintenance of the existing installation.

3. Select Call Progress Detection Server as the component to install.
4. If you are setting up client-side port configuration for the initial connection 

to Configuration Server, select the Use Client Side Port check box and 
then specify the following parameters:
• Port—Enter the port number for the client as pre-configured on your 

firewall. (This is not the Listening port of the CPD Server application.)
• IP Address—Enter the IP Address of the machine where you are 

installing and running the CPD Server application.

Note: After selecting this option, the installation process will add the 
necessary command line arguments (-transport-address and 
-transport-port) for connecting to Configuration Server at the 
application startup.

5. Enter the host name, port, username, and password of Configuration 
Server.

6. Select the application object that you created in the Configuration 
Manager.

7. Select the license options:
• License Manager: Enter port and name for the license server.
• License File: Use the Browse button to locate the license file.

8. To select the destination directory, either click Next to accept the default 
(displayed) or click Browse to locate another directory.

9. Click Install to start the installation.
On Windows operating systems, all servers are installed as services. 
Therefore, you will not be asked whether you want to install CPD Server 
as a Windows service. For more information, see “Using Windows 
Services” on page 121.

10. Click Finish to complete the installation.

End of procedure
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Procedure:
Installing CPD Proxy Server on Microsoft Windows 
2000, or 2003
CPD Proxy Server is an optional application. CPD Proxy installation does not 
require Dialogic hardware to be installed on the target machine.

Start of procedure

1. From the product CD, open the following folder:
solution_specific\cpd_server\windows

2. As the Maintenance Setup Type, select either Install new instance of the 
application or Maintenance of the existing installation.

3. Select Call Progress Detection Proxy as the component to install.
4. If you are setting up client-side port configuration for the initial connection 

to Configuration Server, select the Use Client Side Port check box and 
then specify the following parameters:
• Port—Enter the port number for the client as pre-configured on your 

firewall. (This is not the Listening port of the CPD Proxy Server 
application.)

• IP Address—Enter the IP Address of the machine where you are 
installing and running the CPD Proxy Server application.

Note: After selecting this option, the installation process will add the 
necessary command line arguments (-transport-address and 
-transport-port) for connecting to Configuration Server at the 
application startup.

5. Enter the host name, port, username, and password of the Configuration 
Server.

6. Select the application object that you created in the Configuration 
Manager.

7. To select the destination directory, either click Next to accept the default 
(displayed) or click Browse to locate another directory.

8. Click Install to start the installation. 
On Windows operating systems, all servers are installed as services. 
Therefore, during installation, you will not be asked whether you want to 
install CPD Proxy Server as a Windows service. See “Using Windows 
Services” on page 121 for more information.

9. Click Finish to complete the installation.

End of procedure
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Procedure:
Installing OCM on Microsoft Windows 2000, 2003, 
Vista, or XP

Start of procedure

1. From the product CD, open the following folder:
solution_specific\outbound_contact_mgr\windows 

2. Locate and double-click setup.exe to start the installation.
3. On the Welcome dialog box, click Next when you are prompted to continue 

with the setup program.
At this point, the Install Shield performs a check for the presence of 
Microsoft Data Access Components 2.8 or higher.

Note:  If the Microsoft Data Access Components are not present, the 
following message appears: Microsoft Data Access Components 
(MDAC), version 2.8 or higher, must be installed. Do the 
following:

• Click OK. The following message appears: The installation 
procedure will now terminate.

• Click OK. 
• In a web browser, go to http://www.microsoft.com, browse to 

the Downloads page, and find and install MDAC 2.8.
• When the setup program is finished, reboot the system if 

InstallShield prompts you to restart Windows. 
• Start the OCM installation procedure again from Step 1.

After you click Next, the Security Banner Configuration dialog box 
appears.

4. On the Security Banner Configuration dialog box, choose whether you 
want to configure a Security Banner for this application. Refer to the 
Genesys 7.6 Security Deployment Guide for detailed information about the 
security banner. 
Do one of the following:
• If you do not want to configure a Security Banner for this instance of 

OCM, clear the Enable Security Banner check box if it is selected, 
then click Next.
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• If you want to configure a Security Banner for this application:
i. Select Enable Security Banner.
ii. Follow the instructions in the procedure “Installing and 

configuring the Security Banner” in the Genesys 7.6 Security 
Deployment Guide. When you are finished that procedure, return 
here and finish this procedure.

5. When the Choose Destination Location dialog box appears, to select the 
destination directory, either click Next to accept the default (displayed) or 
click Browse to locate another directory.

6. Click Install to proceed with the installation.
7. Click Finish to complete the installation.
8. When the setup program is finished, reboot the system if InstallShield 

prompts you to restart Windows.

End of procedure

Real-Time and Historical Reporting
The Reporting Technical Reference Guide describes the Reporting templates.
For information about importing templates, refer to the following resources:
• Reporting 7.5 CCPulse+ Help, “Using the Import/Export Utility”
• Reporting 7.2 Data Modeling Assistant Help, “Importing and Exporting 

Templates”
For information about actions the user should take if the CCPulse+ Import/
Export Utility is disabled, refer to the Reporting 7.5 CCPulse+ Administrator's 
Guide.

Using Windows Services 
An application that is set up as a Windows Service starts automatically when 
the computer is started and runs in the background, without a console window.

Procedure:
Stopping or modifying the startup type for an 
application running as a Windows Service

Start of procedure

1. On the Windows taskbar, click Start and then select Control Panel > 
Administrative Tools > Services.

2. Double-click the application to open its Property dialog box window.
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3. Under Service Status, click the appropriate button to change the 
operational status of the service.

4. From the Startup type drop-down list, select the desired startup type.
5. Click Apply.

End of procedure

Installing on UNIX
The only Outbound Contact component that can be installed on a UNIX 
operating system is Outbound Contact Server.

Procedure:
Installing OCS on UNIX

Start of procedure

1. On the Outbound Contact 7.6 CD, locate the directory for your UNIX 
vendor:
solution_specific/outbound_contact_server/<UNIX directory>

2. Copy the directory into a temporary directory.
3. In the temporary directory, locate the install.sh shell script.

Note: All files require permission to execute.

4. Run the script by executing the following command: sh install.sh
5. Type the host name of the computer on which Outbound Configuration 

Server will be installed, or press Enter to accept the default.
6. When/if prompted, enter the host, network port, user name, and 

password of Configuration Server.
7. When prompted, specify whether you want to use the Client Side Port 

option. Then specify the following parameters:
• Port—Enter any free port number. (This is not the Listening port of the 

OCS application.)
• IP Address—Enter the IP Address of the machine where you are 

installing and running the OCS application. (The installation script will 
propose an IP Address for you to use.)
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Note: After selecting this option, the installation process will add the 
necessary command line arguments (-transport-address and 
-transport-port) for connecting to Configuration Server at the 
application startup.

8. From the list of applications configured for this host, select a specific OCS 
application.

9. Select the destination directory into which OCS will be installed.
10. When prompted, enter either 32 or 64 to specify the version that will be 

used.
11. Enter the full path to the license file.
After the installation process is complete, a message appears, indicating that 
the installation was successful.

End of procedure
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Chapter

6 Silent Setup
This chapter describes the purpose and configuration of Silent Setup.
It contains the following sections:

Introduction, page 125
Creating the Response File, page 125
Running the Silent Installation, page 127
About the Silent Setup Log File, page 127

Introduction
InstallShield Silent allows for an automated electronic software distribution, 
also known as a Silent Setup. InstallShield Silent only works on Windows 
operating systems. With InstallShield Silent, you do not have to monitor the 
setup or provide input via dialog boxes. Once this information is stored in a 
response file, an InstallShield Silent setup runs on its own, without any 
intervention by the end-user. An installation procedure for a server application 
differs slightly from an installation procedure for a GUI application. Both, 
however, require that you create a response file with the necessary parameters 
and then use it for the actual installation. Outbound Contact Manager supports 
Silent Setup installation.

Creating the Response File
To select setup options and automatically record the InstallShield Silent 
response file, run your setup with the following command line:

setup -r

Your responses to the dialog boxes are recorded and used to create a response 
file. By default, the response file is named Setup.iss, and is stored in the 
Windows directory of your computer. To specify a different directory or file 
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name for the response file, add /f1“[full_path to iss file\]<FileName>” to 
the setup command. Include the double quotes and do not put a space between 
/f1 and the path—for example:

setup –r /f1”C:\GCTI\silent_response_files\mySetup.iss”

Note: In the optional argument, the /f1 portion uses the numeral one (1), not 
the letter l.

Subsequently, use the response file any time you need to install an application 
with the configured parameters.

Sample Response File (setup.iss)
[InstallShield Silent]
Version=v7.00
File=Response File
[File Transfer]
OverwrittenReadOnly=NoToAll
[{C660F232-38A4-45AF-AE08-A332091BDC91}-DlgOrder]
Dlg0={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdWelcome-0
Count=4
Dlg1={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdAskPath-0
Dlg2={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyToInstall-0
Dlg3={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdWelcome-0]
Direction=1
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdAskPath-0]
Direction=1
Path=C:\Program Files\GCTI\Outbound Contact Manager
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyToInstall-0]
Direction=1
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0]
Reboot=0
[{45805BA8-94DF-4C49-A49E-9CC2179FDB8D}-DlgOrder]
Count=0

The response file contains saved information about the number of dialog boxes 
displayed, the order in which the dialog boxes were displayed, the values of 
any data entered or selected by the end user, and which button the user clicked 
to close the dialog box.
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Running the Silent Installation
Launch the InstallShield Silent Installation with this command line:
Setup.exe -s /f1“<full path to Setup.iss>” /f2“<full path to setup log 
file>”

Where: 
• <full path to Setup.iss>

The full path to the Setup.iss file put within double quotation marks. For 
example: c:\windows\setup.iss.
By default, Setup.exe looks for a response file called Setup.iss in the 
same directory as Setup.exe.

• <full path to setup log file>

The full path to the setup log file put within double quotation marks. For 
example: c:\windows\setup.log
By default, setup.log generated in the same directory as the response file 
being used.

A silent installation program does not display a dialog if an error occurs. The 
status information for the silent installation is recorded (by default) in a file 
called setup.log.

Note: Do not enter a space between the f1 or f2 parameter and its value in 
double quotation marks.

The log file generated as a result of the Silent Setup procedure is described in 
the following section.

About the Silent Setup Log File
InstallShield Silent prints installation results into a setup.log file. The default 
name for the silent setup log file is Setup.log, and its default location is the 
same folder as Setup.iss. You can specify a different name and location for 
your setup log file using the f2 switch when launching Setup.exe. The 
Setup.log file contains three sections:
• In the first section, the first entry, [InstallShield Silent], identifies the 

version of InstallShield Silent used in the silent setup. The second entry 
identifies the file as a log file.

• Entries in the second section, [Application], identify the installed 
application's name and version and the company name.

• The third section, [ResponseResult], contains the result code indicating 
whether the silent setup has succeeded. Table 11 describes the integer 
return values that is assigned to the ResultCode key name.
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Sample Setup Log File
An example of a Setup.log file is as follows:
[InstallShield Silent]
Version=v7.00.000
File=Log File
[Application]
Name=Genesys Outbound Contact Manager
Version=7.6
Company=GCTI
Lang=0009
[ResponseResult]
ResultCode=0

Table 11: Silent Setup Result Codes

Result Code Description

0 Success

1 General error

2 Invalid mode

3 Required data not found in the Setup.iss file

4 Not enough memory

5 File does not exist

6 Cannot write to the response file

7 Unable to write to the uninstallation log file

8 Invalid path to the InstallShield Silent response file

9 Not a valid list type (string or number)

10 Data type is invalid

11 Unknown error during setup

12 Dialog boxes are out of order.

51 Cannot create the specified folder

52 Cannot access the specified file or folder

53 Invalid option selected
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Chapter

7 Manually Defining 
Outbound Configuration 
Objects
This chapter explains how to create and configure each of the Outbound-
related objects in Configuration Manager. It contains the following sections:

Overview, page 129
Outbound-Specific Configuration of Framework Objects, page 131
Table Access Object, page 135
Field Object, page 137
Format Object, page 141
Calling List Object, page 143
Filter Object, page 147
Time Zones, page 153
Treatment Object, page 154
Campaign Object, page 162
Campaign Group Object, page 165

Overview
After you configure and install the component applications for Outbound 
Contact, you configure additional objects in Configuration Manger, in order to 
support and run campaigns. 
The following Framework objects should already exist before you create the 
Outbound-specific objects: Tenants, Persons, and telephony configuration 
objects (Switches, Agent Logins, DNs), Places, Place Groups and/or Agent 
Groups.
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Outbound Object-Creation Sequence 
Genesys recommends that you create the Outbound-specific objects in the 
following order:
1. Fields. Create user-defined fields (if necessary) before you create the 

Format object that will contain them.
2. Format. Create a Format before you create the Table Access Point object 

to which it will be applied.
3. Table Access Point. Create the Table Access Point before your create the 

Calling List object to which it will be applied.
4. Filters.
5. Treatments.

6. Calling Lists.
7. Campaigns.

8. Campaign Groups.

Note: You might need to configure Outbound-related options for certain 
objects (such as Field, Calling List, Campaign, Switch, and DN) in 
the Annex tab of the object’s Properties dialog box. However, the 
Annex tab is not displayed by default in the Properties dialog box. For 
information about displaying the Annex tab, see the “Annex Tab” in 
Configuration Manager Help.

Permissions in Campaign-Related Objects
In order for users to run or change an Outbound campaign, they must be 
assigned to an Access Group object that has special access privileges to all 
campaign-related configuration objects. Special access is the default value.

Procedure:
Verifying or changing permissions for an Access 
Group object

Start of procedure
1. Open the Properties dialog box for each campaign-related object. 
2. Select the Security tab. 
3. Click Permissions and make the necessary changes. 
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For more information about setting permissions, see Framework 7.6 
Configuration Manager Help.

End of procedure

Common Features of Configuration Objects
Properties

Dialog Boxes
You can configure Outbound Contact configuration objects as you would 
configure other objects in Configuration Manager.

Annex Tab Configuration objects, unlike Application objects, do not have an Options tab. 
The Outbound options are defined on the Annex tab. To make the options 
accessible to all Outbound Contact applications, create a section named either 
default or OCServer. To make the options accessible to a particular Outbound 
Contact application, the section name should be exactly the same as the 
application name. 

Note: Genesys recommends that you define all OCS options only in the 
section folder named OCServer.

For information on how to create sections and define options, see Framework 
7.6 Configuration Manager Help.

Tenant field The Tenant field is automatically populated by the system in a multi-tenant 
environment. This field is absent in a single-tenant environment.

Apply Button Click Apply to save the changes in a Properties dialog box.

OK Button Click OK to save the changes and to close a Properties dialog box.

Cancel Button Click Cancel to close a Properties dialog box without saving the changes.

Outbound-Specific Configuration of 
Framework Objects

The following Framework objects require additional configurations for 
Outbound Contact:
• Special DNs
• Place Groups or Agent Groups
• Places
This section discusses the configuration of each of these objects in turn.

Special DNs
The DNs that require Outbound-specific configurations include 
Communication DNs and Overflow DNs.
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Communication DN

Outbound Contact 7.6 reports on Outbound activity through a DN set up as a 
Communication DN. This type of DN enables communication between 
Outbound Contact Server (OCS) and Stat Server (which determines what 
agents are assigned to which Agent or Place Groups, identifies the current 
Agent State, and provides the statistics for Outbound real-time and historical 
reporting). This DN type also enables communication between OCS and other 
parties, using a Communication DN API. It is a virtual DN, meaning that it 
does not exist in a switch. The name of this DN type can be either text or 
numeric.

Procedure:
Creating a Communication DN

Start of procedure

1. Open the Switch object and select the DNs folder. 
2. From the File menu, select New > DN.
3. On the General tab of the DN Properties, define the fields as follows:

• Name
— Required; default value is [DN]. Specifies the name of the DN. The 

name that you enter must be unique within the tenant and it must 
not match any actual directory number in the switch.

• Type
— Required; default value is [Unknown DN Type]. Specifies the type 

of DN. Select the Communication DN type from the drop-down 
menu.

4. On the Annex tab, create a default section. 
5. In the default section, create an outbound_contact_server option 

(page 221) by entering the Option Name and Option Value in the Edit 
Option dialog boxes.

6. Click OK or Apply.

Note: The Advanced, Access Numbers, and Remote-Resources tabs are not 
used by Outbound Contact.

End of procedure
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Overflow DN

A predictive campaign sometimes overdials and, as a result, has outbound calls 
waiting in the queue. Some contact centers define (by using Virtual DN or 
routing strategy) business rules to send these outbound calls to another queue. 
This other queue is commonly known as an overflow queue. There are two 
types of overflow DNs:
• ACD Queue or Routing Point; used to mark the record as dropped.
• Extension or Position; used to send RequestReleaseCall to T-Server.

Procedure:
Designating an Overflow DN
To designate an existing DN as an Overflow DN, you must configure an 
overflow_dn option on the Annex tab of a particular DN object.

Start of procedure

1. Select Switches > DNs > <specific DN>.
2. Create a section named default on the Annex tab. 
3. Create the option overflow_dn with a value of true on the Annex tab.
4. Create a Place and insert a shortcut to the overflow DN.

End of procedure

Agent and Place Group Objects
Agents, Places, and Agent/Place Groups are configured in Framework; 
however, Agent Groups and Place Groups still need to be configured 
specifically for Outbound Contact. The following sections pertain to these 
Outbound-specific configurations.

Agent or Place Group Object—Advanced Tab Fields

An Agent/Place Group object needs at least one DN (directory number) 
associated with it in an Origination DN list (see “Origination DNs”). An ACD 
(automatic call distribution) queue is a required DN for an Agent/Place Group. 
Other DN(s) in the list could be VQ (virtual queue) or Routing Point. 
Outbound Contact Server (OCS) monitors queues to determine how to pace 
outbound calls and to determine which group an agent logs into for a particular 
campaign. OCS monitors the telephony events EventQueued, EventDiverted, 
and EventAbandoned to determine the number of calls that are waiting in the 
queue. Stat Server notifies OCS about agent logins, that provides information 
about which queue or group an agent exists.
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Origination DNs

Configuration Manager: Agent/Place Group object, Advanced tab, Origination 
DNs
The primary role of an Origination DN is for OCS to monitor it for 
EventQueued and EventDiverted so that calls can be properly tracked as they 
are dialed and moved to agents (or Abandoned). For this reason, if a Route 
Point is used, it may be necessary to use a Virtual Queue also if the Route 
Point on the T-Server does not support the correct events.
The origination DNs can be of the following types: 
• ACD Queue 
• Routing Point 
• Virtual Queue
Any DN of these types will be registered in the relevant T-Server on start up or 
when added to the Origination DN (if OCS is already started). OCS will not 
allow a campaign to be loaded unless the Origination DNs for a Campaign 
Group are monitored.
Agents log into an ACD queue that has a DN number. OCS recognizes that DN 
as an identifier for an Agent/Place Group and might use that DN as the point of 
origin for Outbound calls. OCS might use an alternate DN (for instance, a 
Routing Point) as the point of origin for Outbound calls. 

Note: Do not share DNs in the Origination DNs List among Agent/Place 
Groups. Assign each Agent/Place Group to a unique Origination 
DN.The pacing of outbound calls in the Predictive dialing mode can 
cause unpredictable results if DNs are shared.

Procedure:
Adding DN(s) to the Original DNs list

Start of procedure

1. Click Add.
2. Browse in the Switches folder for the DN(s) to add.
3. Select (highlight) the DN(s).
4. Click OK in the Browse dialog box.
5. Click Apply in the Properties dialog box.

End of procedure



Deployment Guide 135

Chapter 7: Manually Defining Outbound Configuration Objects Table Access Object

Place Object
Telesets are assigned to Place objects. A Place might contain more than one 
DN. Prepare an actual layout of the numbering plan to configure the Places and 
assign DNs to them. 
OCS works only with DNs that are assigned to places. Genesys recommends 
that you do not assign more than two telephony DNs (extension and position) 
to one place and that you do not assign telephony DNs from several switches 
to one place.

Table Access Object
A Table Access object defines the relationships among calling list(s), formats, 
and the database. This object points to a database table of a specified format by 
providing a Database Access Point. 

Note: You cannot delete a Table Access object as long as it is associated with 
at least one calling list.

Procedure:
Creating a new Table Access object

Start of procedure

1. Select the Table Access directory.
2. From the File menu, select New > Table Access.
3. On the General tab of the Table Access Properties dialog box, define the 

fields as described below.
4. Click OK or Apply.

End of procedure

Table Access Object—General Tab Fields

Name

Required: default value is [Table Access]. Specifies the name of the Table 
Access object. The name that you enter must be unique within the tenant.
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Note: You can define the Table Access names for calling lists but the Table 
Access object for the Do Not Call table has a gsw_donotcall_list fixed 
name. 

Table Type

Required: default is [Unknown Table Type]. Specifies the type of Table Access 
in the database. Select either Calling List or Log Table for Do Not Call List.

Note: After you define and save the table type for a Table Access object, you 
cannot change it.

Description

Optional: default value is [Blank]. A brief description of the Table Access 
object.

DB Access Point

Required: default value is [None]. Specifies the Database Access Point 
through which the table is accessed. Enter a value by locating an existing 
Database Access Point object.

Format

Required: default value is [None]. Specifies the name of the format to be 
applied to the table. Enter a value by locating an existing Format object.

Note: After you define and save the format, you cannot change it. The Do Not 
Call table has a fixed structure, and therefore, it does not require 
format or field configurations.

Database Table

Required: default value is [Blank].Specifies the name of the table in the 
database.

Update In

Not used by Outbound Contact 7.6.

Cachable

Not used by Outbound Contact 7.6.
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State Enabled

Required: by default, this checkbox is selected. Indicates whether a check box 
that indicates a customer interaction can be directed to this target. For a more 
complete description of this check box, see Framework 7.6 Configuration 
Manager Help.

Field Object
The Field object defines a field in a Calling List database table. Fields are 
single pieces of data (for example, a phone number) within a record. 
There are two types of fields in a calling list: 
• Genesys mandatory fields—These fields must exist in all calling list tables. 

See “Identifying Mandatory Fields” in the “Formats” topic in the 
Outbound Contact Manager Help file. This page contains a list of 
mandatory fields and associated data types, and a short description for each 
field.

• User-defined fields—These custom fields contain business-related data. 

Procedure:
Creating a new Field object

Start of procedure

1. On the left pane, select the Fields folder.
2. From the File menu, select New > Field.
3. On the General tab of the Properties dialog box, define the fields as 

described below.
4. Click the Annex tab and define option(s) in the default section.
5. Click OK or Apply.

End of procedure

Field Object—General Tab Fields

Name

Required; default is [Field]. The field name is the name of the column in the 
database table. This value must be unique within the tenant. Depending on the 
database management system (DBMS), the field name in this object has to 
conform to the same rules as the field’s name in the database table. 
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Tenant

Automatically populated by the system.

Data Type

Required; default is [Unknown Data Type]. You must select a value other than 
default for this object. The type of data stored in this field corresponds to a 
data type supported by the relational database management system. Table 12 
provides information on data type values. Table 13 provides information on 
DATETIME formats.

Table 12: Campaign Data Type Values

Data Type 
Value

Description

char Character string with a fixed length

datetime Date and timea

a. Data for the DATETIME field type is presented in the specific format of the calling 
list when it is populated. This format is database dependent.

float Real number

int Integer

varchar String of variable length

[Unknown Data 
Type]

Default value. You must change this default value and 
replace it with another value from this table.

Table 13: DATETIME formats 

DBMS Data type for date/time user field Required Format Example

MSSQL DATETIME YYYY.MM.DD 
hh:mm:ss

2003.04.15 11:32:56

Sybase DATETIME YYYY.MM.DD 
hh:mm:ss

2003.04.15 11:32:56

Oracle DATE MM/DD/YYYY 
HH24:MI:SS 

04/15/2003 
23:32:56
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Description

Optional; default is [Blank]. A brief description of the field.

Length

Required for char and varchar data types only; not used for any other data 
types. Default is [0]. The length of the field in the database.

Field Type

Required; default is [Unknown Field Type]. You must select a different value 
than the default for this object. Outbound business-specific information is 
stored in this field. Table 14 provides information on field type values.

Informix DATETIME YEAR TO SECOND YYYY-MM-DD 
hh:mm:ss 

2003-04-15 
12:32:56

DB2  TIMESTAMP  yyyy-mm-dd-
hh.mm.ss.nnnnnn

2003-04-15-
12.32.56.123456

Table 13: DATETIME formats  (Continued) 

DBMS Data type for date/time user field Required Format Example

Table 14: Field Type Values

Field Type Value Description

Agent Login ID of the last agent who handled an outbound call associated with this 
record.

Application Unique Application identifier (DBID).

Call Time Time of the actual dialing attempt.

Campaign Campaign database identification number (DBID) with which this record is 
associated.

Chain ID of records that are linked in a chain. All records associated with one 
customer account have the same chainID. 

Contact Info Contact telephone number (home, work, cell), FAX number, or e-mail address.
Contact Info in 7.1 was Phone Number in 6.5.1.

Contact Info Type Type of contact information, such as telephone, FAX, or e-mail address. 
Contact Info Type in 7.1 was Phone Type in 6.5.1. 

Dialing Result Result of a dialed call.



140 Outbound Contact 7.6

Chapter 7: Manually Defining Outbound Configuration Objects Field Object

Default

Optional; default is [Blank]. The default value for the field. All formats that 
include the field will use this default value. The value should be consistent 
with the data type of the field. For example, if the data type is integer, the 
default value should be an integer value only. When OCM imports records 
from an ASCII file in which a field is missing or has no value, OCM populates 
the field with this default value—if the checkbox nullable is not checked. If 
the field is nullable, OCM will accept a blank value. See also “Populating 
Calling Lists Overview” in Outbound Contact Manager 7.6 Help. 

Primary Key

Optional; default is unchecked. The checkbox indicates whether the field is a 
primary key in a database table. In Outbound Contact, the only primary key 
fields are chain_id and chain_n. For more information about these fields, see 
Outbound Contact Manager 7.6 Help.

From Earliest time after midnight to dial a call.

Group Unique Agent Group or Place Group identifier (DBID).

Number in Chain Priority assigned to a given record in the chain. The smallest number is
processed first. 

Number of Attempts Number of dialing attempts.

Record ID Unique ID number for the current record.

Record Status Status of the record.

Record Type Type of record, such as General, Scheduled, Personal CallBack, NoCall

Scheduled Time Time at which scheduled call should be dialed

Switch ID Unique Switch identifier (DBID).

Time Zone Time zone database identification number (DBID) of the record.

To Latest time after midnight to dial a call.

Treatments History History of applied treatments for the given chain (see the 
treatment_sched_threshold option, page 213).

User-Defined Field An optional field that contains custom business data. 

[Unknown Field 
Type]

Default value. You must replace this value with another value from this table. 

Table 14: Field Type Values (Continued) 

Field Type Value Description
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Note: In the 6.5 Calling List table, phone and phone_type were primary keys. 
With release 7.1, chain_id and chain_n replaced phone and 
phone_type, respectively, as primary keys to accommodate different 
persons with the same combination of contact_info (formerly phone) 
and contact_info_type (formerly phone_type) in one Calling List.

Unique

Optional; default is unchecked. The checkbox indicates whether the field value 
is unique within the table.

Nullable

Optional; default is unchecked. The checkbox indicates whether the field value 
can be set to NULL.

State Enabled

Required; default is checked. Unchecking this checkbox disables the entire 
format object. Do not change the default.

Editing Fields in the Field Object
Default and Description are the only fields in the Field object that you can edit 
after you save the object. To modify the Default and Description of a field, 
double-click or right-click the Field object and select Properties to open the 
dialog box where these are configured. A field cannot be deleted as long as it is 
associated with at least one format. Field objects are closely related to Format, 
Table Access, and Calling List objects. Refer to the “Calling List Objects” and 
“Format Objects” topics in this chapter for more information.

Note: For information about options that can specified in the Annex tab of a 
field, please refer to Chapter 8, “Field-Level Options for OCS” on 
page 211.

Format Object
Format objects contain fields that form a structure for a database table. 
Outbound Contact provides two default Format objects: Default_Outbound_ 6 
(for backward compatibility) and Default_Outbound_70. By default, both of 
these objects contain Genesys mandatory fields only.
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Procedure:
Creating a new Format object

Start of procedure

1. On the left pane, select the Formats folder.
2. From the File menu, select New > Format.
3. On the General tab, define the fields.
4. Click OK or Apply.

End of procedure

Format Object—General Tab Fields

Name

Required; default is [Format]. The name must be unique within the tenant. 
Once specified, it cannot be changed.

Tenant

Automatically populated by the system.

Description

Optional; default is [Blank]. A brief description of the named format.

State Enabled

Required; default is checked. A check box that indicates a customer interaction 
can be directed to this target. A more complete description can be found in 
Framework 7.6 Configuration Manager Help.

Format Object—Annex Tab Fields

Not used at this time.

Procedure:
Populating Format with Fields
A newly created Format object is empty and must be populated with shortcuts 
to fields (all mandatory and perhaps some custom fields). The most secure way 
to get all mandatory fields without losing any or acquiring unwanted custom 
fields is to copy an entire set of shortcuts from an existing default format.
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Start of procedure

1. Right-click on Format object and select New > Shortcut to Field.
2. From the Browse dialog box, locate the Environment directory and double 

click on it.
3. Locate the Formats directory and double click. 
4. Locate an existing, default Format (version 6 or 7.x) and double click.
5. Select all fields and click OK. 

Your newly created format is now populated with shortcuts to all the 
mandatory fields.

6. To customize this format, add user-defined field(s): Right-click on Format 
object and select New > Field.

7. Define the field(s) following the procedures in the section “Creating a new 
Field object” on page 137.

Notes: Do not remove mandatory fields. 
You cannot delete a format if it is associated with a Table Access 
object or Filter object. You cannot modify existing fields after you 
associate the format with a Table Access object.

End of procedure

Calling List Object
Calling lists are tables containing customer contact information, including 
phone numbers to be called during an Outbound campaign. Calling Lists are 
also configuration objects in CME. Define a Calling List object after you have 
created the Format and Table Access objects. If you need user-defined fields in 
your Calling List, create those fields and add them to the Format object before 
you create the Table Access object. Once a format is associated with a Table 
Access object, you cannot add or delete fields in that format. You can create 
Filter and Treatment objects before, while, or after you define the Calling List 
object and add or remove these objects at any time.

Notes: Only calling lists based on a 7.1 or 7.2 format can be migrated to 
Outbound Contact 7.6. OCS release 7.1 supports calling lists based on 
the 6.5.2 to 7.1 formats. OCM 7.1 also allows the importation of 6.5.2 
calling lists into the 7.1 format. 
Calling lists that are associated with formats that do not contain the 
switch_id, group_id, and treatments fields (such as those from 
version 7.0 or earlier, or that contain the fields phone and phone_type 
instead of contact_info and contact_info_type respectively) must be 
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migrated to Outbound Contact Solution 7.1 first, then migrated to 
release 7.6. See the Genesys 7 Migration Guide for more details.

New Calling List Object 
Genesys recommends that you create the Calling List object before the Calling 
List table exists in the relational database. This approach enables OCM to 
create the Calling List table according to the properties of the Calling List 
configuration object. If the table does not exist yet, OCM displays this message 
The table [table name] does not exist. Create it?

Click Yes to create the calling list table.
If the Calling List table already exists in the database, then the properties of the 
Calling List object must exactly match the structure of the table (as defined by 
its Format and Table Access objects) in the database.

Procedure:
Creating a new Calling List object

Start of procedure

1. Select the Calling List directory in the left pane.
2. Select New > Calling List from the File menu. 
3. Define the field values in each Properties dialog box, including the 

General tab, Treatment tab (see page 146), and Annex tab (page 146).
4. Click Apply or OK.

End of procedure

Calling List Object—General Tab Fields

Name

Required; default is [Calling List]. The name of the calling list. This value 
must be unique within the tenant.

Tenant

Automatically populated by the system.

Description

Optional; default is [Blank]. A brief description of the calling list. 
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Table Access

Required; default is [None]. The Table Access object to which the calling list 
refers. The Table Access object defines the format of the Calling List and 
identifies the DB Access Point used to access the calling list table. Use the 
Browse button to locate an existing value.

Log Table Access

Default is [None]. Not used at this time.

Filter 

Optional; default is [None]. The filter to be applied to this calling list. A filter 
defines which call records within the calling list table will be dialed by the 
campaign. 

Note: The Filter field becomes enabled only when the Table Access field is 
populated. 

Calling Time From

Default is [8:00:00 AM]. Not used at the list level at this time.

Calling Time To

Default is [6:00:00 PM]. Not used at the list level at this time.

Script

The Script Property in the Campaign, Calling List, and Campaign Group 
defines the Script Object, which contains all of the attributes that are required 
by Agent Scripting. For more information, see the section, “Attaching Script 
Information to OCS User Events and Telephony Events,” in the Outbound 
Contact 7.6 Reference Manual.

Maximum Attempts

Required; default is [10]. The maximum number of attempts to call a single 
record in this calling list during one campaign. You cannot set this value to 
zero.

Note: This parameter is taken into account by Outbound Contact Server 
when applying treatments only. If the record is being processed again 
as a Personal or Campaign Callback, then this parameter is not used by 
OCS.
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State Enabled

Required; default is checked. A check box indicating that a customer 
interaction can be directed to this target. You can find a more complete 
description in Framework 7.6 Configuration Manager Help.

Calling List Object—Treatments Tab Fields

You can add an existing treatment to the calling list by clicking the Add button 
and selecting an available treatment. You can delete an applied treatment by 
selecting a displayed treatment in this dialog box and clicking Delete. Click 
Apply to save the changes.This tab in the Calling List Properties dialog 
box displays the following information for applied treatments.

Name

Name of applied treatment.

Call Result

Call result associated with the applied treatment.

Description

Description of the treatment. See “Treatment Object” on page 154 for more 
information about setting up treatments for unsuccessful calls.

Calling List Object—Annex Tab

Use this tab to define Outbound Calling List-related options. For informa-
tion how to use the Annex tab, see “Common Features of Configuration 
Objects” on page 131.

Changing the Structure of a Calling List 
The database administrator can make changes directly to the Calling List table 
using the database management system (DBMS) tools; however, OCM will no 
longer be able to access this table. Genesys recommends that you create a new 
Calling List object, which will match the new physical structural of the table, 
as described on page 144.

Fine Tuning a Calling List
When OCM creates a physical table for the Calling List, OCM also creates 
appropriate indexes on the table; however, if the structures of the dialing filters 
require additional indexes, the customer needs to create them. The customer 
also needs to perform tune-up procedures, such as updating index statistics and 
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maintaining transaction logs. To assign a List Weight to a calling list, see “List 
Weight” on page 163.

Filter Object
Filters specify the criteria for data selection from a database table. Outbound 
filters are applied to Calling Lists. See the Filter field under “Calling List 
Object” on page 145.

Procedure:
Creating a new Filter object:

Start of procedure

1. Select the Filters folder in the left pane.
2. From the File menu, select New > Filter.
3. Define the fields in the General tab.
4. Define options in the Annex tab. 
5. Click OK or Apply.

End of procedure

Filter Object—General Tab Fields

Name

Required; default is [Filter]. The name of the filter. This value must be 
unique within the tenant. 

Tenant

Automatically populated by the system.

Description

Optional; default is [Blank]. A brief description of the filter.

Format

Required; default is [None]. The format to which this filter is applied. Once it 
is specified, it cannot be changed. You assign a Filter object to a Calling List 
object with the same format. Use the Browse button to locate an existing value.
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State Enabled

Required; default is checked. A check box that indicates that a customer 
interaction can be directed to this target. A more complete description is in 
Framework 7.6 Configuration Manager Help.

Filter Object—Annex Tab Fields

Two options on the Annex tab define a Dialing Filter: criteria and order_by. 
Create a section called default on the Filter object’s Annex tab; then add the 
options criteria (see “Configuring the criteria option”) and order_by. (see 
“Configuring the order_by option to sort records”).

Procedure:
Configuring the criteria option
The criteria option defines the where clause of a SQL statement. It defines 
the restricting conditions for the records to be dialed by a campaign. The 
syntax for values in the criteria option is SQL syntax.

Notes: 
• The Outbound Contact Wizard was not updated for release 7.6.
• The criteria option is called WHERE in the Outbound Contact 7.5 

Configuration Wizard.

Start of procedure

1. In the [filter name] Properties dialog box, select the Annex tab.
2. Create a new section called default, if one does not exist.
3. Double-click default.
4. Click Create New Section/Option icon.
5. In the Edit Option dialog box, enter criteria in the Option Name field.
6. Add a SQL statement in the Option Value field in the Edit Option dialog 

box.
For example, to restrict the dialing records to contact only platinum credit 
card holders, type card_type=’platinum’ in the Option Value field.
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Note: When using Genesys mandatory fields in SQL statements, the value 
must be in enum format. Refer to “Genesys Enumeration Tables” in the 
“Communication Protocols” chapter of the Outbound Contact 7.6 
Reference Manual. (When creating viewing filters in OCM, this only 
applies on the Expert Mode tab.)

End of procedure

Procedure:
Configuring the order_by option to sort records
The order_by option defines the sort order of the records that meet the 
restrictions defined in the criteria option.

Start of procedure

1. Open the default section.
2. Right-click and select New from the pop-up menu.
3. Enter order_by in the Option Name field in the Edit Option dialog box.
4. In the Option Value field, type the name of the field by which you want to 

sort.
For example, to order records by telephone number, enter phone in the 
Option Value field.

Note: If you use a filter on a large calling list with more than 1,000 records, 
Genesys recommends that the Administrator create an index using 
DBMS tools. This dramatically improves data-retrieval performance.

End of procedure

Defining a Dialing Filter that Exceeds 255 Characters

To define a dialing filter that exceeds the 255-character limit, divide the long 
string into several shorter strings. Use configuration options with the same 
name and add sequential numbers at the end of the option's name. OCM builds 
a dialing filter by concatenating the values of these options. 

Sample Configuration: 

In the example ahead, the values of these configuration options 
• criteria 

• criteria1 
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• criteria2 

are the first, second, and third parts, respectively, of the dialing filter’s 
WHERE clause. 
In the example ahead, the values of these configuration options 
• order_by 

• order_by1 

• order_by2 

are the first, second, and third parts, respectively, of the dialing filter ORDER 
BY clause. 

Note: When parts of the filter are concatenated, no extra spaces are added. As 
a rule, when configuring the options, you should add the space, either 
at the end of a line (see example) or at the beginning of the next line. 
Without <space>, the following configuration would create an invalid 
filter. 

Example 1 criteria = phone like '415%' AND tz_dbid IN (116, 118, <space> 

criteria1 = 122) AND customer_priority IN (10, 9, 4, <space> 

criteria2 = 3, 2, 18) AND customer_type = 1 <space> 

order_by = phone_type ASC, tz_dbid DESC, <space> 

order_by1 = customer_priority ASC, customer_policy_n DESC, <space> 

order_by2 = customer_id DESC 

Resulting Filter 1 The options configured as shown above result in the following dialing filter:
WHERE phone like '415%' AND tz_dbid IN (116, 118, 122) AND 
customer_priority IN (10, 9, 4, 3, 2, 18) AND customer_type = 1 ORDER 

BY phone_type ASC, tz_dbid DESC, customer_priority ASC, 

customer_policy_n DESC, customer_id DESC 

Filters that Break a Chain of Records 

You can write a filter so that it breaks a chain of records into two logical 
chains: one chain that satisfies the filtering expression and a second chain that 
does not. For example:
List:

Record 1:phone = ‘111’, phone_type = 1, chain_id = 1, chain_n = 0

Record 2:phone = ‘222’, phone_type = 2, chain_id = 1, chain_n = 1

Record 3:phone = ‘333’, phone_type = 1, chain_id = 1, chain_n = 2

Record 4:phone = ‘444’, phone_type = 3, chain_id = 1, chain_n = 3

Example: The following filter
where phone_type = 1
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will break the given chain into two logical chains:
Logical chain 1 includes records 1 and 3, which satisfy the filter 
condition.
Logical chain 2 includes records 2 and 4, which do not satisfy the filter 
condition.

You should avoid filtering conditions such as this, if possible. 

Record Cancel for
Broken Chain

Under particular conditions, records with the same chain_id are not all 
cancelled by a cancel by phone request (RequestRecordCancel with GSW_PHONE 
attribute). 
This behavior occurs when four conditions co-exist:
• The RequestRecordCancel has the All Chain attribute, which means to 

update the whole record chain, not just the single record,
but

• a filter applied to the calling list breaks a single chain into two logical 
chains
while

• the campaign (to which the calling list belongs) is loaded or running, 
and 

• a phone number specified in the GSW_PHONE attribute is filtered out. 
The records that are not filtered out are also not cancelled even though the 
chain attribute is All Chain.
Take, for example, these conditions applied to the list that follows:
• Filter: where phone_type = 1
• RequestRecordCancel: Phone = '222' 
• ChainAttr = 'AllChain'

List:
Record 1: phone = '111', phone_type = 1, chain_id = 1, chain_n = 0

Record 2: phone = '222', phone_type = 2, chain_id = 1, chain_n = 1

Record 3: phone = '333', phone_type = 1, chain_id = 1, chain_n = 2

Record 4: phone = '444', phone_type = 3, chain_id = 1, chain_n = 3

Records 1 and 3 meet the filter condition where phone_type = 1. Records 1 and 
3 comprise logical chain 1. These two records (with chain_n = 0 and chain_n = 
2) are retrieved from the database and dialed.
Record 2 (with chain_n = 1) and record 4 (with chain_n = 3) comprise the 
second logical chain. Record 2 is subject to the RequestRecordCancel where 
Phone = ‘222’. Since the RequestRecordCancel has the All Chain attribute 
(ChainAttr = ‘All Chain’), both records 2 and 4 are cancelled. 
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Full Chain Update
The full chain update feature applies to configurations in which chains of 
records are separated by the dialing filter, and therefore, are partially processed 
by OCS. After OCS finishes processing this type of chain, by default it marks 
the records that were filtered out by the dialing filter (such as Record 2 in the 
example below) as record_status = Ready.
Ordinarily, if a dialing filter is changed and the chain processing is resumed, 
such an update will cause repetitive dialing of other records that belong to the 
same chain. This could lead to contacting the same customer again within that 
dialing period. Using the full chain update feature prevents this unwanted 
behavior of OCS.
The following provides an example of the configuration when a chain of 
records is separated by the dialing filter:

Chain: 

• Record 1: Phone = 4155551212, phone type = Home Phone, Chain ID = 1, 
Chain N = 0 

• Record 2: Phone = 6505551212, phone type = Direct Business Phone, 
Chain ID = 1, Chain N = 1 

Dialing filter applied: 

criteria = ‘phone_type = 1’ 
Outbound Contact provides the option update_all_records to enable control 
over how OCS updates the status of records after the chain processing has been 
completed, in the following way: 
• If the value for the update_all_records option is set to True: OCS updates 

all records in the chain, regardless of the dialing filter applied. All records 
outside the parameters of the dialing filter are updated with the same status 
that the chain receives after OCS has finished processing it. 

• If the value for this option is set to False (default): Records that were 
filtered out by the dialing filter are marked as record_status = Ready.

Note: This option can be configured both on the Application- and individual 
Calling List-levels. The Calling List-level option takes precedence 
over the Application-level.

When in use, Full Chain Update ensures that all records in the chain are 
updated with the same status as the chain itself, regardless of the chain’s 
currently applied dialing filter, which might separate the chain by filtering 
some records out. For example, if the record in the chain has been cancelled 
with the flag 'AllChain', then all records, regardless of the dialing filter, will be 
marked as Cancelled.
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Time Zones
Outbound Contact 7.6 uses time zones in call records to determine the 
contact’s time zone. OCM populates the tz_dbid field with the international 
three-letter abbreviation for the time zone parameter when it imports or exports 
a calling list. Call time, dial schedule time, and valid dial time (dial from and 
dial till) are based on the record’s time-zone. For more information about the 
time zone abbreviations see Outbound Contact Manager 7.6 Help.

Note: If Daylight Savings Time (DST) is configured for time zones located 
below the equator using the Current Year or Fixed Date (Local) 
properties, define both the Start Date and End Date in the DST 
definition as the current year and make the Start Date later than the 
End Date.

Outbound Contact 7.6 dynamically updates time changes from winter to 
summer and summer to winter. The default set of Time Zones created during 
Configuration Server installation is located in the Time Zones folder under the 
Environment (for a multi-tenant environment) or under the Resources folder 
(for a single tenant).

Procedure:
Creating a custom Time Zone for a Tenant

Purpose:  To create a custom Time Zone for a Tenant, if needed.

Start of procedure

1. Select the Time Zones directory.
2. Select New > Time Zone from the File menu.
3. Define the fields in the General tab of the Time Zone Properties dialog 

box. 
4. Define the fields in the Daylight Savings tab.
5. Click OK or Apply.

End of procedure

Time Zones Object—General Tab Fields

Name

Required; default is [Time Zone]. The name of a Time Zone object. This value 
must be unique within the tenant.
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Tenant

Automatically populated by the system.

Description

Optional; default is [Blank]. A brief description of the Time Zone object.

Offset

Optional; default is [GMT]. Greenwich Mean Time (GMT) plus the amount of 
time (in hours and minutes) to add to that standard.

DST Observed

Optional; default is unchecked. A checkbox to indicate whether or not the time 
zone observes Daylight Savings Time (DST). 

Netscape

Required; Enter the time zone as it appears in Netscape Navigator. 

Microsoft Internet Explorer

Required; Enter the time zone as it appears in Microsoft Internet Explorer. 

State Enabled

Required; default is checked. A check box indicating whether or not a 
customer interaction can be directed to this target. A more complete 
description can be found in Framework 7.6 Configuration Manager Help.

Treatment Object
Treatment objects are assigned to Calling List objects. Treatment objects 
define what OCS should do with a call that does not reach the intended party. 
A treatment, for example, could be that Outbound Contact redials a number 
that returns a Busy call result. If no treatments are assigned to a call result, OCS 
changes the record status to Updated. You can add or remove treatments from a 
Calling List object while a campaign is running. Note, however, that once a 
treatment is in progress, it cannot be interrupted. Changes made to that 
treatment will be applied to the next record that receives the call result that 
prompts the treatment. 
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Procedure:
Creating and applying Treatments

Start of procedure

1. Select the Treatments directory.
2. Select New > Treatment from the File menu.
3. Define the fields in the General tab of the Treatment Properties dialog box. 
4. Click OK or Apply.

End of procedure

Treatment Object—General Tab Fields

Name

Required; default is [Treatment]. Type the name of the treatment. It must be 
unique within the tenant.

Tenant

Automatically populated by the system.

Description

Optional; default is [Blank]. A brief description of the selected treatment. 

Call Result

Required; default is [Unknown Call Result]. Select a value (the result of a 
dialing attempt) for this object. Table 15 provides information on call result 
values.
.

Table 15: Call Result Values

Call Result Value Description

[Unknown Call Result] Default value. You must change this default value and replace 
it with another value from this table.

Abandoned Call dropped and will not be redialed.
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Agent CallBack Error OCS generates this call result when a call record is rescheduled 
according to a personal callback request from the desktop 
application, but OCS cannot find the designated agent to 
receive the callback when the scheduled time arrives.
See the “Communication Protocols” chapter in the Outbound 
Contact 7.6 Reference Manual for details on the personal 
callback request.

All Trunks Busy No free trunks on the switch for dialing a call.

Answer Customer was reached at the dialed phone number.

Answering Machine Detected Answering machine was detected at the dialed phone number.

Bridged Reserved for future use.

Busy Dialed phone number was busy.

Call Drop Error Reserved for future use.

Cancel Record Record has been marked with Cancel by the agent desktop 
application or a third-party application.

Cleared Reserved for future use.

Conferenced Reserved for future use.

Consult Reserved for future use.

Converse-On Reserved for future use.

Covered Reserved for future use.

Deafened Reserved for future use.

Dial Error Hardware error from a Dialogic board or a call progress 
detection (CPD) board on the switch

Do Not Call Record has been marked with DoNotCall by the agent desktop 
application or a third-party application.

Dropped Call dropped by dialer after call dialed. Call dropped if/when 
the call_wait_queue_timeout option expires.

Dropped on No Answer Reserved for future use.

Fax Detected Fax machine was detected at the dialed phone number.

Forwarded Reserved for future use.

Table 15: Call Result Values (Continued) 

Call Result Value Description
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General Error General error occurs when a call is not completed, possibly 
caused by an invalid telephone number in the record or a 
wrong number according to the switch.

Group CallBack Error This call result is generated by OCS internally when a call 
record is rescheduled according to a campaign callback request 
from the desktop application, but OCS cannot find any 
available agent to receive the callback record. See the 
“Communication Protocols” chapter in Outbound Contact 7.6 
Reference Manual for details on the campaign callback request.

Held Reserved for future use.

No Answer Ring without answer at destination.

No Dial Tone Absence of dial tone based on an error returned by the Dialogic 
board or the call progress detection (CPD) board on the switch.

No Established Detected Reserved for future use.

No Port Available No port is available to place call.

No Progress Reserved for future use.

No RingBack Tone Reserved for future use.

NU Tone A special Public Switched Telephone Network (PSTN) code 
valid only in Europe.

OK OCS treats the call result OK as undefined, therefore, it 
disregards any treatments created for this call result.

Overflowed Reserved for future use.

Pager Detected Pager was reached at the dialed phone number.

Pickedup Reserved for future use.

Queue Full Reserved for future use.

Redirected Reserved for future use.

RemoteRelease Reserved for future use.

Silence Call was dialed, but there is no call progress detection (CPD).

SIT Detected Any type of network tone.

Table 15: Call Result Values (Continued) 

Call Result Value Description
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Apply to Record

Required; default [Unknown Action]. Select a value from the drop-down list. 
The action to apply to a calling list record based on the call result. Applies to 

SIT IC (Intercept) Only applies if the network supports this specific standard 
information tone (SIT). Check with the switch vendor for 
confirmation.

SIT Invalid Number Only applies if the network supports this specific SIT. Check 
with the switch vendor for confirmation.

SIT NC (No Circuit) Only applies if the network supports this specific SIT. Check 
with the switch vendor for confirmation.

SIT RO (Reorder) Only applies if the network supports this specific SIT. Check 
with the switch vendor for confirmation.

SIT Unknown Call State Only applies if the network supports this specific SIT. Check 
with the switch vendor for confirmation.

SIT VC (Vacant Code) Only applies if the network supports this specific SIT. Check 
with the switch vendor for confirmation.

Stale Call result is marked as stale if the following timer has 
expired: 
stale_clean_timeout
OCS will also mark the call result as stale for call records that 
have not received a RecordProcessed request from the desktop 
application when a campaign is being unloaded.

Switch Error No dial tone received.

System Error Dialing software error from the Dialogic driver or CPD from 
the switch.

Transfer Error Dialer has a problem transferring calls based on call action.

Transferred Reserved for future use.

Wrong Number Call is answered but the desired person(s) could not be reached 
at this number; this call result is sent by the agent desktop 
application and not detected by the dialer.

Wrong Party Call is answered but by a wrong party; this call result is sent by 
the desktop application and not detected by the dialer.

Table 15: Call Result Values (Continued) 

Call Result Value Description



Deployment Guide 159

Chapter 7: Manually Defining Outbound Configuration Objects Treatment Object

all call results in the Call Results Values table except for call result Answer. 
Table 16 provides information on Apply to Record values.

Apply to Call

Optional; applicable only when call result is Answer, Answering Machine 
Detected, or Fax Detected; default is [Unknown Action Code]. Allows an 

Table 16: Apply to Record Values (Unanswered Call Results)

Apply to Record Value Description

Assign to Group Used for the Agent CallBack Error call result. The call record is 
treated as a scheduled call of type Campaign. The record type is set 
as CampaignCallBack. The call record is sent to one of the desktops 
in the Campaign Group. The desktop must be programmed with a 
communication protocol to use this feature. See the 
“Communication Protocols” chapter in the Outbound Contact 7.6 
Reference Manual.

Mark as Agent Error Used for the Agent CallBack Error or Group CallBack Error call 
result. The record status is set to Missed Callback. See also the 
predictive_callback option in this guide.
Note: Although you can set this value to other negative call results 
in Configuration Manager, you should only use it for Agent 
CallBack Error or Group CallBack Error call results.

Next in chain Used to set the total number of times that the next-in-chain 
treatment cycle occurs, and set the time period to wait before 
beginning the cycle again.

Next in chain after Used to set the interval until the next record in chain is dialed, and 
until the next pass through the chain, after the last record in the 
chain has been dialed.

Next in chain at specified date Used to set the date/time to dial the next record in chain.

No Treatment No treatment will be applied.

Redial Redial number within a specified number of minutes (Interval) for a 
specified number of times (Cycle Attempt).

Retry at specified date Record will be redialed at the specified Date and Time.

Retry in Retry once after the specified number of minutes (Interval).

Update all records in chain No more dial attempts are made for the chain and all records in the 
chain are marked as Updated.

[Unknown Action] Default value. You must change this default value and replace it 
with another value from this table.
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alternate path when a dialing attempt is answered or reaches an answering 
machine or fax machine. Select a value from the drop-down menu. Table 17 
provides information on Apply to Call values.

Destination DN

Required for the Apply to Call actions Connect and Transfer; default is 
[None]. The DN to which the call will be connected or transferred. Browse for 
an existing DN. If a Destination DN is not supplied, OCS will ignore the 
treatment.

Number in sequence

Required; default is [0]. Assign the value 1 for a stand-alone treatment or for 
the first treatment of a treatment sequence. In a treatment sequence, each 
treatment contains a unique number that determines the order in which each 
treatment is applied to the same call result. 

Interval (minutes)

Required when Apply to Record is set to Next in chain, Next in chain 
after, Redial, or Retry in; default is [0]. A time interval, in minutes, that 
OCS waits between the first dialing attempt and the first treatment attempt.

Table 17: Apply to Call Values (Answering Machine/Fax Results)

Apply to Call Value Description

Connect Call connected to the DN defined as the Destination DN. 

Drop Drop = Unknown. Call is dropped or disconnected.

Mute Transfer Reserved for future use.

Play a Message Reserved for future use.

Route Reserved for future use.

Send a fax Reserved for future use.

Send a page Reserved for future use.

Send an e-mail Reserved for future use.

Transfer Call transferred to the DN defined as the Destination DN.

[Unknown Action Code]  [Unknown Action Code] = Dropped. Default value. You must change 
this default value and replace it with another value from this table.
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Cycle Attempt

Required to be other than 0 when Apply to Record is set to Next in chain, 
Next in chain after, Next in chain at specified date, Redial; default is 
[0]. The maximum number of consecutive attempts to execute the treatment 
on the record.

Increment (minutes)

Required when Apply to Record is set to Next in chain, Next in chain 
after, Rerty in, Redial; default is [0]. Specifies the number of minutes 
added to the previous redial time interval.

Date

Required if the Apply to Record action is set to Next in chain at specified 
date or Retry at specified date; default is [current date]. The date when 
another treatment attempt will be performed. Select a calendar date from the 
drop-down list.

Time

Required if the Apply to Record action is set to Next in chain at specified 
date or Retry at specified date; default is [current time]. The time of 
day that another treatment attempt will be performed. Select a time from the 
drop-down list.

Range

This is reserved for future use.

State Enabled

Required; default is checked. A check box that indicates that customer 
interaction can be directed to this target. A more complete description can be 
found in the Framework 7.6 Configuration Manager Help.

Treatment Sequences

Note the following:
• You can define treatment sequences (sometimes called linked treatments) 

for the same call result by using the Number in sequence field in the 
Treatment Properties dialog box. The first treatment in the sequence must 
have a value of 1 in the Number in sequence field. The values for this field 
must be numbered sequentially (1,2, 3, etc.). The sequence will not work if 
a treatment sequence is broken, for example, numbered 1, 2, and 4.
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• You can create two Busy treatments and specify the order (sequence) in 
which to apply them. For example, create one Busy treatment that has an 
action of Redial and the Number in sequence field set to 1; create a second 
Busy treatment that has an action of Retry in and the Number in sequence 
field set to 2; then assign both Busy treatments to the same Calling List.

• You can also use the sequence of treatments in combination with cycling 
through the chain. To do this, you need to place one of the treatments of the 
type Next-In-Chain, Next-In-Chain After, or Next-In-Chain at Specified 
Date, at the end of the sequence of treatments. 
Properly configuring one of these treatments to be the last in the sequence 
will result in the following: When the chain is completed, OCS will jump 
from the last record to the first record in the chain to begin the cycle again.

Campaign Object
A Campaign object contains information about the Calling List(s) and, if 
needed, defines campaign-level options.

Procedure:
Creating a new Campaign object

Start of procedure

1. Select the Campaigns directory in the left pane.
2. From the File menu, select New > Campaign. 
3. Define the field values in the Properties dialog boxes.
4. Click Apply or OK.
The following sections (“General Tab” and “Calling List Tab”) describe how 
to configure this object.

End of procedure

General Tab

Name

Required; default is [Campaign]. Type or choose the name of the campaign. 
This name must be unique within the tenant.

Tenant 

Automatically populated by the system.
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Description

Optional; default is [Blank]. A brief description of the campaign.

Script

Optional; default is [None]. Defines the Script object that contains all of the 
attributes that are required by Agent Scripting. See the section, “Attaching 
Script Information to OCS User Events and Telephony Events,” in the 
Outbound Contact 7.6 Reference Manual for more information.

State Enabled

Required; default is checked. A check box that indicates that customer 
interaction can be directed to this target. A more complete description can be 
found in Framework 7.6 Configuration Manager Help.

Calling List Tab

For the calling list in a campaign, you can do the following:
• Add a calling list or make it active or inactive (see page 164).
• Edit a calling list (see page 164).
• Delete a calling list (see page 165).

The following fields are in the Campaign Calling List Info Properties dialog 
box, which opens after you click the Add or Edit button or double-click on an 
existing Calling List.

Calling List

Required; default is [None]. The names of calling lists that will be dialed 
during this campaign. A campaign can have zero or more calling lists. Select 
from defined calling lists.

List Weight 

Required; default is [10]. This property is applicable for a campaign with 
more than one active calling list. It is the percentage of call records to be 
retrieved from a calling list for a campaign. Specify what percentage of that 
volume will be drawn from each calling list. See the “Understanding Weights” 
topic in the Outbound Contact Manager 7.6 Help.

Note: The List Weight field is the Share field in the Calling List tab.
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Active

Required; default is checked. A check box that indicates if the selected 
Calling list is involved in this campaign. The check box is used to dynamically 
activate or deactivate the calling list in a running campaign.

Procedure:
Adding a Calling list to a campaign or making it active 
or inactive

Start of procedure

1. Click Add. The Campaign Calling List Info Properties dialog box opens.
2. Locate and select an existing calling list.
3. Assign a List Weight.
4. Make the list active (default) or inactive.
5. Click OK.
6. Click Apply to save all changes

End of procedure

Procedure:
Editing a Calling list attached to a campaign

Start of procedure

1. Click Edit.
2. Change the List Weight 
3. Make it active or inactive.
4. Change the Calling list by selecting another Calling list.
5. Click OK.
6. Click Apply to save all changes.

End of procedure
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Procedure:
Deleting a Calling list from a campaign

Start of procedure

1. Select the calling list name 
2. Click Delete.
3. Click Apply to save all changes.

End of procedure

Annex Tab 

Use this tab to define Outbound Campaign-related options. For information 
how to use the Annex tab, see “Common Features of Configuration Objects” on 
page 131. An option defined in this tab fine-tunes the system on the individual 
campaign level. 

Campaign Group Object
A Campaign Group is the main configuration object in Outbound Contact. It can 
be found as a subfolder within the Campaign object in Configuration Manager. 
The Campaign Group is defined as a Campaign (a set of calling lists) that is 
assigned to work resources such as an Agent Group or a Place Group.
The following sections describe how to configure a Campaign Group:

Procedure:
Creating a new Campaign Group object

Start of procedure

1. Select the Campaigns folder in the left pane.
2. Select a Campaign. 
3. Select the Campaign Group folder.
4. From the File menu, select New > Campaign Group.
5. Define the field values in the Properties dialog boxes.
6. Click Apply or OK.



166 Outbound Contact 7.6

Chapter 7: Manually Defining Outbound Configuration Objects Campaign Group Object

The following sections (“General Tab”, “Advanced Tab”, “Buffer Size 
Coefficient”, “Connection Tab”, and “Annex Tab”) describe how to configure 
this object.

End of procedure

General Tab

Name

Required; The format is [Campaign@CampaignGroup]. This name must be unique 
within the tenant.

Tenant 

Required; Automatically populated by the system.

Campaign

Required; The name of the campaign that will form the Name field above. 
Automatically populated by the system.

Group

Required; The name of the group that will form the Name field above.

Note: If using OCS version 7.2.x, 7.5.x, 7.6.0, or 7.6.100 and are running the 
same Outbound Campaign against multiple agent groups, when an 
agent schedules a Personal Callback or a Personal Rescheduled, OCS 
might fail to deliver a Personal CallBack or Personal Rescheduled 
record to the designated agent. As a workaround, Genesys 
recommends that you either use Campaign Callbacks or to associate 
one campaign with a single agent group. 

If you are using OCS version 7.6.101, this issue is corrected with the 
addition of the callback-observe-group option (see page 186).

Group Type

Required; The type of group (agent or place). Automatically populated by the 
system.

Description

Optional; default is [Blank]. A brief description of the campaign.
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State Enabled

Required; default is checked. A check box that indicates that customer 
interaction can be directed to this target. A more complete description can be 
found in Framework 7.6 Configuration Manager Help.

Advanced Tab

The Campaign Group’s parameters can be found on the Advanced tab of the 
Campaign Group object. See Figure 12 as an example.

Figure 12: Campaign Group Advanced Tab

The following lists the different parameters that can be configured:

Dialing Mode 

Required; default is [Predictive]. Any of the modes that are described on 
“Dialing Modes” on page 51.
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Voice Transfer Destination 

Required; default is [None]. Identifies where calls are to be delivered for 
handling. In addition to the Voice Transfer Destination DN, any ACD Queue, 
Virtual Queue, Routing Point, or Service Number DN that may be part of a 
call flow involving this group of agents or places must be specified as an 
Origination DN in the Advanced tab of the Agent Group or Place Group objects 
in Configuration Manager. OCS needs to monitor these DNs to identify 
“foreign” inbound or outbound calls that are delivered to agents but were not 
issued by OCS on behalf of the Campaign Group, or if the ACD Queue DN is 
configured as an “overflow” DN.

Note: You must avoid situations when the same DN is configured as an 
Origination DN for more than one Agent Group or Place Group that is 
part of a predictive or progressive dialing mode campaign because it 
may cause incorrect results with the dialing algorithm.

Operation Mode

Required: default is [Manual]. Not used at this time.

Optimization Method and Target Value 

Required in Predictive mode: default is [Agent Busy Factor] for Optimization 
Method and default is [80] for Target Value. Work together to determine how 
busy the campaign will be. These parameters are not applicable to Push 
Preview and Power GVP dialing modes.

Max Queue Size 

Optional; default is [0]. Determines the number of records to keep in the 
dialer’s queue. It is an internal counter that is used when OCS performs with 
Power GVP or Push Preview modes. OCS tries to always keep dialer’s buffer full 
with the specified Max Queue Size.

IVR Profile ID

Optional; default is [Blank]. Specifies the IVR Profile DBID that is specified 
in the GVP EMPS IVR Profile. The ivr-profile-name option uses the value 
specified in this field. See page 197 for more information about this option.

Interaction Queue

Optional; default is [None]. Specifies a configuration object that is created in 
the Scripts folder in Configuration Manager by Interaction Routing Designer 
when developing a Business Process to process outbound Preview mode 
interactions. For more information, see the Universal Routing 7.6 Business 
Process User's Guide. An Interaction Queue is used in Push Preview mode 
only.
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Script 

Optional; default is [None]. Defines the Script object that contains all of the 
attributes that are required by Agent Scripting. See the section, “Attaching 
Script Information to OCS User Events and Telephony Events,” in the 
Outbound Contact 7.6 Reference Manual for more information.

Buffer Size Coefficient 

Required; default is [4] for Minimum and default is [6] for Optimal. Acts as a 
multiplier for the number of agents that are available for a campaign. Together, 
the Minimum and Optimal values determine how many records OCS keeps in 
memory when performing traditional campaigns. Since there might be no 
agents for the Push Preview and Power GVP dialing modes, these parameters 
are used differently by OCS as a percentage of the desired Max Queue Size 
value. For example, you can set them as: Min: 100%, Opt: 150-200%.

Number of CPD Ports 

Identifies the maximum number of interactions at any time when OCS is using 
CPD Server to make calls.

Connection Tab

The Connections tab enables you to specify all server connections (besides T-
Server) that are required to run an outbound campaign in a certain dialing 
mode for a particular campaign group.

Note: This type of connection provides basic host/port connectivity only. It 
does not provide features such as Advanced Disconnect Detection 
Protocol (ADDP). Also, you can add your application to the 
Connections tab of the OCS Application object in order to configure 
any additional connection parameters.

Annex Tab 

Use this tab to define Outbound Campaign-related options. For information 
how to use the Annex tab, see “Common Features of Configuration Objects” 
on page 131. An option defined in this tab fine-tunes the system on the 
individual campaign level.
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Chapter

8 Outbound Contact 
Configuration Options
This chapter describes each of the options that you can configure in order to 
ensure that Outbound Contact performs as needed in your environment. It 
contains the following sections:

Overview, page 171
Outbound Contact Manager Options, page 172
Outbound Contact Server Options, page 178
CPD Server Options, page 221
Changes from Release 7.5 to 7.6.x, page 260

Overview
In Outbound Contact 7.6, you define options at the Outbound Contact Server 
(OCS) application level. You can also define options at the object level for 
Switch, DN, Agent, Place Group, Calling List, and Campaign objects. 
Defining the settings at the object level enables flexibility and fine-tuning for a 
campaign setup. 
OCS first reads the configuration options in the objects. If an option is not 
defined at the object level, OCS checks the configuration at the application 
level. If the option is not specified at the application level, OCS uses the 
default value for that option. 

Note: When you make changes to an option, the changes take effect 
immediately, unless otherwise noted in the option description.
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Depending on the needs of the contact center configuration, the Outbound 
Contact Administrator can choose to:
• Use default OCS options, if the contact center has no specific 

requirements.
• Set options at the OCS application level, if the contact center requires 

overriding of OCS settings.
• Set options at the level of a specific object, if the contact center has 

specific needs for individual Switch, Agent, Place Group, or Campaign 
objects.

OCS stores configuration options in section folders on the Options tab and the 
Annex tab. The Options tab contains the section folders and options for 
application objects in OCM, OCS, and CPD Server. The Annex tab contains the 
section folders and options for all other objects.
This chapter lists the section folders and options according to their general 
function, and according to the name of the object.

Note: Logged data can be truncated to hide sensitive data in the logs by 
configuring either the default-filter-type option or any of the log-
filter-data section options to a value other than copy. The truncation 
is represented in the log by asterisks. For more information about these 
options, see the Common Framework 7.6 Configuration Options 
Reference Manual, “Common Configuration Options” chapter.

Outbound Contact Manager Options
The following options are configured in the OCM Application object.

Annex Tab
The following options are configured on the Annex tab.

AutoReconnect
Type: Optional
Default Value: false
Valid Value(s): true/yes, false/no
Changes Take Effect: Immediately
Determines if OCM performs an automatic reconnect procedure to a given 
server. There are two values:
• When the value of the option is true, OCM does not display the 

reconnection dialog and immediately attempts the backup connection.
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• When this option is set to false or it is not present, OCM displays a 
message box that provides you with the following choices:

Connect to backup (if available)
Reconnect to primary
Cancel

You can configure this option in the Annex tab of the OCM Application object. 
The Section name can contain the following values:
• DBServer for DB Server connections
• Config for all Configuration Server connections
• OCServer for OCS connections

Note: The Options tab cannot be used to configure this option. 

Options Tab

Security Section

The following option is configured in the security section of the Options tab.

inactivity-timeout
Type: Optional
Default Value: 0 (minutes)
Valid Value(s): Any non-negative integer (0–N)
Changes Take Effect: Immediately
Specifies the amount of time, in minutes, that Outbound Contact Manager 
waits for activity before disabling a logged-in user who is not interacting with 
the application. If this option is not present or if it is set to 0, OCM will not 
disable the user due to an extended period of inactivity.

OCManager Section

The section folder OCManager, on the Options tab of the OCM Application 
object, stores the options for Outbound Contact Manager (OCM). 

addp
Type: Optional
Default Value: false
Valid Value(s): yes/true/on or no/false/off
Changes Take Effect: Immediately
Specifies whether or not Advanced Disconnect Detection Protocol (ADDP) 
should be enabled between OCM and any DB Server to which OCM connects.
If set to yes, true, or on, ADDP is enabled.
If set to no, false, or off, ADDP disabled.
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addp-timeout
Type: Optional
Default Value: 0 (zero seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately
Specifies the timeout in seconds between poll messages. If this option is set to 
0 (zero), no disconnection occurs, even if there is no activity.

addp-remote-timeout
Type: Optional
Default Value: 0 (zero seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately
Specifies the timeout in seconds between remote poll messages. If this option 
is set to 0 (zero), no disconnection occurs, even if there is no activity.

addp-trace
Type: Optional
Default Value: false
Valid Value(s): off/false/no or local/on/true/yes or remote or full/both
Changes Take Effect: Immediately
Specifies the trace (log output) mode for both applications involved in ADDP 
messaging.
If set to off, false, or no, there is no trace in the log files.
If set to local, on, true, or yes, a trace occurs on local side only. 
If set to remote, a trace occurs on the remote side only.
If set to full or both, a full trace occurs on both local and remote sides.

Note: The option settings local or full do not enable the tracing on the local 
(OCM) side. OCM is not a server application, and it does not have any 
logging.

asm
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Changes Take Effect: On restart
Enables or disables Active Switching Matrix (ASM) mode in OCM. 
If set to yes or true, ASM mode is enabled in OCM. When a campaign is loaded, 
the user can select one of the following dialing modes: Predictive with 
seizing, Progressive with seizing, or Preview.
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If set to no, false, or if not specified, ASM mode is disabled in OCM. When a 
campaign is loaded, the user can select one of the following dialing modes: 
Predictive, Progressive, Preview, Push Preview, or Power GVP. 

Note: This setting takes effect when OCM starts. If you change this option’s 
setting, you must restart OCM, or you must close and reopen a session.

db_timeout
Type: Optional
Default Value: 60 (seconds)
Valid Value(s): Any positive integer
Changes Take Effect: Immediately
Specifies the timeout, in seconds, for the DB Server operation. This option is 
particularly useful when the Modify All operation is applied to calling lists 
containing 15,000 or more records.

<any string that is a “Field Type” attribute>
Type: Optional 
Default Value: none
Valid Value(s): Any regular expression
Changes Take Effect: Immediately
Enables you to add various configuration options for validating or restricting 
the values entered into fields. A regular expression is a pattern of text that 
consists of ordinary characters and special characters. Go to the Microsoft 
website and enter the search phrase “Regular Expression Syntax” for more 
information about regular expressions.
The values that you assign to the configuration option must be in the same 
format as the regular expression. The regular expression indicates the 
characters that are acceptable as input into the field. 
For example, if you want the contact_info field to accept only numbers 0 
through 9, commas, and pound (#) signs, you would add the following option:
Contact Info =^[0-9,#]+$
When you add a configuration option, the name that you assign to it must be 
identical to the name of the field type that appears in Configuration Manager 
that requires the validation.
For example, the field type Contact Info indicates that the contact_info field 
stores contact information.
For information about field types, see Framework 7.6 Configuration Manager 
Online Help.
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force_unload_timeout
Type: Optional 
Default Value: 5 (seconds)
Valid Value(s): Any positive integer of 5 or more
Changes Take Effect: After OCM restarts.
Specifies the timeout, in seconds, between when OCS is requested to unload a 
campaign or a campaign sequence, and when the Unloading status and the 
Force Unload command become available in OCM’s Graphical User Interface. 

Note: This timeout cannot be shorter than 5 seconds. If this option is set to 
less than 5 seconds, OCM automatically increases the value to 5 
seconds.

OCManager Section–Options for Record Prioritization

The following options control record-type prioritization: 
• record_priority 
• default_general_priority

• default_campaignrescheduled_priority 
• default_campaigncallback_priority 

Dynamic Modification

At start-up, OCM sets the prioritization parameters for all campaigns and 
sequence items that are not configured. After that, the user can change these 
values for each campaign individually.
When either Campaign details or Group details is selected, the dialog box 
appears on the Priority pane in the lower-left corner of the OCM user 
interface. If the user assigns an incorrect value or a 0 (zero), the dialog box 
displays the value in red text. 

Note: OCM supports dynamic modification of the parameters for stand-alone 
campaigns. If you assign dynamic modifications to individual 
campaigns, these values apply only during the time that OCM is 
running. Changing the priorities in the dialog box does not change the 
default values for OCM at start-up. The default values are persistent in 
the Configuration Database.

record_priority
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Changes Take Effect: Immediately
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Specifies whether Outbound Contact Manager sends priority-related 
parameters to Outbound Contact Server when sending Load/Start/
OptimizationModeUpdate requests.
If set to yes, true, or on, OCM passed the priority parameters for the given 
Campaign Group or a sequence item to OCS.
If set to no, false, or off, OCM does not pass the priority parameters to OCS.
This option controls the optional Priority dialog box in the OCM user 
interface.
If set to yes, true, or on, the Priority dialog box is displayed.
If set to no, false, or off, the Priority dialog box is not displayed.

default_general_priority
Type: Optional
Default Value: 1;2
Valid Value(s): Any two non-negative integers separated by a semicolon:
<an integer larger or equal to 0> ; <an integer larger or equal to 0> 
Changes Take Effect: Immediately
Specifies the priority of record types and the number of records to fetch for 
dialing.
The two numbers that make up this option’s value are separated by 
semicolons, and they represent two parameters: priority and n_records. 
The first number defines the priority of the record_type; the second number 
specifies the number of records of this type to fetch from the buffer for dialing. 
• In the priority parameter–The value 1 is the highest priority; 0 (zero) means 

do not dial. The recommended values for priority are 0, 1, 2, or 3. 
• In the n_records parameter–A valid value is any positive number or 0. 0 

(zero) means do not dial.
OCS does not dial the record types with a 0 (zero) value for any parameter. If 
the user assigns an incorrect value or a 0 (zero), the dialog box displays the 
values in red text. 

default_campaignrescheduled_priority
Type: Optional
Default Value: 1;1
Valid Value(s): Any two non-negative integers separated by a semicolon–
<an integer larger or equal to 0> ;<an integer larger or equal to 0> 
Changes Take Effect: Immediately
Specifies the priority of record types and the number of records to fetch for 
dialing.
The two numbers that make up this option’s value are separated by 
semicolons, and they represent two parameters: priority and n_records. 
The valid values for this option are similar to the default_general_priority 
option.
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default_campaigncallback_priority
Type: Optional
Default Value: 1;1
Valid Value(s): Any two non-negative integers separated by a semicolon–
<an integer larger or equal to 0> ; <an integer larger or equal to 0> 
Changes Take Effect: Immediately
Specifies the priority of record types and the number of records to fetch for 
dialing.
The two numbers that make up this option’s values are divided by semicolons, 
and they represent two parameters: priority and n_records. 
The valid values for this option are similar to the default_general_priority 
option.

Outbound Contact Server Options
The Outbound Contact Server options are defined in various configuration 
objects. These option descriptions are organized according to configuration 
objects in the following subsections:
• “OCS Application Object Options” on page 180
• “Campaign-Level Options for OCS” on page 186
• “Campaign Group-Level Options for OCS” on page 188
• “Place Group-Level Options” on page 210
• “Field-Level Options for OCS” on page 211
• “Calling List-Level Options for OCS” on page 212
• “Switch-Level Options for OCS” on page 216
• “DN-Level Options for OCS” on page 220

Section Names
The Options tab or Annex tab of the configuration object needs to contain a 
section that is named in one of the following ways:
• <OCS application object name>, which specifies the name of the current 

OCS Application object.
• default.

• OCServer.

Note: Genesys recommends that you define all OCS options only in the 
section folder named OCServer.

When OCS looks for the defined value of an OCS option, it searches the 
sections in a prescribed order until it finds the option in one of the sections. 



Deployment Guide 179

Chapter 8: Outbound Contact Configuration Options Outbound Contact Server Options

The prescribed search order is:
1. OCS searches the designated sections on the Annex tab of the configuration 

object, as follows:
a. <OCS application object name> section
b. default section
c. OCServer section

2. If OCS does not find the option, it follows the same procedure to search in 
the Options tab of its own Application object.

3. If OCS does not find the option, it uses the option’s default value. 

Example of an OCS Option Search

In this example, two different OCS applications (OCS1 and OCS2) work with 
the same switch. The options for each OCS application are defined on the 
Annex tab of the switch configuration object or on the Options tab of the OCS 
Application object.
OCS1 is searching for the outbound_release_action option.
1. Annex tab:

a. OCS1 searches for the outbound_release_action option in the OCS1 
section.

b. If the option is not in the OCS1 section or if there is no section named 
OCS1, OCS1 searches for the option in the section named default.

c. If the option is not in the default section, or if there is no section 
named default, OCS1 searches for the option in the section named 
OCServer.

2. Options tab:
If OCS1 does not find the outbound_release_action option in any of the 
three sections on the Annex tab, it searches the Options tab of its own 
Application object, repeating the search process that it performed on the 
Annex tab.

3. Other:
If OCS1 does not find the outbound_release_action option on the Annex or 
Option tab, it uses the option’s default value (false).

Note: Most Outbound Contact Server options are dynamic. This means that 
the application does not have to be restarted in order for option changes 
to take effect, unless otherwise noted in the option description. 
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OCS Application Object Options

check_dnc_callback
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Enables or disables a special pre-dial check of callback records against the Do 
Not Call (DNC) List. This option applies to the Personal CallBack, Campaign 
CallBack, and Personal Rescheduled record types. The value set for this option 
determines whether a scheduled call is processed or not processed, depending 
at which time the DNC restriction was applied.
If the option is set to yes or true, OCS identifies the record type and, after 
comparing the timestamps, determines whether the DNC restriction was 
applied after or before a customer agreed to a scheduled call from an agent: 
• If after, OCS processes the call.
• If before, OCS does not process the call.
See also “DNC Rule for Scheduled Calls”.
This option works only if the check_dnc_list option is set to true. If you set 
check_dnc_callback to true, it may override check_dnc_list = true for the 
Personal CallBack, Campaign CallBack, or Personal Rescheduled records, 
based on the timestamp comparison.

DNC Rule for Scheduled Calls

The purpose of the Do Not Call (DNC) rule for scheduled calls is to determine 
whether a Personal CallBack, Campaign CallBack, or Personal Rescheduled 
record can be dialed even though the phone number or customer ID on the 
record is on the DNC List. The callback might be permissible, for example, if 
both of the following conditions are met:
• The check_dnc_callback option is set to true, which enables OCS to 

perform a pre-dial check of callback type records.
• The customer had requested a callback before submitting a DNC request.
The algorithm for the pre-dial check is as follows:
1. OCS checks the DNC List to determine whether the record to be dialed is on 

it.
2. If yes, OCS reads the value of the check_dnc_callback option:

If check_dnc_callback = false, OCS marks the record DNC. End of 
pre-dial check.
If check_dnc_callback = true, OCS continues the pre-dial check. 

3. OCS checks the record type:
If the record type is not a callback, OCS marks the record DNC. End of 
pre-dial check.
If the record type is Personal CallBack, Campaign CallBack, or 
Personal Rescheduled, OCS continues the pre-dial check.
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4. OCS checks the time stamp:
If the timestamp of the original call (when the callback was scheduled) 
precedes the timestamp of the DNC request, OCS will dial the callback 
record. End of pre-dial check.
It the timestamp of the original call does not precede the timestamp of 
the DNC request, OCS will not dial the callback record. End of pre-dial 
check.
Figure 13 shows the algorithm for the DNC rule for scheduled calls.

Figure 13: DNC Rule for Scheduled Calls
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customer_id
Type: Optional
Default Value: None
Valid Value(s): <The name of a user-defined field in the calling list to 
serve as a customer identifier for Do Not Call requests>

Specifies a user-defined field in the Calling List table that will serve as a 
customer identifier. 
When this option is not present in the Application object, or if the value of this 
option is the name of a field that does not exist in the Calling List table, OCS 
uses the phone number in order to determine which records cannot be dialed. 

Note: The Field configuration object that is used as the value for the 
customer_id option must specify the send_attribute key-value pair 
listed on its Annex tab. The section name is created according to the 
section naming convention that is described on page 178. The value of 
the send_attribute key-value pair must be GSW_CUSTOMER_ID. For more 
information, see “Attaching Record Information to Desktop and OCS 
User Events” in the Outbound Contact 7.6 Reference Manual.

inbound-agent-assignment-priority
Type: Optional
Default Value: 1
Valid Values: 1 … n

Defines the priority of inbound call activities. It is used when determining 
agent reassignment. As the value increases, the priority for the specified agent 
also increases.

inbound-agent-assignment-min-num
Type: Optional
Default Value: 0
Valid Values: 0 … n
Defines the minimum amount of agents to perform inbound call activities. It is 
used when determining agent reassignment.
When the value is set to 0, there are no restrictions for the minimum amount of 
agents performing inbound call activities. Agents are assigned to inbound call 
activities even when the lowest priority Campaign Groups are understaffed.

num-of-licenses
Type: Optional
Default Value: 0 (all available licenses)
Valid Value(s): String max or an integer from 0 to (9999 + num-sdn-
licenses)
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Specifies how many licenses OCS checks out initially. This option is not OCS-
specific. It is specified in the license section. This option, along with the 
license-file option, pertains to OCS license control. When the value 
increases, OCS will apply the change immediately. When the value decreases, 
it will take effect the next time OCS is started.

license-file
Type: Required
Default Value: None
Valid Value(s): Any string
Specifies the license address. This option is not OCS-specific. It is specified in 
the license section, which is optional. This option, along with the num-of-
licenses option, pertains to OCS license control.
The license address format can be entered in either of the following formats:
• The host name and port of the license server, as specified in the SERVER 

line of the license file, in the port@host format; for example,
7260@ctiserver.

• The full path to, and the exact name of, the license file - for example,
/opt/mlink/license/license.dat.

Note: Changes that you make to this option take effect after an 
application is restarted.

log_call_stats
Type: Optional 
Default Value: no 
Valid Value(s): yes/true or no/false
Specifies whether to create a separate logging subsystem.
• If you set this option to yes or true, OCS creates a separate logging 

subsystem for Audit Logging, in order to capture additional statistics on 
telephony events. 
The separate log file is created in the same directory where the OCS 
application resides. OCS does not overwrite the existing data in this log or 
replace it with new data. The Audit Logging function adds data to a 
cumulative log. When the size of this log file reaches 10 MB, a new log 
file of the same type is created. 

• If you set the option to no, false, or if the option is not present, OCS 
does not create the separate logging subsystem.

user_data_section_name
Type: Optional 
Default Value: None
Valid Value(s): Any valid name for a configuration section
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Enables you to attach additional information as a permanent key-value pairs to 
the UserData attribute for dialing requests, preview records, or interactions.
The value of this option identifies the name of a section that you created on the 
Annex tab of the following configuration objects:
• Calling List
• Campaign Group
• Campaign
• Agent Group or Place Group
• Switch
• OCS application
OCS searches these configuration objects for a section with this value. When 
found, OCS attaches any options that are specified within the section as 
key-value pairs to the UserData attribute for all dialing requests, preview 
records, or interactions that are associated with the configuration object. 
The configuration object that you choose depends on the desired level of 
distribution:
• When you specify an option value that is the section name for a Calling 

List object, the specified data is attached only to calls for that calling list.
• When you configure this option for a Campaign Group object, the specified 

data is attached to calls for all calling lists in the Campaign Group.
You can explicitly identify the type of data to be attached by adding a specifier 
as a prefix to the data (that is, the option's value) for the options listed under 
the section name identified by the user_data_section_name option. When OCS 
finds these specifiers, it converts the data to the specified type. The 4-character 
specifier, though, is removed from the resulting data.
The type specifier descriptions are as follows:
• str:—All characters following this specifier are attached as a string. The 

value can consist of any characters. (Example: By specifying str:String 
example 123, the string value String example 123 is attached.) 

• int:—OCS converts the value that follows this specifier to an integer. The 
value should consist of digits (0 through 9) only and not exceed the 
maximum integer supported by the operating system where OCS is 
running. (Example: By specifying int:2563, the integer value 2563 is 
attached.) 

• bin:—OCS converts the value that follows this specifier to a binary type. 
The value should consist of pairs of hexadecimal numbers separated by 
spaces. (Example: By specifying bin:0A 0D 22 13 33 FF, the binary value 
0A 0D 22 13 33 FF is attached.) 

Note: If no type specifier is included in the data value, the user data pair is 
attached as a string.
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Configuration Example

The following example clarifies the relationship between the 
user_data_section_name option and configuration object sections associated 
with attaching User Data.
If you do the following:
• Configure a section named userdatalist on the Annex tab of the Calling 

List object.
• Within that userdatalist section, configure:

an key-value pair: name=str:premier
an key-value pair: acct=int:1234

• Configure the user_data_section_name option with a value of userdatalist 
in the Options tab of the OCS application object.

When OCS starts processing a specific chain, it searches for the userdatalist 
section among the configuration objects, and when it finds this section name, it 
attaches the two key-value pairs to the User Data for all dialing requests, 
preview records, and interactions associated with this Calling List object. The 
pair with the acct key is attached with the integer value of 1234. The pair with 
the name key is attached with a string value of premier.

How OCS Prioritizes If Different Configuration Objects Contain the Same Section

If there are different configuration objects that contain options in the same 
named sections with the same key and different values, OCS chooses only one 
of them, according to the following priorities:
• Calling List (highest priority)
• Campaign Group
• Campaign
• Agent Group or Place Group
• Switch
• OCS application (lowest priority)
If there are several configuration objects that are used in a particular campaign 
with options that contain different keys, OCS attaches all of these options as a 
list of key-value pairs in the UserData attribute.
If you want to indicate that a particular outbound campaign has a higher 
priority than other campaigns, you can attach a campaign_priority = high 
key-value pair to every call or preview record that OCS generates while 
running this campaign. As an example, you can perform the following steps if 
you want to configure a campaign group to run a campaign called 
Collections90days that uses an OCS application called OCS Western Region:
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1. Choose a section name to store the data that you want to attach, such as 
collection_options. 

2. Create a section with this name on the Annex tab of a Campaign Group 
configuration object. In this section, add an option specifying the key as 
campaign_priority and the value as high. 

Note: If more than one Campaign Group is going to run this campaign, 
configuration objects representing all these campaign groups 
should have this configuration.

3. Configure the user_data_section_name option and set the value to 
collection_options in the OCServer section of the Options tab of the OCS 
Western Region application object.

Campaign-Level Options for OCS
You can set the Campaign level options at the Annex tab of Campaign 
configuration object, using OCServer, default or <OCS Application name> 
section names.
Alternatively, you can set these options in the OCS application object. Changes 
that you make to these options take effect immediately, unless otherwise noted 
in the option description.
OCS can work with many Campaigns. At the Campaign level, you can assign 
different values for each Campaign. When set on the Options tab on the 
application level, the value applies to all Campaigns.
OCS looks first at the Campaign-Level, and the option setting at this level 
overrides the value on the OCS application object Options tab.

callback-observe-group
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Changes Take Effect: Upon loading of the Campaign Group
Specifies whether OCS should select Personal Callbacks and Personal 
Rescheduled records from the Calling Lists based on both the Campaign DBID 
and the Group DBID or just the Campaign DBID. If these records are selected 
based on both DBIDs, then it is guaranteed that they will be processed by the 
same group where agent belonged when these records where initially 
scheduled.
• When set to true, OCS selects them based on the Campaign DBID and the 

Group DBID. 
• When set to false, OCS selects them based on the Campaign DBID only.



Deployment Guide 187

Chapter 8: Outbound Contact Configuration Options Outbound Contact Server Options

Note: A new option for OCS 7.6.101.

check_dnc_list
Type: Optional
Default Value: yes/true
Valid Value(s): yes/true or no/false
Enables or disables a pre-dial check against the Do Not Call list for all types of 
records.
• If you set this option to yes or true or if the option is not defined in the 

configuration, OCS performs a pre-dial check against the Do Not Call 
(DNC) List.

• If this option is set to no or false, OCS dials without performing a pre-dial 
check.

Note: When set to false, OCS also does not check any records that are 
already delivered to an agent's desktop against the phone number (or 
customer_id) in the newly submitted request (by phone or customer_id 
respectively). Therefore, OCS does not issue a RecordCancel 
notification to the desktop.

force-unload-wait-db
Type: Optional
Default Value: false
Valid Value(s): true/yes or false/no
Changes Take Effect: Next time the Campaign Group is unloaded forcefully
Controls how OCS handles requests for a records update sent to the database 
when a Campaign is unloaded forcefully.
• When set to false/no, OCS does not wait for a database response for the 

records update request and terminates the connection to DB Server 
immediately after the last update request is sent. This ensures that the 
Campaign is forcefully unloaded almost immediately. However, this may 
cause some records to be left in the Retrieved state, even though OCS has 
requested that those records be returned to either the Ready state or marked 
as Stale. 

• When set to true/yes, OCS waits for database responses for all update 
requests that were sent before terminating the connection to DB Server. 
This ensures that all records are updated properly in the database. 
However, this may slow down the forced unloading process and keep the 
Campaign Group in an Unloading state longer, depending on the number of 
calling list records in the OCS buffers. OCS holds these records in the 
buffers to properly mark them when unloading a Campaign Group.
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Note: A new option for OCS 7.6.101.

ignore-empty-group
Type: Optional
Default Value: false
Valid Values: true/yes or false/no
Changes Take Effect: Immediately
Specifies how to handle record processing when no agents are logged into 
group.
• When the value is set to false, OCS functions as it did previously and 

retrieves callback/rescheduled records when the scheduled time 
approaches, regardless of agent availability, and does not return any 
records back to the database when a group becomes empty.

• When the value is set to true, OCS behaves as follows:
When the last agent logs out of the group, OCS returns all records 
retrieved for the campaign group back to the calling list with the Ready 
status.
When there are no agents logged into the group, no records of any type 
are retrieved for the campaign group.

Campaign Group-Level Options for OCS
You can set the Campaign Group level options at the Annex tab of Campaign 
Group configuration object, using OCServer, default or <OCS Application 
name> section names.
Alternatively, you can set these options in the OCS application object. Changes 
that you make to these options take effect immediately, unless otherwise noted 
in the option description.
OCS can work with many agent or place groups. At the group level, you can 
assign different values for each group. When set on the Options tab, the value 
applies to all groups.
OCS looks first at the Campaign Group-Level, and the option setting at this 
level overrides the value on the OCS application object Options tab.

agent-assignment
Type: Optional
Default Value: no/false
Valid Values: yes/true or no/false
Controls the ability of the Campaign Group to be used in agent reassignment. 
The value no/false is used for Campaign Groups that have calls distributed by 
the switch and not distributed by Universal Routing Server.
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Note: Unlike other options in this section, this option can only be configured 
in the Campaign Group-Level section.

agent-assignment-priority
Type: Optional
Default Value: 1
Valid Values: 1 … n
Defines the priority of the Campaign Group when determining agent 
reassignment. As the value increases, the priority for the specified campaign 
group also increases.

Note: Unlike other options in this section, this option can only be configured 
in the Campaign Group-Level section.

agent-assignment-min-num
Type: Optional
Default Value: 0
Valid Values: 0 … n
Defines the minimum number of agents in the Campaign Group when 
determining agent reassignment.
When the value is set to 0, there are no restrictions for the minimum amount of 
agents in the Campaign Group. Agents are assigned to this Campaign Group 
even when the lowest priority Campaign Groups are understaffed.

Note: Unlike other options in this section, this option can only be configured 
in the Campaign Group-Level section.

agent-assignment-max-num
Type: Optional
Default Value: 0
Valid Values: 0 … n
Defines the maximum number of agents in the Campaign Group when 
determining agent reassignment.
When the value is set to 0, there are no restrictions for the maximum amount of 
agents in the Campaign Group.

Note: Unlike other options in this section, this option can only be configured 
in the Campaign Group-Level section.
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agent_logout_preview_call_result
Type: Optional
Default Value: -1
Valid Values: -1, 0, 1,...n
Enables OCS to change the call result for Preview, Personal CallBack, or 
Campaign CallBack records that are on an agent’s desktop after receiving an 
EventAgentLogout message from Stat Server.
When the value is -1, OCS updates the record with the previous call result.
When the value is greater than or equal to 0, OCS updates the record in the 
database table with the integer value of this option. In order for Outbound 
Contact Manager to display the call result as a string, the integer value of this 
option must match a call result enumeration value listed in the Outbound 
Contact 7.6 Reference Manual. 

agent_preview_mode_start
Type: Optional 
Default Value: no/false 
Valid Value(s): yes/true, no/false
Enables agents to receive preview records or callbacks as soon as they send a 
PreviewDialingModeStart event. Before sending a personal or group callback, 
Outbound Contact checks the agent’s status, to see whether his or her desktop 
sent PreviewDialingModeStart.

call_answer_type_recognition
Type: Optional 
Default Value: no_am_detection
Valid Value(s): no_progress_detection, no_am_detection, 
positive_am_detection, full_positive_am_detection, 

accurate_am_detection, telephony_preset

Specifies whether answering machine and fax detection are enabled or 
disabled. This option applies only when OCS uses CPD Server. It does not 
apply when OCS uses PBX equipment for call progress detection.
The values are as follows:
• no_progress_detection–Disables call progress detection, and the call is 

transferred as soon as it is established.
• no_am_detection—Disables answering machine detection but detection of 

all other devices is still enabled. 
• positive_am_detection—Enables standard answering machine detection 

(Positive Answering Machine [PAM] mode).

Note: This value only works with tape-based answering machines. It does 
not work with modern digital answering machines.
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• full_positive_am_detection—Enables full positive answering machine 
detection (Full Positive Answering Machine [FPAM] mode).

• accurate_am_detection—Enables or disables detection, based on an 
analysis of the duration of the greeting.

• telephony_preset—Causes the same behavior as the no_am_detection 
value. If the user selects telephony_preset, this value is automatically 
converted to the no_am_detection value.

call_transfer_type
Type: Optional 
Default Value: one_step
Valid Value(s): one_step, two_step
Specifies the transfer type that the dialer will use for the call. It does not apply 
when OCS uses PBX equipment for call progress detection.
The dialer (CPD Server) translates the value one_step as either mute or 
single_step depending on the switch that is being used; check your switch 
documentation.
The value two_step is commonly used to overcome some switch transfer 
issues such as ring splash on a Meridian switch. Ring splash occurs when a 
dialer transfers a connected call to an agent, and the caller hears a ringback 
before he or she hears the agent answer. For some switches, this ringback 
cannot be turned off, either by a command in the CTI link or by a switch 
setting. 
As a workaround to this situation, Genesys uses a two-step transfer. In a two-
step transfer, the switch puts the original leg of the call on hold and starts to 
initiate a transfer. For a moment, the caller hears silence or music depending 
on whether the music on hold feature is enabled on the trunk or queue. For the 
second leg of the call, the Origination DN (usually a queue), as defined in the 
Campaign Group, is dialed. The transfer process is complete when an agent 
answers the call. The call_wait_in_queue_timeout option on page 192 is a 
timer and the value determines how long the call should wait (in the queue) 
before an agent answers. If the timer expires, the dialer drops the call, and the 
record is marked with the call result Dropped.

Note: Genesys recommends turning off the music on hold feature on the 
trunk or queue when using a two-step transfer.

call_timeguard_timeout 
Type: Optional
Default Value: 0 (milliseconds)
Valid Value(s): 0...<N> (milliseconds) 
Enables a user to set a timeout for post-connect call progress detection. The 
call is transferred to a queue when the timeout expires, regardless of the call 
result or the completion of call progress detection. The timeout is calculated 
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from the moment that CPD Server receives an EventEstablished message. If 
this option is set to 0 (zero) or if it is not present, CPD Server does not break 
call progress detection.
This option applies only when OCS uses CPD Server. It does not apply when 
OCS uses PBX equipment for call progress detection.

call_wait_agent_connected_timeout
Type: Optional 
Default Value: 6 (seconds)
Valid Value(s): Any positive integer
Specifies the timeout, in seconds, between call dialing and when the agent 
answers the call. 
This timeout applies only to engaging calls in ASM mode; that is, calls that 
engage an agent before the customer answers. If the agent answers the call, the 
agent is seized for that call. The value of this option indicates how long to wait 
for an agent to be seized after dialing that agent. 
This option applies only when OCS uses CPD Server. It does not apply when 
OCS uses PBX equipment for call progress detection.

call_wait_connected_timeout
Type: Optional 
Default Value: 120 (seconds)
Valid Value(s): 0-7200 (seconds) 

Note: Set the value between 6 and 99 when using the Aspect switch 
classification board. The default value of 120 causes the 
RequestMakePredictiveCall requests sent by OCS to fail because the 
switch accepts only two digit values. 

• For ISDN: Specifies the timeout, in seconds, between dialing and the 
determination that the called party is not answering.

• For analogue and line-side DNs: Specifies timeout between the first ring 
and the determination that the called party is not answering.

Note: If calls are dialed through the T-Server, the value of this option is 
passed to the T-Server as an AttributeTimeout in the 
MakePredictiveCall message. The timeout value received in the 
request has a higher priority than T-Server's own options, and it is used 
to set up the duration of the No Answer interval on the switch. 

call_wait_in_queue_timeout
Type: Optional 
Default Value: 10 (seconds)
Valid Value(s): Any positive integer
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Specifies the maximum amount of time, in seconds, that an outbound call is 
allowed to stay in a queue. This option applies only when OCS uses 
CPD Server. 
Note that, after this timeout expires, the call can be released by CPD Server 
only when the two-step transfer is used (see the call_transfer_type option on 
page 191), and CPD Server has control over the consult leg of the transferred 
call.

call_wait_original_establish_timeout 
Type: Optional 
Default Value: 4 (seconds)
Valid Value(s): Any positive integer
Specifies the timeout, in seconds, between the end of a positive call progress 
detection response from Dialogic—such as Answer, Answering Machine (AM), 
or Cadence Break—and an EventEstablished from T-Server. 
This option applies only when OCS uses CPD Server. It does not apply when 
OCS uses PBX equipment for call progress detection.

campaign-callback-distr
Type: Optional
Default Value: random
Valid Value(s): random, equal-from-zero, or equal-from-avg
Changes Take Effect: Immediately
Specifies how campaign callbacks are distributed to agents when the 
predictive_callback option is set to false and campaign callback notifications 
are distributed as UserEvents.
The option values that define this distribution are as follows:
• For the random value, OCS randomly distributes callbacks between eligible 

agents, as it did previously.
• For the equal-from-zero or equal-from-avg values, OCS monitors the 

actual number of campaign callbacks distributed to each agent in the 
campaign group from the moment the campaign is loaded until it is 
unloaded. When OCS needs to distribute new campaign callback, it selects 
an agent who has processed the fewest number of campaign callbacks 
since the campaign group was loaded. If two or more agents have 
processed the same minimum number, an agent is selected randomly from 
among them.
If an agent logs out of the group, OCS clears the agent's history, including 
the number of callbacks processed. When an agent logs into the group, 
OCS assigns the number of callbacks processed by this agent, as follows:

If you set the value to equal-from-zero, OCS assigns 0 as the number 
of callbacks processed.
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If you set the value to equal-from-avg, OCS assigns the average 
number of callbacks processed by agents in the group. You might use 
this value in a scenario where an agent logs in for the first time at mid-
day and want to ensure that all agents receive callback requests. 
Otherwise, this new agent would receive all requests until he or she 
reached the group average.

CPN Options CPNType
Type: Optional
Default Value: 0
Valid Value(s): 0 - 7 
Specifies the decimal representation of the Type of Number code.

CPNPlan
Type: Optional
Default Value: 0
Valid Value(s): 0 - 15 
Specifies the decimal representation of the Numbering Plan code.

CPNPresentation
Type: Optional
Default Value: 0
Valid Value(s): 0 - 3 
Specifies the decimal representation of the Presentation Indicator code.

CPNScreening
Type: Optional
Default Value: 0
Valid Value(s): 0 - 3 
Specifies the decimal representation of the Screening Indicator code.

CPNDigits
Type: Optional
Default Value: Empty string
Valid Value(s): String of characters, according to the formats specified in the 
appropriate numbering/dialing plan.
Specifies the Calling Party Number (CPN).

Note: Starting with release 7.6, this option value is also passed to OBN 
Manager in the Power GVP dialing mode.

For more information about the Caller ID Support feature and the CPN 
options, see the following resources:
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• Extensions related to TMakePredictiveCall() in the “Extensions” section of 
the “Unstructured Data” chapter in the Genesys Developer Program T-
Library SDK Developer's Guide, 7.6

• Framework 7.6 T-Server for Alcatel A4400/OXE Deployment Guide
• Framework 7.6 T-Server for Avaya Communication Manager Deployment 

Guide
• Q.931 ISDN user-network interface layer 3 specification for basic call 

control

dialer-ttl
Type: Optional
Default Value: 5
Valid Values: 3 - 1440
Specifies the Time To Live (in minutes) during which OBN Manager will 
attempt to pass a request to the GVP dialer (IPCS or VCS) for a dial from it's 
internal dialing queue. 

Note: This option is used with OBN Manager in Power GVP dial mode only.

dialer-num-attempts
Type: Optional
Default Value: 3
Valid Values: 1 - 25
Specifies the number of attempts that OBN Manager will attempt to pass a 
request to the GVP dialer (IPCS or VCS) for a dial from it's internal dialing 
queue.

Note: This option is used with OBN Manager in Power GVP dial mode only.

dialing_rate_limit
Type: Optional
Default Value: 100
Valid Value(s): 0 - N 
Specifies the maximum number of dialing requests per second. If option is set 
to 0 (zero), then OCS does not dial at all.

direct-personal-callback
Type: Optional
Default Value: true
Valid Values: true/yes or false/no
Controls how personal callback records of type are processed.
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• When the value is set to true, OCS will submit the personal callback 
interaction directly to the agent.

• When the value is set to false, OCS will submit the personal callback 
interaction to an interaction queue assigned to the Campaign Group. This 
allows the Universal Routing Server strategy to distribute this interaction.

Note: This option is used with Interaction Server in Push Preview dial mode 
only.

divert_to_unknown_dn
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Specifies OCS's reaction to a EventDiverted with either an unknown 
ThirdPartyDN or without an agent logged in to it.
• If set to no or false, immediately upon receiving this type of 

EventDiverted, OCS updates the record with the call result Stale and the 
record status Agent Error.

• If set to yes or true, OCS does not update the record, and continues to 
monitor the outbound call.

Notes: If a call is diverted to a DN, on which OCS has not been registered, 
then the corresponding record will not be updated in a calling list upon 
call release. Instead, it will stay in a Retrieved status until the timer set 
by the stale_clean_timeout option expires.
In release 7.5 and higher, an “unknown DN” is a DN that is either 
excluded from any Place object, or is included in a Place object but the 
Place object does not have an associated agent. An agent is associated 
to a Place object when a campaign group that is configured with this 
agent is activated within OCS.

history_length
Type: Optional 
Default Value: 30
Valid Value(s): any positive integer from 30 to 300
Specifies the point at which OCS switches from Progressive mode to 
Predictive mode, and begins collecting the call history for the purpose of 
making predictive statistics. 
Outbound Contact Server always starts a campaign in Progressive mode to 
collect call flow statistics for the predictive dialing algorithm. It counts the 
number of completed (answered) outbound calls that it has placed, and turns 
on Predictive mode when the number exceeds the value of history_length. 
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By default, OCS switches from Progressive mode to Predictive mode when 
the agent completes the 30th successful outbound call.
For large agent groups (approximately 1000 agents), Genesys recommends 
that you set the value of history_length to 100 or higher, and that you also 
control the number of CPD ports.
These settings help maintain the target busy factor and minimize the number of 
abandoned calls in large agent groups.

inbound_agent_outlier_limit
Type: Optional
Default Value: 600 (seconds)
Valid Value(s): Any non-negative integer
Specifies the minimum amount of inbound call time before an agent's status 
changes to Not Available. If an agent is busy with an inbound call longer than 
the specified value (including the After Call Work state), then the predictive 
algorithm does not consider this agent available when calculating the number 
of predictive calls.

ivr-profile-name
Type: Optional
Default Value: NULL
Valid Values: 1… n
Populated after a nine-digit value is entered in the IVR Profile field in the 
Advanced tab of Campaign Group configuration object. The value itself is the 
IVR Profile DBID that is specified in the GVP EMPS IVR Profile.

outbound_agent_outlier_limit
Type: Optional
Default Value: 600 (seconds)
Valid Values: Any non-negative integer
Specifies the minimum amount of outbound call time before an agent's status 
changes to Not Available. If an agent is busy with an outbound call longer than 
the specified value (including the After Call Work state), then the predictive 
algorithm does not consider this agent available when calculating the number 
of predictive calls.

Note: When the new 7.6.1 predictive-longcalls-truncation option 
(page 203) is configured, this outbound_agent_outlier_limit is not 
taken into account by OCS.

pa-dial-expire
Type: Optional
Default Value: 2
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Valid Values: 1 - 6000
Specifies the timeout (in minutes) that the predictive algorithm uses to clean up 
calls that are in a Dialed state. If an outbound call is dialed, and no further 
events about this call are received by the predictive algorithm within the 
timeout specified, the call will not be included when predicting the next call.

pa-handle-expire
Type: Optional
Default Value: 30
Valid Values: 1 - 6000
Specifies the timeout (in minutes) that the predictive algorithm uses to clean up 
calls that exist on an agent's desktop. If an outbound call is dialled and is 
delivered to an agent, and no further events are received about this call are 
received by the predictive algorithm, the call will not be included when 
predicting the next call.

pa-handle-time-consider
Type: Optional 
Default Value: 1800 (seconds)
Valid Value(s): Any positive integer
Specifies the maximum call duration for all call types when calculating the 
average call duration. If a call’s duration (including the After Call Work state) 
is more than the specified value, then the predictive algorithm does not include 
this call duration when calculating the average call duration.

pa-selfcheck-awt-threshold
Type: Optional 
Default Value: 10 (percent)
Valid Value(s): integer >=1
Changes Take Effect: Immediately
Specifies the percentage of the target Average Waiting Time that the predictive 
algorithm (PA) uses as the threshold to report a dialing performance 
degradation. If the difference between the current and the target Average 
Waiting Time is less than the percentage of the expected Average Waiting 
Time, the PA does not make a report. Otherwise, the PA reports the 
degradation only if a suspicious condition is detected for the Average Waiting 
Time.
For more information what a suspicious condition might be, see “Predictive 
Algorithm Self-diagnostic” on page 54.

Note: A new option for OCS 7.6.101.
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pa-selfcheck-bf-threshold
Type: Optional 
Default Value: 10 (percent)
Valid Value(s): integer >=1
Changes Take Effect: Immediately
Specifies the percentage of the target Busy Factor that the PA uses as the 
threshold to report a dialing performance degradation. If the difference 
between the current and the target Busy Factor is less than the percentage of 
the expected Busy Factor specified in this option, the PA does not make a 
report. Otherwise, the PA reports the degradation only if a suspicious condition 
is detected for the Busy Factor.
For more information what a suspicious condition might be, see “Predictive 
Algorithm Self-diagnostic” on page 54.

Note: A new option for OCS 7.6.101.

pa-selfcheck-interval
Type: Optional 
Default Value: 20 (minutes)
Valid Value(s): integer >=2
Changes Take Effect: Immediately
Specifies the time interval, in minutes, that the PA uses to calculate the current 
values of the optimization parameters and to track any suspicious condition for 
reporting dialing performance degradation.

Note: A new option for OCS 7.6.101.

pa-selfcheck-odr-threshold
Type: Optional 
Default Value: 20 (percent)
Valid Value(s): integer >=1
Changes Take Effect: Immediately
Specifies the percentage of the target Overdial Rate that the PA uses as the 
threshold to report about a dialing performance degradation. If the difference 
between the current and the target Overdial Rate is less than the percentage of 
the expected Overdial Rate, the PA does not make a report. Otherwise, the PA 
reports the degradation only if a suspicious condition is detected for the 
Overdial Rate.
For more information what a suspicious condition might be, see “Predictive 
Algorithm Self-diagnostic” on page 54.

Note: A new option for OCS 7.6.101.
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predictive_algorithm
Type: Optional 
Default Value: small_group 
Valid Value(s): classical, small_group, advanced_small_group
Changes Take Effect: Immediately

Note: A new valid value, advanced_small_group, was added to release 7.6.1.

Controls which predictive algorithm (PA) OCS uses for dialing outbound calls 
when a campaign is running in the Predictive or Predictive with seizing 
dialing mode. The values function as follows:
• classical—OCS uses the classical predictive algorithm based on 

classical queuing theory, regardless of the current number of available 
agents and the optimization parameter that are used.

• Small group values: These two values are optimized for small groups of 
agents. Either of these values can be used if the Overdial Rate is specified 
as an optimization parameter and the number of available agents does not 
exceed the number set in the small_group_size option (see page 208). If 
the number of agents exceeds the number set in the small_group_size 
option, OCS uses the classical predictive algorithm. Also see “Predictive 
Dialing Modes for Small Groups” on page 54.
The two small group values include:

small_group—OCS uses a small group predictive algorithm, which 
waits until all dialed calls are completed before dialing new calls.
advanced_small_group—OCS uses an advanced predictive algorithm. 
This option value activates the new and improved predictive algorithm 
for small groups of agents. The advantages of this new algorithm 
include:

It better tracks inbound calls, because it counts inbound calls that 
are at all stages of processing and not just those that are queued.
It allows outbound calls to be initiated, even if one or more calls 
remain in the dialing stage, rather than waiting until all dialed calls 
are completed.

Using the advanced_small_group value may result in busier agents, as 
the Busy Factor increases or the waiting time between calls reduces for 
agents for the same Overdial Rate.
This value can be set in conjunction with the time-to-ready-tolerance 
option (see page 208).

predictive_callback
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies how Outbound Contact Server handles a Campaign Callback. 
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• If this option is set to yes or true in Predictive or Progressive modes, OCS 
automatically dials callbacks.

• If this option is set to yes/true in Preview mode, OCS puts records that are 
scheduled as Campaign Callback in the preview records list, and delivers 
them to the agent’s desktop upon receipt of a PreviewRecordRequest.

If this option is set to no or false, OCS delivers records scheduled for callback 
directly to the agent’s desktop through a UserEvent regardless of the dialing 
mode. The agent then decides whether or not to dial this record. If the desktop 
application is not capable of processing preview records and this record 
remains on the agent’s desktop, OCS marks the call result of the record as 
stale when the timer set by the stale_clean_timeout option expires. Figure 14 
illustrates how Outbound Contact Server handles a Scheduled Call during a 
predictive or progressive campaign.

Note: See the “Communication Protocols” chapter of the Outbound Contact 
7.6 Reference Manual for information the events distributed when 
rescheduling records.
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Figure 14: Scheduled Call During a Predictive or Progressive Campaign
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predictive_hot_start
Type: Optional
Default Value: false
Valid Value(s): yes/true or no/false
Specifies how OCS uses predefined statistical data in certain circumstances.
If this option is set to yes or true, OCS uses the predefined statistical data to 
start predictive dialing, without first using the preliminary dialing in 
Progressive mode.This predefined statistical data will be taken from the 
following options: predictive_hit_ratio, 
predictive_outbound_call_duration, predictive_inbound_rate, and 

predictive_inbound_call_duration.

predictive_hit_ratio
Type: Optional
Default Value: 75
Valid Value(s): 1 - 100 
Specifies the Starting Value for Hit Ratio, as a percentage (%).

predictive-longcalls-truncation
Type: Optional 
Default Value: false
Valid Value(s): false/no or true/yes
Changes Take Effect: Immediately

Note: This option is new to release 7.6.1.

Instructs the predictive algorithm how to handle so called “long” outbound 
calls, (that is, if a few outbound calls last significantly longer than the majority 
of the outbound calls for the given campaign group). Although these “long” 
calls happen rarely, they are taken in the account by the predictive algorithm 
when average call duration is calculated. As a result, these long calls will 
increase the average call duration, negatively affecting the dialing efficiency.
When this option is set to true, the predictive algorithm truncates the length of 
time associated with these calls when calculating the average call duration, 
which may positively effect the predictive dialing efficiency.

Notes: 
• When configured, this option has a higher priority than the 

outbound_agent_outlier_limit option (see page 197).
• This option only applies to outbound calls.

predictive_outbound_call_duration
Type: Optional
Default Value: 120
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Valid Value(s): 1 - N 
Specifies the starting value for the average outbound call duration, in seconds.

predictive_inbound_rate
Type: Optional
Default Value: 0
Valid Value(s): 0 - N 
Specifies the starting value for the average number of inbound calls, per hour.

predictive_inbound_call_duration
Type: Optional
Default Value: 300
Valid Value(s): 1…N 

Specifies the starting value for the average inbound call duration, in seconds.

predictive_max_overdial_rate
Type: Optional
Default Value: 0
Valid Value(s): Number between 0 and 100 in decimal format (i.e. 3.55)
Specifies the maximum allowed overdial rate for dialing in Predictive mode. 
If the current overdial rate of a running campaign exceeds this value, OCS 
switches the dialing mode from Predictive to Progressive. When the current 
overdial rate falls below this value, OCS switches the dialing mode from 
Progressive to Predictive. 
This checking of the limit is performed separately from all predictive 
optimization parameters; that is, overdial rate, busy factor and average waiting 
time.
If this option is set to 0 (zero) or 100, OCS does not perform separate control 
of the overdial rate.

progressive_blending_reserved_agents
Type: Optional 
Default Value: 0
Valid Value(s): Any non-negative integer
Enables OCS to keep a specified number of agents who are in the Progressive 
dialing mode available for inbound traffic or some other non-outbound 
activity. 
Outbound Contact initiates the next outbound call when both of the following 
are true:
• There is at least one ready agent.
• The total number of ready or busy non-outbound agents exceeds the value 

of the option.
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The agent is treated as busy outbound when he or she is in the BusyOutbound, 
BusyPaper, or BusyRinging state.
All other states except the Ready state are treated as non-outbound.
The following is an example of how this option works.
An agent group has a total of four agents: 
• One agent is in the BusyInbound state.
• One agent is in the BusyOutbound state.
• Two agents are in the Ready state.
At this time, the progressive_blending_reserved_agents option is set to 2. As 
a result, OCS sends one outbound call.

progressive_blending_reserved_status
Type: Optional
Default Value: all_seized_inbound
Valid Values: all_seized_inbound, ready
Specifies how agents are reserved for outbound calls.
• If progressive_blending_reserved_status is set to all_seized_inbound, 

OCS reserves all agents that do not have any of the following outbound 
statuses: BusyOutbound, BusyPaper, NotReady, and BusyRinging. This value 
is similar to the progressive_blending_reserved_agents option 
functionality in OCS 7.x

• If progressive_blending_reserved_status is set to ready, OCS reserves 
only those agents who are in Ready status. This value is similar to the 
progressive_blending_reserved_agents option functionality in OCS 6.5, 
which kept a specified number of reserved agents who were in progressive 
dialing mode available for inbound traffic. In this scenario, OCS waited 
until more than the specified number of reserved agents were in the Ready 
status before initiating the next outbound call.

public_network_access_code
Type: Optional
Default Value: NULL
Valid Value(s): Any character string
Specifies the string that is added as a prefix to each phone number that OCS 
sends to a specific switch. The phone numbers in the call UserData remain 
unchanged. This number specifies the PSTN access code for the switch to 
which T-Server is connected. When an access code is added as a value, the 
system always places the access code in front of the phone number that is 
dialed. For example, if you set the value 9 into the value field, then the prefix 9 
is always dialed before each phone number. 
If you are using the Outbound Contact Wizard, it prompts you to enter a value 
for this option. To accept the default value for this option, click the Cancel 
button on the wizard screen.
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You can add Dialogic dialing control parameters as a prefix to the dialed 
numbers from a calling list. When combined with the string defined for the 
public_network_access_code option, Dialogic dialing control symbols (prefix) 
determine the dialing time. 
The following Dialogic symbols are available:
• L—Wait for the local dial tone before dialing
• I—Wait for the international dial tone before dialing
• X—Wait for the special dial tone before dialing
• , (comma)—Pause 2 seconds
For example, suppose that the public_network_access_code is defined as L9. In 
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then 
dial the number from the calling list.

Notes: Dialing control parameters work only if the CPD Server dials the calls 
through the Dialogic card (tscall=false).
This option can be set at three levels: Switch/Application (which has 
the lowest priority), Campaign Group (which has a medium priority), 
and Calling List (which has the highest priority).

record_processed
Type: Optional 
Default Value: true
Valid Value(s): yes/true or no/false 
Specifies whether OCS or the agent will update the calling list record when 
completed.
• If record_processed is set to true or yes, Outbound Contact waits for a 

RecordProcessed request from the agent handling the calling list record. A 
RecordProcessed request is mandatory from the desktop application to 
Outbound Contact Server. This request informs OCS that the agent has 
finished with this call record and that OCS can update the database with 
the final information about the call record. 

Note: If an agent changes his or her state (such as EventAgentReady or 
EventAgentLogout), OCS treats the agent state as ReleaseNextCall 
or LoggedOut. The change in agent state informs OCS that the agent 
has finished with this call record, and that OCS can update the 
database with the final information about the call record. OCS can 
change an internal agent state after it receives EventReleased from 
the T-Server.

• If record_processed is set to false or no, Outbound Contact will assume 
that the record is processed when the agent or customer releases the call; 
that is, when OCS receives a EventReleased message for this call, or when 
it receives an EventLogout message for the agent who handled the call. 
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Usually false is used when agents in an Outbound campaign do not have 
desktop phone applications and therefore cannot send the RecordProcessed 
event.

This option is used only in Predictive and Progressive dialing modes. In 
Preview dialing mode, Outbound Contact Server updates a record only after 
receiving a RecordProcessed event from a desktop, regardless of whether the 
record_processed option is set to true or false. 

Note: The desktop can send multiple UpdateCallCompletionStats requests to 
Outbound Contact Server to update the record before sending the final 
RecordProcessed request. UpdateCallCompletionStats requests are 
stored in OCS memory and are not recorded into the Calling List 
Record database until the RecordProcessed request is received.

For more information, see “Updating Genesys Mandatory Fields and Custom 
Fields” in the Outbound Contact 7.6 Reference Manual.

record_save_intermediate_results 
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies whether the calling list should be updated with intermediate dialing 
results during the lifetime of a calling list record.
• If the value is set to yes or true, the Calling List table is updated with 

intermediate dial results for each calling list record after each dial attempt. 
OCS writes the following information to the database: call result, 
scheduled time, number of attempts, and other data that is pertinent for 
treatment redials and for calls that are rescheduled by an agent.

• If the value is set to no or false (default), OCS updates the record in the 
Calling List table with the final result only. Only the information about the 
last treatment application result is recorded for each record before the 
record is deleted from OCS memory.

remote_release_action
Type: Optional 
Default Value: error
Valid Value(s): error, no_contact, abandoned
Specifies how OCS handles calls with the call result of RemoteRelease. 
• If set to error (default), OCS processes the call as if OCS has received an 

EventError. The call result is RemoteRelease. The dialing rate does not 
change.

• If set to no_contact, OCS processes the call as if no contact has been made, 
as with call results Busy and NoAnswer. OCS decreases the Hit Ratio. The 
call result is RemoteRelease.
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• If set to abandoned, OCS processes the call as if the customer has hung up. 
OCS increases the abandoned rate when the call result is Abandoned.

small_group_size
Type: Optional
Default Value: 7
Valid Values: Any non-negative integer (0 - n)

Note: In release 7.6.1, the maximum value limit of 50 agents was removed.

Specifies the maximum number of available agents in a group that can be 
treated by OCS as a small group, and therefore have a special type of 
predictive algorithm applied.
If the current number of available agents in the group is less than or equal to 
this option's value, OCS uses a predictive algorithm specially optimized for 
small groups of agents for campaigns that use this group. This algorithm may 
provide better optimization results than the general predictive algorithm in 
some campaigns if the number of active agents is relatively low.

Note: OCS considers this option's setting only when all of the following are 
true:

The campaign is running in Predictive or Predictive with seizing 
dialing modes.
The Overdial Rate is used as optimization parameter.
The predictive_algorithm option (see page 200) is set to the 
small_group or the advanced_small_group value.

stale_clean_timeout
Type: Optional 
Default Value: 30
Valid Value(s): Any positive integer
Specifies a timeout (in minutes) before OCS marks any records that remain in 
the buffer as Stale. Such records may have been sent for processing, but were 
not processed.

time-to-ready-tolerance
Type: Optional
Default Value: 2 sec
Valid Value(s): Any positive integer of 2 sec or more
Change Take Effect: Immediately

Note: This option is new to release 7.6.1.
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Specifies the allowed variance on the time estimate for when an agent will 
become Ready.
OCS uses the value for this option in its calculations to determine whether an 
agent delivers correct (or “trusted”) estimations on when the agent will 
complete the processing of the given call and become Ready. The calculations 
are based on information provided by the agent desktop to OCS about each 
agent. For more information on trusted versus distrusted agents, see 
“Predictive Dialing Modes with Agent Feedback” on page 53.

Note: OCS uses this information to further improve the dialing efficiency in 
Predictive modes; for example, to increase the Busy Factor for a given 
value of the Abandon Rate.

transfer_to_unknown_dn
Type: Optional
Default Value: no /false
Valid Value(s): yes / true or no / false
Specifies OCS’s behavior when an outbound call is transferred to an unknown 
DN.
This is important in multi-site group deployments, because OCS cannot 
properly resolve the destination DN. This option prevents OCS from treating 
such transfers as transfers to an unknown DN.
• If set to no or false, immediately after the transfer is completed, OCS 

updates the record with the call result Stale and the record status Agent 
Error.

• If set to yes or true, OCS does not update the record, and it continues to 
monitor the outbound call.

Notes: If a call is transferred to a DN that OCS has not registered, the record 
will not be updated in the calling list upon call release and its status 
will remain Retrieved until the timer set by the stale_clean_timeout 
option expires.
In release 7.5 and higher, an “unknown DN” is a DN that is included in 
a Place object, but this Place object does not have an associated agent. 
An agent is associated to a Place object when a campaign group that is 
configured with this agent is activated within OCS.

vtd-override
Type: Optional
Default Value: none
Valid Value(s): any string representing a valid DN name
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Defines the name of the Voice Transfer Destination (VTD) DN that OCS sends 
to CPD Server in the extensions of RequestSeizeAgent and 
RequestMakePredictiveCall.When CPD Server receives it, that number will be 
used as destination number where an engaging call is delivered and for the 
T-Server registration as the Voice Transfer Destination (VTD) DN.
If this option is not configured, OCS does not add the corresponding key-value 
pair in to RequestSeizeAgent and RequestMakePredictiveCall extensions and 
CPD Server takes the destination number from the Voice Transfer Destination 
DN configured for the Campaign Group.

Note: A new option for OCS 7.6.101.

Place Group-Level Options
The following options can be set in the Annex tab of Place Group configuration 
object only. The options determine if OCS provides simplified resource 
availability management for IVR groups. This model does not require agent 
login to DNs that are assigned to Places in this group.

ivr_group
Type: Optional
Default Value: false
Valid Value(s): true/yes, or false/no 
Configuration Object: Place Group (only)
Specifies whether OCS provides simplified resource availability management 
for IVR groups.
When this option is set to true or yes, OCS uses the simplified resource 
availability model when running a campaign for a Campaign Group linked to 
this Place Group. Places in that group can contain DNs of type Position, 
Extension, or Voice Treatment Port.

Note: Changes that you make to this option take effect only after OCS 
reloads a campaign.

ivr_update_on_release
Type: Optional
Default Value: false
Valid Value(s): true/false, yes/no
Configuration Object: Place Group (only)
Enables OCS to update the calling list record with values from the outbound 
call’s UserData.
When this option is set to true or yes, OCS updates the fields from the calling 
list record with values from the corresponding UserData key-value pairs that 
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are received in the EventReleased message. This is similar to 
UpdateCallCompletionStats UserEvent processing.

Note: The true or yes value for this option takes effect only when the 
ivr_group option is set to true or yes.

Field-Level Options for OCS
You set the following options on the Annex tab of the Field object. They are 
stored in a section folder called OCServer or default. 

send_attribute
Type: Optional
Default Value: ‘’
Valid Value(s): Any name that Outbound Contact Server can use as a key in a 
key-value pair in UserData.
OCS sends the data attached to a call (UserData) as a key-value pair. The value 
of this option defines the key in the pair. The value of the field is the value of 
the pair. For example, a user-defined field LastName may have the 
send_attribute option with name in the Option Value field. OCS attaches the 
key value pair name = <LastName> to the UserData. Suppose the <LastName> in a 
record is Smith. When OCS processes this record, it attaches the UserData name 
= Smith to a call. 
The value of this option should not be an empty string (string of length 0). 
Also, all fields should have different values for this option in order to 
distinguish them from UserData.
For additional information on attaching field values using this option, see 
“Attaching Record Information to Desktop and OCS User Events” in the 
Outbound Contact 7.6 Reference Manual.

icon_attribute
Type: Optional
Default Value: 0
Valid Value(s): 0,1,2
Defines how the field’s value will be stored by ICON.
• If set to 0, ICON will not store the value of this field.
• If set to 1, ICON will use a non-secured table.
• If set to 2, ICON will use a secured table.

Note: The options send_attribute and icon_attribute should be configured 
for user-defines fields in order for ICON to store the field’s value.
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GIM requires the following two options to be configured in order to calculate 
metrics: “right_person” and “conversion.”

right_person
Type: Optional
Default Value: ‘’
Valid Value(s): Any value that can be stored in the field that this option is 
configured for
Marks the field that indicates that the answered call was with the proper 
contact. If it is updated with a value equal to what is configured in this option's 
value, it will be recognized by GIM as a right person contact indicator.

conversion
Type: Optional
Default Value: empty
Valid Value(s): Any value that can be stored in the field for which this option 
is configured
Marks the field that indicates that the answered call was a successful 
transaction. If it is updated with a value equal to what is configured in this 
option's value, it will be recognized by GIM as a conversion indicator.

Warning! Each of these two options should be specified for only one field 
within a calling list.

Calling List-Level Options for OCS
You can set the following options as configuration objects on the Options tab 
of the Outbound Contact Server Application object, or they can be stored at 
the Calling List level. 
The folder(s) can be named as follows:
• OCServer

• default

• <OCS application object name> (see page 178)
OCS can work with many calling lists. At the Calling List level, you can 
assign different values for each calling list. When set on the Options tab, the 
value applies to all calling lists. OCS looks first at the Calling List level. 
When set at this level, this value overrides the value on the Options tab.

am-detection-map
Type: Optional
Default Value: NULL
Valid Values: Any name of a Business Attribute value configuration object, 
or default
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Specifies the name of the Business Attribute value configuration object that 
contains the AM-detection map to be used for a particular Calling List or to be 
used application-wide. See “Per-record Basis” on page 290 for more 
information.

interaction-media-type
Type: Optional
Default Value: outboundpreview
Valid Values: Any valid value for the media type business attribute
Defines the media type of the interaction submitted to Interaction Server.

treatment_sched_threshold
Type: Optional
Default Value: 30 (minutes)
Valid Value(s): Any positive integer
Determines the threshold for OCS to either:
• Keep rescheduled chains in its memory.
• Remove rescheduled chains from its memory and return them to the 

database in the Ready status. OCS will store the treatment application 
history information so that it can continue to processing the chains at the 
scheduled time.

If the difference between the current time and the scheduled time exceeds the 
specified value, OCS will:
• Remove the chain from memory.
• Update it in the database as Ready.
• Store the treatment’s application history info in a calling list's treatments 

field for each record in this chain.
OCS retrieves this chain back into memory shortly before the scheduled time 
of the next attempt and continues processing the chain of records in treatment 
sequence.
If the value is 0, this functionality is disabled and prevents OCS from removing 
rescheduled chains from its memory until the campaign is stopped and 
unloaded.

campaign_name_field
Type: Optional 
Default Value: ''
Valid Value(s): A valid field name from the Calling List table with an 
appropriate data type to store the campaign name.
All calling list records in Outbound Contact Manager and the Calling List table 
include the campaign name and the campaign ID. OCS stores the campaign 
name in a user-defined field in the Calling List table. This option specifies the 
name of that field in the Calling List table.
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If the value of the campaign_name_field option is any string (not an empty 
string), when OCS updates the campaign_id field with the DBID of the 
campaign, it also updates the field specified by this value with the name of the 
campaign.

Warning! Misuse of this option can cause statements from OCS to fail on a 
SQL Server.

dial_log_destination
Type: Optional 
Default Value: none (no logging)
Valid Value(s): <directory path>
Specifies the path to the directory that stores a log for the calling list. 
You can put this option in the OCS Application object or in a specific list. 
OCS first looks for the option in the OCServer section on the Annex tab of a 
list. If it does not find the option there, it looks on the Option tab (OCServer 
section) of the Application object. If OCS still does not find the option, then 
OCS does not maintain a log for the list. For additional information, see “Log 
Options Defined” on page 264.

dial_log_delimiter
Type: Optional 
Default Value: ‘’
Valid Value(s): Any character combination
Specifies the delimiters that are used between the fields of the log for the 
calling list. Because the flat files are produced for this option, delimiters must 
be added to the log. The default value is an empty string. If the value of the 
option is an empty string (string length of 0), the ASCII TAB character (code 
9) is used. 
You can put this option in the OCS Application object or in a specific list. 
OCS first looks for the option in the OCServer section in the Annex tab of a list. 
If it does not find the option there, it looks on the Option tab (OCServer section) 
of the application object. For additional information, see 
“Log Options Defined” on page 264.

dial_log_buffer
Type: Optional 
Default Value: 16384 (bytes)
Valid Value(s): 2 - 32768
Specifies the size of the buffer used for the Record History Log file output, and 
the frequency within which OCS updates the History Log file.
The smaller the setting of the size limit for the OCS buffer, the more frequently 
OCS must empty the buffer by unloading the data into the file.
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public_network_access_code
Type: Optional
Default Value: NULL
Valid Value(s): Any character string
Specifies the string that is added as a prefix to each phone number that OCS 
sends to a specific switch. The phone numbers in the call UserData remain 
unchanged. This number specifies the PSTN access code for the switch to 
which T-Server is connected. When an access code is added as a value, the 
system always places the access code in front of the phone number that is 
dialed. For example, if you set the value 9 into the value field, then the prefix 9 
is always dialed before each phone number. 
If you are using the Outbound Contact Wizard, it prompts you to enter a value 
for this option. To accept the default value for this option, click the Cancel 
button on the wizard screen.
You can add Dialogic dialing control parameters as a prefix to the dialed 
numbers from a calling list. When combined with the string defined for the 
public_network_access_code option, Dialogic dialing control symbols (prefix) 
determine the dialing time. The following Dialogic symbols are available:
• L—Wait for the local dial tone before dialing.
• I—Wait for the international dial tone before dialing.
• X—Wait for the special dial tone before dialing.
• , (comma) — Pause 2 seconds
For example, suppose that the public_network_access_code is defined as L9. In 
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then 
dial the number from the calling list.

Notes: Dialing control parameters work only if the CPD Server dials the calls 
through the Dialogic card (tscall=false).
This option can be set at three levels, Switch/Application (which has 
the lowest priority), Campaign Group (which has a medium priority), 
and Calling List (which has the highest priority).

update_all_records
Type: Optional
Default Value: false
Valid Value(s): true/yes, false/no 
Specifies how OCS updates the status of records after the chain processing has 
been completed. 
• If set to true or yes, OCS updates all records in the chain, regardless of the 

dialing filter applied. All records in the chain that are outside the 
parameters of the dialing filter are updated with the same status that the 
chain receives after OCS has finished processing it. 
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• If set to false or no, records in the chain that were filtered out by the 
dialing filter are marked as record_status = Ready.

Switch-Level Options for OCS
You can set the following options as configuration objects on the Options tab 
of the Outbound Contact Server Application object, or they can be stored at 
the switch level. OCS can work with many switches. At the switch level, you 
can assign different values for each switch. When set on the Options tab, the 
value applies to all switches.
OCS looks first at the switch level. The option setting at this level overrides the 
value in the Options tab.
Switch options are stored in a section folder called OCServer or Default on the 
Annex tab of the Switch object.

channel_num 
Type: Optional 
Default Value: 0 
Valid Value(s): 0 or any positive integer
Specifies the total number of available channels (CPD ports) on the switch 
when using either the Predictive or Progressive dialing mode.
• If OCS dials a call through T-Server, this value of this option is taken from 

the Annex tab of the Switch object.
• If OCS dials through CPD Server, the option is not used. OCS derives the 

proper number of CPD ports directly from CPD Server through the 
protocol events.

This option works as follows:
1. Before requesting the next call from T-Server, OCS calculates the number 

of busy channels on the switch.
2. OCS dials an outbound call when the number of busy channels is less than 

the value specified for the channel_num option.
If the default value 0 (zero) is assigned to channel_num, there are no restrictions 
on the switch, and OCS dials continuously.

dialing_rate_limit
Type: Optional
Default Value: 100
Valid Values: 0 - N (maximum integer)
Changes Take Effect: Immediately
Specifies the maximum number of calls per second that are shared among all 
campaign groups running in the auto dialing modes (Progressive, Predictive, 
Progressive with seizing, and Predictive with seizing) that use the switch. The 
option is not applicable to engage call legs. If the option is set to 0, OCS does 
not dial for any of the campaign groups that use the switch.
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Note: The dialing_rate_limit options set at campaign group and application 
levels are not affected.

engaged_answer_action
Type: Optional 
Default Value: soft_answer
Valid Value(s): hard_not_ready, hard_ready, soft_answer
Determines the teleset state after an engaging call has been established.
• When set to hard_not_ready, OCS sends a request to T-Server to force the 

teleset to a Not Ready state.
• When set to hard_ready, OCS sends a request to T-Server to force the 

teleset to a Ready state.
• When set to soft_answer, OCS uses the agent state provided by Stat 

Server.

Notes: 
• This option is new in OCS version 7.6.101.
• When using this option, OCS takes the value of 

“hard_request_to_login_dn” option into account. In other words, if 
hard_request_to_login_dn is set to true, OCS sends 
RequestAgentReady to the login DN instead of the DN where the 
call was answered.

engaged_release_action
Type: Optional 
Default Value: soft_previous
Valid Value(s): soft_previous, hard_ready, hard_not_ready
Determines the teleset state after an engaging call has been released.
• When set to soft_previous, OCS uses the agent state provided by Stat 

Server.
• When set to hard_ready, OCS sends a request to T-Server to force the 

teleset to a Ready state.
• When set to hard_not_ready, OCS sends a request to T-Server to force the 

teleset to a NotReady state.

Notes: 
• This option is new in OCS version 7.6.101.
• When using this option, OCS takes the value of 

“hard_request_to_login_dn” option into account. In other words, if 
hard_request_to_login_dn is set to true, OCS sends 
RequestAgentReady to the login DN instead of the DN where the 
call was released.
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hard_request_to_login_dn
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Determines which DN receives the AgentReady or AgentNotReady request when 
an agent's Place in the database has more than one DN associated with it.
You can use this option when Outbound Contact is configured as follows:
• An agent’s Place is configured with an ACD Position and an Extension.
• The “outbound_release_action” option is set to hard_ready or 

hard_not_ready.
When both of these conditions are met, OCS sends an AgentReady or 
AgentNotReady request after receiving an EventReleased message on either of 
the agent's DNs, depending on the value of this option.
• When set to yes or true, OCS sends an AgentReady or AgentNotReady 

request to the DN where the agent is logged in.
• When set to no or false, OCS sends an AgentReady or AgentNotReady 

request to the DN that received the EventReleased message.

outbound_answer_action
Type: Optional 
Default Value: soft_answer
Valid Value(s): hard_not_ready, hard_ready, soft_answer
Determines the teleset state after an outbound call has been established.
• When set to hard_not_ready, OCS sends a request to T-Server to force the 

teleset to a Not Ready state.
• When set to hard_ready, OCS sends a request to T-Server to force the 

teleset to a Ready state.
• When set to soft_answer, OCS uses the Agent State provided by Stat 

Server.

Note: When using this option, OCS takes the value of 
“hard_request_to_login_dn” option into account. In other words, if 
hard_request_to_login_dn is set to true, OCS sends 
RequestAgentReady to the login DN instead of the DN where the call 
was answered.

outbound_release_action
Type: Optional 
Default Value: soft_previous
Valid Value(s): hard_ready, hard_not_ready, soft_previous
Determines the teleset state after an outbound call has been released. 
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• When set to hard_ready, OCS sends a request to T-Server to force the 
teleset to the Ready state.

• When set to hard_not_ready, OCS sends a request to T-Server to force the 
teleset to the Not Ready state.

• When set to soft_previous, OCS uses the Agent State provided by Stat 
Server.

Note: When using this option, OCS takes the value of 
“hard_request_to_login_dn” option into account. In other words, if 
hard_request_to_login_dn is set to true, OCS sends 
RequestAgentReady to the login DN instead of the DN where the call 
was released.

preview_release_nocontact_action
Type: Optional
Default Value: soft_previous
Valid Value(s): hard_ready, hard_not_ready, soft_previous
Determines the teleset state after an agent releases an unsuccessful outbound 
call that the agent had placed manually.
• When set to hard_ready, OCS sends a request to T-Server to force the 

teleset to the Ready state.
• When set to hard_not_ready, OCS sends a request to T-Server to force the 

teleset to the Not Ready state.
• When set to soft_previous, OCS does not send any requests to T-Server.

Notes: 
• A new option for OCS 7.6.101.
• When using this option, OCS takes the value of 

“hard_request_to_login_dn” option into account. In other words, if 
hard_request_to_login_dn is set to true, OCS sends 
RequestAgentReady to the login DN instead of the DN where the 
call was released.

public_network_access_code
Type: Optional
Default Value: NULL
Valid Value(s): Any character string
Specifies the string that is added as a prefix to each phone number that OCS 
sends to a specific switch. The phone numbers in the call UserData remain 
unchanged. This number specifies the PSTN access code for the switch to 
which T-Server is connected. When an access code is added as a value, the 
system always places the access code in front of the phone number that is 
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dialed. For example, if you set the value 9 into the value field, then the prefix 9 
is always dialed before each phone number. 
If you are using the Outbound Contact Wizard, it prompts you to enter a value 
for this option. To accept the default value for this option, click the Cancel 
button on the wizard screen.
You can add Dialogic dialing control parameters as a prefix to the dialed 
numbers from a calling list. When combined with the string defined for the 
public_network_access_code option, Dialogic dialing control symbols (prefix) 
determine the dialing time. The following Dialogic symbols are available:
• L—Wait for the local dial tone before dialing.
• I—Wait for the international dial tone before dialing.
• X—Wait for the special dial tone before dialing.
• , (comma)—Pause 2 seconds.
For example, suppose that the public_network_access_code is defined as L9. In 
this case, the dialer will wait for a dial tone, dial 9, pause for 2 seconds, then 
dial the number from the calling list.

Notes: Dialing control parameters work only if the CPD Server dials the calls 
through the Dialogic card (tscall=false).
This option can be set at three levels, Switch/Application (which has 
the lowest priority), Campaign Group (which has a medium priority), 
and Calling List (which has the highest priority).

DN-Level Options for OCS
You set the following options at the DN level. DN options are stored in section 
folders on the Annex tab of the DN object. The section folder(s) can be named 
as follows:
• OCServer

• default

• <OCS application object name> (see page 178)

overflow_dn
Type: Optional 
Default Value: false
Valid Value(s): yes/true or no/false
Designates a DN to which the switch reroutes overflow calls.
Outbound calls that are answered by the called party but that remain in an 
ACD Queue too long before an agent answers are recognized by the switch as 
overflow calls 
If this option is set to true or yes, Outbound Contact treats such call as 
overflow calls.
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Outbound Contact supports two different methods of handling these overflow 
calls. The DN configuration in Configuration Manager determines which 
method OCS uses. The two methods are as follows:

• If the overflow DN is an Extension/Position DN, OCS instructs T-Server 
to release the call. To use this method, set the overflow_dn option to true 
on the Annex tab of the Extension/Position DN to which the switch delivers 
overflow calls. When OCS receives an EventRinging message on this DN, 
it automatically sends a request to T-Server to answer the call, and then 
updates the record with the Dropped call result. After receiving the 
EventEstablished response from T-Server, OCS sends a request to T-
Server to release the call.

• If the overflow DN is a Queue or a Routing Point, the call is transferred to 
a Destination DN such as voice mail or IVR for a pre-recorded message. 
To use this method, set the overflow_dn option to true on the Annex tab of 
the ACD Queue or Routing Point from which the overflow calls are 
distributed to the destination DNs. When OCS receives an EventQueued on 
this DN, it automatically destroys the call in its memory, and then updates 
the record with the Dropped call result.

If you set the value of this option to false or no, OCS does not treat calls as 
overflow calls if they remain in an ACD Queue (waiting for an agent) beyond 
the timeout period. OCS does not update the record as Dropped, and the call is 
not released as an overflow call.

outbound_contact_server
Type: Optional
Default Value: undefined
Valid Value(s): yes/true, no/false, or undefined
Applying this option to the Communication DNs (CommDNs) reduces the 
number of DNs used for OCS. OCS uses CommDNs to communicate with the 
Stat Server, the backup OCS, and third-party applications. Set this option to 
true or yes if you want OCS to communicate with a third-party application 
through this DN. The value undefined has the same effect as if this option is 
absent.

CPD Server Options
The CPD Server options are located in section folders on the Options tab of the 
CPD Server application object in the Configuration Manager. These sections 
include new options that allow you to configure the CPD Server 7.6 to meet 
the needs of your contact center.
Each of these sections has its own set of configuration options:
• “General Section” on page 222
• “HMP Section” on page 230
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• “ISDN Section” on page 231
• “Line-Side Section” on page 233
• “Tones Section” on page 234
• “License Section” on page 239

Notes: Ignore messages about dynamic option changes when the keep-
channels-open option is set to yes, or if Dialogic DM3 hardware or 
HMP software is used.
CPD Server does not read options that are not supported for a 
particular line type.
The pre-connect-cpd-priority (page 227) and post-connect-cpd-
priority (page 227) CPD Server options are ignored when the line-
type option (page 224) contains the hmp value.

General Section

continuous-no-signal
Type: Optional 
Default Value: 20 
Valid Value(s): unsigned integer
Specifies the time, in seconds, of continuous silence (no ring back timeout).

Note: You can configure CPD Server to create two voice files for each 
outbound call that it dials on a Dialogic port. The next two options 
define the prefixes in the file names for two types of voice recording 
files.

cpd-recording
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Enables recording of call progress detection.

conversation-file-name-prefix
Type: Required if the cpd-recording option is enabled
Default Value: conv_
Valid Value(s): Any ASCII string
Specifies the prefix for the file name for the conversation recording file.
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cpd-file-name-prefix
Type: Required if the cpd-recording option is enabled
Default Value: cpd_
Valid Value(s): an ASCII string 
Specifies the prefix for the file name for the call result recording file.

cpd-if-established
Type: Optional
Default Value: false
Valid Value(s): true/false, yes/no 
Part of the OCS support for uncommon CPD/CTI event flows. It controls the 
way the pre-connect Call Progress Analysis (CPA) is performed. This option 
defines when Dialogic voice resource should be engaged for CPA. 
• If set to true or yes, Dialogic CPA is engaged after the EventEstablished 

message has been received.
• If set to false or no, Dialogic CPA is engaged immediately at the 

beginning of the call start.
For increased flexibility in CPA, two additional options, pre-connect-cpd-
priority and post-connect-cpd-priority, work together to control the 
outcome of conflicting call results that come separately from T-Server (CTI) 
and Dialogic (CPD).

Notes: 
• The cpd-if-established option is ignored when CPD Server is 

used with Dialogic DM3 hardware. It is also ignored for 
Springware hardware with an isdn line-type.

• When you are using the line-side-dm3, isdn-dm3, cas-dm3, or hmp 
line types, the value for this option automatically adjusts to false.

destination-busy-timeout
Type: Optional 
Default Value: 2000 (milliseconds)
Valid Value(s): <A numeric value representing milliseconds>

CPD Server normally waits for both of the following indicators that a dialed 
number is busy before it terminates call progress detection. 
• Busy call result from the Dialogic board 
• EventDestinationBusy from T-Server 
This option prevents CPD Server from waiting indefinitely for a Busy call 
result by specifying the length of time (in milliseconds) that CPD Server 
waits for confirmation of the call result from the second source after the 
first has arrived. When the timeout expires, CPD Server accepts the Busy 
call result as correct.
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keep-channels-open
Type: Optional
Default Value: no
Valid Value(s): yes, no
Changes Take Effect: Immediately
Determines how CPD Server uses Dialogic channels.
When set to yes, CPD Server keeps all Dialogic channels open and reuses them 
for the next call. CPD Server is unable to process dynamic option changes 
when this value is specified.
When set to no, CPD Server closes the Dialogic channels after use and reopens 
them for the next call.

Note: Please ignore messages about dynamic option changes when the keep-
channels-open option contains a value of yes.

line-type
Type: Required
Default Value: None
Valid Value(s): analogue, line-side, line-side-dm3, isdn, isdn-dm3, cas-
dm3, sip-hmp, sip-hmp-asm

Specifies the type of line (Dialogic card) that is being used. It also specifies the 
type of the protocol used to connect the Dialogic board to the switch or PSTN; 
for example: dm3, analogue, line-side, or isdn.
The analogue value represents analog Dialogic boards that are supported in 
transfer mode only because answer supervision is not supported by analog 
lines.
The line-side-dm3 and sip-hmp values are for transfer mode only.
The isdn-dm3, cas-dm3, and sip-hmp-asm values are for ASM-mode only.

Notes: The sip-hmp and sip-hmp-asm values prompt CPD Server to process the 
sip-proxy option. See page 231 for more information about this option.
Please ignore messages about dynamic option changes when Dialogic 
DM3 hardware is used.

location 
Type: Required
Default Value: None
Valid Value(s): Any string
Specifies the name of the folder under the DN section of the Switch object of the 
T-Server application that CPD Server uses when dialing.
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max-number-ports-to-record
Type: Optional
Default Value: 0
Valid Value(s): 0 - k
Enables CPD Server to record files in a plain VOX format (PCM/8000Hz/
8bps). It creates the following two voice files for each outbound call:
• File 1 contains the line recording for the call progress detection stage.
• File 2 records the conversation between an agent and the called party if the 

call result is answer (ASM mode only).
CPD Server records these voice files on the Dialogic ports used for outbound 
dialing. Specific ports are not dedicated for reporting, but the number of ports 
to use for recording is configurable. The max-number-ports-to-record option 
specifies the maximum number of agent ports on which to record at the same 
time. A value of 1 or more enables voice file recording on that number of ports 
concurrently. A value of 0 (zero) disables the voice file recording function.
CPD Server keeps track of the ports that are being recorded and stops 
recording when the specified number of ports are engaged for this purpose. 
CPD Server will not record on another port until one is disengaged. The 
number of times that the same call transfers from Agent DN to Agent DN does 
not increase the number of ports being used for the recording of that call. The 
call remains on the same port when it passes from agent to agent.
The value of the max-number-ports-to-record is limited by two factors:
• The number of configured recording ports
• The hardware limit for the number of Dialogic ports per box 
For example:

switch
DNs

'location_name'
regular
engaging
recording

dxxxB1
dxxxB1C1
dxxxB2C2

When a number of voice channels are reserved for recording, the same number 
of digital channels should be disabled so that CPD will report the correct 
number of available ports for dialing. This should be done if the following is 
true:
• CPD Server is working in transfer mode and the number of either digital or 

loop start channels is equal to the number of voice channels.
• CPD Server is working in ASM ISDN mode and the number of non-

engaging channels is equal to the number of voice channels.
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• CPD Server is working in ASM Melcas mode and the number of digital 
channels is equal to the number of voice channels.

You can upgrade the number of voice channels by adding more Dialogic voice 
only boards.

Note: The extended port usage for recording might necessitate the allocation 
of more Dialogic resources—that is, an increased number of ports to be 
used for outbound dialing in general. 

off-hook-delay
Type: Optional 
Default Value: -1
Valid Value(s): Any integer
Specifies the delay, in seconds, between off-hook and TMakeCall:
If set to a negative value,: off-hook, and then tmakecall
If set to a positive value: tmakecall, and then off-hook

off-hook-timeout
Type: Optional 
Default Value: 1
Valid Value(s): Any positive integer
Specifies the amount of time to wait, in seconds, that CPD Server waits before 
assuming that the channel is in the off-hook state.

on-hook-timeout
Type: Optional 
Default Value: 1
Valid Value(s): Any non-negative integer
Specifies the amount of time, in seconds, that CPD Server waits before 
assuming that the channel is in an on-hook state.

out-of-service-attempts
Type: Optional
Default Value: 2
Valid Value(s): Any non-negative integer; minimum 2 
Specifies the number of failed attempts to use a port (channel) before CPD 
Server marks it out of service.

out-of-service-timeout
Type: Optional
Default Value: 1 
Valid Value(s): Any non-negative integer, with no upper limit restrictions; 
minimum 0>
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Specifies the amount of time (in minutes) that CPD Server waits before trying 
to use an out-of-service port again. If the value is 0, CPD Server ignores out-
of-service conditions and continues to attempt to use the port.

post-connect-cpd-priority
Type: Optional
Default Value: tserver
Valid Value(s): tserver, dialogic
Defines the CPD priority for post-connect CPA. This option works together 
with the pre-connect-cpd-priority option.

pre-connect-cpd-priority
Type: Optional
Default Value: tserver
Valid Value(s): tserver, dialogic 
Defines the source of Call Progress Information that is used for pre-connect 
CPA.
For increased flexibility in CPA for uncommon CPD/CTI event flow support, 
the pre-connect-cpd-priority and post-connect-cpd-priority options work 
together.
They control the outcome of conflicting call results that come separately from 
T-Server (CTI) and Dialogic (CPD). They also define the conclusive source of 
CPA. Each of these options controls some possible conflicting CPA outcomes 
for the pre- and post-connect CPA.
This option works together with the post-connect-cpd-priority option.

sit-detection
Type: Optional
Default Value: yes/true
Valid Value(s): yes/true or no/false
Defines the SIT signal parameters in the Dialogic DX_CAP data structure to 
enable CPD Server to more easily identify a SIT signal.
Controls SIT detection under the following conditions: SIT is disabled, and the 
tscall option is enabled to determine, from the DestinationBusy event, 
whether a number is valid.

tscall
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies whether CPD Server sends a request to T-Server (tscall = true or 
yes) or to Dialogic board (tscall = false or no) to make a call.
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tsclear
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Controls the way a call is released. If this option is set to yes,
a RequestClearCall (G3 specific) is issued to release an active call.
This option is useful, but not required, if a two-step transfer fails on a G3 
switch.

use-engaging-lines
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Applicable only to ASM mode:
• If set to no or false, CPD Server engages agents by using lines from the 

regular lines pool—that is, from the regular folder.
• If set to yes or true, CPD Server engages agents by using lines from a 

special lines pool that is dedicated to engaging purposes—that is, from the 
engaging folder.

You can benefit from this option if, for example, you wants to use special 
trunks for agent engagement—for example, lines that connect directly to the 
switching office and deliver calls directly to agents, free of charge. When this 
value is set to yes, this option provides an alternative to using trunks that incur 
a charge for every call.

Notes: Changes to the engaging folder are not supported while CPD Server is 
running.
All voice channels (dxxx) are used by the regular network channels 
(dti) first, and then are used by the engaging channels. If you do not 
have more voice channels than network channels in your regular 
folder, then there will be no voice channels remaining for use for the 
engaging channels. In this case, engaging calls cannot be made.

use-busy2-as-nu-tone
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Controls the way in which the Busy2 tone is detected. This option enables CPD 
Server to detect a NU (Number Unobtainable) tone call result by using the 
Busy2 tone. 
When the value is set to yes, the NU tone call result is assigned to all Busy2 tone 
detected calls. You can set this option at the Application level.
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use-fax2-as-am-tone
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false
Controls the way in which the Fax2 tone is detected. This option enables CPD 
Server to detect an Answering Machine call result by using the Fax2 tone. 
When the value is set to yes, the Answering Machine call result is assigned to all 
Fax2 tone detected calls. You can set this option at the Application level.

wait-off-hook
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies whether CPD Server waits (a value of yes or true) or does not wait 
(a value of no or false) for an off-hook event from T-Server.

Note: This value is used when the tscall option has a value of true and the 
off-hook-delay option has a negative value.

Releasing A Call Before Bridging

If the established customer leg of the call has to be released by CPD Server 
because it could not be bridged with the agent “engage” call leg, a predefined 
announcement to the customer can be used before the call is released.

Note: This feature is used in ASM mode only.

The following option is used by OCS to provide the announcement file 
location to CPD Server:

asm_drop_announcement_data
Type: Optional
Default Value: Null
Valid Value: Any string that contains the full network path and the voice file 
name
• If no value is specified, OCS does not add the OCS_DROP_ANNOUNCE_DATA 

attribute to the extensions parameter of the Outbound Contact Server 
RequestMakePredictiveCall event.

• If a value is specified, the full path to the voice file will be used by CPD 
Server in the following extensions parameter of the Outbound Contact 
Server RequestMakePredictiveCall event:
OCS_DROP_ANNOUNCE_DATA
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Data Type: String
Contains the full name of the voice file in .vox format

Note: CPD Server must be able to access this network path so that this file 
can be used.

CPD Server will play the specified file before releasing the established 
customer call. If CPD Server successfully opens the file specified in the 
OCS_DROP_ANNOUNCE_DATA attribute, it prints a dx_playvox success message to 
the log file. If there was an error, a dx_playvox failed message is printed in 
the log file.

CPD Proxy Server Options

The following options apply to CPD Proxy Server only.

max-dialing-channels
Type: Optional
Default Value: 0
Valid Value(s): 0...n
Changes Take Effect: Immediately
Specifies the maximum number of dialing channels that can be used by the 
OCS client of CPD Proxy Server. If the value is 0, there is no restriction to the 
number of channels used.

Note: A new option for CPD Proxy Server version 7.6.101.

max-engaging-channels
Type: Optional
Default Value: 0
Valid Value(s): 0...n
Changes Take Effect: Immediately
Specifies the maximum number of engaging channels that can be used by the 
OCS client of CPD Proxy Server. If the value is 0, there is no restriction to the 
number of channels used.

Note: A new option for CPD Proxy Server version 7.6.101.

HMP Section
The options in this section are enabled when the line-type option (page 224) 
contains the sip-hmp or sip-hmp-asm values.
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audio-codecs
Type: Optional
Default Value: PCMU
Valid Value(s): PCMU, PCMA, or both separated by a comma
Changes Take Effect: After restart
Defines the codec(s) to use for HMP. If more than one codec is listed, the first 
codec has priority over the second.
• The PCMU value corresponds to the G.711 mu-law codec.
• The PCMA value corresponds to the G.711 a-law codec.

sip-proxy
Type: Mandatory
Default Value: ‘’
Valid Value(s): <any valid host name or IP address>
Defines the SIP Proxy host name or IP address.

Note: Please ignore messages about dynamic option changes when HMP 
software is used.

ISDN Section
The isdn section is ignored when CPD Server is use with Dialogic DM3 
hardware.

Note: If you are using the line-side-dm3, isdn-dm3, and cas-dm3 line types, 
all options in this section are ignored, except calling-party-number.

called-party-number-plan
Type: Optional 
Default Value: isdn
Valid Value(s): String: unknown, isdn, telephony, or private
Identifies the number plan of the party called. 

called-party-number-type
Type: Optional 
Default Value: national
Valid Value(s): national, international, en-block, overlap
Indicates the type of number for the party called. 

calling-party-number-plan
Type: Optional 
Default Value: isdn
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Valid Value(s): unknown, isdn, telephony, or private
Identifies the number plan of the calling party.

calling-party-number-type
Type: Optional 
Default Value: national
Valid Value(s): national, international, en-block, or overlap
Indicates the type of number for the calling party.

calling-party-number
Type: Optional 
Default Value: None
Valid Value(s): Any digit string not longer than 31 characters
Specifies the number of the calling party.

Notes: The calling party number (isdn-dm3) is always sent and cannot be an 
empty string when CPD Server is used with Dialogic DM3 hardware
If you are using isdn-dm3 and cas-dm3 line types this option is 
mandatory, and its value cannot be an empty string.

engage-cpd-on-call-setup
Type: Optional
Default Value: no/false
Valid Value(s): yes/true or no/false 
Instructs the CPD Server to engage in Call Progress Analysis during the ISDN 
call setup. This option is especially useful in the following situations:
• Setup for ISDN to non-ISDN destination calls.
• In-band signaling is present before the connection is established.

isdn-trace
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies whether CPD Server creates an ISDN board resource (d-channel) 
trace log (value = yes or true) or does not create this trace log (value = no or 
false).
Genesys recommends that you use this isdn-trace option for log purposes 
only when additional call information is required. The default value (no or 
false) normally applies.
If the value is set to yes or true, CPD Server receives error messages (Device 
busy and/or Invalid device) after approximately 100,000 calls. CPD Server 
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then stops Outbound calling due to the inability to dial through the Dialogic 
channels.
If this happens, complete the following procedure:
1. Stop the CPD Server.
2. Change the value of the isdn-trace option to no to turn off the ISDN board 

resource (d-channel) trace log.
3. Restart the Dialogic drivers.
4. Restart the CPD Server.

isdn-trace-file-name-prefix
Type: Optional 
Default Value: isdn_
Valid Value(s): Any string
Specifies the prefix for the ISDN trace file.

presentation-indicator
Type: Optional 
Default Value: restricted
Valid Value(s): allowed, restricted, not-available
Specifies whether a presentation indicator (Caller_ID) is allowed, restricted, or 
not available for an ISDN call-setup message. 

use-channel-state
Type: Optional 
Default Value: no/false
Valid Value(s): yes/true or no/false 
Specifies whether CPD Server uses a channel state (value = yes or true) or 
does not use a channel state (value = no or false). If yes or true, an in-service 
message is sent to the switch through the d-channel (ISDN line). Available in 
North America only.

user-info-layer-1 
Type: Optional
Default Value: g711-ulaw;
Valid Value(s): g711-ulaw; g711-alaw;
CPD Server reads the value of this option from the ISDN section of its 
application object and applies the value to the user info layer 1 field in the 
ISDN call setup message. 

Line-Side Section
The line-side section is ignored when CPD Server is used with Dialogic 
DM3 hardware. The /config/fcd/pcd Dialogic files must be used instead.
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Note: If you are using the line-side-dm3 and cas-dm3 line types, you cannot 
modify the bit mask parameters through the CPD Server configuration 
options. Instead, you use the Dialogic *.config, *.fcd, and *.pcd 
files. These files are located at $DIALOGICDIR\data. Consult the 
Dialogic documentation for more information on modifying these files.

off-hook-bit-mask
Type: Optional 
Default Value: a-on;b-on;
Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask for a T1/E1 line that is off-the-hook.

on-hook-bit-mask
Type: Optional
Default Value: a-off;b-on;
Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask for a T1/E1 line that is on-the-hook.

rcv-idle-bit-mask
Type: Optional 
Default Value: a-off;b-on;
Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask that indicates a T1/E1 line in an idle state.

snd-idle-bit-mask
Type: Optional 
Default Value: a-off;b-on;
Valid Value(s): a-off;b-on; a-off;b-off; a-on;b-off; a-on;b-on;
Specifies the mask that the Dialogic board sends to a switch to make a T1/E1 
line idle.

Tones Section
The tones section does not configure the tone definition when CPD Server is 
used with Dialogic DM3 hardware. The /config/fcd/pcd Dialogic files must 
be used instead. The only exceptions are the use-fax2-as-am-tone and forth-
tone options.

Note: This section is not used when the line-type option (page 224) is set to 
sip-hmp.
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Any of the following can be represented by a tone:
• Busy signal
• Dial tone
• Fax machine
• Ring back
• Beep signal 
Within each of these broad categories of tones, there are specific types of 
tones—for example a local dial tone or an international dial tone.

Notes: The qual templates are configured in the /config/fcd/pcd Dialogic 
files when CPD Server is use with Dialogic DM3 hardware
If you are using the line-side-dm3, isdn-dm3, or cas-dm3 line types, 
you cannot modify the tone parameters through the CPD Server 
configuration options. Instead you must use the Dialogic *.config, 
*.fcd, and *.pcd files. These files are located at $DIALOGICDIR\data. 
For more information on modifying these files, consult the Dialogic 
documentation.

Tone Options
There is a Dialogic option for each type of tone, that the Genesys configuration 
environment recognizes. These tone options are as follows:
• busy-tone-1

• busy-tone-2 

• disconnect-tone 
• extra-dial-tone 
• fax-tone-1 

• fax-tone-2 
• forth-tone

• intl-dial-tone 
• local-dial-tone 
• ring-back-tone-1 
• ring-back-tone-2 
• sit-tone 
The following section provides more details about each of these tone options.

Tone Parameters
For the tone options described in this section, a series of numbers separated by 
semicolons represents the following nine parameters for each tone:
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• Frequency of first tone
• Frequency deviation for first tone
• Frequency of second tone
• Frequency deviation for second tone
• On duration
• Ontime deviation
• Off duration
• Offtime deviation
• Repetition count

Note: All parameters inside string values for CPD Server options are 
separated by semicolons.

For examples of tone parameters, see the default values for the following tone 
options.

Note: In the following tone option descriptions, parameters are in 10 ms 
units.

busy-tone-1 
Type: Optional 
Default Value: 500;200;0;0;55;40;55;40;4;
Valid Value(s): Any string of numbers separated by semicolons and 
representing the nine tone parameters. (see “Tone Parameters” on page 235). 
Defines a template for the first busy tone.

busy-tone-2 
Type: Optional 
Default Value: 500;200;500;200;55;40;55;40;4;
Valid Value(s): Any string of numbers separated by semicolons and 
representing the nine tone parameters. (see “Tone Parameters” on page 235).
Defines a template for the second busy tone.

disconnect-tone
Type: Optional
Default values: 500;200;500;200;55;40;55;40;10;
Valid Value(s): Any string of numbers separated by semicolons and 
representing the nine tone parameters.
Defines a template for disconnect tone, also known as a “fast busy tone.”
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extra-dial-tone
Type: Optional 
Default Value: 401;125;401;125;0;0;0;0;0;
Valid Value(s): Any string of numbers separated by semicolons and 
representing the nine tone parameters. (see “Tone Parameters” on page 235”).
Defines a template for an extra dial tone.

fax-tone-1
Type: Optional 
Default Value: 2150;150;0;0;25;-25;0;0;0;
Valid Value(s): Any string of numbers separated by semicolons representing 
the nine tone parameters. (see “Tone Parameters” on page 235).
Defines a template for the first FAX tone.

fax-tone-2 
Type: Optional 
Default Value: 1100;50;0;0;25;-25;0;0;0;
Valid Value(s): Any string of numbers separated by semicolons representing 
the nine tone parameters. (see “Tone Parameters” on page 235).
Defines a template for a second FAX tone.

forth-tone
Type: Optional 
Default Value: 0;0;0;0;0
Valid Value(s): Any string of numbers separated by semicolons representing 
these following tone parameters: (see “Tone Parameters” on page 235).
Frequency of first tone:
• Frequency range: 200 Hz to 4000 Hz 
• Frequency resolution: 1 Hz
Frequency of second tone:
• Frequency range: 200 Hz to 4000 Hz 
• Frequency resolution: 1 Hz
Amplitude of first tone:
• (E-1) -40 dBm0 to +0 dBm per tone nominal
• (T-1) -43 dBm0 to -3 dBm per tone nominal 
Amplitude of second tone:
• (E-1) -40 dBm0 to +0 dBm per tone nominal
• (T-1) -43 dBm0 to -3 dBm per tone nominal 
Duration: 10 millisecond increments
The forth-tone option enables or disables a beep signal that alerts an agent 
immediately before a customer is connected to him or her. When an agent is in 
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the engaged mode and waiting to be connected to a customer, this low-
frequency tone notifies him or her that a connection is imminent. You can 
configure the tone frequency, duration, and amplitude of the signal. CPD 
Server supports this signal on DM3 hardware and SIP-HMP-ASM line-type.

intl-dial-tone
Type: Optional 
Default Value: 402;125;402;125;0;0;0;0;0;
Valid Value(s): Any string of numbers separated by semicolons representing 
the nine tone parameters (see “Tone Parameters” on page 235). 
Defines a template for an international dial tone. 

local-dial-tone
Type: Optional 
Default Value: 400;125;400;125;0;0;0;0;0;
Valid Value(s): Any string of numbers separated by semicolons and 
representing the nine tone parameters (see “Tone Parameters” on page 235).
Defines a template for a local dial tone.

ring-back-tone-1
Type: Optional 
Default Value: 450;150;0;0;130;105;580;415;0;
Valid Value(s): Any string of numbers separated by semicolons and 
representing nine tone parameters (see “Tone Parameters” on page 235).
This option defines a template for the first ring-back tone.

ring-back-tone-2 
Type: Optional 
Default Value: 450;150;450;150;130;105;580;415;0;
Valid Value(s): A string of numbers separated by semicolons representing nine 
tone parameters (see “Tone Parameters” on page 235).
This option defines a template for a second ring-back tone.

sit-tone
Type: Optional
Default Value: 900;1000;5;50;0;0;0;0;0;0;0;0; 
Valid Value(s): Any string of numbers separated by semicolons and 
representing the following tone parameters. 
Defines the SIT signal parameters in the Dialogic DX_CAP data structure. 
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A series of 12 numbers separated by semicolons representing these 12 
parameters for the sit-tone:
• Lower Frequency: Lower bound for 1st tone in an SIT. (Call Analysis) 

Length: 2. Default Value: 900. Units: Hz. 
• Upper Frequency: Upper bound for 1st tone in an SIT. (Call Analysis) 

Length: 2. Default Value: 1000. Units: Hz. 
• Time Frequency: Minimum time for 1st tone in an SIT to remain in 

bounds. The minimum amount of time required for the audio signal to 
remain within the frequency detection range specified by upper frequency 
and lower frequency for it to be considered valid. (Call Analysis) Length: 
1. Default Value: 5. Units: 10 ms

• Maximum Time Frequency: Maximum allowable time for 1st tone in an 
SIT to be present. Length: 1. Default Value: 0. Units: 10 ms. 

• Lower Bound for 2nd Frequency: Lower bound for 2nd tone in an SIT. 
Length: 1. Default Value: 0. Units: Hz. 

• Upper Bound for 2nd Frequency: Upper bound for 2nd tone in an SIT. 
Length: 1. Default Value: 0. Units: Hz. 

• Time for 2nd Frequency: Minimum time for 2nd tone in an SIT to remain 
in bounds. Length: 1. Default Value: 0. Units: 10 ms. 

• Maximum Time for 2nd Frequency: Maximum allowable time for 2nd tone 
in an SIT to be present. Length: 1. Default Value: 0. Units: 10 ms. 

• Lower Bound for 3rd Frequency: Lower bound for 3rd tone in an SIT. 
Length: 1. Default Value: 0. Units: Hz. 

• Upper Bound for 3rd Frequency: Upper bound for 3rd tone in an SIT. 
Length: 1. Default Value: 0. Units: Hz. 

• Time for 3rd Frequency: Minimum time for 3rd tone in an SIT to remain in 
bounds. Length: 1. Default Value: 0. Units: 10 ms. 

• Maximum Time for 3rd Frequency: Maximum allowable time for 3rd tone 
in an SIT to be present. Length: 1. Default Value: 0. Units: 10 ms. 

Note: Please note that SIT tone definitions should be customized only if the 
default settings are inappropriate for your particular system.

License Section
The License section contains two options that support the licensing of CPD 
Server:

license-file
Type: Optional
Default Value: None
Valid Value(s): Any string
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Specifies the license address in one of these formats: 
• The host name and port of the license server, as specified in the SERVER 

line of the license file, in the port@host format—for example:
• 7260@ctiserver

• The full path to and the exact name of the license file—for example:
/opt/mlink/license/license.dat

Note: Changes take effect after an application is restarted.

num-occ-port-licenses 
Type: Optional
Default Value: 0 (all available licenses)
Valid Value(s): max or an integer from 0 to 9999
Specifies how many licenses CPD checks out initially. 
• If the value of this option is increased, CPD will attempt to check out an 

additional amount of licenses. This change takes effect immediately.
• If the value of this option is decreased, CPD Server will check in the extra 

licenses and will not release the ports. CPD Server will not use the ports 
until the number of used ports falls below the number of licenses available 
for the CPD Server.

Correlation Between CPD Server Options and Dialogic 
Boards

This section provides information on the correlation between CPD Server 
options, Dialogic Board types, and Dialer modes.
In the tables, note the following:
• No indicates that the option is not used in the given Dialing Mode / Board 

Type / Line-Type.
• Yes indicates that the Option is used in the given Dialing Mode / Board 

Type / Line-Type.
• A dash (-) indicates that the Dialing Mode / Board Type / Line-Type 

combination is not possible.

ASM Dialer Mode

The section provides correlation information on the ASM (Active Switching 
Matrix) Dialer Mode for the following board types:
• DMV (Table 18)
• JCT (Table 19 on page 244)
• HMP (Table 20 on page 247)
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Table 18: DMV Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 – – – – No No – –

busy-tone-2 – – – – No No – –

extra-dial-tone – – – – No No – –

fax-tone-1 – – – – No No – –

fax-tone-2 – – – – No No – –

intl-dial-tone – – – – No No – –

local-dial-tone – – – – No No – –

ring-back-tone-1 – – – – No No – –

ring-back-tone-2 – – – – No No – –

disconnect-tone – – – – No No – –

forth-tone – – – – Yes Yes – –

sit-tone – – – – No No – –

line-side off-hook-bit-mask – – – – No No – –

on-hook-bit-mask – – – – No No – –

rcv-idle-bit-mask – – – – No No – –

snd-idle-bit-mask – – – – No No – –
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isdn called-party-number-
plan

– – – – No No – –

called-party-number-
type

– – – – No No – –

calling-party-number – – – – Yes Yes – –

calling-party-
number-plan

– – – – No No – –

calling-party-
number-type

– – – – No No – –

isdn-trace – – – – No No – –

isdn-trace-file-name-
prefix

– – – – No No – –

presentation-
indicator

– – – – No No – –

use-channel-state – – – – Yes Yes – –

engage-cpd-on-call-
setup

– – – – No No – –

user-info-layer-1 – – – – No No – –

hmp audio-codecs – – – – No No – –

sip-proxy – – – – No No – –

Table 18: DMV Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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general continuous-no-signal – – – – No No – –

conversation-file-
name-prefix

– – – – Yes Yes – –

cpd-file-name-prefix – – – – Yes Yes – –

cpd-recording – – – – Yes Yes – –

cpd-if-established – – – – No No – –

destination-busy-
timeout

– – – – Yes Yes – –

keep-channels-open – – – – No No – –

line-type – – – – Yes Yes – –

location – – – – Yes Yes – –

max-number-ports-
to-record

– – – – Yes Yes – –

off-hook-delay – – – – No No – –

off-hook-timeout – – – – No No – –

on-hook-timeout – – – – No No – –

Table 18: DMV Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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out-of-service-
attempts

– – – – Yes Yes – –

out-of-service-
timeout

– – – – Yes Yes – –

pre-connect-cpd-
priority

– – – – No No – –

post-connect-cpd-
priority

– – – – No No – –

sit-detection – – – – Yes Yes – –

tscall – – – – No No – –

tsclear – – – – No No – –

use-busy2-as-nu-tone – – – – No No – –

use-fax2-as-am-tone – – – – No No – –

use-engaging-lines – – – – Yes Yes – –

wait-off-hook – – – – No No – –

Table 18: DMV Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

Table 19: JCT Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 – – – Yes – – – –

busy-tone-2 – – – Yes – – – –

extra-dial-tone – – – Yes – – – –

fax-tone-1 – – – Yes – – – –

fax-tone-2 – – – Yes – – – –
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intl-dial-tone – – – Yes – – – –

local-dial-tone – – – Yes – – – –

ring-back-tone-1 – – – Yes – – – –

ring-back-tone-2 – – – Yes – – – –

disconnect-tone – – – Yes – – – –

forth-tone – – – Yes – – – –

sit-tone – – – Yes – – – –

line-side off-hook-bit-mask – – – No – – – –

on-hook-bit-mask – – – No – – – –

rcv-idle-bit-mask – – – No – – – –

snd-idle-bit-mask – – – No – – – –

isdn called-party-number-
plan

– – – Yes – – – –

called-party-number-
type

– – – Yes – – – –

calling-party-number – – – Yes – – – –

calling-party-
number-plan

– – – Yes – – – –

calling-party-
number-type

– – – Yes – – – –

isdn-trace – – – Yes – – – –

isdn-trace-file-name-
prefix

– – – Yes – – – –

Table 19: JCT Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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presentation-
indicator

– – – Yes – – – –

use-channel-state – – – Yes – – – –

engage-cpd-on-call-
setup

– – – Yes – – – –

user-info-layer-1 – – – Yes – – – –

hmp audio-codecs – – – No – – – –

sip-proxy – – – No – – – –

general continuous-no-signal – – – Yes – – – –

conversation-file-
name-prefix

– – – Yes – – – –

cpd-file-name-prefix – – – Yes – – – –

cpd-recording – – – Yes – – – –

cpd-if-established – – – No – – – –

destination-busy-
timeout

– – – Yes – – – –

keep-channels-open – – – Yes – – – –

line-type – – – Yes – – – –

location – – – Yes – – – –

max-number-ports-
to-record

– – – Yes – – – –

off-hook-delay – – – No – – – –

off-hook-timeout – – – No – – – –

Table 19: JCT Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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on-hook-timeout – – – No – – – –

out-of-service-
attempts

– – – Yes – – – –

out-of-service-
timeout

– – – Yes – – – –

pre-connect-cpd-
priority

– – – Yes – – – –

post-connect-cpd-
priority

– – – Yes – – – –

sit-detection – – – Yes – – – –

tscall – – – No – – – –

tsclear – – – No – – – –

use-busy2-as-nu-tone – – – No – – – –

use-fax2-as-am-tone – – – No – – – –

use-engaging-lines – – – Yes – – – –

wait-off-hook – – – No – – – –

Table 19: JCT Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

Table 20:  HMP Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 – – – – – – – No

busy-tone-2 – – – – – – – No

extra-dial-tone – – – – – – – No

fax-tone-1 – – – – – – – No
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fax-tone-2 – – – – – – – No

intl-dial-tone – – – – – – – No

local-dial-tone – – – – – – – No

ring-back-tone-1 – – – – – – – No

ring-back-tone-2 – – – – – – – No

disconnect-tone – – – – – – – No

forth-tone – – – – – – – Yes

sit-tone – – – – – – – No

line-side off-hook-bit-mask – – – – – – – No

on-hook-bit-mask – – – – – – – No

rcv-idle-bit-mask – – – – – – – No

snd-idle-bit-mask – – – – – – – No

isdn called-party-number-
plan

– – – – – – – No

called-party-number-
type

– – – – – – – No

calling-party-number – – – – – – – Yes

calling-party-
number-plan

– – – – – – – No

calling-party-
number-type

– – – – – – – No

isdn-trace – – – – – – – No

Table 20:  HMP Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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isdn-trace-file-name-
prefix

– – – – – – – No

presentation-
indicator

– – – – – – – No

use-channel-state – – – – – – – No

engage-cpd-on-call-
setup

– – – – – – – No

user-info-layer-1 – – – – – – – No

hmp audio-codecs – – – – – – – Yes

sip-proxy – – – – – – – Yes

general continuous-no-signal – – – – – – – Yes

conversation-file-
name-prefix

– – – – – – – Yes

cpd-file-name-prefix – – – – – – – Yes

cpd-recording – – – – – – – Yes

cpd-if-established – – – – – – – No

destination-busy-
timeout

– – – – – – – Yes

keep-channels-open – – – – – – – No

line-type – – – – – – – Yes

location – – – – – – – Yes

max-number-ports-
to-record

– – – – – – Yes

off-hook-delay – – – – – – No

Table 20:  HMP Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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Transfer Mode (TM) Dialer Mode

The section provides correlation information on the TM Dialer Mode for the 
following board types:
• DMV (Table 21)
• JCT (Table 22 on page 254)
• HMP (Table 23 on page 257)

off-hook-timeout – – – – – – No

on-hook-timeout – – – – – – – No

out-of-service-
attempts

– – – – – – – Yes

out-of-service-
timeout

– – – – – – – Yes

pre-connect-cpd-
priority

– – – – – – – No

post-connect-cpd-
priority

– – – – – – – No

sit-detection – – – – – – – Yes

tscall – – – – – – – No

tsclear – – – – – – – No

use-busy2-as-nu-tone – – – – – – – No

use-fax2-as-am-tone – – – – – – – No

use-engaging-lines – – – – – – – Yes

wait-off-hook – – – – – – – No

Table 20:  HMP Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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Table 21: DMV Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 – – No – – – – –

busy-tone-2 – – No – – – – –

extra-dial-tone – – No – – – – –

fax-tone-1 – – No – – – – –

fax-tone-2 – – No – – – – –

intl-dial-tone – – No – – – – –

local-dial-tone – – No – – – – –

ring-back-tone-1 – – No – – – – –

ring-back-tone-2 – – No – – – – –

disconnect-tone – – No – – – – –

forth-tone – – No – – – – –

sit-tone – – No – – – – –

line-side off-hook-bit-mask – – No – – – – –

on-hook-bit-mask – – No – – – – –

rcv-idle-bit-mask – – No – – – – –

snd-idle-bit-mask – – No – – – – –

isdn called-party-number-
plan

– – No – – – – –

called-party-number-
type

– – No – – – – –

calling-party-number – – No – – – – –



252 Outbound Contact 7.6

Chapter 8: Outbound Contact Configuration Options CPD Server Options

calling-party-
number-plan

– – No – – – – –

calling-party-
number-type

– – No – – – – –

isdn-trace – – No – – – – –

isdn-trace-file-name-
prefix

– – No – – – – –

presentation-
indicator

– – No – – – – –

use-channel-state – – No – – – – –

engage-cpd-on-call-
setup

– – No – – – – –

user-info-layer-1 – – No – – – – –

hmp audio-codecs – – No – – – – –

sip-proxy – – No – – – – –

general continuous-no-signal – – No – – – – –

conversation-file-
name-prefix

– – No – – – – –

cpd-file-name-prefix – – Yes – – – – –

cpd-recording – – Yes – – – – –

cpd-if-established – – No – – – – –

destination-busy-
timeout

– – Yes – – – – –

keep-channels-open – – No – – – – –

Table 21: DMV Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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line-type – – Yes – – – – –

location – – Yes – – – – –

max-number-ports-
to-record

– – No – – – – –

off-hook-delay – – Yes – – – – –

off-hook-timeout – – Yes – – – – –

on-hook-timeout – – Yes – – – – –

out-of-service-
attempts

– – Yes – – – – –

out-of-service-
timeout

– – Yes – – – – –

pre-connect-cpd-
priority

– – No – – – – –

post-connect-cpd-
priority

– – No – – – – –

sit-detection – – No – – – – –

tscall – – Yes – – – – –

tsclear – – Yes – – – – –

use-busy2-as-nu-tone – – Yes – – – – –

use-fax2-as-am-tone – – Yes – – – – –

use-engaging-lines – – No – – – – –

wait-off-hook – – Yes – – – – –

Table 21: DMV Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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Table 22: JCT Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 Yes Yes – – – – – –

busy-tone-2 Yes Yes – – – – – –

extra-dial-tone Yes Yes – – – – – –

fax-tone-1 Yes Yes – – – – – –

fax-tone-2 Yes Yes – – – – – –

intl-dial-tone Yes Yes – – – – – –

local-dial-tone Yes Yes – – – – – –

ring-back-tone-1 Yes Yes – – – – – –

ring-back-tone-2 Yes Yes – – – – – –

disconnect-tone Yes Yes – – – – – –

forth-tone Yes No – – – – – –

sit-tone Yes Yes – – – – – –

line-side off-hook-bit-mask No Yes – – – – – –

on-hook-bit-mask No Yes – – – – – –

rcv-idle-bit-mask No Yes – – – – – –

snd-idle-bit-mask No Yes – – – – – –

isdn called-party-number-
plan

No No – – – – – –

called-party-number-
type

No No – – – – – –

calling-party-number No No – – – – – –



Deployment Guide 255

Chapter 8: Outbound Contact Configuration Options CPD Server Options

calling-party-
number-plan

No No – – – – – –

calling-party-
number-type

No No – – – – – –

isdn-trace No No – – – – – –

isdn-trace-file-name-
prefix

No No – – – – – –

presentation-
indicator

No No – – – – – –

use-channel-state No No – – – – – –

engage-cpd-on-call-
setup

No No – – – – – –

user-info-layer-1 No No – – – – – –

hmp audio-codecs No No – – – – – –

sip-proxy No No – – – – – –

general continuous-no-signal Yes Yes – – – – – –

conversation-file-
name-prefix

No No – – – – – –

cpd-file-name-prefix Yes Yes – – – – – –

cpd-recording Yes Yes – – – – – –

cpd-if-established Yes Yes – – – – – –

destination-busy-
timeout

Yes Yes – – – – – –

keep-channels-open Yes Yes – – – – – –

Table 22: JCT Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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line-type Yes Yes – – – – – –

location Yes Yes – – – – – –

max-number-ports-
to-record

No No – – – – – –

off-hook-delay Yes Yes – – – – – –

off-hook-timeout Yes Yes – – – – – –

on-hook-timeout Yes Yes – – – – – –

out-of-service-
attempts

Yes Yes – – – – – –

out-of-service-
timeout

Yes Yes – – – – – –

pre-connect-cpd-
priority

Yes Yes – – – – – –

post-connect-cpd-
priority

Yes Yes – – – – – –

sit-detection Yes Yes – – – – – –

tscall Yes Yes – – – – – –

tsclear Yes Yes – – – – – –

use-busy2-as-nu-tone Yes Yes – – – – – –

use-fax2-as-am-tone Yes Yes – – – – – –

use-engaging-lines No No – – – – – –

wait-off-hook Yes Yes – – – – – –

Table 22: JCT Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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Table 23:  HMP Dialogic Board Type

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type

tones busy-tone-1 – – – – – – No

busy-tone-2 – – – – – – No

extra-dial-tone – – – – – – No

fax-tone-1 – – – – – – No

fax-tone-2 – – – – – – No

intl-dial-tone – – – – – – No

local-dial-tone – – – – – – No

ring-back-tone-1 – – – – – – No

ring-back-tone-2 – – – – – – No

disconnect-tone – – – – – – No

forth-tone – – – – – – No

sit-tone – – – – – – No

line-side off-hook-bit-mask – – – – – – No

on-hook-bit-mask – – – – – – No

rcv-idle-bit-mask – – – – – – No

snd-idle-bit-mask – – – – – – No

isdn called-party-number-
plan

– – – – – – No

called-party-number-
type

– – – – – – No

calling-party-number – – – – – – No
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calling-party-
number-plan

– – – – – – No –

calling-party-
number-type

– – – – – – No –

isdn-trace – – – – – – No –

isdn-trace-file-name-
prefix

– – – – – – No –

presentation-
indicator

– – – – – – No –

use-channel-state – – – – – – No –

engage-cpd-on-call-
setup

– – – – – – No –

user-info-layer-1 – – – – – – No –

hmp audio-codecs – – – – – – Yes –

sip-proxy – – – – – – Yes –

general continuous-no-signal – – – – – – Yes –

conversation-file-
name-prefix

– – – – – – No –

cpd-file-name-prefix – – – – – – Yes –

cpd-recording – – – – – – Yes –

cpd-if-established – – – – – – No –

destination-busy-
timeout

– – – – – – Yes –

keep-channels-open – – – – – – No –

Table 23:  HMP Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type
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line-type – – – – – – Yes –

location – – – – – – Yes –

max-number-ports-
to-record

– – – – – – No –

off-hook-delay – – – – – – No –

off-hook-timeout – – – – – – No –

on-hook-timeout – – – – – – No –

out-of-service-
attempts

– – – – – – Yes –

out-of-service-
timeout

– – – – – – Yes –

pre-connect-cpd-
priority

– – – – – – No –

post-connect-cpd-
priority

– – – – – – No –

sit-detection – – – – – – Yes –

tscall – – – – – – No –

tsclear – – – – – – No –

use-busy2-as-nu-tone – – – – – – No –

use-fax2-as-am-tone – – – – – – No –

use-engaging-lines – – – – – – No –

wait-off-hook – – – – – – No –

Table 23:  HMP Dialogic Board Type (Continued) 

Section CPD Server 
Option

analogue 
line-type

line-
side 
line-
type

line-
side-
dm3 
line-
type

isdn 
line-
type

isdn-
dm3 
line-
type

cas-
dm3 
line-
type

sip-
hmp 
line 
type

sip-
hmp
-asm 
line-
type



260 Outbound Contact 7.6

Chapter 8: Outbound Contact Configuration Options Changes from Release 7.5 to 7.6.x

Changes from Release 7.5 to 7.6.x
Table 24 lists any option changes that occurred between release 7.5 and release 
7.6.x.

Table 24: Option Changes in Release 7.6.x

Option Name Option Values Type of 
Change

Comments

Outbound Contact Server

callback-observe-
group

false/no or true/yes New in 
7.6.101

Campaign or Application 
level

force-unload-wait-db false/no or true/yes New in 
7.6.101

Campaign or Application 
level

pa-selfcheck-awt-
threshold

integer >=1 New in 
7.6.101

Campaign Group-Level or 
Application level

pa-selfcheck-bf-
threshold

integer >=1 New in 
7.6.101

Campaign Group-Level or 
Application level

pa-selfcheck-interval integer >=2 New in 
7.6.101

Campaign Group-Level or 
Application level

pa-selfcheck-odr-
threshold

integer >=1 New in 
7.6.101

Campaign Group-Level or 
Application level

preview_release_
nocontact_action

hard_ready, hard_not_ready, 
soft_previous

New in 
7.6.101

Switch level or Application 
level

vtd-override Any string representing a valid 
DN name

New in 
7.6.101

Campaign Group-Level or 
Application level

predictive_algorithm classical, small_group, 
advanced_small_group

New value 
in 7.6.1

The advanced_small_group 
value was added to instruct 
OCS to use a new advanced 
small group predictive 
algorithm; Campaign Group-
Level or Application level

predictive-longcalls-
truncation

false/no or true/yes New in 7.6.1 Campaign Group-Level or 
Application level

small_group_size Any non-negative integer (0 –
n)

Valid values 
expanded in 
7.6.1

Maximum value limit of 50 
agents was removed; 
Campaign Group-Level or 
Application level
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time-to-ready-
tolerance

Any positive integer of 2 sec 
or more

New in 7.6.1 Campaign Group-Level or 
Application level

ignore-empty-group yes/true or no/false New in 7.6 Campaign-Level or 
Application level

check_dnc_list yes/true or no/false New in 7.6 Campaign Level or 
Application level

campaign-callback-
distr

random, equal-from-zero, or 
equal-from-avg

New in 7.6 Campaign Group-Level or 
Application level

Outbound Contact Manager

inactivity-timeout Any non-negative integer (0–N) New in 7.6 Application level

CPD Server

max-dialing-channels 0...n New in 
7.6.101

CPD Proxy Server, General 
section

max-engaging-
channels

0...n New in 
7.6.101

CPD Proxy Server, General 
section

audio-codecs PCMU, PCMA New in 7.6 In the hmp section.

Table 24: Option Changes in Release 7.6.x (Continued) 

Option Name Option Values Type of 
Change

Comments
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Chapter

9 Log Files
This chapter discusses three types of log files:

General Logging, page 263
Record History Logging, page 263
Extended Audit Trail Log, page 268
gsw_request_log, page 272

General Logging
The applications that are part of the Outbound Contact Solution conform to 
Genesys logging standards. See the Framework 7.6 Management Layer User’s 
Guide for more information and enabling and modifying the output log.
Outbound Contact Server will generate two logs after its first successful start:
• The first log contains initial information about connecting to Configuration 

Server.
• The second log contains configuration information and any information 

produced by Outbound Contact Server as it processes information. 
The level of output is determined by the verbose option in the log section.

Record History Logging
Record History logging provides you with additional reporting options for 
calling lists. This logging process does not use database access to write logs; 
instead it uses flat (text) files that the customer defines. With flat files you can 
selectively turn logging on or off for different calling lists. Flat files must be 
imported into a database in order to generate reports (see your database 
administrator for assistance).
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This section includes the following topics:
• “Prestart Information” on page 264
• “Configuration Options” on page 264
• “File Structure” on page 265
• “Log File Naming Conventions” on page 267
• “Generating Record History Log Reports” on page 268

Prestart Information
Before you create a Record History Log for your calling list, make sure that 
you have:
• Properly configured the destination for your log (see “Log Options 

Defined” on page 264).
• Provided a sufficient amount of free disk space on the target drive.

Configuration Options
Two options configure the Record History Logs; they are 
dial_log_destination and dial_log_delimiter. 

Log Options Defined

This topic describes the Record History Log options dial_log_destination and 
dial_log_delimiter. You must configure the option dial_log_destination to 
use Record History logging. Then, if the option dial_log_delimiter is omitted, 
a tab delimiter is used in the log file. 
The option dial_log_destination is used to provide the path where a log for 
the calling list is stored. This option can be placed in the OCS application 
object or in a specific calling list object. First, OCS looks for this option in the 
OCServer section in the Annex tab of a list; if does not find this option, it looks 
in the Options tab (OCServer section) in the application object; if it does not 
find this option, then no logging will be performed for the list.
The option dial_log_delimiter is used to create delimiters between the fields 
of the log for the calling list. Because the files for this option are flat files, 
delimiters must be added to the log. If the dial_log_destination option is 
configured, but the dial_log_delimiter is omitted, then tabs are used for the 
delimiters. By default, if the value of this option is not set, it uses a tab (\t) to 
delimit fields.
The dial_log_delimiter option can be placed in the OCS Application object or 
in a specific list. First OCS looks for this options in the OCServer section in the 
Annex tab of a list. If OCS does not find this option there, it looks in the Options 
tab (OCServer section) in the application object. If it still does not find this 
option, then OCS will use a <tab> character for the delimiter. For more 
information about these options, see page 214.
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File Structure

The file structure of a Record History Log is shown in columns that include:
• Tracking information.
• Information from Genesys mandatory fields.
• Information from user defined fields.
Information from only some of the Genesys mandatory fields are included 
when generating the Record History Log. These fields include:
• record_id

• contact_info

• contact_info_type

• record_type

• record_status

• call_result

• attempt

• dial_sched_time

• call_time

• daily_from

• daiy_till

• tz_dbid

• agent_id

• chain_id

• chain_n

This information is followed by rows of the Actions and Events for a record. 
Table 25 shows an example of the Record History log file structure.

Note: The column name that is listed in the history log is not always the same 
name as it is in the calling list. For example, the contact_info field in 
the calling list corresponds to the phone field in the Record History 
Log).

For more information about how to configure the user-defined fields so that the 
data from the user-defined fields will be written into the flat file, see 
“Attaching Record Information to Desktop and OCS User Events” in the 
Outbound Contact 7.6 Reference Manual for more information.

Table 25: Log File Structure

time action record_
handle

list_
id

campaign_
id

group_
id

ocs_app_
id

tenant_
id

connection_i
d

dn Genesys 
Mandatory 

User 
Defined 
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Tracking Information

The first ten columns in the log represent the tracking information for each 
record. Table 26 shows the tracking fields and their descriptions. These fields 
are followed by Genesys mandatory fields.

Log Data

The subsequent rows in the Record History Log represent the event data for the 
record. Table 27 on page 266 shows the actions and events that may display in 
the Record History Log. OCS will log numeric data using numeric values. 
The fields in the Record History Log are separated by a dialing_log_delimiter, 
which is defined with the dial_log_delimiter option (see page 214).
The data for each record in the log breaks when:
• The campaign stops or starts.
• The format of the list changes (for example, a send attribute was added or 

changed).

Table 26: Tracking Information Fields 

Field Description

1. time The time logging for the record began.

2. action The actions and events logged for the record.

3. record_handle The record’s record_handle.

4. list_id The DBID of the list.

5. campaign_id The DBID of the campaign.

6. group_id The DBID of the group.

7. ocs_app_id OCS’s application DBID.

8. tenant_id The tenant id.

9. connection_id The Connection_id of the call.

10. dn The dn used for this campaign.

Table 27: Actions and Events in Record History Log

Action/Event Value

DA_CALL_DIALED_OUTBOUND 1

DA_CALL_DIALED_PREVIEW 2
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Log File Naming Conventions
OCS creates a name for each Record History Log. Every log file is named 
according to the following rule:
<ListName>_<ListDBID>_<CampaignDBID>_<GroupDBID>_
<OCSServerApplicationDBID>_<DateTime>

DA_CALL_DIALED_CALLBACK 3

DA_CALL_DIALED_CHAIN 4

DA_RECORD_APPLY_TREATMENT 5

DA_CALL_QUEUED 6

DA_CALL_ESTABLISHED 7

DA_CALL_RELEASED 8

DA_RECORD_RESCHEDULED 9

DA_RECORD_UPDATED (UpdateCallCompletionStats, 
means that user data has changed)

10

DA_RECORD_PROCESSED
Usually is associated with a RecordProcessed request from 
the Desktop or an EventAgentReady when the record is 
updated in a calling list. 
DA_RECORD_PROCESSED action can be also triggered by 
other events—for instance, call abandoned, call released with 
an unsuccessful call result, record returned to a calling list 
database table while the campaign is unloading or a call filter 
is changing.

11

DA_CALL_COMPLETED (to have an agent’s timing 
statistics, not related to a record N.B. abandoned, cancel, do 
not call will be logged as DA_RECORD_PROCESSED with 
the corresponding call result)

12

DA_CALL_TRANSFERRED 13

DA_RECORD_PROCESSED_EVENT (A desktop 
RecordProcesssed event. In the log file, this event is always 
followed by DA_RECORD_PROCESSED.)

14

Table 27: Actions and Events in Record History Log (Continued) 

Action/Event Value



268 Outbound Contact 7.6

Chapter 9: Log Files Extended Audit Trail Log

The angle brackets indicate variables. Substitute the actual values for the type 
of data named in brackets. 
The <DateTime> field uses this format: mmddyy_hhmmss
Where:

mm is replaced by a two-digit representation of the month.
dd is replaced by a two-digit representation of the day.
yy is replaced by a two-digit representation of the year.
hh is replaced by a two-digit representation of the hour.
mm is replaced by a two-digit representation of the minutes.
ss is replaced by a two-digit representation of the seconds.

For example:
112305_193805

Generating Record History Log Reports
The flat files generated in the Record History Log file must be imported into a 
database in order to generate reports. Genesys recommends that you check 
with your database administrator for assistance with this process.

Extended Audit Trail Log
Outbound Contact provides an audit trail for each outbound call dialed in 
preview, progressive, or predictive mode. A new OCS option log_call_stats 
creates a separate logging subsystem for Audit Logging to capture additional 
statistics on telephony events. OCS does not overwrite the existing data in this 
log or replace it with new data. The audit logging function adds data to a 
cumulative log.
The extended Audit Trail Log is discussed in detail in the following sections:
• “log_call_stats Configuration Option” on page 268
• “Configuration of Audit Logging” on page 269
• “Audit Log Record Format” on page 269
• “Timed Events in PBX and CPD Server” on page 270
• “Timing Data Availability in Preview Mode” on page 272

log_call_stats Configuration Option
You define the log_call_stats option in the OCS Application Object. If you 
set this option to yes, OCS creates the separate Audit Log. If you set the option 
to no or if the option is not present, the audit log function is not enabled.
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Configuration of Audit Logging
The configuration of Audit Logging is hard-coded in OCS as follows:

Audit log file name: CallStats.<MMDDYY_HHMMSS_MS>.log
Example: CallStats.072303_182754_216.log
Audit log file location: OCS Application folder
Audit log file segment size: 10 MB
Audit log file segment expiration: none

Audit Log Record Format
OCS produces log records in a comma-delimited format, which can be easily 
imported into third-party applications, such as MS Excel or SQL Server's BCP 
utilities, for further processing. 
These are the comma-delimited fields in the log record: 
• Date in this format: 'MM/DD/YYYY'
• Tenant name in single quotation marks
• Tenant DBID
• Campaign name in single quotation marks
• Campaign DBID
• Phone number in single quotation marks
• Call result (name of CallState from GctiCallState enumerable set, obtained 

from ConfigServer) in single quotation marks
• Time when dialing starts ('HH:MM:SS.MS')
• Approximate time when ringing starts ('HH:MM:SS.MS')
• Time when an unsuccessful call (such as “no answer”) is released 

('HH:MM:SS.MS')

• Time when called party picks up the phone ('HH:MM:SS.MS')
• Time when call progress detection is completed and when CPD Server 

initiates the call transfer to a Queue ('HH:MM:SS.MS')
• Time when call is placed in a queue ('HH:MM:SS.MS')
• Time when ringing starts on an agent's DN ('HH:MM:SS.MS')
• Time when call is established on the agent's DN ('HH:MM:SS.MS')
• Time when call is diverted to an auto-answering device ('HH:MM:SS.MS') 

(For example, calls that are not connected to an agent in two seconds might 
be redirected to a pre-recorded message.)

• Name of the file with CPD recording in single quotation marks
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• Name of the voice file that contains the recorded conversation in single 
quotation marks

• Approximate time difference between OCS and CPD Server computers (in 
milliseconds)
This field cannot be empty. The field value is zero (0) if the data is not 
available.

Note: Note that the timestamps (above) are precise to the millisecond and 
enclosed in single quotation marks. For example, '15:20:50.245'

To support Audit Logging, the CPD Server conveys its timestamp values to 
OCS. For example, CPD Server passes to OCS the values that indicate when 
CPD Server has completed call progress detection and when it has initiated the 
call transfer to a queue.
Fields cannot be omitted. Two commas with no value between them indicate 
that there is no data for that field. That type of placeholder follows, for 
example, the time when an unsuccessful call is released. The reason is that the 
field represented by this particular placeholder is reserved for the time when a 
called party picks up the phone, which does not occur once the call is released. 
There is no field value in this case, thus nothing between the commas.

Timed Events in PBX and CPD Server
Which telephony events are timed and when the timestamps are issued depend 
on the type of hardware (PBX or Dialogic Board) and software (OCS, CPD 
Server) that you use for placing and monitoring calls. The next three tables 
provide details on timed telephony events for various hardware and software.
Table 28 on page 270 shows telephony events that trigger the timing 
mechanisms in a PBX board/OCS.

Table 28: Timed Events for PBX  

Timestamp For: Application

Dialing started OCS

Ringing started OCS

Unsuccessful call released OCS

Call answered N/A

CPD completed / Transfer initiated N/A

Call placed in Queue OCS

Agent DN ringing OCS
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Table 29 shows telephony events that trigger the timing mechanisms in a CPD 
Server in transfer mode.

Table 30 shows telephony events that trigger the timing mechanisms in a CPD 
Server in ASM mode.

Connected to an agent OCS

Diverted for auto-answer OCS

Table 29: Timed Events for CPD Server (Transfer Mode)

Timestamp For: Application

Dialing started CPD Server

Ringing started CPD Server

Unsuccessful call released CPD Server

Call answered CPD Server

CPD completed / Transfer initiated CPD Server

Call placed in Queue CPD Server or OCS

Agent DN ringing CPD Server or OCS

Connected to an agent CPD Server or OCS

Diverted for auto-answer OCS

Table 30: Timed Events for CPD Server (ASM Mode)

Timestamp For: Application

Dialing started CPD Server

Ringing started CPD Server

Unsuccessful call released CPD Server

Call answered CPD Server

CPD completed / Transfer initiated CPD Server

Call placed in Queue N/A

Table 28: Timed Events for PBX (Continued)  

Timestamp For: Application
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Timing Data Availability in Preview Mode
In Preview dialing mode, OCS attempts to obtain the data required for audit 
logging from the telephony events (EventDialing, EventRinging) on the 
Agent's DNs. These events should have outbound-specific pairs in the User 
Data. Thus, the desktop application has to apply to TMakeCall all the UserData 
received in Preview Record.

gsw_request_log
A gsw_request_log table stores Outbound Contact dialing activity for 
reporting, auditing, and other purposes. During installation, the Wizard 
prompts the user to create a gsw_request_log Table Access object, which 
allows OCS to access the log table.
If the Wizard is not used, than the Table Access object for gsw_request_log 
table can be created manually by creating a new Table Access object under the 
tenant that will contain campaign information. This Table Access object must 
be a Log table table type and have the name gsw_request_log. It must also 
contain a reference to a valid database access point. The actual name of the 
database table is user-defined.

Note: In multi-tenant environments, each tenant can have a separate 
gsw_request_log table.

The Outbound Contact Manager checks the configuration of this log table 
every time it starts. If the gsw_request_log Table Access object is configured, 
but the actual table does not exist in the database, Outbound Contact Manager 
will create the table.
Outbound Contact Server opens the gsw_request_log table for a particular 
tenant when the first campaign for this tenant is loaded.
Outbound Contact tracks the following call request messages in the 
gsw_request_log table:
• PreviewDialingModeStart

• PreviewDialingModeOver

Agent DN ringing N/A

Connected to an agent CPD Server

Diverted for auto-answer CPD Server

Table 30: Timed Events for CPD Server (ASM Mode) (Continued) 

Timestamp For: Application
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• PreviewRecord

• UpdateCallCompletionStats

• RecordProcessed

• RecordReject

• RequestRecordCancel 

• RecordReschedule

• ScheduledRecordReschedule

• DoNotCall

• ChainedRecord

• AddRecord

This release of Outbound Contact includes an expanded list of call request 
messages in a gsw_request_log table. Since the log tracks call request 
messages for agents, a gsw_request_log table can be used for auditing 
purposes. The log does not provide any statistical analysis.
To view a gsw_request_log table, use server DMBS SQL features.
For more details, see the chapter entitled, “Communication Protocol,” in the 
Outbound Contact 7.6 Reference Manual.
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Chapter

10 Call Handling
The information in this chapter is divided among the following topics:

How Treatments Work, page 275
Treatment Properties, page 276
Rules for Call Results, page 277
Apply to Record Actions, page 280
Treatment Sequences, page 285
Apply to Call Outcomes, page 288
Outbound Record Sharing Between Multiple Desktops, page 289
Answering Machine Call Handling, page 290

How Treatments Work
This section contains a basic description of treatments. The other topics 
covered in this chapter contain more complex treatment information for those 
who create and change treatments in Configuration Manager.
A treatment object tells Outbound Contact Server (OCS) how to respond to an 
unsuccessful call result (a call that does not reach the intended party).
A treatment sequence (sometimes called a linked sequence) is a general term 
describing a series of treatment actions, each assigned a unique sequence 
number and applied to the same unsuccessful call result.
After Treatment objects are created and then applied to Calling List objects in 
Configuration Manager, treatments were generally handled in the following 
way in previous versions of Outbound Contact:
• The chain’s status in the database remained as Retrieved.
• Outbound Contact kept the chain in memory until the scheduled time.
Since the Outbound Contact 7.2 release, a treatment processing method was 
implemented by the option treatment_sched_threshold (see this option’s 
description on page 213). Outbound Contact Server stores the information that 
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is required to properly restore the treatment application sequence in a 
dedicated treatments field for each chain. This information is stored as a 
string in format <CfgTreatment DBID>@<Cycle attempt number>@<Chain 
number>@<Treatment sequence number>, where:
• <CfgTreatment DBID> is the DBID of the last treatment applied.
• <Cycle attempt number> is the number of cycle attempts within the current 

treatment starting from 1. 
• <chain number> is the chain number value of the record which is to be 

dialled when the chain is retrieved by OCS.
• <treatment sequence number> is the number of cycle through the chain of 

records (for more details see Repeat the Treatment Cycle through the 
Chain of Records).

OCS retrieves and processes treatments history from the database only for 
records of types CampaignRescheduled, PersonalRescheduled, 
CampaignCallback, or Personal Callback. For other types of records (for 
example, General), the treatments history field is ignored. When the chain is 
selected, Outbound Contact will retrieve information about the last applied 
treatment from the field treatments and use it to determine the next treatment 
action that should be applied.

Treatment Properties
Properties are assigned to Treatment objects in the Treatment Properties dialog 
box in Configuration Manager.
Table 31 defines the primary treatment properties.

Table 31: Primary Treatment Properties

Treatment 
Property

Definition

Call Result Type of response received after dialing a calling list record’s telephone number.
An unsuccessful call result (for example, Busy or No Answer) is assigned to a call 
that does not reach the intended party.

Apply to Record Treatment action applied to the next dialing attempt.
This value identifies the next action (for example, Redial) that OCS will take 
when an unsuccessful call result is received.

Apply to Call Connection required. Determine if the Answering Machine Detected or Fax 
Detected call result should be transferred or dropped.
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Rules for Call Results
Three call result values have special treatment rules: Answer, Answering 
Machine Detected, and Fax Detected. A complete list of call results with 
descriptions is provided in the Outbound Contact 7.6 Reference Manual.
Treatments are normally applied to a record for unsuccessful calls; however, 
under certain circumstances Answer (successful call) does require treatment.

Number in 
Sequence

A unique number assigned to each treatment in a series of treatments linked to the 
same call result.
This number sorts treatment sequences in the order they are to be applied to 
consecutive instances of the same call result. Creating multiple treatments for the 
same call result links the treatments.

Cycle Attempt The number of times to apply a treatment action if the first dialing attempt has an 
unsuccessful call result.

Interval (minutes) The number of minutes between cycle attempts if the first cycle attempt has an 
unsuccessful call result.

Increment 
(minutes)

The increment is added to the interval after the first cycle attempt of an 
unsuccessful call result. After the second, and all subsequent cycle attempts of an 
unsuccessful call result, the increment is added to the sum of the last cycle 
attempt. 
For example: 
The interval = 5 minutes
The increment = 3 minutes
In this scenario the first cycle attempt is 5 minutes. If the first cycle attempt is 
unsuccessful, the increment (3 minutes) is added to the interval (5 minutes) and 
the second cycle attempt would be in 8 minutes. For all subsequent unsuccessful 
cycle attempts, the increment (3 minutes) is added to the sum of the last cycle 
attempt: 
(8 + 3) = 11 minutes; (11 + 3) = 14 minutes; and so on.

Table 31: Primary Treatment Properties (Continued) 

Treatment 
Property

Definition
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Rules for Answer
Answer by a live person is a successful call result and usually does not require 
a treatment. Special circumstances, such as the following, do warrant a 
treatment for a call result of Answer:
• If a call originates at a Route Point and the call is answered, then the 

logical treatment is to direct the call to a Queue.
• If an answered call is transferred (connected), then a treatment is required.

Rules for Answering Machine Detected or Fax Detected
These rules apply when a call result is Answering Machine Detected or Fax 
Detected.
For a call that is answered, but the call result is Answering Machine Detected or 
Fax Detected, the system administrator may assign the “Apply to Call” 
treatment and specify the Destination DN to which the call is transferred. Here 
the Destination DN is an ACD queue for an Interactive Voice Response (IVR), 
such as a recorded message to be left on an answering machine or a FAX sent 
to a FAX machine. The administrator specifies the Destination DN in the 
Configuration Manager or through the Outbound Configuration Wizard.

Procedure:
Adding a Destination DN

Start of procedure

1. Add all required IVR DNs and their logins in CME under the Switches 
folder. 

2. In the Switches folder, add the queue that the IVRs log in to.
3. Create a Place for each IVR DN and a shortcut to that DN.
4. Create a Person for each IVR DN.

Note: In step 4 (above), the “person” is actually an IVR that emulates a 
person; that is, the IVR does the work of an agent. In Steps 5 and 6 
(below), the “person” (IVR) is configured as an Agent because 
OCS requires a LoginID to facilitate access to a DN. 

5. Configure the Person as an Agent.
6. Create a shortcut to the default Place and LoginID for that IVR Person.
7. Under Agent Group properties, add an Origination DN shortcut to the 

queue that your IVR DNs log in to.
8. Create an Answering Machine treatment using the following parameters:

• Call Result: Answering Machine Detected
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• Apply to Record: No Treatment
• Apply to Call: Transfer or Connect

Note: Transfer and Connect are synonymous in this context. Both transfer 
the call to the ACD queue for the IVR DNs.

9. Add this treatment to the calling list you are using.
No Treatment for Apply to Record is one of the two choices available in this 
release. A second choice for Apply to Record is to Update all records in 
chain. There are different procedures for configuring No Treatment and Update 
all records in chain, as explained in the next two sections.

End of procedure

Apply to Record: No Treatment

OCS updates the record at the conclusion of the call; that is, when the IVR 
hangs up.

Procedure:
Apply to Record, updating all records in a chain
With Update all records in chain, OCS updates all records in a chain as soon 
as OCS detects an answering machine or FAX machine and transfers the call to 
a queue for an IVR response.

Start of procedure

If the administrator chooses to Update all records in chain for 
Apply to Record, follow this procedure:
1. Under Agent Group properties, add an Origination DN shortcut to the 

queue that the IVR DNs log in to. 
2. Create an Answering Machine treatment using the following parameters:

• Call Result: Answering Machine Detected
• Apply to Record: Update All Records in Chain
• Apply to Call: Transfer or Connect (Recall that a call can be transferred 

or connected to a queue for an IVR. The two terms are synonymous 
here.) 

3. Destination DN: The ACD queue that the IVR DNs log in to. (See note 
below.)

4. Add this treatment to the calling list you are using.
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Note: Recall that the administrator specifies the Destination DN in the 
Configuration Manager or through the Outbound Configuration 
Wizard.

End of procedure

Apply to Record Actions
When creating a Treatment object in Configuration Manager, you must assign 
an Apply to Record action to unsuccessful call results—for example, busy or 
no answer. See the “Configuration Objects” chapter in this guide for Apply to 
Record definitions and configuration instructions.

Note: Outbound Contact 7.6 will update the call_result field of a record as 
Answered in the following scenario:

The Apply to Record action is Assign To Group.
An agent scheduled a personal RecordReschedule and then logs out. 
At the scheduled call time, another agent receives and processes the 
record without specifiying a all result.

Previously in this scenario, Outbound Contact would update the record 
as Agent CallBack Error.

Rules for Next-in-Chain Actions
The three Next-in-Chain actions have special rules. All records in a calling list 
are assigned a chain ID and chain number, even if there is only one record in a 
chain. These are unlinked records containing a unique chain ID and a chain 
number represented by a positive number. These unlinked records are not 
considered to be chained records.
The term “chained records” refers to two or more records linked to each other 
and assigned the same chain ID. Each chained record has a unique chain 
number within its chain.
In the example of chained records in Table 32, the Chain # Column shows the 
order of calling. The first number in the chain to be called starts with 1, the 
second number in the chain to be called starts with 2, and continues to 
increase.
The chain numbers can be in any order, but, by default, they are processed in 
ascending order. You can change the order by using a filter for a call list in the 
Configuration Manager, by specifying a list of the record fields followed by 
ASC or DESC and separated by commas.
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The Next-in-Chain actions are as follows:
• Next-in-Chain (immediately dialed)
• Next-in-Chain after (dialed after a specified interval)
• Next-in-Chain at specified date (dialed at a date set in the treatment 

configuration)
The following guidelines apply:
1. To use any of the next-in-chain actions in a treatment, a calling list must 

have chain_id and chain_n populated correctly. 
2. When creating a treatment sequence, use the next-in-chain action as the 

last member in the treatment sequence.
3. When defining treatments for the chained records, treatments of the type 

Next-In-Chain are used more often than the Cycle and Redial type of 
treatments. 

Generally, if an unsuccessful call result is received, you do not want to redial 
that number if you have another number to dial for the same contact. However, 
the final decision on what type of treatment to apply depends upon the goal 
and strategy of the specific Outbound campaign. 

Repeat the Treatment Cycle Through the Chain of Records
When applying treatments, Outbound Contact has the capability of cycling 
through the chain of records more than once; when the chain has ended, OCS 
can start dialing the chain again from the first record. Both of the following 
must be true:
• The last record in the chain is dialed and receives a negative call result.
• The current treatment to be applied is either Next-in-Chain, Next-in-Chain 

After, or Next-in-Chain at Specified Date.

Table 32: Example of Chained Records

Phone Type Chain ID Chain #

James Smith (Home) 19 1

James Smith (Work) 19 3

James Smith (Mobile) 19 2

Janet Green (Work) 20 3

Janet Green (Home) 20 1

Janet Green (Pager) 20 2
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If both of these are true, OCS can cycle from the last record in the chain to the 
first record in the chain, and then start dialing the chain again. The behavior to 
cycle through the chain more than once is optional. 
To enable this chain cycling, you must properly set the timing properties for 
any of the three Next-in-Chain treatments, as follows:
• Cycle Attempt—Determines the total number of times that a chain will 

jump from the last to the first record in the chain. The default value for this 
property is 0, which means one cycle. The value 1 also means one cycle. 
Setting the value to be greater than 1 means that the cycling will occur for 
that specific number of times. The initial dialing of the chain is counted as 
the first cycle attempt. 

• Interval—Determines the time period to wait before beginning the cycle 
again. The interval measures the time between completing the last record 
in the chain and then jumping to begin again with the first record in the 
chain. 

• Increment—Determines the additional amount of minutes to add to the 
next interval, beyond the length of the previous interval. 

Notes: The default behavior is one cycle. When a chain ends, it is updated in 
the Calling List and OCS stops processing that chain unless you have 
configured the system to repeat the cycle through the chain again.
The Interval and Increment properties are not applicable to the Next-
in-Chain at Specified Date treatment.
For the Next-in-Chain After treatment, the Interval property 
specifies both the amount of time to wait before dialing the next 
record, and also, the time to wait before beginning the cycle again. The 
Increment property applies to the time interval before beginning the 
cycle again, but not to the time interval between records.

For more information about the timing properties for these treatments, see 
Table 33, “Using Timing Properties,” on page 284. 

Example of the Chain of Records Treatment Cycle Repetition

The following provides an example of the cycle behavior for the chain of 
records for a Next-in-Chain treatment. In this example, the calling list has a 
Next-in-Chain treatment for a No Answer call result, with the following 
configuration:
• Cycle Attempts: 3. The total number of times that the cycle through the 

chain occurs will be 3 times.
• Interval: 30. The time to wait before beginning the cycle again is set for 

30 minutes. So, the amount of time between ending the last record in the 
chain and jumping to the first record in the chain will be 30 minutes. 



Deployment Guide 283

Chapter 10: Call Handling Apply to Record Actions

• Increment: 20. The time period to add to the interval for each subsequent 
cycling will be 20 minutes. 

The configurations in the example above will result in the following behavior: 
1. OCS retrieves a chain consisting of three records and dials the first record 

in the chain. There is no answer. The treatment is: if there is no answer, 
dial the next record in the chain. 

2. OCS dials the next record in the chain. There is no answer. The treatment 
is: if there is no answer, dial the next record in the chain.

3. OCS dials the third record in the chain. There is no answer. The treatment 
is: if there is no answer, dial the next record in the chain.

4. The chain has ended. The number of Cycle Attempts in our example is set 
to greater than 1, so OCS will wait for the specified time of 30 minutes 
(Interval value in our example), and then proceed.

5. After waiting 30 minutes; OCS will now jump to the first record in the 
chain, and begin with the first treatment step. This cycle will repeat two 
more times; a total of three times, because the Cycle Attempts is set to 3 in 
our example.

6. For the next two cycles, the Increments between intervals will now take 
effect and they will increase between each cycle. On the second cycle, 
OCS will wait 50 minutes (Interval of 30 minutes + Increment of 20 
minutes in our example) before jumping to the first record in the chain. On 
the third cycle, OCS will wait 70 minutes (Interval of 30 minutes + 
Increment of 20 minutes + Increment of 20 minutes) before jumping to the 
first record in the chain.

Note: The Next-in-Chain treatment must be the last treatment in the 
sequence. If the Next-in-Chain treatment is not the last treatment in the 
sequence, all treatments after the Next-in-Chain will be ignored.

Rules for Update All Records in Chain
The Update all records in chain action can be used even if there are no 
chained records in a calling list. It does not have the same restrictions as the 
next-in-chain actions for the following reasons:
1. This action does not require that timing properties be set.
2. All records contain a chain ID and number even when they are not chained.

Notes: The No Treatment action can be used for the call result Answering 
Machine Detected in a Connect/Transfer treatment only if AM calls are 
connected to agents that belong to the OCS Campaign Group. 
Otherwise, the treatment Update all records in chain must be 
configured for the Apply to Record action.
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The Update all records in chain action does not work for Answer call 
results in the Connect/Transfer to treatment.

Timing Properties Used with Apply to Record Actions
Understanding timing properties is essential when creating treatments and 
applying them to Calling List objects. Table 33 shows which timing properties 
are required for each treatment action.

Table 33: Using Timing Properties

Apply to 
Record 
Action

Cycle Attempt Interval Increment
(minutes)

Date
Time

Assign To 
Group

Not Applicable Not Applicable Not Applicable Not Applicable

Mark As Agent 
Error

Not Applicable Not Applicable Not Applicable Not Applicable

Next-in-Chain Required
Set the maximum 
number of passes 
through the chain: 
values 0 and 1 = one 
pass; the next record in 
the chain is dialed 
immediately 

Required
Set the time interval 
until the next pass 
through the chain, 
after the last record 
in the chain has 
been dialed.

Required
Set the time 
interval for the 
subsequent 
chain passes

Not Applicable

Next-in-Chain 
after

Required
Set the maximum 
number of passes 
through the chain: 
values 0 and 1 = one 
pass

Required
Set the time interval 
until the next record 
in chain is dialed, 
and until the next 
pass through the 
chain, after the last 
record in the chain 
has been dialed.

Required
Set the time 
interval for the 
subsequent 
chain passes

Not Applicable

Next-in-Chain at 
specified date

Required
Set the maximum 
number of passes 
through the chain: 
values 0 and 1 = one 
pass

Not Applicable Not Applicable Required
Set the date/time 
to dial the next 
record in chain
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When OCS calculates the time for the next dial according to the treatment 
configuration, it is possible that the new calculated time is out of the “daily 
from” – “daily till” boundaries of the record. If this happens, OCS adds an 
appropriate amount of time to the calculated time so that it falls within the 
boundaries.

Treatment Sequences
Treatment sequences allow you to apply different treatments to each 
consecutive instance of the same call result. For example, if a Busy call result 
is received four times in sequence, you might want to apply a different action 
to each occurrence. Each treatment in the sequence must have a unique 
treatment name, an Apply to Record action, and a unique, consecutive 
sequence number. Treatments are linked by assigning the same call result to 
each treatment in the sequence.

No Treatment Not Applicable Not Applicable Not Applicable Not Applicable

Redial Required
Set the maximum 
number of retry 
attempts

Required
Set the time interval 
until the first cycle 
attempt.

Required
Set the time 
interval for 
subsequent 
cycle attempts.

Not Applicable

Reschedule Not Applicable Not Applicable Not Applicable Not Applicable

Retry at 
specified date

Not Applicable Not Applicable Not Applicable Required
Set the date/time 
for the next 
attempt

Retry in Not Applicable Required
Set the time interval 
until the next (only 
one) attempt

Not Applicable Not Applicable

Update all 
records in chain

Not Applicable Not Applicable Not Applicable Not Applicable

Table 33: Using Timing Properties (Continued) 

Apply to 
Record 
Action

Cycle Attempt Interval Increment
(minutes)

Date
Time
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Note: Campaign sequences are not the same as treatment sequences. See 
“Campaigns” on page 46 for more information about campaign 
sequences.

Rules for Treatment Sequences
Apply these general rules to treatment sequences.
• Treatment sequences are compatible with next-in-chain Apply to Record 

actions. Next-in-Chain treatments should be the last one in a sequence. 
When OCS dials the next record in a chain and receives the same call 
result for this record as it did for the previous record, the whole treatment 
sequence will be repeated.

• Always assign consecutive numbers to treatment sequences and always 
begin with 1. If you use non-consecutive numbers—such as 1, 2, and 4— 
the treatment sequence stops at the first non-consecutive number, which in 
this example is 4. The first two treatments would apply, but not the fourth.

• OCS applies each treatment in sequential order until a successful call result 
is received, a dialing attempt generates a different unsuccessful call result, 
or the number of dialing attempts equals the Maximum Attempts value 
assigned in the calling list object.

• If a treatment sequence for one call result (for example, Busy) is 
interrupted with a different call result (No Answer), the sequence is broken 
and the Number in sequence value for Busy resets to one 1. If the Busy call 
result is received again, the treatment sequence restarts at the beginning.

Treatment Object List

Table 34 shows Treatment objects that will be used in Examples 1 and 2, 
which follow.

Table 34: Treatment Objects List

Treatment 
Object 
Name

Call Result Number in 
Sequence

Treatment Action
(Apply to Record)

Busy1 Busy 1 Redial

Busy2 Busy 2 Retry in (60 min.)

AnsMach1 Answering 
Machine Detected

1 Retry in (60 min.)
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Example 1: Treatment Sequence Exhausted

In this example, the Maximum Attempts value in the Calling List object is 8, 
and a record is dialed five times. The results are shown in Table 35.

In Example 1, the call did not reach its intended party and, on the fifth dial 
attempt, the second number in the Answering Machine Detected treatment 
sequence is executed.

Example 2: Record Reaches Maximum Attempts Value

When the number of times the telephone number is dialed matches the 
Maximum Attempts value from the calling list, the final outcome of the last 
attempt is applied and logged in the database.

AnsMach2 Answering 
Machine Detected

2 Retry at specified date

NoAnswer No Answer 1 Retry in (60 min.)

Table 35: Example 1, Treatment Sequence Exhausted

Call Result Treatment Action
(Apply to Record)

Reached Party?

Busy Redial No

Answering Machine 
Detected

Retry in (60 min.) No

Busy Redial No

Answering Machine 
Detected

Retry in (60 min.) No

Answering Machine 
Detected

Retry at specified date No

Answer No treatment Yes

Table 34: Treatment Objects List (Continued) 

Treatment 
Object 
Name

Call Result Number in 
Sequence

Treatment Action
(Apply to Record)
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In this example the calling list object’s Maximum Attempts value is 8. Using 
the same Treatment objects from Example 1, a record is dialed eight times, 
with the results shown in Table 36. 

In Example 2, the call did not reach its intended party after eight attempts. 
Because the Maximum Attempts value is 8, dialing stops and OCS applies the 
final outcome.

Apply to Call Outcomes
When creating a Treatment object in Configuration Manager, you can assign 
an Apply to Call outcome for two call results: Answering Machine Detected or 
Fax Detected. See “Rules for Special Call Results” on page 277 for additional 
information. See the “Configuration Objects” chapter in this guide for 
configuration instructions.

Note: The Apply to Call treatments work when in Transfer mode. 

The Apply to Call treatments are:
• Drop. This is the default if no treatment is specified. OCS drops the call and 

logs the call result as Answering Machine or Fax Detected in the database.

Table 36: Example 2, Record Reaches
Maximum Attempts Value

Number 
of 
Attempt
s

Call Result Treatment 
Action
(Apply to 
Record)

Reached 
Party

1 Answering Machine 
Detected

Retry in (60 min.) No

2 Busy Redial No

3 Answering Machine 
Detected

Retry in (60 min.) No

4 Busy Redial No

5 Answering Machine 
Detected

Retry in (60 min.) No

6 Busy Redial No

7 Answering Machine 
Detected

Retry in (60 min.) No

8 Busy Redial No
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• Connect or Transfer. This treatment can be user-assigned only to 
Answering Machine Detected or Fax Detected call results. OCS transfers 
calls to the specified DN. 

• In addition, OCS checks both the “AnswerClass” data and the call state data 
to determine if a dialed call has reached an answering machine. This 
process eliminates problems with some switches. For more information, 
see “Rules for Answering Machine Detected or Fax Detected” on 
page 278.

Rules for Apply to Call
There is one rule for Apply to Call:

The default value is [Unknown Action code]. Do not change this default 
unless you are creating a treatment for Answering Machine Detected or 
Fax Detected call results and have created and configured a Destination 
DN for this purpose.

Outbound Record Sharing Between 
Multiple Desktops

Outbound record sharing between multiple outbound-enabled desktops is 
possible when the outbound call is made for a certain record (that is, a call with 
the GSW_RECORD_HANDLE key and a valid record handle value attached 
to it) is transferred or conferenced between two or more agent places. For 
proper record sharing, OCS must monitor all of the DNs that participate in the 
call transfer or conference. In addition, all agents who intend to share the 
record must be logged in.
There are three possible scenarios for sharing records.

Scenario 1: Outbound Call Single Step Transfer or Mute (Blind) Transfer

Upon a successful transfer completion, all rights to the record and chained 
records access are revoked from the agent who initiated the transfer and are 
granted to the agent who received the transferred call.

Scenario 2: Outbound Call Two-step Transfer with Consultation Call

During the consultation phase of the transfer (or conference), when the 
consultation call is established on the agent’s DN who should receive the 
transferred call (or be added to the conference), this agent has read-only 
permissions for the record. No desktop events will be accepted from this agent, 
except for a request for chained records (ChainedRecordRequest), which are 
also passed to the agent desktop in the read-only mode.
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Scenario 3: Outbound Call Conference

All agents participating in the conference call have full access to the record 
(and chained records of the same chain) and the right to update the chain (that 
is, by sending desktop protocol events for specific record handling). 

Note: During the conference scenario, when more than one agent has full 
access to the record, record access is concurrent. This means, that if 
one agent sends the RecordProcessed event for the record and receives 
an Acknowledgement from OCS, the other agent(s) will not be able to 
update this record anymore.

Answering Machine Call Handling
You can handle calls that are detected with an Answering Machine call result 
on a per-record basis.

Per-record Basis
OCS supports the ability to assign different types of AM-detection to each 
dialing request based on a custom configured value of an arbitrary field in 
calling list record.
In order to configure AM-detection on a per-record basis, OCS uses the 
Business Attributes configuration object. You can configure it as follows:
• Specify the name as OC AM Detection.
• Specify the type as Custom. See Figure 15 as an example.
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Figure 15: Creating a Business Attribute

• Specify the display name and the description attributes as any value. See 
Figure 16 as an example.
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Figure 16: Configuring a Business Attribute

Note: Any number of attribute values can be configured under this Business 
Attribute object. Each individual attribute value represents a field in 
the Calling List with a map of values for this field and the 
corresponding values for the desired AM-detection. You can only 
specify one map per calling list or OCS application. The name of the 
attribute value is arbitrary; however it should be meaningful so that it 
is easier to associate a calling list with this attribute value.

The actual map for field values for AM-detection settings translation is 
configured in the Annex tab of the attribute value as follows:
• The section name must contain the name of the Calling List Field 

configuration object. 
• The option name corresponds to the value of the Field name. The option 

name must contain the actual enumeration value of the field (the value of 
the field stored in the database). The supported option values correspond to 
the valid values for the call_answer_type_recognition option.
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• The option value specifies the desired AM-detection setting.
In order to specify which Calling List uses which attribute value, the am-
detection-map option can be used. See page 212 for more information about 
this option.
OCS uses the following approach to determine which AM-detection value to 
apply to a dialing request.
• OCS finds the name of the AM-detection map in the Annex tab of the 

Calling List that contains the record. 
If it is not found, then the previous Campaign-level 
call_answer_type_recognition option is used for AM-detection 
settings.
If it is found, OCS attempts to find the Business Attribute value with 
the specified name in the configuration. This attribute value should be 
present under the Business Attribute object with the OC AM Detection 
name in the same Tenant where the Calling List resides; if it is not 
found, it should be in the Environment section. If the value of the am-
detection-map option is set to default, then OCS looks for the attribute 
value with the Default flag turned ON, as configured under the same 
Business Attribute object.

• Once the map is found, OCS reads through the names of the sections in the 
Annex tab for this map for the section name that matches a field name of the 
given calling list is used. 

If the field is not found, or the value of this field in the current record 
does not have a representation in the option name, then the 
call_answer_type_recognition option is used.

• OCS assigns an AM-detection value to the Calling List record when the 
record is retrieved from the database if an AM-detection map is found. 
Otherwise, the call_answer_type_recognition option determines the AM-
detection value when it is dialed. Any configuration changes in the AM-
detection map will not affect any records that have been already retrieved 
by OCS. 

If the attribute value is not found or disabled, then OCS uses the AM-detection 
method that is defined in the call_answer_type_recognition option.

Note: When working with GVP, the ANSWER_TYPE_RECOGNITION attribute is 
added to the dialing attributes. This attribute holds the value for AM-
detection for a given dialing request.
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11 Deploying Do Not Call 
Functionality
This chapter discusses the deployment of Do Not Call functionality. This 
chapter covers these topics:

User-Defined Field for Do Not Call, page 295
Do Not Call Table Structure, page 297
Updating the DNC List, page 298
OCS-Desktop Protocol Changes for DNC, page 300

User-Defined Field for Do Not Call
The restriction on dialing a particular customer is an alternative to the Do Not 
Call restriction applied to a particular telephone number. The ability to apply a 
a Do Not Call request to a specific customer is helpful when the same phone 
number appears on more than one customer's records. For example, in a family 
or roommate situation, one member of the household might want to be on the 
Do Not Call list while another person at the same residence and with the same 
telephone number might not make that request.
The value of the customer_id option in the OCS Application object is the 
name of the field that the user designates for the customer identifier. At start-
up, OCS reads all the records from the table referenced in the 
gsw_donotcall_list Table Access and populates two separate tables in 
memory with unique values from the phone field and from the customer_id 
field. Do Not Call requests from the agent desktop can also populate these 
tables in memory during runtime.
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Configuration Procedure
Perform this procedure in the Configuration Manager to create a user-
defined field to identify customers for a Do Not Call List. This new field 
will serve as the customer_id for Do Not Call requests and will be included 
in the UserData attached to T-Server events. As the value of the 
customer_id option in the OCS Application object, this field will 
correspond to the customer_id field in the Do Not Call 
(gsw_donotcall_list) table.

Procedure:
Creating a user-defined field to identify customers for 
the Do Not Call list

Start of procedure

1. Create a new user-defined field. In the General tab, define the fields as 
follows:
• Name = <user-specific name> 
• Data Type = varchar 
• Length = 64 
• Field Type = User-Defined 
Also select the options Nullable and State Enabled. 

2. Assign the send_attribute to it in the Annex tab by adding a default 
section.
In the Edit Option dialog box, define the fields as follows: 
• Option Name = send_attribute 
• Option Value = GSW_CUSTOMER_ID 

3. Designate the new user-defined field as the customer_id option in the OCS 
Application object. 
In Configuration Manager > Environment > Applications > Outbound 
folder> OCS Properties dialog box > Options tab > OCServer section, 
create and define the customer_id option. Use the name of the new user-
defined field as the value of customer_id. 
• Option Name = customer_id 
• Option Value = <name of new user-defined field> 

4. Add the new field (defined in #1) to a new Format object. 
In Configuration Manager > <Tenant> > Format folder > Format 
Properties dialog box, create a new format for a Calling List table that 
will include the new user-defined field. 
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5. Configure a Table Access object for the gsw_donotcall_list. 
In Configuration Manager > <Tenant> > Table Access folder > Table 
Access Properties dialog box, create and configure a new Table Access 
object as follows:
In the General tab, specify the following: 
• Name = gsw_donotcall_list (This is a required field value.) 
• Table Type = Log Table 
• DB Access Point = <user-specific name of DB Access Point> 

The DB Access Point here is for the gsw_donotcall_list. 
• Format = None 
• Database Table = <user-specific name of database table>

6. Create a Calling List object with the new format. In Configuration 
Manager> <Tenant> > Calling Lists, configure a Calling List object 
with the following:
In the General tab, specify the following:
• Table Access: <New Calling List> 

This is a new Calling List formatted with the customer_id field.
These configurations allow the customer ID to be inserted into Do Not Call 
requests, into the database table specified in the gsw_donotcall_list Table 
Access, and into the memory tables.

End of procedure

Do Not Call Table Structure 
The Do Not Call table has a fixed structure, as shown in Table 37. The 
customer_id field, like the phone field, is part of that established structure. The 
Do Not Call table does not require Format and Field configurations. OCM 
generates this table if the Table Access object is present, but the physical table 
does not yet exist.

Note: If you manually add entries to the Do Not Call table, you must restart 
Outbound Contact Server (OCS) so OCS can read the new records into 
its memory.

 

Table 37: Do Not Call Table Structure

Field Name Type Nullable

phone varchar (64) yes

customer_id varchar (64) yes
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Note: The phone field in 6.5 was changed to the contact_info field in the 7.0 
Calling List table. The phone field is still in the Do Not Call List table.

Updating the DNC List 
Through OCM, you can update a current DNC list with data from an external 
source. OCM first reads data from an ASCII file, which is in comma-delimited 
format. The user then maps this data to the appropriate columns in the DNC 
list (database table).
Figure 17 shows Step 1 (selecting a tenant) in the process of updating the DNC 
list with data from an external source.

Figure 17: Step 1: Selecting Tenant

dnc_message varchar (255) yes

tenant_dbid decimal (18, 0) yes

campaign_dbid decimal (18, 0) yes

list_dbid decimal (18, 0) yes

is_internal int yes

time_stamp int yes

Table 37: Do Not Call Table Structure (Continued) 

Field Name Type Nullable
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In Step 2, the OCM user maps data to the appropriate columns in the DNC list 
(database table). Figure 18 shows Step 2 in the process of updating the DNC 
list with data from an external source.

Figure 18: Step 2: Mapping to DNC List

OCM first presents the data from the ASCII file in columns.
Figure 18 (top) shows the phone, customer_id, campaign_id. The user maps 
these columns to corresponding columns in the DoNotCall call list table.
Figure 18 (bottom) shows a highlighted column being mapped to a 
corresponding column in the DoNotCall call list table. The drop-down list 
shows the choice of columns in the database table.



300 Outbound Contact 7.6

Chapter 11: Deploying Do Not Call Functionality OCS-Desktop Protocol Changes for DNC

Figure 19 shows Step 3 in the process of updating the DNC list with data from 
an external source. Step 3 is the selection of import options. These are the 
choices:
• Empty the database table before import.

Delete external “Do Not Call” entries only.
Delete all “Do Not Call” entries.

• If the time_stamp field is empty, then:
Set it to the current time.
Leave it empty.

• Do table modification in Transaction.

Figure 19: Step 3: Specify Import Options

Note: When importing a Do Not Call list with the option Do Table 
Modifications in Transaction switched to ON (see Figure 19), 
Genesys recommends that you set the DB Server option 
tran_batch_mode to false. When this option is set to true, DB-Server 
buffers all the transaction statements and sends them as a batch to 
DBMS Server once the transaction is complete. This prevents OCM 
from being able to roll back the whole transaction if an error occurs, 
because OCM is notified about the error after the COMMIT TRANSACTION 
actually occurs.

OCS-Desktop Protocol Changes for DNC
A Do Not Call (DNC) request from an agent (GSW_AGENT_REQ_TYPE = DoNotCall) 
includes an attribute to specify the customer_id: GSW_CUSTOMER_ID. At least 
one attribute (GSW_PHONE or GSW_CUSTOMER_ID) must be present in the UserData 
of the request if the GSW_RECORD_HANDLE is not specified.
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12 Configuring Dialogic 
Boards
This chapter contains information on how to configure dialogic boards with 
Outbound Contact. It contains these sections:

Introduction to Dialogic Boards, page 301
Dialogic Board Setup, page 302
Configuring Dialogic Boards, page 304
Dialogic Board Configuration Structure, page 308
HMP Software, page 320
Dialogic Utilities, page 324

Introduction to Dialogic Boards
If you intend to install CPD Server, you must first set up the Dialogic boards. 
You need to install a hardware card and a software driver to implement 
Dialogic. Contact the Dialogic vendor for your company or visit the Dialogic 
support website for more information about Dialogic boards and supported 
software. Information about Genesys supported hardware and third-party 
software is available on the Genesys Technical Support website in the 
following documents:
• Genesys 7 Supported Operating Systems and Databases
• Genesys 7 Supported Media Interfaces
The following lists specific information when CPD Server is use with Dialogic 
DM3 hardware:
• All recordings are in a PCM/8000Hz/8bps (VOX) format. The .wav format 

is no longer supported.
• DM3 boards do not work with a NEC switch containing a line-side 

configuration and the tscall option value is set to true or on.
• DM3 boards are supported in line-side environments.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
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Note: Starting with release 7.5, you can also use Dialogic’s Host Media 
Processing (HMP) software instead of a physical hardware card. See 
“HMP Software” on page 320 for more information.

Dialogic Board Setup

Procedure:
Setting up Dialogic boards

Start of procedure

1. Make sure a supported version of Microsoft Windows operating system is 
installed.

2. Install Dialogic SR 6.
3. Select the required drivers, firmware, and configuration files from the 

custom package.
4. Configure the Dialogic boards. See “Configuring Dialogic Boards” on 

page 304 for more information.
5. Start Dialogic Configuration Manager (DCM). DCM should automatically 

detect the board and find valid address/port/interrupt values for the 
particular machine.

6. Start the Dialogic drivers.
7. Use the Dialogic application provided with the Dialogic board to test each 

port for off-hook ability, to dial a test telephone number, and then to place 
the port on-hook. 

8. Make sure that each port can complete this test before installing and 
configuring CPD Server.

Notes: When installing Dialogic boards, make sure that the board number set 
by the switch on the board is unique inside each board type. If you 
have two T1 boards, the first one must be 0, the next 1, and so on. 
Make sure the SCBus/CTBus cable connects the boards, if needed. 
If there are error messages when starting the Dialogic drivers, the error 
messages will display in the Windows NT Event Viewer. Restart 
Dialogic Configuration Manager or reinstall the Dialogic boards if 
there are errors. If these steps do not solve the problem, contact 
Dialogic support.

End of procedure
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Active Switching Matrix Mode Call Flow
Active Switching Matrix (ASM) mode is a dialer mode that eliminates various 
problems of switches that do not support call progress detection or that 
produces unacceptable transfer delays or force-tone problems.
You can configure ASM mode either in Configuration Manager or in the 
Outbound Contact Wizard. The switch determines the correct dialing mode 
based on the presence or absence of a Dialogic board. CPD Server checks the 
ASM configuration (for ISDN or Melcas) set up in Configuration Manager to 
determine what the dialing mode is.
The key feature of the ASM-mode call flow is the Engage call, which OCS 
requests from the Dialogic board. This call engages the agent in a real, 
established call before the dialed party actually responds and is connected to 
the call. The sequence of events in this call flow is as follows:
1. The agent sets the phone set to Ready.
2. The switch notifies T-Server that this agent is ready, and T-Server informs 

OCS by distributing an EventAgentReady message.
3. As soon as OCS learns that one or more agents are available at a given 

queue, it sends an EngageAgent request to CPD Server.
4. CPD Server instructs the Dialogic board to send a special Engage call to the 

available agent’s queue. This is a real call, but is created only on an 
internal segment—from a Dialogic port to the ACD Queue. 

Note: The switch considers this an inbound call because the call is 
coming to an internal DN from a point outside the switch.

5. The Engage call is queued, which generates an EventCallQueued message. 
T-Server distributes this event to OCS, but OCS recognizes it as a special 
type of call and knows to ignore the event.

6. Since this queue has an available agent, the ACD diverts the Engage call to 
the agent’s desktop. This generates an EventDiverted message, but OCS 
also ignores it, knowing that it refers to an Engage call.

7. The agent answers the Engage call, generating an EventEstablished 
message. At this point the agent is on a real call and hears a tone from the 
switch indicating that he or she is in an engaged state. The agent 
encounters a delay of some seconds while OCS and CPD Server generate 
the second segment of the call to a dialed number from the calling list.

8. In Progressive dialing mode, OCS waits until it knows the agent is Engaged 
before asking CPD Server to make an outbound call. In Predictive dialing 
mode, OCS is making outbound calls according to its predictive algorithm 
without regard to availability of agents.

9. CPD Server informs the Dialogic board to make a call to the customer 
number supplied by OCS. 
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Note: This call is dialed outside the switch, so that neither the switch nor 
T-Server sees it. Therefore, no T-Server events are associated with 
this call.

10. If the call reaches a live customer, CPD Server attaches the account 
information or other data to the Engage call.

Note: The first agents engaged are the first to be distributed.

11. T-Server delivers this data to the Engaged agent’s desktop as a screen pop. 
Simultaneously, CPD Server connects the internal and external segments 
of the call, and the call is established between the agent and the customer. 
T-Server considers the call type for the call to be Inbound, whereas 
Campaign Manager sees the call type as Outbound because it was generated 
by CPD Server.

12. CPD Server informs OCS of the call result. 
From this point, the call is handled according to the campaign requirements 
similar to transfer-mode.

Port Requirements for ASM Mode

CPD Server uses two ports in ASM-mode to connect the agent to the customer. 
CPD Server releases both ports at the end of the call.
When CPD Server is not in ASM-mode, it uses only one port to make a call and 
to transfer it to an agent. CPD Server releases the port when the call is 
transferred.
OCS reports the number of ports available. If for some reason, OCS does not 
track the number of ports available, CPD Server sends a No Free Port message 
to OCS.

Configuring Dialogic Boards
Outbound Contact Configuration Wizard puts the information about installed 
Dialogic boards and resources in CME. You can use Configuration Manager to 
change the configurations, as needed. See “Dialogic Board Configuration 
Structure” on page 308.
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Frequently Used Configurations
Table 38 lists frequently used configurations for Dialogic boards. The driver 
names are provided for a single board configuration. For multiple boards, the 
corresponding board numbers must be sequentially numbered.

Table 38: Dialogic Board Configurations

Board Type Configuration

D/160JCT-LS Virtual Board 4 LSI (dxxxB1...dxxxB4)

Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

Voice Virtual Board 4 voice (dxxxB1...dxxxB4)

Voice Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

D/41JCT Virtual Board 4 LSI (dxxxB1...dxxxB4)

Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

Voice Virtual Board 4 voice (dxxxB1...dxxxB4)

Voice Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

D/240JCT-T1 Virtual Board 1 DTI board (dtiB1)

Virtual Device 24 channels (23 if) (dtiBxT1...dtiBxT24)

Voice Virtual Board 6 voice (dxxxB1...dxxxB6)

Voice Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

D/480JCT-2T1 Virtual Board 2 DTI boards (dtiB1, dtiB2)

Virtual Device 24 channels (23 if) on each board (dtiBxT1...dtiBxT24)

Voice Virtual Board 12 voice boards (dxxxB1...dxxxB12)

Voice Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)

D/480SC-2T1 Virtual Board 2 DTI boards (dtiB1, dtiB2)

Virtual Device 24 channels (23 if) on each board (dtiBxT1...dtiBxT24)

Voice Virtual Board 12 voice boards (dxxxB1...dxxxB12)

Voice Virtual Device 4 channels on each board (dxxxBxC1...dxxxBxC4)
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Suggested DM/V Dialogic Board Configuration

When configuring a DM/V-type board, configure the Dialogic channels similar 
to the way in which you configure any CPD Server that is operating in 
Transfer mode and that interfaces with a lineside T1/E1. The following two 
sections provide more information about configuring specific models of this 
board type.

Note: The line-type option must contain a value of line-side-dm3. See 
page 224 for more information about this option.

D/300JCT-E1 Virtual Board 1 DTI board (dtiB1)
4 channels on boards 1 to 7

Virtual Device 30 channels (dtiBxT1...dtiBxT30)

Voice Virtual Board 8 voice boards (dxxxB1...dxxxB8)

Voice Virtual Device 2 channels on board 8

D/300JCT-2E1 Virtual Board 2 DTI boards (dtiB1, dtiB2)

Virtual Device 30 channels on each (dtiBxT1...dtiBxT30)

Voice Virtual Board 8 voice boards (dxxxB1...dxxxB8)

Voice Virtual Device 4 channels on boards 1 to 7, 2 channels on board 8

D/600JCT-2E1 Virtual Board 2 DTI boards (dtiB1, dtiB2)

Virtual Device 30 channels on each board (dtiBxT1...dtiBxT30)

Voice Virtual Board 16 voice boards (dxxxB1...dxxxB16)

Voice Virtual Device 4 channels on boards 1 to 7 and 9 to 15; 2 channels on 
boards 8 and 16

DM/V1200-4E1 DM3 board with CPD 
functionality

120 channels

DM/V600-2E1 DM3 board with CPD 
functionality

60 channels

DM/V960-4T1 DM3 board with CPD 
functionality

96 channels

Table 38: Dialogic Board Configurations (Continued) 

Board Type Configuration
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Procedure:
Configuring the DMV480A-2T1 board

Start of procedure

If you are using a DMV480A-2T1 board, do the following:
1. Create a new file called pdk.cfg that contains the following statement:

Board 0 fcdfile ml2_dsa_cas.fcd pcdfile ml2_dsa_cas.pcd variant 

pdk_sw_e1_ntmd_io.cdp

2. Move this file to C:\Program Files\Dialogic\cfg.
3. Open a command prompt and type in the following path:

C:\Program Files\Dialogic\bin

4. Execute the following command:
PDKManagerRegSetup add

You should receive the following message:
PDKManager key insertion succeeded.

5. Open Dialogic Configuration Manager and right-click your Dialogic board 
type.

6. Select Configure device.
7. On the Misc tab, select:

• ml2_dsa_cas.fcd as the FCD file 
• ml2_dsa_cas.pcd as the PCD file

8. Restart the Dialogic System Service.
9. Start CPD Server.

Note: If you are using a DMV960A-4T1 board, replace ml2_dsa_cas with 
ml2_qsa_cas.

End of procedure

Procedure:
Configuring DMV480-4T1 board

Start of procedure

If you are using a DMV480-4T1 board, do the following:
1. Create a new file called pdk.cfg that contains the following statement:

Board 0 fcdfile ml1_4x2_cas.fcd pcdfile ml1_4x2_cas.pcd variant 

pdk_sw_e1_ntmd_io.cdp
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2. Move this file to C:\Program Files\Dialogic\cfg
3. Open a command prompt and type in the following path:

C:\Program Files\Dialogic\bin

4. Execute the following command:
PDKManagerRegSetup add

You should receive the following message:
PDKManager key insertion succeeded.

5. Open Dialogic Configuration Manager and right-click your Dialogic board 
type.

6. Select Configure device.
7. On the Misc tab, select:

• ml1_4x2_cas.fcd as the FCD file 
• ml1_4x2_cas.pcd as the PCD file

8. Restart the Dialogic System Service.
9. Start CPD Server.

End of procedure

Dialogic Board Configuration Structure
In Outbound Contact, the configuration process for Dialogic boards has been 
simplified.
The structure of Dialogic board configuration is now represented by a folder 
tree under Switch/DN folder in Configuration Manager. The folder tree 
consists of the following folders:
<location>—This folder is taken from the location option (default section) 
and serves as the board root folder. When a board is deleted, Wizard deletes 
this folder and everything under it. The current Wizard implementation does 
not allow deletion of only part of a board; the whole board is deleted. 
regular—This folder contains channel-DN configuration for dialing outbound 
calls.
recording – optional – folder contains channel-DN configuration for CPD 
recording on the regular DNs. Recording is used to tune up Voice/AM 
detection and should not be used in regular work since it takes half of the voice 
resources. This folder is created but not configured by the Wizard.
engaging—This folder (optional) contains channel-DN configuration assigned 
to engage agents when working in ASM mode.
dxxxB<n>—This root folder for an analog virtual (logical) board. It contains 
voice resources (channels). It may have one or more voice resources.
dxxxB<n>C<m>—Voice resource (channel). In the configuration it links a 
dialogic voice resource and a DN on the switch.
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dtiB<n>—The root channel for a network (T1) virtual board. It contains one 
or more digital resources.
dtiB<n>T<m>—Digital (network) resource. In the configuration it links a 
Dialogic digital (network) resource and a DN on the switch.

Note: Non-analog line type folders representing dxxx channels do not have to 
include real DNs. CPD Server works without DNs in dxxx folders and 
performs call progress detection on non-analog lines. Thus, multiple 
licenses are not required to allow for two DNs per channel and a 
subsequent increase in dialing ports.

Configuration Logical Structure
A logical structure describes a single configuration of many boards. Every 
logical board in a configuration is given a unique logical board number based 
on the order in which the boards are configured. See Figure 20.

Figure 20: Logical Structure

Genesys recommends a 1-to-1 relationship between the CPU, CPD Server, and 
the Location folder.

Note: The number 1 in the above diagram shows a 1 to 1 representation, and 
1...* shows a 1 to more than 1 representation.

The following describes what each item in Figure 20 represents:
• Box—Represents a CPU (central processing unit of a computer running on 

a Windows operating system), where the Dialogic boards and CPD Servers 
are installed.

• Dialogic Board—Represents a hardware board installed into the CPU. The 
CPU may have more than one board installed.

• Logical Board—A logical part of the hardware board representing four 
analog or digital resources (for example, dxxxB1 and all the hierarchy 
belonging to it). One hardware board consists of several logical boards. 
One logical board belongs to only one hardware board.

CPU Dialogic 
Board

1 1..*

Logical Board

1 1..*

Location Folder

1

1..*

CPD Server

11

1

1..*
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• CPD Server—Represents a piece of software installed on the box. It can be 
one or more different CPD Server installations.

• Location Folder—Represents a set of logical boards, and one CPD Server. 
A Location Folder is allowed to have logical boards connected to different 
hardware boards (see example below). Genesys recommends that you set 
up a 1-to-1 association between CPD Server applications and the Locations 
folder.

Considerations

• The Location folder may have logical boards belonging to hardware boards 
installed in one, and only one, computer running on the Windows 
operating system.

• If you have two or more different Location folders, they must not have the 
same logical board configured.

• If you have more than one hardware board installed in the same computer, 
then the first board (minimal hardware ID) has 1…n logical boards 
numbering (dxxxB1…dxxxBn), the second board (next ID) has n+1…m 
(m > n+1) logical boards numbering (dxxxB<n+1>…dxxxBm), and so on. 
If a logical board is removed from a configuration, then all other logical 
boards in the configuration must be renumbered to preserve a logical 
numbering system.

CPD Server Dialogic Hardware Setup in Configuration 
Manager

The following procedure provides guidelines for setting up your Dialogic 
hardware in Configuration Manager folders.

Procedure:
Setting Up your Dialogic hardware

Start of procedure

1. First create the Location folder in the Switch DN folder.
2. Create three subfolders that will contain board resource subfolders with the 

names: 
• engaging (should only contain DM3 (Melcas) resources of Dialogic 

board)
• recording (should contain only voice resources)
• regular (can contain any type of Dialogic resources)
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Note: These board resource subfolder names should be the same as the 
virtual board names used for the Dialogic hardware that is 
installed.

3. In each of these three subfolders, create another group of board resource 
subfolders named exactly the same as the individual channels of the 
corresponding virtual board.

4. In each channel subfolder, include the real DN (Extension) or virtual DN 
(Call Processing Port) that corresponds to the DN assigned to the board 
channel.
• For voice-processing ports and ISDN or Melcas virtual channels, you 

must assign unique numbers to the Call-Processing port DN type.
• For LSI and T1/E1 ports, you should assign the Extension DN type and 

real channel numbers that are recognizable by the switch.

Note: The ACD Position DN type is not a valid value for CPD Server 
DNs.

5. The Register check box should be cleared (unchecked) for CPP and 
selected (checked) for ACD Extension DNs.

End of procedure

Dialogic Board Configuration
The following includes configuration information you can use to configure 
ASM (ISDN and Melcas), Analog, or T1/E1 line-side protocols.

ASM Mode

An ASM configuration must have at least one digital board and one voice 
board in the regular folder. Figure 21 shows the directory structure for an 
ISDN or Melcas board.
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Figure 21: ASM Mode Directory Structure

In the ISDN and Melcas configurations, network resources are associated with 
DNs of Call Processing Port type. Figure 22 shows a call processing port DN 
in an ASM configuration.
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Figure 22: ASM Call Processing Port DN 

Analog

An Analog board configuration must have the following folders and subfolders 
in this type of directory structure:
• A regular folder 

At least one dxxxB<n> folder within the regular folder
At least one dxxxB<n>C<n> subfolder within the dxxxB<n> folder. 

Figure 23 shows the directory structure for an Analog configuration.
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Figure 23: Analog Directory Structure 

Figure 24 shows an Extension DN in an Analog configuration.
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Figure 24: Extension DN in Analog Configuration 

For more information, see “CPD Server Dialogic Hardware Setup in 
Configuration Manager” on page 310). 
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T1/E1 Line-Side

A T1/E1 line-side configuration must have at least one digital and one voice 
logical board configured in the regular folder. See Figure 25.

Figure 25: T1/E1 Line-Side Directory Structure

In the line-side configuration, each network resource must have one, and only 
one, DN associated with it. Network resources are associated with DNs of type 
Extension. See Figure 26.
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Figure 26: Extension DN in T1/E1 (Line Side) Configuration

Dialogic Board Configuration Examples
The following figures show sample configurations for ISDN or Melcas (in 
ASM), Analog, or T1/E1 protocols.

ASM Mode (ISDN or Melcas)

An ASM configuration must have at least one digital board and one voice 
board in the regular folder.
In the an ASM configuration, network resources are associated with DNs of 
Call Processing Port type.
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Figure 27 shows a configuration example for an ISDN or Melcas protocol.

Figure 27: Board Configuration Example for ISDN or Melcas Protocol

Analog Board Configuration

Figure 28 shows a configuration example for an Analog board.

Figure 28: Configuration Example for an Analog Board

Note: In the 7.x release, the only DN type for an Analog board or a 
T1/E1 board is Extension, not Position.

T1/E1 Line-Side Configuration

A line-side configuration must have at least one digital and one voice logical 
board configured in the regular folder.
In the line-side configuration, network resources are associated with DNs of 
Extension type.
Figure 29 shows the configuration example for a T1/E1 Board.

<regular> : folder

recording : folder

dxxxB<n> : folder

dxxxB<j> : folder

dxxxB<n>C<m> : folder

dxxxB<j>C<m> : folder<location> : folder

DNs : folder

<switch> : Switch *

*

*

*

1dtiB<n>T<m> : folderdtiB<n> : folder *
*

engaging : folder dtiB<k> : folder dtiB<k>T<m> : folder

DN : Call Processing Port

DN : Call Processing Port
* *

1

DN_____________ nExtension<regular> : folder

recording : folder

dxxxB<n> : folder

dxxxB<j> : folder

dxxxB<n>C<m> : folder

dxxxB<j>C<m> : folder<location> : folder

DNs : folder

<switch> : Switch

DN_____________ nExtension

*

*

*

*

1

1



Deployment Guide 319

Chapter 12: Configuring Dialogic Boards Dialogic Board Configuration Structure

Figure 29: Configuration Example for a T1/E1 Board

Note: Each network resource may have one, and only one, DN associated 
with it.

DNs Inside Dialogic Channels Folders
For more information about the Dialogic boards and their channels, see the 
following documents available on the Genesys Technical Support website:
• Genesys 7 Supported Operating Systems and Databases
• Genesys 7 Supported Media Interfaces

New Dialogic Board Configuration
To configure a new Dialog board, follow the procedure provided here.

Procedure:
Configuring a new Dialogic board

Start of procedure

1. In Configuration Manager, create a <location> folder under the Switch 
object.

2. Under the <location> folder, create a folder named recording.
3. Again in the <location> folder, create a folder named engaging.
4. Create a folder named regular. For a description of this folder, see “CPD 

Server Dialogic Hardware Setup in Configuration Manager” on page 310.
5. Configure the regular folder.

DN_____________ nExtension

<regular> : folder

recording : folder

dxxxB<n> : folder

dxxxB<j> : folder

dxxxB<n>C<m> : folder

dxxxB<j>C<m> : folder<location> : folder

DNs : folder

<switch> : Switch *

*

*

*

1dtiB<n>T<m> : folderdtiB<n> : folder *
*

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054&view=item
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7&view=item
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Note: A DN can belong to only one channel across the switch.

End of procedure

HMP Software
CPD Server 7.6 supports Dialogic HMP software in both transfer-mode and 
ASM-mode scenarios. It is enabled by the line-type option (page 224). The 
following are the differences between standard and HMP deployment:
• HMP is simply another connection protocol used in CPD Server.
• An HMP board is represented in Configuration Manager as an iptB1 folder 

under the regular folder. There are no required changes for the names or 
locations of the voice resources.

• An HMP channel is represented as iptB1TX where X is a channel number. 
The DN type is Call Processing Port. The maximum number of channels 
is 256, but 128 is the maximum recommended number of channels.

• HMP transfer-mode requires the following amounts of resources:
Two times as many RTP/IPCC resources as standard transfer-mode.
The same amount of voice resources as standard transfer-mode.

• HMP ASM-mode requires the same amount of resources as regular 
ASM-mode.

• Unlike standard Transfer mode, the UserData in HMP Transfer mode is 
attached when the call enters the agent ACD Queue or Routing Point. This 
enables CPD Server to run in “hybrid” mode when a standard T-Server 
target is used with a media gateway.

• SIP Server is supported without needing to use a media gateway. However, 
only the SIP protocol without registration is supported.

• Each CPD port will still use one Genesys license. However, three types of 
Dialogic HMP licenses are required for each successful outbound call:

1 license for Voice (dxxx)
2 licenses for RTP_G_711
2 licenses for IP_Call_Control (ipt)

Contact your Dialogic representative for more information about HMP 
licensing.

Note: 
• It is recommended that you complete the media processing channel 

configuration in the Outbound Contact 7.5 Configuration Wizard.
• Only one instance of CPD Server using HMP software can be 

executed on a host machine.
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Configuration
To enable CPD Server to work with HMP software, you must complete the 
following configuration.

Procedure:
Configuring CPD Server for HMP software

Start of procedure

In the CPD Server application in Configuration Manager, configure the 
following two options:
1. Set the line-type option to sip-hmp for Transfer mode, or sip-hmp-asm for 

ASM mode. See page 224 for more information about this option.
2. Set the sip-proxy option in the hmp section. This option contains the IP 

address of the SIP Server that HMP will use for dialing. See page 231 for 
more information about this option.

End of procedure

Procedure:
Configuring the SIP Switch for HMP software
The configuration of a Dialogic folder in Configuration Manager is still 
required when running HMP software. The subdirectories are still named 
regular, engaging, and recording.

Note: The engaging folder is for ASM mode only.

Start of procedure

Configure the subfolders under the main regular, engaging and recording 
folders either manually or using the Configuration Wizard.
1. Configure the HMP board as an iptB1 folder under either the regular or 

the engaging folders. No changes for the names or locations of the voice 
resources (dxxx) are required.

2. Configure the HMP channels as iptB1TX where X is a channel number. The 
DN type must be set to Call Processing Port. The maximum number of 
channels is 256. Genesys does not recommend using more than 128 
channels per server. See Figure 30 as an example.
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Figure 30: Configuring HMP channels

3. Configure the ipt DNs as type Call Processing Ports. The Annex tab of 
these ports must contain a TServer section with the following entries:

contact, with a value of <DN@IP Address>. This specifies the host 
running the HMP software.
refer-enabled, with a value of false.

See Figure 31 as an example.
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Figure 31: Configuring a HMP DN

Refer to the Framework 7.6 SIP Server Deployment Guide for more 
information about these options.

Notes: HMP transfer mode requires two times as many RTP/IPCC resources 
as hardware transfer mode, but the same number of voice resources as 
hardware transfer mode. HMP ASM mode requires the same number of 
resources as hardware ASM mode.
Unlike hardware transfer mode, the UserData in HMP transfer mode is 
attached when the call enters the agent queue or route point. This 
allows CPD Server to run in environments where a conventional T-
Server (not SIP Server) with a media gateway is used.

End of procedure
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Procedure:
Configuring Host Media Processing (HMP) software

Start of procedure

Perform the following configuration instructions to use HMP software:
1. The fcd and pcd file names are the license file name with an fcd or pcd 

extension. They are stored in the ...\HMP\data directory on the host where 
HMP is installed. There are 4 license files with the following extensions:
• lic, which is the actual license file provided by Dialogic.
• pcd, which is the pcd file that will be used by HMP, as generated from 

the .lic file.
• fcd, which is the fcd file that will be used by HMP, as generated from 

the .lic file.
• config, which is the configuration file that will be used by HMP.

2. Generate these files by performing the following steps:
a. Run the Dialogic NetStructure Host Media Processing (HMP) 

License Manager from the Windows Start menu.
b. Browse to the desired license file.
c. Click on the Activate License file to generate the fcd, pcd and config 

files.
3. Configure the HMP software to use the newly generated files by 

performing the following steps:
a. Start Dialogic Configuration Manager (DCM).
b. Stop the HMP software (if not already stopped).
c. Right-click on the HMP entry in DCM and select Restore Device Defaults.
d. Select the pcd file in the Assign Firmware File window that is 

associated with the license file created by Dialogic’s License Manager.
4. Start the system.

Note: Only the SIP protocol without registration (registrar) is currently 
supported.

End of procedure

Dialogic Utilities
The following utilities can help you to resolve problems that might occur when 
you are using Dialogic boards.
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ISDIAG Dialogic Utility
The ISDIAG Dialogic Utility is part of the Dialogic software package. Use this 
utility to test lines, for example, when working with different protocols. You 
can also set call parameters using this utility. 
The utility is a console application. To run the utility, follow the Help menu 
via the command prompts. If the system is not working, use this utility to make 
a call, if you can; then, if the system is still not working, check your hardware 
settings. If you cannot make a call using the utility, contact Genesys Technical 
Support.
Also, try comparing the Trace log against the Dialogic board Component log 
to check for possible problems.

PRI-Trace Utility
The PRI-Trace utility is part of the Dialogic software package. Use it to see all 
the parameters sent through the D-channel. The parameters display in binary 
log files; the PRI-Trace utility turns the logs into readable text.

Dialogic Configuration Manager
Dialogic Configuration Manager (DCM) is part of the Dialogic software 
package.
Make sure that you use this utility when you are configuring Dialogic boards 
for your system. To access this utility from the Start menu, select 
Programs > Dialogic System Software > Dialogic Configuration Manager–

DCM. 
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Chapter

13 Starting and Stopping 
Procedures
This chapter explains how to start and stop Outbound Contact 7.6 with the 
Solution Control Interface (SCI), and how to start and stop Outbound Contact 
Server and CPD Server manually.

Prestart Information, page 327
Using Solution Control Interface, page 328
Starting Manually, page 330
Stopping Manually, page 334
Connection and Reconnection, page 337

Prestart Information
Before starting Outbound Contact, the following Framework components must 
be running:
• Configuration Server
• DB Server (for Configuration Server)
The next two components are optional; however, if you want to start Outbound 
Contact Server with the Solution Control Interface, these must be running:
• Solution Control Server
• Solution Control Interface

Note: If you will be using the CPD Server, install all Dialogic components on 
the same computer as CPD Server before starting CPD Server.

Reporting components can be started anytime after the Framework 
components are started.
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Using Solution Control Interface
Outbound Contact components can be started and stopped through Solution 
Control Interface (SCI) according to the specified starting and stopping 
sequence in the Outbound Solution object.

Starting Outbound Contact
By starting the Outbound Contact solution, you start the components that make 
up that solution.

Procedure:
Starting Outbound Contact Solution/Components with 
SCI

Start of procedure

1. Start SCI either by clicking Sci.exe or selecting Solution Control 
Interface from the Start menu.

2. Go to the Solutions view.
3. Select the solution in the List pane.
4. Click Start or select Start from the shortcut menu.
The solution’s status changes from Stopped to Started after all solution 
components have reported that their status is Running.

Note: Because many components are shared by several solutions, some 
Outbound Contact components may have the status Started before the 
solution is started.

End of procedure

Stopping Outbound Contact Solution/Components with SCI
There are three ways to stop all servers in Outbound Contact using SCI:
• In the Solutions folder, select the Outbound Contact to stop.
• Select Stop from the Action menu.
• From the toolbar, click the Stop Solution/Application button.
You can also stop components individually. See the next sections.
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Note: Stopping the solution does not stop OCM; You must stop OCM 
manually (see page 333)

Procedure:
Stopping CPD Server

Start of procedure

To stop CPD Server using SCI:
1. Select the CPD Server component in the Applications folder.
2. Select Stop from the Action menu.

End of procedure

Procedure:
Stopping CPD Proxy Server

Start of procedure

To stop CPD Proxy Server using SCI:
1. Select the CPD Proxy Server component in the Applications folder.
2. Select Stop from the Action menu.

End of procedure

Procedure:
Stopping OCS

Start of procedure

To stop OCS in SCI:
1. Select the OCS component in the Applications folder.
2. Select Stop from the Action menu.
For more information, see Framework 7.6 Solution Control Interface Help. To 
view the Help file, open SCI, and then launch the Help file.

End of procedure
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Starting Manually
To start Outbound Contact manually, components must be started in a specific 
order. For information about starting the Framework components DB Server, 
Configuration Server, T-Server, and Stat Server, see the Framework 7.6 
Deployment Guide.
For information about starting the Reporting components ICON and 
CC Pulse+, see the Interaction Concentrator 7.5 Deployment Guide (or later) 
and Reporting 7.5 Deployment Guide respectively.
Start components in the following order:
1. DB Server for Configuration Server
2. Configuration Server
3. T-Server
4. All other DB Servers (for Calling Lists)
5. Stat Server
6. ICON components for historical reporting
7. CPD Server (if needed)/CPD Proxy Server (if used)
8. Outbound Contact Server (OCS)
9. CC Pulse+ (for real-time and historical reporting)
10. Outbound Contact Manager (OCM)

Procedure:
Starting Outbound Contact Server

Start of procedure

You can start Outbound Contact Server (OCS) manually in three ways:
• From the Start menu.
• Open an MS-DOS command prompt and type the directory where 

Outbound Contact Server is installed, for example, \Gcti\outbound 
contact\, and use a command line. When starting OCS from a command 
line, use the following common command-line parameters:
-host The name of the host where Configuration Server is running
-port The Configuration Server port
-app The exact name of the Application as configured in the 

Configuration Database
-l The full path to the license file or host and port of the License         

Manager in the <License Manager port>@<License 
Manager host> format.
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For example: cm_server.exe -host ConfigServer1 -port 2020 -app 
OCServer1 -l C:\flexlm\license.dat.

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

• Run batch files, startServer.bat. 
The startServer.bat files are created automatically during installation and 
located at the same directories as executable files. Basically, these files 
include some comments and the same options as are used when starting the 
application from the command line. 
Here is an example of a batch file for OCS:
@echo off

rem ---------------------------------------------------------------

rem Copyright (C) 2008 Genesys Telecommunications Laboratories, Inc.

rem

rem startServer.bat file for Outbound Contact Server, version 
7.6.000.05

rem ---------------------------------------------------------------

@TITLE Outbound Contact Server v. 7.6.000.05: Application OCServer

cm_server.exe -host lab1 -port 7070 -app OCServer -l 7260@lab1

End of procedure

Procedure:
Starting CPD Server

Start of procedure

You can start CPD Server manually in three ways:
• From the Start menu. 
• Open an MS-DOS command prompt and type the directory where CPD 

Server is installed—for example, \Gcti\cpd_server\—and use a 
command line. 
When starting CPD Server from a command line, use the following 
common command-line parameters:
-host The name of the host where Configuration Server is running
-port The Configuration Server port
-app The exact name of the application as configured in the 

Configuration Database
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-l The full path to the license file or host and port of the License         
Manager in the <License Manager port>@<License 
Manager host> format.

For example: cpdserver.exe -host ConfigServer1 -port 2020 -app 
CPDServer1 -l C:\flexlm\license.dat.

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

• Run batch files, startServer.bat. 
The startServer.bat files are created automatically during installation and 
located at the same directories as executable files. Basically, these files 
include some comments and the same options as are used when starting the 
application from the command line. 
Here is an example of a batch file for CPD Server:
@echo off

rem ---------------------------------------------------------------

rem Copyright (C) 2008 Genesys Telecommunications Laboratories, Inc.

rem

rem startServer.bat file for Call Progress Detection Server, version 
7.6.000.04

rem ---------------------------------------------------------------

@TITLE Call Progress Detection Server v. 7.6.000.04: Application 
cpdserver

cpdserver.exe -host lab2 -port 7070 -app cpdserver -l 7260@lab2

End of procedure

Procedure:
Starting CPD Proxy Server

Start of procedure

You can start CPD Proxy Server manually in three ways: 
• From the Start menu. 
• Open an MS-DOS command prompt and type the directory where CPD 

Proxy Server is installed—for example, \Gcti\cpd_proxy\—and use a 
command line. When starting CPD Proxy Server from a command line, use 
the following common command-line parameters:
-host The name of the host where Configuration Server is running
-port The Configuration Server port
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-app The exact name of the application as configured in the 
Configuration Database

For example: cpdproxy.exe -host ConfigServer1 -port 2020 –app 
CpdProxy

Note: If you are implementing the client-side port security feature, 
specify the additional arguments described in “Client-Side Port 
Security Configuration” on page 105.

• Run batch files, startServer.bat. 
The startServer.bat files are created automatically during installation and 
located at the same directories as executable files. Basically, these files 
include some comments and the same options as are used when starting the 
application from the command line.
Here is an example of a batch file for CPD Proxy Server:
@echo off

rem ---------------------------------------------------------------

rem Copyright (C) 2008 Genesys Telecommunications Laboratories, Inc.

rem

rem startServer.bat file for Call Progress Detection Proxy, version 
7.6.000.04

rem ---------------------------------------------------------------

@TITLE Call Progress Detection Proxy v. 7.6.000.04: Application 
cpdproxy

cpdproxy.exe -host lab3 -port 7070 -app cpdproxy

End of procedure

Procedure:
Starting and logging in to Outbound Contact Manager

Start of procedure

1. To start Outbound Contact Manager, from the Start menu, select All 
Programs > Genesys Solutions > Outbound Contact > Outbound Contact 

Manager (OCM).

Note: Using Windows Explorer, you could also locate the OCM 
executable in the destination folder of the OCM installation and 
double-click it.
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2. In the Login dialog box, enter a user name that has permission to use this 
OCM. Change the user name to match Configuration Manager’s user 
name.

Note: Persons (non-agents) are added automatically to the Admin Access 
Group.

3. Click Details.
4. Enter the application name. The default application name is blank; this 

name must be changed to the instance of Outbound Contact Manager as it 
is registered in the Configuration Database.

5. Enter the host name of the computer running Configuration Server.
6. Enter the port number for the network port used by Configuration Server 

on the host computer.
7. Click OK.

Note: Login will fail if Configuration Server is not running or if you do 
not have permission to log in.

8. In the Select Tenant window, select a tenant from the list and click Next. 
(Outbound Contact Manager can work with only one tenant at a time).

Note: You only see all tenants if you are a Super Administrator.

9. In the next window, select the Outbound Contact Server to which you 
would like to connect and click Finish.

Campaigns, Calling Lists, Agent Groups, and Place Groups that have already 
been defined in the Configuration Database appear the first time OCM is run.
If Outbound Contact Server is not running, Outbound Contact Manager still 
logs in to Configuration Server and the user can work with calling lists.

End of procedure

Stopping Manually
Stop components in the following order:
1. Outbound Contact Manager (OCM)
2. CC Pulse
3. Outbound Contact Server (OCS)
4. CPD Server/CPD Proxy Server (if used)
5. ICON components for historical reporting
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6. Stat Server
7. All other DB Servers (for Calling Lists)
8. T-Server
9. Configuration Server
10. DB Server for Configuration Server

Outbound Contact Manager (OCM)

Procedure:
Stopping OCM

Start of procedure

1. Select the File menu.
2. Select Exit.

End of procedure

Outbound Contact Server (OCS)

Procedure:
Stopping manually

Start of procedure

1. Find the OCS console window on the computer’s desktop.
2. Click the Close button in the window’s upper-right corner.

End of procedure

Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows services window, select the OCS to stop.
3. Select Stop.

End of procedure
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CPD Server

Procedure:
Stopping manually

Start of procedure

1. Find the CPD Server console window on the computer’s desktop.
2. Click the Close button in the window’s upper-right corner.

End of procedure

Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows Services window, select the CPD Server to stop.
3. Select Stop.

End of procedure

CPD Proxy Server

Procedure:
Stopping manually

Start of procedure

1. Find the CPD Proxy Server console window on the computer’s desktop.
2. Click the Close button in the window’s upper-right corner.

End of procedure
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Procedure:
Stopping as a Windows Service

Start of procedure

1. Select Services in the computer’s Control Panel.
2. In the Windows Services window, select the CPD Proxy Server to stop.
3. Select Stop.

End of procedure

Restarting Outbound Contact Components
To restart Outbound Contact components, follow the previously documented 
steps.
OCM does not keep long-term data, so it is safe to stop and restart. OCS will 
update OCM with the campaign status.

Connection and Reconnection
Outbound Contact components connect to servers to deliver and receive 
information about the contact center. OCS and CPD Server can be set up with 
the following standby mode:
• Warm Standby

Note: Outbound Contact components cannot currently be set up in cold 
standby or hot standby modes. 

OCS now has an enhanced warm standby mode to handle situations when OCS 
stops working for any reason.
In Outbound Contact, the primary and backup OCS communicate through a 
CommDN (Communication DN). In enhanced warm standby mode, a 
secondary OCS receives all of the same data about campaign status (for 
example, start, stop, load, unload) as the primary OCS. If the primary OCS 
stops working for any reason, the secondary OCS takes over the operations of 
the primary OCS without interruption. All client applications are connected to 
the primary OCS.
The difference between enhanced warm standby mode and warm standby 
mode is that the backup/secondary OCS in warm standby mode, does not 
receive all of the same data about campaign status as the primary server. 
For more information about the standby modes, refer to the Framework 7.6 
Deployment Guide.
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OCS Connections
OCS has connections to these components:
• DB Server
• T-Server, see page 339
• Stat Server, see page 340
• Configuration Server, see page 340
• CPD Server, see page 341
• CPD Proxy Server (if used), see page 341
• Backup or primary OCS (through a Communication DN)
• Interaction Server (if used), see page 342
• OBN Manager (optional), see page 342
Using the option outbound_contact_server, you can set up special options for 
the Communication DN that OCS uses. The Communication DN 
communicates information about the status of campaigns (for example, start, 
stop, load, unload, and so on) between the backup and primary OCS as well 
as third-party applications, which can be used in place of OCM.

OCS and DB Server

If the connection between OCS and DB Server is lost, OCS sends an error 
message. Depending on how long the loss of connection lasts, a message may 
display in real-time reporting and historical reporting to indicate that OCS is 
waiting for records.

Warm Standby

OCS supports DB Server in warm standby mode without manual intervention 
and without double dialing of records.
If the OCS connection to the primary DB Server is lost, the currently running 
campaign continues to dial calls until all records in the OCS buffer are 
depleted. OCS sends a Waiting-for-Records message to Stat Server, which 
causes the message to display also in CC Pulse. OCS then connects to the 
backup DB Server. The campaign continues to run after the switchover is 
complete. After switching to the backup DB Server, OCS retries the failed 
transactions from the transaction buffer. Double dials due to failed transactions 
are not induced by the switchover.
If the connection to the backup DB Server is lost, OCS will reconnect to the 
primary DB Server.OCS retries any failed transactions. During the switchover 
to the primary DB Server, OCS runs without manual intervention.
Because OCS periodically queries calling lists for the number of ready records 
and notifies Stat Server of the estimated time to complete the campaign 
calculation, this function may be interrupted during the loss of connection. 
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However, OCS continues to send this information after the connection is 
reestablished.

No Standby

OCS tries to reconnect to DB Server without manual intervention and without 
double dialing of records. Failed transactions are retried.

OCS and T-Server

The OCS connection to T-Server is set up on the Connections tab of the OCS 
Application object.

Note: Starting with release 7.5, the backup OCS application maintains a 
direct connection to the primary OCS application. Previously, the 
backup OCS application monitored UserEvents that were distributed by 
the primary OCS application using the T-Server application. 

Hot Standby

T-Server can operate in hot standby mode; however, this mode is transparent 
to OCS. That is, although OCS is connected to T-Server, the switchover 
between primary and secondary T-Servers does not affect OCS call processing.

Warm Standby

OCS reconnects to T-Server without manual intervention and without double 
dialing of records.
OCS cannot send statistics during the switch to a backup server. OCS does not 
re-send the statistics after the reconnection; therefore, some campaign statistics 
might be lost.
Some calls are lost while OCS tries to reconnect to T-Server. According to an 
internal timer expiration, OCS is able to track the lost calls, and mark the call 
records with call result stale, thus preventing double dialing of records.
If the OCS connection to the primary T-Server is lost, the currently running 
campaign pauses. OCS connects to the backup T-Server and then queries the 
backup T-Server for Queue, Agent, and Call Status. The campaign continues to 
run after the switchover is complete.
If the connection to the backup T-Server is lost, OCS reconnects to the primary 
T-Server.

ADDP

OCS supports Advanced Disconnect Detection Protocol (ADDP), thus 
enabling speedy disconnect detection. This option is configurable in the OCS 
Application object.
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The connection between OCS and T-Server is a passive connection; OCS 
receives information from T-Server and relies on TCP/IP timeouts to identify 
whether the disconnection might be too long. ADDP speeds up the detection of 
the disconnect.
If no warm standby mode is specified, OCS will keep trying to connect to the 
currently configured T-Server. The currently running campaign will be paused 
until connection is resumed.

OCS, Stat Server, and Reporting

OCS can now connect directly with Statserver, and submit data required for 
statistical calculations for StatServer extensions. OCS also communicates with 
Stat Server through a Communication DN. OCS can send statistics to multiple 
Stat Servers through one or more Communication DNs.
There is no warm standby or hot standby mode for Stat Server. Redundancy 
for Outbound Contact real-time reporting can be achieved by:
• OCS sending statistics to multiple Stat Servers running simultaneously.
• CCPulse+ reconnecting to a backup Stat Server when the primary is down.
If the OCS connection to Stat Server is lost, real-time reporting and data 
collection for historical reporting resume without manual intervention after 
Stat Server is running again. Note that real-time reporting and data collection 
for historical reporting is interrupted when Stat Server is down.
In a multi-site environment, OCS is able to identify the statistics for each T-
Server and thus send statistics using the Communication DN registered with 
each T-Server. Redundancy for Outbound reporting is possible by setting up 
multiple Stat Servers running simultaneously. 

OCS and Configuration Server

If the connection between OCS and Configuration Server is lost, OCS sends an 
error message to Management Layer and does the following:
• After waiting the length of time specified in the Reconnect Timeout 

parameter set in the application object, OCS tries to connect to a backup 
Configuration Server.

• If no backup Configuration Server exists, after the timeout it tries to 
reconnect to the primary Configuration Server.

OCS also supports Advanced Disconnect Detection Protocol (ADDP) to 
Configuration Server. To enable ADDP between this server and Configuration 
Server, add the Configuration Server Application (named confserv) to the 
Connections tab and specify the values in seconds for the connection protocol. 
For more information, refer to Framework 7.6 Configuration Manager Help.
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OCS and CPD Server

OCS can connect to multiple CPD Servers. In the Outbound Contact Wizard, 
the association with CPD Server is set at the application level. To set it on the 
group level, use Configuration Manager.

Warm Standby

OCS supports CPD Server in warm standby mode without manual intervention 
and without double dialing of records.
If OCS loses connection to CPD Server, OCS will send a message to 
Management Layer and a system error message to Stat Server for real-time and 
historical reporting.
If the OCS connection to the primary CPD Server is lost, the currently running 
campaign is paused. OCS then connects to the backup CPD Server and the 
campaign will continue to run after the switchover to the backup CPD Server is 
complete.
After switching over to the backup server, OCS does not retry the previous 
transactions handled by the disconnected CPD Server. Instead, call records in 
those transactions are marked with the call result stale when the OCS internal 
timer for those records expires. Double dialing of the same call record does not 
occur.
If the connection to a backup CPD Server is lost, OCS reconnects to the 
primary CPD Server without attempting to redial failed transactions.

No Backup

If there is no warm standby, OCS supports reconnection without manual 
intervention and without double dialing of records. OCS tries to connect to the 
currently configured CPD Server. The currently running campaign pauses until 
the connection is restored.
Some calls are lost while OCS tries to reconnect to CPD Server. OCS tracks 
lost calls according to the expiration of the internal timer for those records and 
marks the call records with call result stale, thus preventing double dialing of 
records.

OCS and CPD Proxy Server

OCS can connect to multiple CPD Proxy Servers. In the Outbound Contact 
Wizard, the association with CPD Proxy Server is set at the application level. 
To set it on the group level, use Configuration Manager.

Warm Standby

OCS supports CPD Proxy Server in warm standby mode without manual 
intervention and without double dialing of records.
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If OCS loses connection to CPD Proxy Server, OCS will send a message to 
Management Layer and a system error message to Stat Server for real-time and 
historical reporting.
If the OCS connection to the primary CPD Server is lost, the currently running 
campaign is paused. OCS then connects to the backup CPD Proxy Server and 
the campaign will continue to run after the switchover to the backup CPD 
Server is complete.
After switching over to the backup server, OCS does not retry the previous 
transactions handled by the disconnected CPD Proxy Server. Instead, call 
records in those transactions are marked with the call result stale when the 
OCS internal timer for those records expires. Double dialing of the same call 
record does not occur.
If the connection to a backup CPD Proxy Server is lost, OCS reconnects to the 
primary CPD Proxy Server without attempting to redial failed transactions.

No Backup

If there is no warm standby, OCS supports reconnection without manual 
intervention and without double dialing of records. OCS tries to connect to the 
currently configured CPD Proxy Server. The currently running campaign 
pauses until the connection is restored.
Some calls are lost while OCS tries to reconnect to CPD Proxy Server. OCS 
tracks lost calls according to the expiration of the internal timer for those 
records and marks the call records with call result stale, thus preventing 
double dialing of records.

OCS and Interaction Server

In order for OCS to process requests and responses from Interaction Server, 
OCS must be a server for Interaction Server and receive these responses on a 
special ESP-type port rather than its default listening port. This ESP PortID 
must be used instead of the default PortID, when configuring a connection to 
the OCS Application object on the Server Info tab of the Interaction Server 
Application object. This makes OCS a server for Interaction Server and 
Interaction Server a client for OCS.

OCS and OBN Manager (Optional)

OCS uses the Outbound Notification Manager (OBN) application as a 
connector to GVP to request that GVP dial records. The OBN Manager GVP 
application should be created in Configuration Manager to provide its host and 
port information to OCS. This application must be specified on the 
Connections tab of the Campaign Group configuration object to enable GVP 
integration. This configuration will enable basic connection capabilities.
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If full connection abilities are required, including Advanced Disconnect 
Detection Protocol (ADDP), then this application should also be present on the 
Connections tab of the OCS application, where the ADDP connection protocol 
can be specified.
For more information about Outbound Contact and GVP integration, see 
“Genesys Voice Platform” on page 71. Also see the Genesys 7.6 Proactive 
Contact Solution Guide.

OCS, Failover, Campaigns

If OCS is running campaigns and then stops functioning due to software, 
hardware, or network issues, the campaigns and records associated with 
outbound calls are affected.

Note: You can configure OCS to restart automatically if you have configured 
LCA, Solution Control Server, and Solution Control Interface 
accordingly.

Impact on Campaigns

When OCS stops functioning, campaigns will not be loaded and will not restart 
automatically even if OCS restarts.
If OCS is operating in the Warm Standby mode and running campaigns, the 
failure of the primary OCS causes the backup OCS to continue running the 
campaigns with a new set of available records, which must be retrieved from 
the database. The retrieval occurs immediately after the switchover to the 
backup OCS.

Note: The primary and backup Outbound Contact Servers synchronize not 
only the state of the campaigns and sequences, but also the predictive 
algorithm information. The backup OCS is capable of taking over and 
continuing dialing as efficiently as the primary if a Predictive dialing 
mode is used.

Impact on Records and Calls

When a failure and switchover occurs, be aware that:
• Records in use by the primary OCS remain in the retrieved state in the 

database. These must be manually updated if you want those records to be 
in a final state or if you want the associated numbers to be dialed again 
when you run the campaign another time.

• The internal state of the records and associated outbound calls stored in the 
memory of the primary OCS are lost when it stopped functioning.
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• Any calls or interactions (if using the Push Preview dialing mode) being 
processed by the OCS at the time of the failure continue to get queued, 
routed, established with an agent DN, transferred, and so on.

• As these calls are processed, though, the agents handling them cannot 
update the associated records because the records were lost when the 
primary OCS stopped functioning.

Impact on Connections

When Outbound Contact Manager loses its connection to the primary OCS, 
OCM displays a dialog box that allows the user to retry the connection to the 
primary server or connect to the backup server.

Note: Starting with release 7.5, OCM supports a silent reconnection.

This reconnection issue does not apply to other servers or dialers to which 
OCS connects (for example, CPD Server, T-Server, DB Server, and so on), 
because connections to them should already be specified in the backup OCS 
Application object. Agent Desktops are also not affected as they do not have a 
direct connection to OCS. They only need the new OCS DBID, which will be 
delivered to the Desktop with a record’s attached data.

OCM Connections
OCM has connections to the following components:
• OCS 
• DB Server
• Configuration Server

OCM and OCS

OCM connects to one OCS at a time by prompting the user during login. OCM 
supports dynamic reconfiguration of all OCS Application objects listed on 
OCM’s Connections tab. Multiple instances of OCM can be connected to one 
OCS concurrently. If multiple OCS Application objects are defined on the 
OCM Application object’s Connections tab, the list of OCS Application 
objects is displayed for the user to select.
If the connection between OCM and OCS is lost, OCM prompts the user to 
reconnect or to select a backup OCS (if available).

OCM and DB Server

OCM establishes an active connection to the DB Server that is associated with 
the calling list on which the user is working.
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If the original connection fails, OCM prompts the user to reconnect to the DB 
Server or to select a backup DB Server (if available).

CPD Server Connections
A CPD Server connects to one T-Server (and one switch) only.
In a multi-site/multi-switch environment, Outbound Contact needs at least one 
CPD Server per switch.

CPD Server and T-Server

The CPD Server connection to T-Server is set up on the Connections tab of the 
CPD Server Application object.

Warm Standby

CPD Server with a T-Server in Warm Standby mode supports reconnection 
without manual intervention and without double dialing of records.
If CPD Server’s connection to the primary T-Server is lost, the currently 
running campaign pauses. CPD Server connects to the backup T-Server. The 
currently running campaign continues to run after the switchover to the new 
server. Some calls might be lost in warm standby mode. According to an 
internal timer expiration, OCS tracks the lost call and marks the calls record as 
stale to prevent double dialing.
If the connection to the backup T-Server is lost, CPD Server reconnects to the 
primary T-Server. After switching over to the primary T-Server, CPD Server 
runs without manual intervention.

No Backup

If CPD Server loses its connection to a T-Server that is not in a standby mode, 
CPD Server tries to reconnect to the same T-Server. It reconnects without 
manual intervention and without double dialing of records. The currently 
running campaign pauses until the connection is restored.
Some calls might be lost while CPD Server is trying to reconnect to T-Server. 
OCS tracks the lost calls and marks the call record as stale to prevent double 
dialing.

CPD Proxy Server Connections
A CPD Proxy Server connects to several CPD Servers, which must be 
connected to the same switch only.
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CPD Proxy Server and CPD Server(s)

The CPD Proxy Server connections to CPD Servers are set up on the 
Connections tab of the CPD Proxy Server Application object.

Warm Standby

CPD Proxy Server with a CPD Server in Warm Standby mode supports 
reconnection without manual intervention and without double dialing of 
records. If CPD Proxy Server's connection to the primary CPD Server is lost, 
the currently running campaign slows down due to decreasing of dialing 
resources available. CPD Proxy Server connects to the backup CPD Server. 
After the switchover to the backup CPD Server is completed the currently 
running campaign speeds up due to an increasing of dialing resources 
available. Some calls might be lost during reconnection in warm standby mode 
on CPD Server side. CPD Proxy Server reports to OCS about such calls as an 
Error to OCS. OCS tracks the lost call and marks the calls record accordingly 
to prevent double dialing.
If the connection to the backup CPD Server is lost, CPD Proxy Server 
reconnects to the primary CPD Server. After switching over to the primary 
CPD Server, CPD Proxy Server runs without manual intervention.

No Backup

If CPD Proxy Server loses its connection to CPD Server that is not in a standby 
mode, CPD Proxy Server tries to reconnect to the same CPD Server. It 
reconnects without manual intervention and without double dialing of records. 
The currently running campaign slows down until the connection is restored.
Some calls might be lost while CPD Proxy Server is trying to reconnect to 
CPD Server.
CPD Proxy Server reports to OCS about such calls as an Error to OCS. OCS 
tracks the lost calls and marks the calls record accordingly to prevent double 
dialing.

Transport Layer Security Connections
Outbound Contact Server, CPD Server, and CPD Proxy Server support TLS 
with any Genesys TLS-supporting client/server.
Outbound Contact Manager and the Outbound Contact Configuration Wizard 
do not support TLS.

Note: If you are configuring TLS between OCS and DB Server, add a 
Database Access Point (DAP) to DB Server on the Connections tab of 
the OCS Application object.

See the TLS section of the Genesys 7.6 Security Deployment Guide for more 
information.
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